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Documentation Updates
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Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
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Welcome to This Guide

This guide describes how to work with HP Business Availability Center 
Dashboard.

This chapter includes:

 ➤  How This Guide Is Organized on page 11

 ➤  Who Should Read This Guide on page 12

 ➤  Getting More Information on page 12

How This Guide Is Organized

The guide contains the following parts:

 Part I Dashboard

Describes how to work with Dashboard and the Dashboard views, how to 
use the Top View, Console, Filters, Geographical Map, Custom Map, and 
Topology Map tabs to display the view’s data, and how to incorporate 
HP Business Process Insight and HP TransactionVision data into HP Business 
Availability Center.

 Part II Reports

Describes how to view the Dashboard reports, and how to use the report 
repository. 

 Part III KPIs

Describes how to manage the Key Performance Indicators (KPIs) of a 
configuration item (CI).
11



Welcome to This Guide
 Part IV KPI Assignments

Describes how to manage the factory and custom KPI assignments that are 
activated under certain conditions and add KPIs, rules, context menus, and 
context menu items to specific CIs.

 Part V External Display

Describes how to install and manage so the Dashboard Ticker so that you 
can display HP Business Availability Center data on your desktop in a Ticker 
Window or in a Message Window.

Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center platform administrators

➤ HP Business Availability Center application administrators

➤ HP Business Availability Center data collector administrators

➤ HP Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with HP Business Availability Center 
and enterprise monitoring and management concepts.

Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the the HP Business Availability Center Deployment Guide PDF.
12
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1
Introduction to Dashboard 

This chapter includes general information about Dashboard.

This chapter includes:

Concepts

 ➤  Dashboard Overview on page 16

 ➤  Dashboard Tabs on page 18

 ➤  How Dashboard Works on page 20

 ➤  Repositories on page 22

 ➤  Views on page 22

 ➤  Real-Time Changes to CI Properties on page 23

 ➤  Dashboard Application Components in the Service Report on page 24

 ➤  About Menu Options on page 24

 ➤  Dashboard General Notes and Tips on page 25

Tasks

 ➤  View Data in Dashboard – Workflow on page 26

 ➤  Customize the Way HP Business Availability Center Displays Views in 
Dashboard on page 30

 ➤  Display Data in Dashboard on page 34

 ➤  View Sample Details on page 35

 ➤  Acknowledge Performance Problems on page 36

 ➤  Switch Off the Alert Sound When CI is Acknowledged on page 40

 ➤  Analyze Real-Time Change Information on page 40
15



Chapter 1 • Introduction to Dashboard
 ➤  View Related Change Requests Reports on page 42

 ➤  View Service Impact Report on page 45

 ➤  Find Visible and Hidden Child CIs on page 50

 ➤  Set Up Sound Notification When KPI Status Changes to Critical on page 52

 ➤  Customize Dashboard Display and Refresh Rate on page 53

 ➤  Use the Troubleshooting Logs on page 55

Reference

 ➤  Dashboard User Interface on page 57

Troubleshooting and Limitations on page 87
Concepts

Dashboard Overview

HP Business Availability Center is a comprehensive business service 
management and application management solution. Dashboard enables 
your team to monitor the health of business services and applications from 
the point of view of the consumers of those services—the business, its 
customers, and its partners.

This section includes the following topics:

➤ “Collecting and Aggregating Data” on page 17

➤ “Prioritizing IT Operations and Maximizing Business Results” on page 17
16



Chapter 1 • Introduction to Dashboard
Collecting and Aggregating Data
Dashboard uses data collected by HP Business Availability Center 
monitoring components, such as Business Process Monitor, SiteScope, and 
Enterprise Management Systems (EMS) integration tools, as well as data 
collected from external monitoring tools. HP Business Availability Center 
collects metrics about the end-user experience from a range of 
environments, including ERP, CRM, Web, and Citrix, and about the system 
performance from a range of back-end infrastructure components, including 
Web, application, database, and firewall servers.

The collected and aggregated data is used by the Dashboard Key 
Performance Indicators (KPIs) to provide quantifiable measurements that 
help you monitor how well your business is achieving objectives. The KPIs 
provide a real-time assessment of the present state of your business and 
processes, enable you to track critical performance variables over time, and 
help you assess the business impact of problems in the system.

At the top level, Dashboard provides an integrated view of critical 
applications and business processes; from there, you can drill down to the 
underlying IT infrastructure associated with these critical business processes. 
This drill-down view can be laid out in any number of ways, such as by data 
centers, by technology clusters, by geographical locations, and so on.

Prioritizing IT Operations and Maximizing Business 
Results
Dashboard helps you to prioritize IT operations and maximize business 
results by:

➤ Presenting global system component data organized into a logical and 
relevant framework.

➤ Providing integrated, scalable, cross-application views that reflect the health 
of mission-critical services and applications in real time. This enables IT 
operations teams to continuously manage the health of mission-critical 
services and applications from one central location.

➤ Providing a common view of how IT operations are meeting line-of-business 
goals. This enables better communication between the teams, and the 
alignment of management and IT operations around customer-centric 
values.
17
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➤ Providing the ability to assess actual customer impact, so that IT teams can 
prioritize response according to business impact and optimize resource 
utilization to meet critical business objectives. The end result is better 
quality of service for your end users.

➤ Providing a big-picture perspective, enabling you to see how a performance 
issue impacts the availability of any part of your business and to quantify 
the business impact of a potential failure.

➤ Providing operational-level service level management reporting. Dashboard 
uses Service Level Management data to provide an indication of whether an 
SLA is in breach of contract, or might be in breach in the near future.

Dashboard Tabs

Dashboard administration and application are accessed from two different 
areas of HP Business Availability Center.

This section includes the following topics:

➤ “Dashboard Administration Tabs” on page 18

➤ “Dashboard Application Tabs” on page 19

Dashboard Administration Tabs
To access the Dashboard Administration tabs, select Admin > Dashboard.

Dashboard Administration includes the following tabs:

➤ KPIs tab. Enables you to edit the KPIs attached to a configuration item (CI), 
and to attach new KPIs to CIs. The KPIs you create are displayed in 
Dashboard to help the user monitor how well the business is achieving its 
objectives and assess the business impact of problems in the system. For 
details, see “KPIs Page” on page 398.

➤ Custom Map tab. Enables you to create a custom map to display real-time 
indicators icons representing CIs in the view on a custom image. For details, 
see “Custom Map Page” on page 192.
18
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➤ Geographical Map tab. Enables you to create an association between 
geographical locations and status indicators on a geographical map. For 
details, see “Geographical Map Page” on page 176.

➤ KPI Assignments tab. Enables you to configure a KPI assignment. For details, 
see “Define Assignment Configuration Dialog Box” on page 440.

➤ Repositories tab. Provides access to the Dashboard Repository. The 
repository provide definitions for objects in the HP Business Availability 
Center system. Many of these definitions can be customized as required by 
your organization. For details, see “Repositories” on page 22.

Dashboard Application Tabs
To access the Dashboard Application tabs, select Application > Dashboard.

Dashboard application includes the following tabs:

➤ Top View tab. Displays the components of the active view in a hierarchical, 
top-down graphic. For details, see “Top View Page” on page 108.

➤ Console tab. Displays the components of the active view arranged in a 
hierarchical tree. For details, see “Console Page” on page 125.

➤ Filters tab. Displays a filtered list of CIs, according to the selected filter 
option. For details, see “Filters Page” on page 148.

➤ Geographical Map tab. Displays an association between geographical 
locations and status indicators in a geographical map. For details, see 
“Geographical Map Page” on page 176.

➤ Custom Map tab. Displays icons representing CIs in the view on a custom 
image. For details, see “Custom Map Page” on page 192.

➤ Topology Map tab. Provides a topological representation of the view's CIs 
and CI relationships. For details, see “Topology Map Page” on page 199.

➤ Reports tab. Displays the Dashboard reports: KPIs Distribution Over Time, 
KPIs Over Time, KPIs Summary, and KPIs Trend reports. In addition, you can 
access the Related Change Requests and Service Impact reports. For details, 
see “Reports User Interface” on page 300.
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How Dashboard Works

The physical and logical entities in your system, such as hardware, software, 
services, business processes, and so on, are represented in Dashboard by 
configuration items (CIs). The CIs are stored in the HP Universal CMDB, and 
organized into hierarchical format based on the interdependencies in your 
organization’s IT environment. 

You can view CIs in service views in Dashboard. Each service view provides a 
different aspect of your organization’s IT universe, enabling you to focus on 
the IT area that is of interest.

Each CI has one or more KPIs showing current operational status or business 
impact over time. Status propagates up the CI hierarchy, from the monitor 
(leaf) CIs at the bottom of a tree, up to the root CI shown at the top of the 
tree. The monitor CIs receive real performance metrics from the monitoring 
data collected by HP Business Availability Center, and KPI status for these 
CIs is calculated from that data. For most higher level CIs, KPI status is based 
on an aggregation of statuses for all child CIs (the calculation method used 
for this aggregation varies, according to the KPI’s business logic).

The child CIs for a CI may not be visible in a view, but the KPI status shown 
is still based on the status propagated up from both visible and hidden child 
CIs.

The incoming report data is updated every 30 seconds (configurable default 
value), so that the status information displayed in Dashboard represents the 
real-time availability of your organization’s infrastructure components. 

This section contains the following topics:

➤ “Monitoring Performance Problems” on page 21

➤ “Monitoring Service Level Agreements” on page 21
20
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Monitoring Performance Problems
When a performance problem is identified, you can drill down to locate the 
source of the problem, view event reports, and track problem handling. You 
can also move directly to the appropriate pages in HP Business Availability 
Center to view reports for problematic components, measurement data over 
time, and general monitoring data.

Dashboard also enables you to view operational status from the viewpoint 
of geographical locations, so you can see which locations are impacted by 
problems. 

In addition, you can isolate and manage enterprise problems discovered in 
HP Business Availability Center, and identify likely suspects that are at the 
root of the problem using the Problem Isolation application.

Monitoring Service Level Agreements
Service Level Management enables you to track applications, infrastructure, 
and services according to the service contracts you have with internal or 
external customers.

In Dashboard, you can view an SLA information bar that gives you 
advanced warning of any potential breaches of contract, and you can act 
proactively to fix a problem before it causes financial damage. 
21
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Repositories

The Repositories tab includes the definitions for objects in the HP Business 
Availability Center system. Many of these definitions can be customized as 
required by your organization. For details, see “Repositories” in CI Attribute 
Customization.

Views

The CIs and relationships produced by the various CI-generating tools that 
operate within HP Business Availability Center are stored in the 
configuration management history database. 

The service views displayed in Dashboard are built from CIs contained in 
the CMDB. These CIs are mapped together to build views that meet your 
business requirements and objectives, and monitor what is important to 
you. (For a more detailed explanation of how views are built, see “Working 
with Pattern and Instance Views in IT Universe Manager” in Model 
Management.) Each CI has only one instance in the CMDB. Different views 
can look at the same CI. 

Details about specific views are provided in subject-related documentation; 
for example Real User Monitor views are detailed in “Understanding Real 
User Monitor Views” in Using End User Management.

The CIs at the lowest level of the hierarchy represent the monitor CIs, such 
as SiteScope monitors, Business Process Monitor transactions, or metrics 
from other external monitoring sources. The upper levels of the hierarchy 
represent logical groups. CI names are either taken from the external source, 
or are defined by the administrator as part of the CI properties.When 
changes are made to your organization’s infrastructure, they are detected by 
the discovery process or by the monitoring source adapters. Dashboard 
checks the engine every 60 seconds (default setting), for configuration 
changes received from the external sources. The structure and content of the 
CI hierarchies are then automatically updated and deployed to the 
Dashboard application. Some settings of the source adapters may affect the 
hierarchy of the view; for example, Transactions/locations in the Business 
Process Monitor source adapter. For more information, see Model 
Management.
22
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In addition, changes made within HP Business Availability Center, by 
changing the profiles in End User Management Administration or manually 
updating CIs in CMDB Administration, are also automatically deployed to 
Dashboard.

KPIs are assigned, by default, to monitor CIs and propagate up the hierarchy. 
You can manually assign additional KPIs to CIs in Dashboard 
Administration. For each CI, one or more KPI columns are displayed. For 
example, Availability, System, Performance, and so on. For a list of the KPIs 
used in Dashboard, see “List of Dashboard KPIs and Their Details” in 
CI Attribute Customization.

For each CI, each KPI column contains status icons or values, representing 
how the KPI objective is met. For details on KPI status, see “Understanding 
KPI Status” on page 352.

The views may also contain dynamic hierarchies generated by the Dynamic 
Node Factory definition file. These hierarchies are created in the CMDB at 
runtime, based on the incoming samples. The parent for a dynamic 
hierarchy is a Dynamic Node Factory CI. Note that the CIs under the 
Dynamic Node Factory parent do not generally have option menus. For 
more information on dynamic hierarchies, see “IT Universe Manager – 
Dynamic Node Factory” in Model Management.

Real-Time Changes to CI Properties

Change icons are displayed in the Console tab and in the Filters tab, on the 
right of the CI name to indicate that changes were made to the first 20 
change-monitored properties of a CI, in real time. For details, see “Console 
Page” on page 125 or “Filters Page” on page 148.

Changes made to additional CIs are displayed in the Change report. For 
details, see “Change Report Page” in Model Management.

To display the real-time change information, see “Analyze Real-Time 
Change Information” on page 40.
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Dashboard Application Components in the Service 
Report 

You can build Service Reports based on data from data sources from the 
Dashboard application. You can add Service Reports as portlets in My BAC 
or in Report Manager. After you have added Service Reports to the Report 
Manager, you can add the reports as custom report components to benefit 
from all the custom report capabilities. For details, see “Service Report 
Overview” in Using My BAC or “Report Manager Overview” in Reports.

About Menu Options

From most tabs in Dashboard and from the View Explorer, you can access 
context menu options that enable you to move to different tabs or 
applications filtered for the selected CI.

Click the down arrow next to a CI name to access the menu options for that 
CI. Available options depend on the type of CI and the context menu 
defined for the CI. If no context menu is defined for the CI, the menu arrow 
is not displayed. If one of the menu options is not supported for the selected 
CI, that option is disabled.

The menu options are available for CIs in the Console and Filters tabs, and 
in View Explorer. 

For advanced information on the various menu options, see “Context Menu 
Items Repository” in CI Attribute Customization.

The available menu options of a CI can include the following functionality:

➤ Enable you to move to other HP Business Availability Center applications or 
SiteScope to view information and reports related to the CI, or to open 
standalone reports or views. For example, you can view a trend report on 
the End User Management page, including measurement data for the CI 
over a specified time period. 

➤ Enable you to move to the Filters tab to view the CIs of a CI’s subtree where 
you can filter the subtree CIs and monitor CIs according to the current 
active filter selected in the Filters tab.
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The menu options displayed in Dashboard View Explorer and the main page 
of the Console and Filters tabs depend on the selected view and the selected 
CI. They can be a subset of the options described in this section. 

For details about the options, see “Menu Options” on page 62.

Dashboard General Notes and Tips

Note the following when working with Dashboard:

➤ It is recommended that you use Microsoft Internet Explorer as your browser 
when using the Dashboard application.

➤ User access to Dashboard views is limited by the viewing permissions 
specified for the user. If you cannot see a view, contact your administrator. 
For details, see “Permissions Overview” in Platform Administration.

➤ The first time you access Dashboard, you may experience a short delay while 
Dashboard compiles the page.

➤ Dashboard uses the timestamp of the database machine hosting the 
HP Business Availability Center database. The times displayed in the tooltips 
reflect the time zone setting on that computer. If you customize the time 
zone setting in HP Business Availability Center using the Admin > Personal 
Settings > General Settings option, then the customized time zone is also 
used in Dashboard.

➤ When Dashboard does not receive data for a Business Process profile because 
a Business Process Monitor is stopped (while the profile itself is not 
stopped), this is not specifically indicated in the tooltip. In this case, after a 
while the tooltip Status parameter displays Not up to date, and the Warning 
parameter displays the number of seconds during which no data has arrived.

Tasks
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View Data in Dashboard – Workflow

To display data in views specific to your organization, create SiteScope 
monitors, Business Process and Real User Monitor monitors and run 
Discovery and Dependency Mapping on your system. The discovery process 
populates the CMDB. HP Business Availability Center collects data about 
end-users, business processes, and systems, and display the data in 
topologies (views) relevant to your organization. Views display system 
performance data about your network and applications.

This section describes the processes to follow to view data in Dashboard.

This task includes the following steps:

➤ “Create SiteScope Monitors” on page 26

➤ “Create Business Process and Real User Monitor Profiles and Monitors” on 
page 27

➤ “Configure Diagnostics Servers and Probes to Monitor Your Applications” 
on page 27

➤ “Customize KPI Assignments – Optional” on page 27

➤ “Customize the Source Adapters” on page 27

➤ “Run Discovery and Dependency Mapping” on page 28

➤ “Create Instance Views” on page 28

➤ “Customize Dashboard Display” on page 28

➤ “Customize the Views in Dashboard” on page 29

➤ “Display Data in Dashboard” on page 29

 1 Create SiteScope Monitors
Create SiteScope monitors to collect network and system data about your 
system for use in HP Business Availability Center. SiteScope monitors 
information is displayed in System views. For details, see “Configure 
SiteScope for Monitoring – Workflow” in Using System Availability 
Management.
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 2 Create Business Process and Real User Monitor Profiles and 
Monitors
Create Business Process and Real User Monitor profiles and monitors to 
collect performance data for HP Business Availability Center. Business 
Process and Real User Monitor monitors information is displayed in End-
User Monitor views. For details, see “General and Administration” in Using 
End User Management.

 3 Configure Diagnostics Servers and Probes to Monitor Your 
Applications
Configure the servers and probes that are going to be used by Diagnostics to 
monitor your applications. For details, see HP Diagnostics Installation and 
Configuration Guide.

You must also specify the Diagnostics server details in Admin > Diagnostics. 
For details, see “HP Diagnostics and HP Business Availability Center 
Integration” in Solutions and Integrations.

 4 Customize KPI Assignments – Optional
You can customize the appropriate KPI assignment rules. KPI assignment 
rules are designed to automatically assign, to a specified CI, the appropriate 
KPIs, rules, and context menus when a specified condition occurs, usually 
when one of the CI’s attributes has a specified value in the sample that is 
sent to HP Business Availability Center. For details on customizing KPI 
assignments, see “Configure a KPI Assignment Rule” in Using Dashboard.

If required, you can customize the SiteScope KPI Assignments. For details, 
see “Work with the SiteScope Assignment Group – Workflow” in Using 
Dashboard.

 5 Customize the Source Adapters
If required, customize the Business Process Monitor, or Real User Monitor 
source adapters. For details, see “Configure a Source Adapter – Workflow” in 
Model Management.
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 6 Run Discovery and Dependency Mapping
Collect information about your system by running Discovery and 
Dependency Mapping to enable you to discover the IT infrastructure 
resources and their interdependencies, such as applications, databases, 
network devices, servers, and so on. Each discovered IT resource is delivered 
to, and stored in, the configuration management database (CMDB) where 
the resource is represented as a managed configuration items (CIs). 

Discovery is an ongoing, automatic process that continuously detects 
changes that occur in the IT infrastructure and updates the CMDB 
accordingly. You do not need to install any agents on the devices to be 
discovered. Discovery and Dependency Mapping processes have 
corresponding views that are automatically correlated with the CIs 
discovered during discovery and displayed in views. For details, see 
“Discovery and Dependency Mapping Content – Overview” in Discovery and 
Dependency Mapping Guide.

 7 Create Instance Views
The IT universe model in the CMDB can be very large, holding thousands of 
configuration items (CIs). A view enables you to build a subset of the overall 
IT universe model, containing only those CIs relating to a specific area of 
interest. Some views are automatically created when you use standard 
SiteScope, Business Process and Real User Monitor profiles and monitors. 
You can also define your own instance views to display only the 
information that is relevant to your organization’s business needs. For 
details, see “Create and Populate an Instance View” in Model Management.

 8 Customize Dashboard Display
You can customize some aspects of the Dashboard display and the refresh 
rate of the display.

For details, see “Customize Dashboard Display and Refresh Rate” on 
page 53.
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 9 Customize the Views in Dashboard
You can customize the views themselves. You can set up geographical maps 
and custom maps. You can customize the display of the view in the other 
Dashboard tabs. For details about customizing the views in Dashboard, see 
“Customize the Way HP Business Availability Center Displays Views in 
Dashboard” on page 30.

 10 Display Data in Dashboard
Use views, Dashboard tabs, and other capabilities to display data in 
Dashboard. For details, see “Display Data in Dashboard” on page 34.
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Customize the Way HP Business Availability Center 
Displays Views in Dashboard

You can customize the way HP Business Availability Center displays views in 
Dashboard. 

The flowchart describes the process of customizing the way a view is 
displayed in Dashboard to reflect your organizational requirements. 

This task includes the following steps:

➤ “Set Your Views in CMDB For Display in Dashboard” on page 31

➤ “Modify KPI Defaults in Dashboard Administration – Optional” on page 31
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➤ “Specify the Time Format Used in a CI Last Status Update Time – Optional” 
on page 32

➤ “Define a Custom Map in Dashboard Administration – Optional” on 
page 33

➤ “Configure Geographical Map in Dashboard Administration – Optional” on 
page 33

➤ “Display Data in Dashboard” on page 34

➤ “Customize Dashboard Tabs – Optional” on page 33

 1 Set Your Views in CMDB For Display in Dashboard
HP Business Availability Center provides several default views. If required, 
you can create custom views (instance views or pattern views) in CMDB 
Administration. 

For details about instance views, see “Create and Populate an Instance View” 
in Model Management.

For details about pattern views, see “Pattern View Workflow” in Model 
Management.

 2 Modify KPI Defaults in Dashboard Administration – Optional
Monitor CIs associated with default sources generally have default KPIs. For 
example, Business Process Monitor, Real User Monitor, and SiteScope 
monitor CIs that you configure in End User Management Administration or 
System Availability Management Administration, all have default KPIs.

Note that CIs with default KPIs that are placed under other CIs in a view 
generally propagate their KPIs upward to the parent CIs.

You can:

➤ Change the default business rule assigned to a KPI.

➤ Change the properties of the default business rule. 
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➤ Modify or delete a KPI associated with a higher level CI in a view if the KPI 
has the following characteristics:

➤ It originates from a lower level CI.

➤ It was propagated upward.

➤ It is not appropriate for the higher lever CI (for example, if you want to 
only see performance and not availability). 

➤ Add a new KPI to a higher level CI. Proceed as follows: select Admin > 
Dashboard, select a view, and click the KPIs tab. For details, see “KPIs Page” 
on page 398.

➤ Save historical data for a KPI if you want to see the associated data in the KPI 
over Time report. For details, see “Persistent Data and Historical Data” on 
page 365.

 3 Specify the Time Format Used in a CI Last Status Update Time – 
Optional
You can modify the default time format (am/pm hh:mm:ss) used in a CI Last 
Status Update Time. A CI Last Status Update Time information is usually 
displayed in tooltips. The time format is specified using a key. The key is 
translated into a localized format in the LocaleDate_<locale>.properties file.

To modify the time format, select a valid key from
<HP Business Availability Center server root directory>\AppServer\
resources\LocalDate_<locale>.properties, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and enter the selected key in the Time Format Key 
of CI Last Status Update Time entry in the Dashboard Application - Filtering 
Properties table. 
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 4 Define a Custom Map in Dashboard Administration – Optional
You can add, to a custom image, status indicators that display the real time 
status for specified CIs. Each status indicator displays the worst status from 
all KPIs associated with that CI. For example, if you place on the image a 
status indicator for a Line of Business CI, the status indicator displays the 
worst status of all KPIs associated with the Line of Business CI.

The custom image can be useful for representing data centers, geographical 
distribution of IT resources, and so on. To add a custom image, select Admin 
> Dashboard, select a view, and click the Custom Map tab. For details on 
creating a custom map, see “Display a View in a Custom Map” on page 188.

 5 Configure Geographical Map in Dashboard Administration – 
Optional
You can specify a geographical location in the location parameters for a CI 
in CMDB Administration. To define geographical locations for CIs, select 
Admin > Universal CMDB > Modeling > It Universe Manager. Select a CI in 
the topology map or View Explorer. In the Information Pane, select the 
Properties tab and click Edit.

Those status indicators automatically appear, at the defined location, on the 
geographical map corresponding to views that include those CIs. When 
there are multiple CIs with the same defined location, one status indicator is 
displayed for the location, showing the worst status for all KPIs associated 
with all CIs at that location.

You can zoom and center the geographical map to focus on the parts of the 
map relevant to the associated view. To zoom and center the geographical 
map, select Admin > Dashboard, select a view, and click the Geographical 
Map tab. For details, see “Display and Customize a View in Geographical 
Map” on page 162.

 6 Customize Dashboard Tabs – Optional
Customize the way the Dashboard tabs display the data. For details, see each 
tab description. For a list of the tabs and links to their descriptions, see 
“Dashboard Tabs” on page 18.
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 7 Display Data in Dashboard
Use views, Dashboard tabs, and other capabilities to display data in 
Dashboard. For details, see “Display Data in Dashboard” on page 34.

Display Data in Dashboard

You can display different aspects of the data obtained from different profiles 
and monitors using views, Dashboard tabs, and other capabilities. You can:

➤ Display the components of the active view in a hierarchical, top-down 
graphic, select Applications > Dashboard > Top View. For details, see 
“Display and Customize View Information in Top View” on page 92.

➤ Display the components of the active view arranged in a hierarchical tree, 
select Applications > Dashboard > Console. For details, see “Display and 
Customize View Information in the Console Tab” on page 120.

➤ Display a filtered list of CIs, according to the selected filter option, select 
Applications > Dashboard > Filters. For details, see “Display and Customize a 
View Information in Filters” on page 132.

➤ Display an association between geographical locations and status indicators 
using a maps applet, select Applications > Dashboard > Geographical Map. 
For details, see “Display and Customize a View in Geographical Map” on 
page 162.

➤ Display icons representing the view’s CIs on a custom image, select 
Applications > Dashboard > Custom Map. For details, see “Display a View in 
a Custom Map” on page 188.

➤ Display the results of pattern views or instance views, select Applications > 
Dashboard > Topology Map. For details, see “Display and Customize a View 
Information in the Topology Map” on page 198.

➤ View the Dashboard reports, select Applications > Dashboard > Reports, and 
select one of the following reports: KPIs Distribution Over Time, KPIs Over 
Time, KPIs Summary, and KPIs Trend reports, and the report repository. For 
details, see “Reports User Interface” on page 300.

➤ Display sample details. For details, see “View Sample Details” on page 35.
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➤ Acknowledge performance problems. For details, see “Acknowledge 
Performance Problems” on page 36.

➤ Display real-time change information. For details, see “Analyze Real-Time 
Change Information” on page 40.

➤ Find visible and hidden children CIs in a specific view. For details, see “Find 
Visible and Hidden Child CIs” on page 50.

View Sample Details

If required, you can set up Dashboard to provide data from the last sample 
that arrived for a monitor CI. This data is viewed in the Event Details dialog 
box for the CI. The Event Details dialog box displays all of the parameters 
for the CI, and provides the values of the parameters at the last update. 

This task includes the following steps:

➤ “Set Up to Display Last Sample Details in Dashboard” on page 35

➤ “Display the Last Sample Information” on page 35

 1 Set Up to Display Last Sample Details in Dashboard
You can set up an individual rule attached to a KPI or all rules to save the 
last sample details in memory. For details, see “Set Up Rules to Display the 
Last Sample Details” in CI Attribute Customization.

 2 Display the Last Sample Information
Click the Console or Filters tabs in Dashboard, and click the status icon for a 
monitor CI to open the Event Details dialog box. (If there is an associated 
Event Details dialog box for a CI, then the cursor changes to a hand when 
you hold the cursor over the status icon for the CI.) 
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For details, see “Event Details Dialog Box” on page 397. 

Acknowledge Performance Problems

The Acknowledging utility enables you to track performance problems 
identified in your system and network infrastructure by keeping a record of 
when the problem was acknowledged and by which user. 

This task includes the following steps:

➤ “Display/Hide the Ack Column in the Console or Filters Tabs” on page 36

➤ “Acknowledge a Problem” on page 37

➤ “View a Problem’s History” on page 38

 1 Display/Hide the Ack Column in the Console or Filters Tabs
By default, the Ack column is displayed. It can be hidden by users with 
administrative permissions. To hide/display the Ack column, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, click the 
Applications context, select Dashboard Application, and locate the Show CI 
Acknowledgment column in the Business Console area, and select false 
(hide the Ack column), or true (display the Ack column). The change takes 
effect immediately.

Note: When you hide the Ack column, the Acknowledgment-related context 
menu options remain available. For details, see “Menu Options” on page 62.
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 2 Acknowledge a Problem
You can acknowledge a problem by clicking the Ack check box for a CI in 
the Console, and Filters tabs (you can clear the acknowledgment by 
selecting the check box again). For details, see “Acknowledgments Details 
Dialog Box” on page 59.

The acknowledgment icon is displayed in Top View for CIs corresponding to 
acknowledged problems. 

You can unset the acknowledgement by clicking the icon, in the Console 
and Filters tabs. 

You can also set/unset acknowledgment and view the CI acknowledgment 
history by using the context menu in the Top View, Console, and Filters 
tabs.

Note: The Ack check box is enabled only if there is at least one KPI defined 
for the CI, and at least one of the KPIs has a status other than OK (green).

Example – Set an Acknowledgment

To acknowledge a problem, click the down arrow to the right of a CI and 
select Acknowledgement > Set/Unset Acknowledgment (you can unset the 
acknowledgement by selecting the same option and clicking OK).

In the Add details box, enter information about the acknowledgment.
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Click OK to set or unset the acknowledgment depending on the previous 
status of the dialog box.

 3 View a Problem’s History
After a problem CI is acknowledged, or the acknowledged status is cleared, 
you can view the history in the Acknowledgment History and Details dialog 
box. For details, see “Acknowledgment History and Details Dialog Box” on 
page 58.

Example – View Acknowledgment Details

A tooltip for the Ack icon displays the current status of the CI’s 
acknowledgment.
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To view the details of the current acknowledgment or the acknowledgment 
history of the CI, click the down arrow to the right of a CI and select 
Acknowledgement > Acknowledgment Details. You can then select one of 
the following options:

➤ Acknowledgment details. Displays the details of the currently opened 
acknowledgment in the Acknowledgment details box.

➤ CI history. Displays the details of all of the acknowledgments over time in 
the Acknowledgment details box.

The Acknowledgment details box displays the date and time when the 
acknowledgment status was modified, the name of the user who modified 
the status, and the type of action that was performed. For details, see 
“Acknowledgment History and Details Dialog Box” on page 58.

You can add information about the actions you are going to perform to 
solve the problem in the Add details box and then click Add to add the 
information you entered to the acknowledgment history.
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Switch Off the Alert Sound When CI is Acknowledged

If you set up for sound notification when a KPI’s status changes to Critical, 
you can select to turn the sound off when the KPI’s CI is acknowledged. This 
way, you do not get sound notification when any of the acknowledged CI’s 
KPIs status changes to Critical.

This task includes the following steps:

➤ “Set Up Sound Notification” on page 40

➤ “Set Up Mute When Acknowledge Option” on page 40

 1 Set Up Sound Notification 
Set up the sound notification. For details, see “Set Up Sound Notification 
When KPI Status Changes to Critical” on page 52.

 2 Set Up Mute When Acknowledge Option
Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the Mute 
When Acknowledged entry in the Dashboard Application - Sound 
Notification table. Modify the value to true to mute the alert or to false to 
hear the alert. The change takes effect immediately. 

Analyze Real-Time Change Information

This section describes the steps to follow to display real-time change 
information in the Console and Filters tabs, and in the Change report.

This task includes the following steps:

➤ “Set the CIT to Monitor Changes to Its Properties” on page 41

➤ “Customize the Change Period” on page 41
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➤ “Customize the Number of CIs Monitored for Real-Time Change” on 
page 41

➤ “View Real-Time Changes” on page 42

 1 Set the CIT to Monitor Changes to Its Properties
For each configuration item type (CIT) properties you want to monitor, 
select Admin > Universal CMDB > Modeling > CIT Type Manager, click the 
Attributes tab, select the CIT, click the Add button, and select Change 
Monitored in the Advanced area in the Add/Edit Attribute dialog box. For 
details, see “Add/Edit Attribute Dialog Box” in CI Attribute Customization.

 2 Customize the Change Period
By default the Change icon is displayed for 24 hours (default value) after a 
change occurs. To modify the default time period (set at 1440 minutes (24 
hours)) select Admin > Platform > Setup and Maintenance > Infrastructure 
Settings, click Applications context, select Dashboard Application, locate 
the Changes period in the Change Impact Properties area, and enter the 
time period (in minutes) in the Value box. The recommended value is the 
default: 1440 minutes.

Note: The change takes effect after the server has been restarted.

 3 Customize the Number of CIs Monitored for Real-Time Change
In the Console tab and in the Filter tab, a limited number (20 by default) of 
CIs and their child CIs can be monitored for real-time changes at any one 
time. This number can be customized.

Note: You can increase the default number of CIs that can be monitored but 
be aware that this might overload HP Business Availability Center.
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To modify the default number of CIs that can be monitored for change in 
real-time, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, click Applications context, select Dashboard 
Application, and modify the value of the Maximum monitored CIs 
parameter in the Change Impact Properties area. The recommended value is 
20.

Note: The change takes effect after the server has been restarted.

For more information about real-time monitoring for change, see “Analyze 
Real-Time Change Information” on page 40.

 4 View Real-Time Changes
You can view real-time changes as follows:

➤ Changes made to the first 20 CIs set to display real-time changes are 
displayed with change icons in the Console tab or in the Filters tab. To 
access the tabs, select Applications > Dashboard, select a view and click the 
Console or Filters tab.

➤ Changes made to other CIs are displayed in the Change report. The Change 
report enables you to view the changes made to CI’s properties for all 
properties that were selected to keep this information. For details, see 
“Change Report Page” in Model Management.

View Related Change Requests Reports

If you are working with Change Control Management, you have the option 
to view, in Dashboard, a Related Change Requests report for a CI, showing 
the impact of planned IT changes that have been submitted to the service 
desk. 

To view Related Change Requests reports in Dashboard, you must set up the 
integration environment and configure infrastructure settings, as described 
in this section.
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This task includes the following steps:

➤ “Integrate with Change Control Management” on page 43

➤ “Configure Infrastructure Settings to Work with Change Control 
Management” on page 43

➤ “Display the Related Change Requests Report” on page 44

 1 Integrate with Change Control Management
To set up the integration with Change Control Management, HP Business 
Availability Center and HP Change Control Management should be working 
with the same CMDB server.

 2 Configure Infrastructure Settings to Work with Change 
Control Management
To enable the integration and view the Related Change Requests report in 
Dashboard, you must set up the environment and configure settings in 
HP Business Availability Center. 

To view change request information in Dashboard, select Admin > Platform 
> Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Dashboard Application, and locate the Active entry in the Change 
Control Management Integration Settings table. 

➤ Set the CCM Integration Status property to True.

➤ In the CCM Web Service address property, define the address of the server 
where Change Control Management is installed.

➤ In the CCM Statuses property, define the change request statuses used in 
Change Control Management that you want to include in the Related 
Change Requests reports. By default, HP Business Availability Center is 
configured to use the CLOSED and IN_PROGRESS statuses.

You can change the default statuses or add additional ones, as long as you 
use the definition used in Change Control Management (<Change Control 
Management root directory>\conf\enumeration-labels.properties). For 
example, the value StatusEnum.ASSIGNED=Assigned should be entered in 
the CCM Statuses property as ASSIGNED.
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➤ In the CCM Username and CCM Password properties, enter the details of a 
user that exists in Change Control Management. The defaults are username 
admin, with no password.

Note: Restart the Gateway Server for the changes to take effect.

 3 Display the Related Change Requests Report
If you are working with Change Control Management, then HP Business 
Availability Center provides an option that enables you to view the impact 
of IT changes that have been submitted to the service desk. You view this 
information in a Related Change Requests report, opened in Dashboard for a 
specific CI using the Related Change Requests context menu option. 

The Related Change Requests report shows all change requests in the system 
that have direct or indirect impact on the selected CI. It is generated by 
Change Control Management, and provides a direct link to the original 
change request.

You can view the report at any time to check the change requests in the 
system for a CI. When a CI is registering a problem, by showing a status 
other than OK, you can use the report to determine if the problem is due to 
a submitted change, before beginning more extensive research into the 
problem.

For more details on the report, see “Related Change Requests Report” on 
page 81.
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View Service Impact Report

The Service Impact report displays information about how a CI impacts the 
Business Services it belongs to. Data about the affected Business Service CIs 
includes KPI data, over-time data, and SLA data. For example, if a host CI 
has critical status, you can use the report to display the status of the Business 
Service CIs to which the host CI is attached.

This task includes the following steps:

➤ “Access the Service Impact Report for a CI” on page 45

➤ “Modify the Default KPIs and Rules Used to Display Data in Service Impact” 
on page 46

➤ “Send a Service Impact Report URL Using Direct Login” on page 48

➤ “Send a Service Impact Report URL With the Login Page” on page 49

 1 Access the Service Impact Report for a CI
To view the Service Impact report for a CI, right-click the CI and select the 
Show Service Impact option. For details, see “Service Impact Report” on 
page 83.

Example

The following Service Impact report lists the Business Service CIs impacted 
by the tx_10 CI. It also indicates, in the Service Details area, the status of the 
KPIs, the current and forecasting statuses of the SLAs that include the 
Business Service CI selected in the Business Services Summary table.
45



Chapter 1 • Introduction to Dashboard
 2 Modify the Default KPIs and Rules Used to Display Data in 
Service Impact
The system derives the parameters needed to get the data displayed in 
Service Impact from default KPIs and rules. For example, from the Number 
of Open Incidents Rule the system derives the state and severity of tickets to 
be counted in the over time number of open incidents. 

If you change the KPI or rule to be used in the Service Impact report, you 
must configure the new KPI Id in Infrastructure Settings.
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To modify the settings, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Dashboard Application, 
and locate the relevant entries in the Dashboard Application - Service 
Impact table. Modify the value of the following parameters:

➤ Number of Open Incidents KPI. Sets the Id number of the KPI that defines 
open incidents in the report. The default is 2600 for the Open Incidents KPI.

➤ Number of Open Incidents Rule. Sets the Id number of the rule that defines 
open incidents in the report. The default is 2600 for the Open Incidents 
rule.

➤ Number of Users' Sessions KPI. Sets the Id number of the KPI that defines 
the number of user sessions in the report. The default is 1050 for the Volume 
KPI. 

➤ Number of Users' Sessions KPI's caption. Defines the caption in the report 
for the Number of Users' Sessions KPI. 
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 3 Send a Service Impact Report URL Using Direct Login
You can send a Service Impact report to a recipient using one of the 
following options:

➤ An XML file containing all the relevant data for generating the report in any 
application. The information included in the report can then be used by 
another application, like Change Control Management or HP operation 
applications (Network Node Manager, Service Desk, and so on). 

Use the following URL:
http://<server_name>/<HP_BAC_web_application_context_name (usually 
topaz)>/TopazSiteServlet?createSession=true
&requestType=login&directLogin=true&directLoginEncrypted=true
&userlogin=<user_name>&userpassword=<password>
&applicationId=bam&customerId=<customer_id>
&portlet_url=/service-impact/main/xml.do?ciId=<CI_id> 

➤ A URL that accesses the HTML report. 

Use the following URL:
http://<server_name>/<HP_BAC_web_application_context_name (usually 
topaz)>/TopazSiteServlet?createSession=true
&requestType=login&directLogin=true&directLoginEncrypted=true
&userlogin=<user_name>&userpassword=<password>
&applicationId=bam&customerId=<customer_id>
&portlet_url=/service-impact/main/page.do?ciId=<CI_id> 

The following parameters are used in the URLs:

➤ <user_name> and <password> are the HP Business Availability Center 
user name and password and must be encrypted according to what 
HP Business Availability Center is using.

➤ <customer_id> is the code of the customer.

➤ <CI_id> is the internal number of the CI. Select Admin > Universal CMDB 
> Modeling > IT Universe, select the CI in the tree. The internal number 
of the CI appears in the ID box in the Properties tab in the Information 
pane.
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 4 Send a Service Impact Report URL With the Login Page

Note to HP Software-as-a-Service: Sending a Service Impact report URL with 
the login page is not supported.

You can send a Service Impact report to a recipient using the following 
options:

➤ An XML file containing all the relevant data for generating the report in any 
application. The information included in the report can then be used by 
another application, like Change Control Management or HP operation 
applications (Network Node Manager, Service Desk, and so on). 

Use the following URL, to display the login page: 
http://<server_name>/<HP_BAC_web_application_context_name (usually 
topaz)>/login.jsp?portlet_url=/service-impact/main/xml.do?ciId=<CI_id> .

The URL displays the login page and, after you enter the user name and 
password information, opens the report.

➤ A URL that accesses the HTML report, included in an alert notification. For 
example, if an alert assigned to a host CI is triggered and the alert includes 
the URL of the Service Impact report for the host CI, the user can view 
information about the impact of the host CI on the Business Service CI. For 
details, see “Create Event-Based Alert Schemes – Workflow” in Alerts.

Use the following URL, to display the login page: 
http://<server_name>/<HP_BAC_web_application_context_name (usually 
topaz)>/login.jsp?portlet_url=/service-impact/main/page.do?ciId=<CI_id> .

The URL displays the login page and, after you enter the user name and 
password information, opens the report.

The following parameter is used in the URL: <CI_id> is the internal number 
of the CI. Select Admin > Universal CMDB > Modeling > IT Universe, select 
the CI in the tree. The internal number of the CI appears in the ID box in 
the Properties tab in the Information pane.
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Find Visible and Hidden Child CIs

A CI’s child CIs can be specified as included (visible) or excluded (hidden) in 
a specific view. The status of any child CI, visible or hidden, has an impact 
on the status of its parent CI in any view where the parent CI appears. For 
details about including or excluding child CIs, see “Include Related CIs” in 
Model Management.

This task includes the following steps:

➤ “Find the Visible and Hidden Child CIs For a Specific CI” on page 50

➤ “Search for the Views That Include a Specific Child CI” on page 50

 1 Find the Visible and Hidden Child CIs For a Specific CI
In either the Console tab, or Filter tab in Dashboard, right-click the CI and 
select the Find Visible and Hidden Child CIs option to open the Find Visible 
and Hidden Child CIs dialog box and list all of the selected CI’s child CIs 
that appear in the CMDB (visible and hidden). 

For details, see “Find Visible and Hidden Child CIs Dialog Box”. 

 2 Search for the Views That Include a Specific Child CI
In View Explorer, click Search to perform a search for the CIs whose names 
include the selected child CI’s name string in all views, and display the 
results in the View Explorer search page. For details, see “Search for CIs in 
Search Mode” in Model Management. 

Click the appropriate CI in the list to display more information about the 
selected CI in the selected view.

If the CI is not visible in any view, in Dashboard, the following message is 
displayed: Search is complete. There are no results to display for the current 
search parameters. The CI is not visible in any view in the following 
situations:

➤ It is included in the CMDB but does not belong to any view.

➤ It belongs to a view but the Exclude all child CIs option has been selected 
for its parent CI in that view. For details, see “New CI Wizard” in Model 
Management.
50



Chapter 1 • Introduction to Dashboard
Example

You might have the situation where, in a specific view, the Availability KPI’s 
status of the parent CI’s is Critical while the Availability KPI’s status of the 
CI’s child CIs are OK. When this happens, you would like to know what 
caused the status of the Availability KPI to be Critical. 

Use the Find Visible and Hidden Child CIs option to list all of the child CIs of 
the selected CI in the CMDB. After the list of child CIs is displayed, you can 
search for the views the child CI belongs to and then display the child CIs 
details in the specific view.

The Find Visible and Hidden Child CIs page displays the following 
information:

➤ The name of the selected CI, whose child CIs you want to list, the CI’s 
KPIs, and their status in the current view.

➤ A list of the child CIs (visible and hidden) that appear in the CMDB, their 
KPIs and their status. In the Visible column, a checkmark indicates that 
the child CI is visible in the view and an X indicates that the child is 
hidden in the view.
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Set Up Sound Notification When KPI Status Changes to 
Critical

You can set up Dashboard to play an alert sound when the status of a KPI 
changes to Critical in the Console or Filters tab.

When the view is loaded for the first time, no sound is played for the KPIs 
that are loaded at Critical status.

When the sound is switched on, a sound alert is played:

➤ In the Console tab. When the Console tab is currently displayed, and a KPI 
in the view changes status to Critical (red). The Critical status icon flashes 
until the next screen refresh. If a CI in a hidden part of the view has 
changed to Critical but does not change the status of any of the CIs in the 
currently displayed branches, no sound is heard.

➤ In the Filters tab. When the Filters tab is currently displayed, and a KPI in 
the view changes status to Critical (red). The Critical status icon flashes until 
the next screen refresh. 

This task includes the following steps:

➤ “Set Up the Sound Notification Option” on page 52

➤ “Switch On the Sound Option in the Console or Filters Tabs” on page 52

➤ “Modify the Alert Sound – Optional” on page 53

➤ “When Using Mozilla, Download a Plug-in” on page 53

 1 Set Up the Sound Notification Option
Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the Sound 
Notification entry in the Dashboard Application - Sound Notification table. 
Modify the value to true to enable the sound notification or to false to 
disable it. The change takes effect immediately.

 2 Switch On the Sound Option in the Console or Filters Tabs
Switch on the sound option using the  button in the Console or Filters page. 
For details, see “Console Page” on page 125 or “Filters Page” on page 148.
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 3 Modify the Alert Sound – Optional
The alert sound is a WAV file downloaded by the browser. 

To use another alert sound for Dashboard, if you have administrative 
permissions, access <HP Business Availability Center server root 
directory>\AppServer\ webapps\site.war \bam\pages\sounds and replace 
the ding.wav file with your own .wav file (you must rename your file 
ding.wav). The change takes effect immediately.

 4 When Using Mozilla, Download a Plug-in
If you are using Mozilla, you must download a plug-in for playing WAV files, 
otherwise no sound is played.

Customize Dashboard Display and Refresh Rate

You can customize some aspects of the Dashboard display and the refresh 
rate of the display. 

Note: All the steps in the task are optional and can be performed in any 
order.

This task includes the following steps:

➤ “Modify the Length of a CI Name” on page 54

➤ “Modify the Maximum Number of CIs to Be Displayed in Dashboard” on 
page 54

➤ “Modify the Dashboard Tabs Refresh Rate” on page 54

➤ “Customize Tooltips and Icons” on page 55
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 1 Modify the Length of a CI Name
To change the default length (40 characters) of the CI name, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Applications, select Dashboard Application, and in the Dashboard 
Application - Dashboard Layout Properties table, modify the CI name 
maximum character length entry. When the CI name is longer than this 
value, it is shortened in the display and a tooltip displays the complete 
name. 

 2 Modify the Maximum Number of CIs to Be Displayed in 
Dashboard
To change the default number of CIs that can be displayed in Dashboard 
Console and Filters pages, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and in the Dashboard Application - Dashboard 
Layout Properties table, modify the Displayed CI limit entry. Default is 3000.

 3 Modify the Dashboard Tabs Refresh Rate
When you open a Dashboard tab for a view tree with a large infrastructure, 
you may experience a short delay while Dashboard builds the view.

The tab is refreshed every 30 seconds. If no change is made to the view, the 
display remains the same. If many changes have been made to a view, or if 
CIs have been deleted from the view, that view’s information in the tab is 
automatically reloaded after 30 seconds and displays the changes. 

While reloading, the following message is displayed in the top right corner 
of the screen: The model has changed. Reloading... After reloading is 
complete, the following message is displayed in the top right corner of the 
screen: Top view has been updated with model changes. Last Update in the 
bottom left corner of the screen indicates the last time an update of the top 
view was reloaded. 

The refresh rate of the view can be modified. To modify the refresh rate, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the UI 
Refresh Rate entry in the Dashboard Application - Service Impact table. 
Change the default.
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 4 Customize Tooltips and Icons
You can customize some aspects of the user interface.

➤ Modifying Tooltip Border and Header Colors. A KPI tooltip border and 
header have a default color that you can modify. For details, see “Change 
the Color of the Tooltip Border and Header” in CI Attribute Customization.

➤ Specifying a Different Icon Set. A different icon is used for the KPI status for 
each value range. 

You can replace the icons set in the Top View tab and for the KPIs in the 
other Dashboard. You can also replace the Trend and History icons with 
customized ones. For details, see “Change the KPI Status Icons” in 
CI Attribute Customization.

Use the Troubleshooting Logs

This section describes how to create troubleshooting logs and how to use 
those logs to debug errors.

This task includes the following steps:

➤ “Use Dashboard Administration Logs” on page 56

➤ “Monitor Usage in the System” on page 57
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 1 Use Dashboard Administration Logs
To facilitate the creation of troubleshooting logs, you must enable Debug 
mode. For details, see “About HP Business Availability Center Logs” in 
Reference Information. 

The logs are located in the <HP Business Availability Center root 
directory>\log\EJBContainer folder:

➤ bam.app.rules.log. To verify the status of a KPI, scan the log file manually 
or use a script for errors in the rule calculations. The log should not 
contain any errors, such as Java exceptions. 

➤ TrinitySamples.log. To verify that samples have reached the HP Business 
Availability Center bus, scan the log file manually or use a script for 
samples coming from SiteScope or Business Process Monitor.

You can use the BusDiscovery utility to search for samples transmitted on 
the bus. The utility is available under the <HP Business Availability Center 
root directory>\tools\BusDiscovery directory. 

Use the following command to activate the utility:
D:\Temp\drv.log: sprinter -dc_attach localhost -dc_print_format 
sample_per_line -drv_log_file

The utility dumps the arriving samples into the following directory:
D:\Temp\drv.log
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 2 Monitor Usage in the System
You can monitor usage of the Dashboard application in a sessions log file. A 
line stating the number of users is added to the <HP Business Availability 
Center server root directory>\log\EJBContainer\bam.sessions.log file for 
each time period. For example, if a user accesses Dashboard, then closes 
HP Business Availability Center, then accesses Dashboard again, this counts 
as two user sessions in the log file.

To change the default time period, open the <HP Business Availability 
Center server root directory>\conf\settings\BACAppSettings.xml file, look 
for the keys: session.log.interval.0, session.log.interval.1, or 
session.log.interval.2., and change the key to match the required time 
period as follows:

Reference

Dashboard User Interface

This section describes:

 ➤  Acknowledgment History and Details Dialog Box on page 58

 ➤  Acknowledgments Details Dialog Box on page 59

 ➤  Find Visible and Hidden Child CIs Dialog Box on page 60

 ➤  Menu Options on page 62

 ➤  Node Details Dialog Box on page 80

 ➤  Related Change Requests Report on page 81

 ➤  Service Impact Report on page 83

Key Represents:

session.log.interval.0 a 6 hour period

session.log.interval.1 a 12 hour period

session.log.interval.2 a 24 hour period
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Acknowledgment History and Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view the details of the current 
acknowledgment or the acknowledgment history of 
the CI.

To Access: Click the down arrow  to the right of a CI or 
right-click a CI in View Explorer and select 
Acknowledgment > Acknowledgment details. 

Included in Tasks “Acknowledge Performance Problems” on page 36

GUI Element (A-Z) Description

Acknowledgment 
details

Select to display the details of the currently opened 
acknowledgment in the Acknowledgment details box. 

Action The type of action that was performed:

➤ Clear. When the acknowledgment history was 
cleared.

➤ Unset. When the acknowledgment was unset.

➤ Info. Details were added to the acknowledgment 
without changing the acknowledgment status.

➤ Open. When the acknowledgment was set.

➤ Edit. When details were added to the 
acknowledgment.

Add Click to add the contents of the Add details box to the 
acknowledgment history.

Add details Add information about the actions you are going to 
perform to solve the problem. You can add information 
whether the acknowledgment is Open or Closed.

CI history Select to display the details of all of the 
acknowledgments over time in the Acknowledgment 
details box.

Clear Click to clear the acknowledgment history.
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Acknowledgments Details Dialog Box

Date The date and time when the acknowledgment status 
was modified.

Message Displays the status of the acknowledgment or the 
information that was entered in the Add details box.

User The name of the user who modified the status.

Description Enables you to set or unset a CI acknowledgment.

To Access: Click the down arrow  to the right of a CI 
and select Acknowledgment > Set/Unset 
Acknowledgment to open the Set/Unset 
Acknowledgment dialog box.

Click the Ack icon to the right of the CI.

Important 
Information

The Ack check box is enabled only if there is at least 
one KPI defined for the CI, and at least one of the KPIs 
has a status other than OK (green).

A tooltip for the Ack icon displays the current status of 
the CI’s acknowledgment. 

The dialog box is a toggle dialog box. If you have 
acknowledged the CI, the top line in the dialog box is: 
The acknowledgment will be unset. If you have not 
acknowledged the CI, the top line in the dialog box 
displays: The acknowledgment will be set.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Find Visible and Hidden Child CIs Dialog Box

GUI Element (A-Z) Description

Add details Add information about the actions you are going to 
perform to solve the problem. You can add information 
whether the acknowledgment is Open or Closed.

OK Click to set or unset the acknowledgment depending on 
the previous status of the dialog box.

Description Enables you to list all of the selected CI’s child CIs that 
appear in the CMDB (visible and hidden). 

To access: In the Console, or Filter tab in Dashboard, 
right-click the CI and select the Find Visible and 
Hidden Child CIs option.

Important 
Information

A CI’s child CIs can be specified as included (visible) or 
excluded (hidden) in a specific view. The status of any 
child CI, visible or hidden, has an impact on the status 
of its parent CI in any view where the parent CI 
appears. For details about including or excluding child 
CIs, see “Include Related CIs” in Model Management.

For details, see “Find Visible and Hidden Child CIs” on 
page 50.

Included in Tasks “Find Visible and Hidden Child CIs” on page 50
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<KPI> The name of the child CI’s KPI and its status.

<Top part of page> Displays the name of the selected CI, whose child CIs 
you want to list, the CI’s KPIs, and their status in the 
current view.

Name The name of the child CIs (visible and hidden) that 
appear in the CMDB.

Search Click to perform a search for the CIs whose names 
include the selected child CI’s name string in all views, 
and display the results in the View Explorer search 
page. For details, see “View Explorer” in Model 
Management.

From the View Explorer search page, click the 
appropriate CI in the list to display more information 
about the selected CI in the selected view. If the CI is 
not visible in any view, in Dashboard, the following 
message is displayed: Search is complete. There are no 
results to display for the current search parameters.

Note: The CI is not visible in any view in the following 
situations:

➤ It is included in the CMDB but does not belong to 
any view.

➤ It belongs to a view but the Exclude all child CIs 
option has been selected for its parent CI in that 
view. For details, see “New CI Wizard” in Model 
Management.

For more details, see “Find Visible and Hidden Child 
CIs” on page 50.

Visible A checkmark indicates that the child CI is visible in the 
view.

An X indicates that the child is hidden in the view.
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Menu Options

The menu options displayed in Dashboard View Explorer and the main page 
of the Console and Filters tabs depend on the selected view and the selected 
CI. They can be a subset of the options described in this section. 

For more information about menu options, see “About Menu Options” on 
page 24. 

The options are listed in alphabetical order.

Main Option Description and Sub-Options

Acknowledgment This menu lists options similar to options in the Top View tab to view 
different trees centered on the selected CI. 

Acknowledgment 
Details

Available for all CIs. 

Opens the Acknowledgment details page that 
displays information about the CI’s 
acknowledgment. 

For details, see “Example – Set an 
Acknowledgment” on page 37.

Set/Unset 
Acknowledgment

Available for all CIs. 

Opens the Set/Unset Acknowledgments page 
where you can set or clear the CI’s 
acknowledgment. 

For details, see “Acknowledgment History and 
Details Dialog Box” on page 58.
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Application 
Mapping

This menu lists options that enable you to open specific capabilities filtered 
by the selected CI.

Problem Isolation Available for SAP-specific CIs. 

Isolates a CI’s problem in a separate browser 
dialog box. For details about the report, see 
“Troubleshooting and Limitations” in Solutions 
and Integrations.

For details about the SAP Systems view, see “SAP 
Systems View” in Solutions and Integrations.

Show Impact Available for SAP-specific CIs. 

Opens a dialog box that shows the impact of a 
root cause object by displaying all of the objects 
that are affected by it. For details about the 
report, see “Troubleshooting and Limitations” 
in Solutions and Integrations.

For details about the SAP Systems view, see “SAP 
Systems View” in Solutions and Integrations.

Business 
Transaction Flow 
Map

Available for TV Monitor CIs. 

This menu lists options that enable you to open specific capabilities filtered 
by the selected CI.

Completed Opens the TransactionVision Flow Map for 
completed instances of the business 
transaction. For details, see “Business 
Transaction Flow Map” on page 256.

In-Process Opens the TransactionVision Flow Map for 
instances of the business transaction that are in 
process. For details, see “Business Transaction 
Flow Map” on page 256.

Main Option Description and Sub-Options
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Drill to Diagnostics This menu lists options that enable you to open specific pages in the 
Diagnostics application filtered by the selected CI. This option is displayed 
only if you have installed Diagnostics.

Layers View Available for:

➤ All Probe Group, and Probe CIs in the 
Diagnostics View.

➤ Business Process Step CI, in the End User 
Monitors View. 

Note: This option is displayed only if you have 
installed Diagnostics.

Opens the Layers (Load) view, with the 
following characteristics:

➤ For a Business Process Step CI, the view 
displays the layer(s) of the transaction that 
corresponds to the Business Process Step CI.

➤ For a Probe Group CI, the view displays the 
performance metrics for the Probe Group.

➤ For a Probe CI, the view displays the 
performance metrics for the Probe. 

For more information about Diagnostics, see 
HP Diagnostics User’s Guide.

Server Requests Available for the Real User Monitor Business 
Process Step CIs in the End User Monitors View.

Note: This option is displayed only if you have 
installed Diagnostics.

Note: If you drill down from a RUM Page 
Monitor CI that is not monitored by 
HP Diagnostics, the Server Requests View in the 
HP Diagnostics application you access using the 
right-click menu option might show incorrect 
data. 

Opens the Server Requests View in the 
HP Diagnostics application with the URL(s) 
that correspond to the Real User Monitor 
Business Process Step CIs selected. 

For more information about Diagnostics, see 
HP Diagnostics User’s Guide.

Main Option Description and Sub-Options
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Drill to Diagnostics 
(continued)

Summary View Available for all Diagnostics Probe Group and 
Diagnostics Probe CIs in the Diagnostics View. 

Note: This option is displayed only if you have 
installed Diagnostics.

Opens the Diagnostics Probe Group Summary 
View for the probe or the probe group in the 
HP Diagnostics application. 

For more information about Diagnostics, see 
HP Diagnostics User’s Guide.

Transactions View Available for all Business Process Step CIs in the 
End User Monitors View.

Note: This option is displayed only if you have 
installed Diagnostics.

Opens the Transactions view that displays 
performance metrics for the transactions being 
executed by your applications. The transaction 
that corresponds to the selected Business 
Process Step CI is highlighted.

For more information about Diagnostics, see 
HP Diagnostics User’s Guide.

Main Option Description and Sub-Options
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Filters This menu lists filters that you can use to display subsets of the selected CI’s 
children on the Filters page. 

Filter Subtree Available for all CIs. 

Opens the Filters page, which displays the 
selected CI subtree filtered by the active filter.

Filter Subtree Monitors Available for all CIs. 

Opens the Filters page, which displays the 
monitor CIs in the subtree of the selected CI 
filtered by the active filter.

Show Complete Subtree Available for all CIs. 

Opens the Filters page, which displays the 
complete subtree of the CI as if it was filtered by 
the Show All active filter. That filter appears in 
the Active Filters box.

Show Subtree Monitors Available for monitor CIs. 

Opens the Filters page, which displays the 
monitor CIs in the subtree of the CI as if it was 
filtered by the Show Monitors Only active filter. 
That filter appears in the Active Filters box.

Find Visible and 
Hidden Child CIs

This option is available for all CIs. 

Returns all of the visible and hidden child CIs of the selected CI as they 
appear in the CMDB.

For details, see “Find Visible and Hidden Child CIs” on page 50.

Go to BPI This option is available for Business Process, BPI Monitor, and BPI Monitor 
CIs.

Opens the HP Business Process Insight application. For details, see 
“Understanding the Application<-->Host or Host Integration Adapters” in 
Solutions and Integrations.

Main Option Description and Sub-Options
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Go to Report This option is available for all CIs.

This menu lists options that enable you to access all types of reports that 
display information about the selected CI.

BPI Monitors Over Time Available for all BPI Duration, Value, or Custom 
Monitor CIs.

Opens the BPI Monitors Over Time report. For 
details about the report, see “BPI Monitors Over 
Time Report” on page 224.

Business Process Over 
Time

Available for all BPI Business Process Step 
Monitor or BPI Business Process Monitor CIs.

Opens the Business Process Over Time report. 
For details about the report, see “Business 
Process Over Time Report” on page 228.

Business Transaction 
Over Time

Available for TV Monitor CIs.

Opens the Business Transaction Over Time 
report. For details about the report, see 
“Business Transaction Over Time Report” on 
page 287.

Business Transaction 
Summary

Available for TV Monitor CIs.

Opens the Business Transaction Summary 
report. For details about the report, see 
“Business Transaction Summary Report” on 
page 282.

Change Rule Available for all CIs whose properties have 
changed. 

Opens the Change report for the CI. The 
Change report displays information about the 
changes made to the properties of CIs for all CIs 
that were assigned to keep this information.

For details about the report, see “Change Report 
Page” in Model Management.

Main Option Description and Sub-Options
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Go to Report 
(continued)

Configuration Item 
Status Alerts

Available for all CIs. 

Opens the Configuration Item Status Alerts 
report for the CI. The Configuration Item Status 
Alerts report lists all of the alerts that occurred 
in the specified period of time.

For details about the report, see “Configuration 
Item Status Alerts Report” in Alerts.

Diagnostics Web Service 
Topology 

Available for Web Service CIs. 

Opens the Diagnostics Service Topology view 
for the selected Web Service CI, for the past half 
hour. For details about the report, see 
HP Diagnostics User’s Guide.

End User Summary Available for Real User Monitor-specific CIs. 

Opens the End User Summary report. The End 
User Summary report displays data for specific 
end users configured for Real User Monitor in 
End User Management Administration. 

For details, see “End User Summary Report” in 
Using End User Management.

For details about the Real User Monitor views, 
see Chapter 11, “Understanding Real User 
Monitor Views” in Using End User Management.

Event Count Over Time Available for Real User Monitor-specific CIs. 

Opens the Event Count Over Time report. The 
Event Count Over Time report displays data for 
all events, or sessions with events, in monitored 
applications that you configured in End User 
Management Administration, broken down 
by time intervals. 

For details, see “Event Count Over Time 
Report” in Using End User Management.

For details about the Real User Monitor views, 
see Chapter 11, “Understanding Real User 
Monitor Views” in Using End User Management.

Main Option Description and Sub-Options
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Go to Report 
(continued)

Event Summary Available for Real User Monitor-specific CIs. 

Opens the Event Summary report. The Event 
Summary report displays a summary of events 
in monitored applications that you configured 
in End User Management Administration. 

For details, see “Event Summary Report” in 
Using End User Management.

For details about the Real User Monitor views, 
see Chapter 11, “Understanding Real User 
Monitor Views” in Using End User Management.

Event Summary (Errors 
Monitor)

Available for RUM Error Events CIs. 

Opens the Event Summary report. For details, 
see “Event Summary Report” in Using End User 
Management.

Event Summary (Event 
Monitor)

Available for RUM Informational Events CIs. 

Opens the Event Summary report. For details, 
see “Event Summary Report” in Using End User 
Management.

Event Summary (HTTP 
Error Monitor)

Available for RUM HTTP Error Events CIs. 

Opens the Event Summary report. For details, 
see “Event Summary Report” in Using End User 
Management.

Event Summary 
(Information Event 
Monitor)

Available for RUM Informational Event 
Monitor CIs. 

Opens the Event Summary report. For details, 
see “Event Summary Report” in Using End User 
Management.

KPIs Over Time Available for all CIs. 

Opens the KPIs Over Time report for the CI. 
The KPIs Over Time report shows the status or 
value, over time, of selected CIs and KPIs that 
are accessible from the Dashboard application.

For details about the report, see “KPIs Over 
Time Report”.

Main Option Description and Sub-Options
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Go to Report 
(continued)

Operations Health Available for Web Service Operation, SiteScope 
Monitor, and Diagnostics Web Service Monitor 
CIs.

Opens the Health Report in the HP Business 
Availability Center for SOA application filtered 
for the specific operation. For details, see 
“Health Report” in Solutions and Integrations. 

Related Change 
Requests

Available for all CIs.

Opens the Related Change Requests report that 
displays all change requests in the system that 
have direct or indirect impact on the selected 
CI. 

For details, see “Change Report Page” in Model 
Management.

SAP Transaction 
Changes

Available for SAP-specific CIs. 

Opens the SAP Transaction Changes report. The 
SAP Transaction Changes report displays the 
SAP transactions and SAP transports and the 
impact of transports on each transaction. 

For details about the report, see “SAP 
Transaction Changes Report” in Solutions and 
Integrations.

For details about the SAP System view, see “SAP 
Systems View” in Solutions and Integrations.

SAP Transport Changes Available for SAP-specific CIs. 

Opens the SAP Transport Changes report. The 
SAP Transport Changes report displays the 
changes inside the Transport and the impact on 
the SAP transaction. 

For details about the report, see “SAP Transport 
Changes Report” in Solutions and Integrations.

For details about the SAP System view, see “SAP 
Systems View” in Solutions and Integrations.

Main Option Description and Sub-Options
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(continued)

Server Summary Available for Real User Monitor-specific CIs. 

Opens the Server Summary report. The Server 
Summary report displays data for the servers 
monitored by the Real User Monitor probe. 

For details about the report, see “Server 
Summary Report” in Using End User 
Management.

For details about the Real User Monitor views, 
see Chapter 11, “Understanding Real User 
Monitor Views” in Using End User Management.

Session Analyzer Available for Real User Monitor-specific CIs. 

Opens the Session Analyzer report. The Session 
Analyzer report displays session data for specific 
applications configured for Real User Monitor 
in End User Management Administration. 

For details, see “Session Analyzer Report” in 
Using End User Management.

For details about the Real User Monitor views, 
see Chapter 11, “Understanding Real User 
Monitor Views” in Using End User Management.

Siebel Cross-
Performance

Available for the Siebel Application Server, 
Siebel Web Server Extension, Siebel Component 
Group, Siebel Component, and Siebel Web 
Application CIs. 

Opens the Cross-Performance report for the CI. 
The Cross-Performance report displays the 
behavior of a measurement running on several 
monitored servers, or the behavior of several 
measurements from various types of monitors 
running on one monitored server. 

For details about the report, see “Cross-
Performance Report” in Using System Availability 
Management.

Main Option Description and Sub-Options
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Go to Report 
(continued)

SiteScope Cross-
Performance

Available for SiteScope Profile, SiteScope Group, 
and SiteScope Monitor CIs.

Opens the Cross-Performance report. For 
details, see “Cross-Performance Report” in Using 
System Availability Management.

SiteScope Quick Report Available for SiteScope Group and SiteScope 
Monitor CIs.

Opens SiteScope Quick Report. For details, see 
“Quick Report” in Using System Availability 
Management.

SiteScope Server Centric 
Report

Available for Windows Resource Monitor and 
Unix Resource Monitor CIs under specific 
conditions described in the report description.

Opens SiteScope Server Centric Report. For 
details, see “Server-Centric Report” in Using 
System Availability Management.

Systinet Web Service 
Data

Available for Business Unit CIs, Web Service 
CIs, and Web Service Operation CIs, when there 
is an integration between HP Business 
Availability Center and HP SOA Systinet. 

Opens the HP SOA Systinet application, focused 
on the relevant Web service. For details, see the 
HP SOA Systinet documentation.

For details on the integration with HP SOA 
Systinet, see “Integration of HP SOA Systinet” 
in Solutions and Integrations.

Transaction Analysis Available for all CIs. 

Opens the Transaction Analysis report for the 
CI. The Transaction Analysis report provides an 
in-depth picture of the performance of 
transactions. 

For details about the report, see “Transaction 
Analysis Report” in Using End User Management.

Main Option Description and Sub-Options
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Go to Report 
(continued)

Trend Available for all CIs. 

Opens the trend report for the CI. Trend reports 
enable you to compare multiple measurements 
from several profiles. 

For details about the report, see “Trend Reports” 
in Reports. 

Triage Available for Real User Monitor-specific CIs and 
for Siebel-specific CIs. 

Opens the Triage report. The Triage report 
displays transaction data for Business Process 
Monitor, and Real User Monitor profiles for the 
past day. 

For details, see “Triage Report” in Using End User 
Management.

For details about the Real User Monitor views, 
see Chapter 11, “Understanding Real User 
Monitor Views” in Using End User Management.

For details about the Siebel Sites view, see 
“Siebel Views” in Solutions and Integrations.

Web Services Health Available for Web Services CIs.

Opens the Health Report in the HP Business 
Availability Center for SOA application filtered 
for the specific. 

For details, see “Health Report” in Solutions and 
Integrations. 

Main Option Description and Sub-Options
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Go to Siebel 
Diagnostics

This menu lists options that enable you to open specific pages in the 
Business Availability Center for Siebel filtered by the selected CI.

Show Processes This option is available for Siebel Application 
Server, Siebel Component Group, and Siebel 
Component CIs. 

This option opens the Task Diagnostics Tool 
filtered by:

➤ The selected site, and server for Siebel 
Application CIs.

➤ The selected site, server, and selected 
Component Group CI for Component 
Group CIs.

➤ The selected site, server, selected Component 
Group CI, and Component CI for 
Component Group CIs.

For details about the Siebel Task Diagnostics 
Tool, see “Siebel Views” in Solutions and 
Integrations.

For details about the Siebel CIs, see “Default 
CITs in the Siebel View” in Solutions and 
Integrations.

For details about the Process Diagnostics Tool, 
see “Siebel Views” in Solutions and Integrations.

Main Option Description and Sub-Options
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Go to Siebel 
Diagnostics

(continued)

Show Running Tasks Available for Siebel Application Server, Siebel 
Component Group, and Siebel Component CIs. 

Opens a separate page with the Task 
Diagnostics Tool filtered by:

➤ The selected site, server, Running status, and 
Session type for Siebel Application CIs.

➤ The selected site, server, selected Component 
Group CI, Running status, and Session type 
for Component Group CIs.

➤ The selected site, server, selected Component 
Group CI, selected Component CI, Running 
status, and Session type for Component CIs.

For details about the Siebel CIs, see “Default 
CITs in the Siebel View” in Solutions and 
Integrations.

For details about the Siebel Task Diagnostics 
Tool, see “Siebel Views” in Solutions and 
Integrations.

Show Tasks in Error Available for Siebel Application Server, Siebel 
Component Group, and Siebel Component CIs. 

Opens a separate page with the Task 
Diagnostics Tool filtered by:

➤ The selected site, server, and Exited with 
Error status for Siebel Application CIs.

➤ The selected site, server, selected Component 
Group CI, and Exited with Error status for 
Component Group CIs.

➤ The selected site, server, selected Component 
Group CI, selected Component CI, and 
Exited with Error status for Component CIs.

For details about the Siebel CIs, see “Default 
CITs in the Siebel View” in Solutions and 
Integrations.

For details about the Siebel Task Diagnostics 
Tool, see “Siebel Views” in Solutions and 
Integrations.

Main Option Description and Sub-Options
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Go to Siebel 
Diagnostics

(continued)

Siebel Database 
Breakdown

Available for the Siebel Site, Siebel Application, 
and Siebel Enterprise CIs.

Opens the Database Breakdown tab in Business 
Availability Center for Siebel to enable you to 
create and analyze database logs that record the 
SQL activity between Siebel components and 
the Siebel database. 

For details, see “Siebel Views” in Solutions and 
Integrations.

Siebel SARM Available for the Siebel Site, Siebel Application, 
and Siebel Enterprise CIs.

Opens the SARM - User Trace Breakdown tab in 
Business Availability Center for Siebel to enable 
you to create and record the SQL activity in 
each monitored Siebel site. 

For details, see “Siebel Views” in Solutions and 
Integrations.

Go to SiteScope Available for SiteScope Profile, SiteScope Group, and SiteScope 
Measurement Group CIs. 

Opens the appropriate monitor page in SiteScope.

For details about SiteScope, see Using System Availability Management.

Go to 
TransactionVision

Available for TV Monitor CIs. 

Opens the the relevant report in HP TransactionVision.

Go to Problem 
Isolation

You can access the appropriate pages in the Problem Isolation application 
filtered by the selected CI. Problem Isolation enables you to isolate 
enterprise problems discovered in HP Business Availability Center, and to 
identify likely suspects to help in solving the root cause of the problem.

This option is available for all CIs. 

Opens the Problem Isolation application, which is also accessible through 
Applications > Problem Isolation. The user enters the application on the 
Problems List page.

Main Option Description and Sub-Options
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HP Service Center This option is available for Business Service CIs or EMS Monitor CIs under 
Business Service CIs. 

Opens the HP ServiceCenter application.

Show Event This option is available for Application Monitor CIs in the Netscout view. 

Opens the Netscout application.

Properties This option is available for all CIs. 

Opens the Properties dialog box appropriate for the CI. 

For details, see “Working with CIs” in Model Management.

Show Service 
Impact

This option is available for all CIs.

Opens the Service Impact report that displays the impact of the current CI 
on the services that depend on that CI. If there are no services attached to 
the CI, the report is empty. For details, see “Service Impact Report” on 
page 83.

Show Related CIs This option is available for all CIs. 

Performs a search for related CIs and displays the result in the Search tab of 
View Explorer. 

For details about the Search tab, see “Search for CIs in Search Mode” in 
Model Management.

Main Option Description and Sub-Options
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Top View This menu lists options similar to options in the Top View tab to view 
different trees centered on the selected CI. 

Show in Top View Available for all CIs. 

Opens the Top View tab with the view’s tree 
centered on the selected CI. 

For details about the Top View tab, see “Top 
View Page” on page 108.

Show Path to Root Available for all CIs. 

Opens a Top View page that displays the path 
from the selected CI to the root CI, in the Filters 
or Console tab. For example:

Main Option Description and Sub-Options
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Top View 
(continued)

Show Problematic 
Subtree 

Available for all CIs. 

Opens a dialog box with capabilities similar to 
the Top View tab capabilities. The dialog box 
displays all of the child CIs with Critical, Major, 
or Minor status and enables you to find the 
problematic child CI that causes the selected 
parent CI to have a status other than OK. It is 
enabled only for CIs that have at least one KPI 
with a status other than OK.

For example, the Default Client_SanityBPM_1 CI 
has the following children:

If you select the Top View >Show Problematic 
Subtree option for Default Client_SanityBPM_1, 
the following children are displayed:

Main Option Description and Sub-Options
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Node Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view CMDB details about the CI.

To Access: In the Console or Filters tab, click Details for 
the appropriate CI.

GUI Element (A-Z) Description

Calc Rule ID The ID number of the calculating rule.

CMDB ID The internal CMDB ID corresponding to the CI (the 
value returned by the field entity_id).

CMDB Property 
Name

The name of the CMDB property.

CMDB Property 
Value

The value of the CMDB property.

KPI CMDB ID The internal CMDB ID corresponding to the KPI (the 
value returned by the field kpi_id).

Result The result of the calculation.

System KPI (x) Where x is the KPI ID (the value returned by the field 
kpi_type).
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Related Change Requests Report

Description Enables you to view the impact of IT changes 
submitted to the service desk when you work with 
Change Control Management for the selected CI.

To access: In Dashboard, right-click the relevant CI and 
select Go to Report > Related Change Requests.

Important 
Information

The report lists all change requests that have a direct or 
indirect impact on the selected CI during the default 
time period. The list may include change requests that 
resulted in a direct change to the CI (a CCI), or that 
affected the CI as a result of a modification to the 
change request (an ACI). The report is generated by 
Change Control Management and provides a link to 
the original change request.

When a CI is registering a problem, by showing a status 
other than OK, you can use the report to determine if 
the problem is due to a submitted change, before 
beginning more extensive research into the problem.

The Related Change Requests option is enabled only if 
HP Business Availability Center is configured to work 
with Change Control Management. For more 
information, see “View Related Change Requests 
Reports” on page 42. 

Included in Tasks “View Related Change Requests Reports” on page 42
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Report Settings

Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Common report 
settings>

See “Common Report Elements” in Reports.

GUI Element (A-Z) Description

Actual End Time The time at which execution of the change request 
ended.

Actual Start Time The time at which execution of the change request 
began.

Contact The owner of the selected change request.

Description A linked description of the change request. The link 
opens the change request in the service desk system, 
where you can see more information on the requested 
change. (You may need to enter login information for 
the service desk system.)

Level The level of the change request in the hierarchy in 
Change Control Management. Possible values are 
Release or Change.

Severity The degree of impact of the change request. The 
severity level is defined in Change Control 
Management.

Status The status of the change request in Change Control 
Management. You can configure HP Business 
Availability Center to include additional status levels 
used in Change Control Management. For details, see 
the Change Control Management documentation.
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Service Impact Report
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Business Services Summary Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays information about the Business Service CIs 
impacted by the selected CI.

To access: In the Console or Filter tab, right-click the 
relevant CI and select Show Service Impact.

Important 
Information

If there are no Business Service CIs attached to the CI, 
the report is empty.

You can hide KPIs so they do not appear in the report. 
To hide KPIs, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose 
Applications, select Dashboard Application, and locate 
the KPIs to hide in the report entry in the Dashboard 
Application - Service Impact table and add the KPI 
numbers separated by a comma. 

For example, to remove the Performance and KPIs, 
enter 6,7. Removing KPIs has an impact on the 
value/status of the CIs to which those KPIs are 
assigned.

Included in Tasks “View Service Impact Report” on page 45

GUI Element (A-Z) Description

Current Status The worst status of the KPI assigned to the selected 
Business Service CI.

Name The name of the Business Service CI impacted by the 
selected CI.

Click one of the Business Service CI in the list to 
display KPIs and SLA details in the <service> Service 
Details area. 
84



Chapter 1 • Introduction to Dashboard
Over Time Status 
Week to Date

The average status of the KPI over a predefined time 
period. The default is: week to date.

To modify the predefined time period, select Admin > 
Platform > Setup and Maintenance > Infrastructure 
Settings, choose Applications, select Dashboard 
Application, and locate the Default Over-Time Time 
Period entry in the Dashboard Application - Service 
Impact table and modify the entry value.

SLAs Current Status The worst status of all the SLAs where the Business 
Service CI is included. 

If the SLA Current Status is No Data and the SLAs table 
below the main table indicates: No information, the 
Business Service CI is not included in any SLA.

If the SLA Current Status is No Data and the SLAs table 
below the main table indicates: No Data, the Business 
Service CI is included in the SLA and the SLA worst 
status is No Data.

SLAs Forecasting The worst expected status of the SLAs where the 
Business Service CI is included. 

If the SLA Forecasting Status is No Data and the SLAs 
table below the main table indicates: No information, 
the Business Service CI is not included in any SLA.

If the SLA Forecasting Status is No Data and the SLAs 
table below the main table indicates: No Data, the 
Business Service CI is included in the SLA and the SLA 
Forecasting worst status is No Data.

GUI Element (A-Z) Description
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Service Details Area

The area includes the KPI and the SLAs tables.

KPI Table

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

SLAs Table

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Current Status The current status of the KPI assigned to the selected 
Business Service CI, as it appears in Dashboard.

KPI The list of KPIs attached to the selected Business 
Service CI.

Over Time Status The status of the KPI over a predefined time period, as 
it appears in the KPI Summary Report in Dashboard.

GUI Element (A-Z) Description

Current Status The current status of the SLA.

Customer The customer related to the SLA.

Expected Breach 
Date

The expected breach date of the SLA.

Forecasting Status The expected status of the SLA, based on extrapolation. 
For additional information, see “Business Services 
Summary Area” on page 84.

SLAs The list of SLAs where the selected Business Service CI 
is included. For additional information, see “Business 
Services Summary Area” on page 84.
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Troubleshooting and Limitations

This section includes troubleshooting and limitations for Dashboard.

Loss of Data after Renaming Transactions
If you rename a transaction in an HP Virtual User Generator script, Business 
Availability Center considers it as a new transaction. A new BPM Transaction 
from Location CI is created in the CMDB using the new name, and the CI 
with the old transaction name is removed after it stops receiving samples. In 
Dashboard, the new CI does not display trend and history status data from 
the period before the transaction name change.
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2
Dashboard Top View

This chapter describes Dashboard Top View.

This chapter includes:

Concepts

 ➤  Top View on page 90

Tasks

 ➤  Display and Customize View Information in Top View on page 92

 ➤  Access an External Application from Top View on page 94

 ➤  Customize Top View Display on page 95

Reference

 ➤  Dynamic URL Parameters on page 105

 ➤  Top View User Interface on page 107
Concepts
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Top View

Top View enables you to see the business availability of your system 
components at a glance. The CI bars in the tab provide a visual 
representation of real-time IT performance metrics mapped onto business 
applications, based on the hierarchy tree structure defined for each view. 
The connecting lines between the bars define the relationships between the 
CIs. For a detailed description of Top View, see “Top View Page” on 
page 108.

By presenting an integrated, single view of essential applications and 
business processes, Top View provides you with an overall perspective on 
the health of your business services, and enables you to instantly assess how 
a performance issue impacts the availability of any part of your business. 
Each CI in the active view is color coded to indicate the worst status held by 
the CI’s KPIs.
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This section includes the following topics:

➤ “Interactive Map” on page 91

➤ “Understanding the Colors and the Icons” on page 91

➤ “Virtual Containers” on page 92

Interactive Map
The Top View tab presents an interactive map of the CIs that can be 
intuitively manipulated using the mouse, enabling you to drill down to 
specific branches of the tree and to focus on particular business areas or 
problem areas.

By default, the Top View tab displays four levels of CIs. The rest of the CIs 
are collapsed. You can expand CIs from the fourth level and see their child 
CIs.

The lines connecting the bars represent the branches of the tree. The bars 
and lines can be manipulated to change the amount of information 
displayed and the overall layout of the diagram, as described in “Top View 
Page” on page 108.

Understanding the Colors and the Icons
Each CI contained in the view is displayed as a bar, color-coded according to 
the current worst operational status for that CI. For details about color 
coding, see “Understanding KPI Status” on page 352.

The icons displayed under a CI bar identify the relevant KPIs for the CI. 
These icons are also color coded to indicate the status of that KPI. 

Note: The root CI does not display KPI icons because it is a container and 
not a real CI.
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For a list of the KPIs used in Dashboard, see “List of Dashboard KPIs and 
Their Details” in CI Attribute Customization.

Virtual Containers
Virtual container CIs are displayed in Top View in regular CI bars, but their 
names appear between brackets. The bar is color-coded according to the 
current worst operational status for the group CI’s children CIs. You cannot 
right-click the bar to display context menu options.

Virtual containers are created by selecting the attribute by which you want 
to group the CIs in pattern views. For details, see “Group By Dialog Box” in 
Model Management.

Tasks

Display and Customize View Information in Top View

This section describes the steps needed to display a view information in Top 
View, and gives examples.

This task includes the following steps:

➤ “Access Top View and Display the View Information” on page 93

➤ “Customize the Top View Display” on page 93

➤ “Filter the Relevant Information in Top View” on page 93
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 1 Access Top View and Display the View Information
Select Applications > Top View to display the CIs of the selected view in a 
top-down, graphical diagram. Select the required view from View Explorer. 
The name of the selected view is displayed in the central bar of the diagram. 

The configuration items (CIs) in the view are displayed in hierarchical 
format within a single, interactive graphical interface, enabling you to gain 
a big-picture perspective of business availability for both the end-user and 
system Key Performance Indicators (KPIs) of your organization. 

For details, see “Top View Page” on page 108.

 2 Customize the Top View Display
You can customize the layout of the hierarchy, use Chinese or Japanese 
characters, change the background or the bar’s colors, the fonts, and more.

For details about the available customizations, see “Customize Top View 
Display” on page 95.

 3 Filter the Relevant Information in Top View
Use context menu options to filter parts of the hierarchy and to handle 
acknowledgments. 

For details, see “Top View Menu Options” on page 114.
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Access an External Application from Top View

You can configure Dashboard Top View so that a user can open an external 
application. 

To open an external application from Top View:

To specify the URL of the external application, select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Dashboard Application, and locate the Top View URL to Open entry in 
the Top View Properties table. Enter the appropriate URL:

➤ Enter the URL of the application.

➤ Enter a dynamic URL that can be used, for example, to integrate external 
tools with HP Business Availability Center.

Use the following syntax (HTTP GET format):

Use only the parameters you need in any combination. For details about the 
parameters, see “Dynamic URL Parameters” on page 105.

For example:
http://<URL>?nodeName=NODE.NAME&nodeParentId=NODE.PARENTID
adds the CI name and the ID of the parent CI to the URL.

➤ To reset the URL to the default (empty), click Default.

Note: 

➤ The change takes place immediately.

➤ You must disable your browser’s pop-up blockers to open a window with 
the external application.

http://<URL>?nodeName=NODE.NAME&nodeId=NODE.ID
&nodeStatus=NODE.STATUS&nodeParentId=NODE.PARENTID
&nodeChildId=NODE.CHILDIDS
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Specifying a URL in the Infrastructure Settings, automatically adds the Open 
in New Window option to the context menu options in Top View. By 
default, no URL is specified and the Open in New Window option does not 
appear in the context menus in Top View. When the user selects Open in 
New Window, Top View calls the URL in another window and supplies it 
with the values of the parameters you specified in the URL. The URL page 
uses the values of the parameters to display what is necessary. 

Customize Top View Display

You can customize the Top View display.

Note: All the steps in this task are optional and can be performed in any 
order.

This task includes the following steps:

➤ “Customize the Layout of the Hierarchy in Top View” on page 96

➤ “Modify the Default Refresh Rate of Top View” on page 99

➤ “Change the KPI Status Icons” on page 99

➤ “Viewing Chinese or Japanese Characters in Top View” on page 99

➤ “Change the Text Color in Top View Bars” on page 99

➤ “Change Fonts in Top View” on page 100

➤ “Change the Caption Font Size in Top View” on page 100

➤ “Modify the Number of CIs Displayed in Top View” on page 100

➤ “Specify the Maximum Length of the Line Between Two CIs” on page 101

➤ “Change the Number of CI Levels Displayed in Top View” on page 101

➤ “Change the Number of CI Levels That Can Be Expanded in Top View” on 
page 101
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➤ “Hide or Display the View Bar in Top View When the View has a Single Root 
CI” on page 102

➤ “Change the Color of the CI Bar in Top View When the CI Status is OK” on 
page 102

➤ “Customize the Background Image for Top View” on page 103

➤ “Customize Top View Tooltips” on page 103

➤ “Set Up the Top View Debugging Mechanism” on page 105

 1 Customize the Layout of the Hierarchy in Top View
You can customize the layout of the hierarchy in the Top View page. By 
default, the parent CI is displayed above the child CIs and the child CIs are 
close to the bottom part of the Top View tab.

To customize the layout of the hierarchy, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Top View Graph Layout entry in the 
Top View Properties area. Select the type of layout (listed below in 
alphabetical order).

Type of Layout Description

BOTTOM Default. The parent CI is above the child CIs and is 
centered on the page. 
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LEFT The child CIs are to the left of the parent CI and the 
parent CI is centered on the page. 

RADIAL The second level of the tree is distributed around 
the parent and the parent is centered on the page.

Type of Layout Description
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Note: The change takes place immediately.

RIGHT The child CIs are to the right of the parent CI and 
the parent CI is centered on the page. 

TOP The parent CI is under the child CIs and is centered 
on the page. 

Type of Layout Description
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 2 Modify the Default Refresh Rate of Top View
The default refresh rate for Top View is 30 seconds. To modify the default 
refresh rate, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Dashboard Application, 
and enter the required refresh rate in the Top View data refresh rate entry in 
the Dashboard Application - Top View Properties table. 

 3 Change the KPI Status Icons
You can use different status icons. For details, see “Change the KPI Status 
Icons” in CI Attribute Customization.

 4 Viewing Chinese or Japanese Characters in Top View
To view Chinese or Japanese characters in Top View, install the Chinese or 
Japanese packages. For details, see “Working in Non-English Locales” in 
Reference Information.

 5 Change the Text Color in Top View Bars
You can improve readability or customize Top View by changing the color of 
the text in Top View bars. 

Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the Top View 
Text Color Property entry in the Dashboard Application - Top View 
Properties table. Enter the appropriate color in the Value box, using the 
#RRGGBB format. Default is white (#FFFFFF). 

You must close all browser instances for the change to take effect.

Note: The setting affects both Top View in Dashboard and the Top View 
portlet in My BAC. 
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 6 Change Fonts in Top View
To change the font displayed in Top View for all locales, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Applications, select Dashboard Application, and locate the Top View Font 
Name entry in the Dashboard Application - Top View Properties table. Enter 
the appropriate font name in the Value box.

You must close all browser instances for the change to take effect.

 7 Change the Caption Font Size in Top View
By default the size of the fonts used for Top View CI names (in the bars) is 9.

To change the default size, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and enter the required value in the Top View 
caption font size entry in the Dashboard Application - Top View Properties 
table.

The change is immediate.

 8 Modify the Number of CIs Displayed in Top View
The maximum number of CIs displayed in Top View is 3000 by default.

To change the default value, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and enter the required value in the Maximum 
number of nodes entry in the Dashboard Application - Top View Properties 
table. 

The change is immediate.
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 9 Specify the Maximum Length of the Line Between Two CIs 

The default percentage by which you can extend the line between two CIs is 
1.5. This is a parameter of the applet that displays the view tree. 

To modify the default percentage, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and enter the required value in the Top View Line 
Extension Percentage entry in the Dashboard Application - Top View 
Properties table. 

The change is immediate. 

 10 Change the Number of CI Levels Displayed in Top View
By default, the Top View tab displays four levels of CIs. The rest of the CIs 
are collapsed. You can then expand a CI at the fourth level and see its 
children.

To modify the number of levels displayed when you open the Top View tab, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the Top View 
Number of Levels entry in the Dashboard Application - Top View Properties 
table. Modify the value. Valid values are 2 to 100. This change is performed 
during the next log in. If you select 2, the name of the view and the top 
level CIs are displayed.

 11 Change the Number of CI Levels That Can Be Expanded in Top 
View
To change the default setting (7) for the number of levels of CIs that are 
displayed when you select the Expand more levels context menu item, on 
the Infrastructure Settings page, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Top View expand levels entry in the 
Dashboard Application - Top View Properties table. Modify the value. Valid 
values are 2 to 12. This change is performed during the next log in.
101



Chapter 2 • Dashboard Top View
 12 Hide or Display the View Bar in Top View When the View has a 
Single Root CI
You can select to hide or display the view bar in the Top View tab, when the 
view has a single root CI. 

To hide or display the view bar in Top View when the view has a single root 
CI, select Admin > Platform > Setup and Maintenance > Infrastructure 
Settings, choose Applications, select Dashboard Application, and locate the 
Hide view bar in Top View entry in the Top View Properties table. Set the 
parameter to:

➤ true. The view bar is not displayed as the root of the hierarchy, the root of 
the hierarchy is the single root CI. 

➤ false. The view bar is the root of the hierarchy. 

 13 Change the Color of the CI Bar in Top View When the CI Status 
is OK
You can modify the default green color (#66CC00) of the CI bar when the CI 
status is OK to another color or a different green. 

To modify the color, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Dashboard Application, 
and enter a different color in the Top View Green Color Property entry in 
the Top View Properties table. 
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 14 Customize the Background Image for Top View
To change the background color or add a background image to the Top View 
tab or to the NOC standalone page, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Applications, and locate in the Dashboard Application - Top 
View table:

➤ Top View Background Color Property. Modify the default value to change 
the color of the Top View tab background or of the NOC standalone page 
background. For example, you can display the Top View tab with a black 
background (#000000). You must close all browser instances for the change 
to take effect.

➤ Top View Background Image. Enter the name of the image you want to use 
as a background image for the Top View tab or the NOC standalone page 
and put the appropriate image in the following location: 
<HP Business Availability Center root directory>/AppServer/webapps/
site.war/bam/

You must close all browser instances for the change to take effect.

 15 Customize Top View Tooltips
You can:

➤ Limit the number of lines displayed in the tooltip

If the tooltip includes more lines than the default number of lines, More... is 
displayed on the last line.

To change the default number of lines (8) displayed in the tooltip, select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and enter the required 
number of lines in the Max lines in tooltip entry in the Dashboard 
Application - Top View Properties table.
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➤ Modify the tooltip font size

The size of the fonts in Top View tooltips is 8 by default.

To change the default font size, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and enter the required font size in the Top View 
Tooltip font size entry in the Dashboard Application - Top View Properties 
table.

➤ Display the weight information in the tooltip

You can add the weight of a CI’s KPIs to the CI’s tooltip for any CI in Top 
View.

Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the Show 
weight property in tooltip entry in the Dashboard Application - Top View 
Properties table. Modify the value to true. Default is false (weight is hidden).
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Note: 

➤ The setting affects both Top View in Dashboard and the Top View portlet 
in My BAC. 

➤ Using this option might affect the performance.

➤ Adding a weight to a CI is explained in “Relationship Properties Dialog 
Box” in Model Management.

 16 Set Up the Top View Debugging Mechanism
To debug Top View, set the debug mode. Log messages are printed to the 
Java console.

To debug Top View, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Dashboard Application, 
and set the Top View Debug entry in the Dashboard Application - Top View 
Properties table to true. Default is false.

Reference

Dynamic URL Parameters

The parameters for a dynamic URL are: 

Constant Description

NODE.NAME The name of the CI. When the URL is executed, 
NODE.NAME is replaced by the name of the CI from 
which you want to open the URL The page specified 
in the URL opens and is filtered to display only 
information related to the CI.

NODE.ID The ID number of the CI. When the URL is 
executed, NODE.ID is replaced by the ID number of 
the CI from which you want to open the URL The 
page specified in the URL opens and is filtered to 
display only information related to the CI.
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NODE.STATUS The status of the CI. When the URL is executed, 
NODE.STATUS is replaced by the status of the CI 
from which you want to open the URL The page 
specified in the URL opens and is filtered to display 
only information related to status. The available 
statuses are:

-4 downtime

-3 stop

-2 no data

-1 uninitialized

0 critical

5 major

10 minor

15 warning

NODE.PARENTID The ID of the parent CI. When the URL is executed, 
NODE.PARENTID is replaced by the ID of the parent 
of the CI from which you want to open the URL. 
The page specified in the URL opens and is filtered 
to display only information related to the parent CI.

NODE.CHILDIDS The ID number of the CI children. When the URL is 
executed, NODE.CHILDIDS is replaced by a list of 
the IDs of the children of the CI from which you 
want to open the URL. The page specified in the 
URL opens and is filtered to display only 
information related to the children CI.

NODE.NAME The name of the node.

NODE.ID The ID number of the node.

NODE.STATUS If you want to filter by status, use 
NODE.STATUS.

Constant Description
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Top View User Interface

This section describes:

 ➤  Top View Page on page 108

NODE.PARENTID The ID of the parent CI.

NODE.CHILDIDS The ID number of the CI children.

Constant Description
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Top View Page
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Description Enables you to see the business availability of your 
system components at a glance. The CI bars in the tab 
provide a visual representation of real-time IT 
performance metrics mapped onto business 
applications, based on the hierarchy tree structure 
defined for each view. The connecting lines between 
the bars define the relationships between the CIs.

To Access: Select Applications > Dashboard, select a 
view in View Explorer, and click the Top View tab.

Important 
Information

Do not select a new view in the Role-Based Views list 
until the currently selected view has finished loading. 
Doing so may cause the browser to freeze. If this 
happens, close the Top View page, then close any other 
open pages, and reopen the page.

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Functionality:

➤ Click anywhere in the tab to change the emphasis of 
the graphic. The graphic rotates to display the 
components of the subtree for the nearest bar.

➤ Click and drag anywhere in the tab to move and 
rotate the graphic around that point.

➤ Increase or reduce the gap between each branch by 
holding down the ALT button on the keyboard and 
dragging the relevant bar.

➤ When you open the Top View tab, it displays by 
default the active view at the root level, centered 
around the view name bar. Any manipulation you 
do to the graphic is not saved; if you move to 
another tab, then when you open the Top View tab 
again it reverts to the default display format.

Included in Tasks “Display and Customize View Information in Top 
View” on page 92.

Useful Links “Top View” on page 90

For details about the functionality of View Explorer, see 
“View Explorer” in Model Management.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<CIs, Child CIs, and 
Root CIs>

The tree is built from branch parent and child 
configuration items (CIs) and monitor CIs. For details, 
see “Working with CIs” in Model Management. 

Right-click a bar to display the context menu options. 
For details, see “Top View Menu Options” on page 114.

Click a bar to move the bar to the center of the graphic.

When you select a CI in View Explorer, Top View 
displays the selected CI centered in the tree with all its 
sub-branches expanded. If you select a CI in the Top 
View tree, it is highlighted in the View Explorer. 

<KPIs and their 
statuses/values>

For each CI, Dashboard displays the CI’s KPIs and their 
real-time status as a color-coded icon (LED). For details, 
see “Understanding KPI Status” on page 352.

For details about the icons, see below.

<right-click menu 
options>

Right-click a CI bar to list the available menu options. 
For details, see “Top View Menu Options” on page 114.
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<View bar> When you select a view in View Explorer, Top View 
displays the selected view bar centered in the tree with 
all its root CIs expanded. 

➤ Expand and collapse the branches of a subtree by 
clicking the expand (+) or collapse (-) symbols, 
displayed in the bottom right corner of the bar. 

➤ When branches are too long to fit on the screen, Top 
View displays lines emerging from the bar, to 
indicate the number of branches and leaves that are 
hidden. Click the end of one of these lines to display 
the entire hidden branch.

Hold the cursor over a bar to enable the following 
functionality:

➤ The bar is outlined in grey.

➤ If the CI has a long name, the bar expands to display 
the full name.

➤ A tooltip is displayed, providing status and 
performance data in each KPI for the item. 

Right-click the bar to display the available menu 
options. For details, see “Top View Menu Options” on 
page 114.

<View Explorer> When you select a CI in View Explorer, Top View 
displays the selected CI centered in the tree with all its 
sub-branches expanded. If you select a CI in the Top 
View tree, it is highlighted in the View Explorer. 

GUI Element (A-Z) Description
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KPI Icons in Top View
A CI can have one of the following icons:

Last Update Shows connectivity with the Dashboard servlet, 
running on the Tomcat servlet engine by displaying 
the time the information in the tab was last updated.

NOC View Click to display the top view tree in a separate window 
to be used by a Network Operations Center (NOC). 

To return to the Top View tab, close the Top View 
standalone window.

Only one instance of Top View can be displayed at a 
time; this means that if you are displaying the top view 
in the NOC View standalone window, you do not see it 
in the Top View tab and vice versa. 

Icon Description

Availability KPI (with OK status)

Customer KPI (with OK status)

System/HP System KPI (with OK status)

OT Impact KPI (with OK status)

Performance KPI (with OK status)

PNR KPI (with OK status)

RT Impact KPI (with OK status)

User KPI (with OK status)

GUI Element (A-Z) Description
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Note: 

In the Top View tab, the icon for a CI with a Stopped or Downtime status CI 
is gray with a green border.

You can customize the set of icons used in Dashboard. For details, see 
“Change the KPI Status Icons” in CI Attribute Customization.

All other KPIs (with OK status)

The CI has been acknowledged

The Duration KPI (with OK status)

The Business Health KPI (with Major status)

The Backlog KPI (with No data Status)

The Volume KPI (with OK status)

Icon Description
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Top View Menu Options
Right-click a CI bar to display the following menu options (in alphabetical 
order):

Menu Option Description

Acknowledgment Details To display acknowledgment information for the CI. 
For details, see “Acknowledge Performance 
Problems” on page 36.

Expand more levels Opens a number of levels (7 by default) below the 
selected level.

Expand to problem Collapses the branches where CIs do not have 
Critical or Major statuses.

For example, in the End User Locations view, Default 
Client_SanityBPM support is red. 

Right-click Default Client_SanityBPM and select the 
Expand to problem option, to get more information 
about the problem by displaying lower levels of the 
view and by collapsing non-problematic branches.
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Open in new window Opens a pop-up window that contains the page 
accessed by the specified URL. This is useful to open 
external applications. By default, this option does 
not appear in the menu. For details about setting up 
an external URL option, see “Access an External 
Application from Top View” on page 94.

Set/Unset 
Acknowledgment

Enables you to set or clear the CI acknowledgment. 
For details, see “Acknowledge Performance 
Problems” on page 36.

View in Console Displays the CI’s branch in the Console tab.

Menu Option Description
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3
Dashboard Console

This chapter describes the Dashboard Console.

This chapter includes:

Concepts

 ➤  Console Page on page 117

 ➤  Service Level Management Results in the Console Page on page 120

Tasks

 ➤  Display and Customize View Information in the Console Tab on page 120

 ➤  Customize the Console Page on page 123

Reference

 ➤  Console User Interface on page 124
Concepts

Console Page

The Console page shows the components of the active Dashboard view 
organized into the same hierarchy tree format that you defined for the CIs. 
For details, see “Working with CIs” in Model Management. 

For details about the Console page user interface, see “Console Page” on 
page 125.
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The tree is built from group CIs (parents and children) and monitor CIs.

This section includes the following topics:

➤ “KPI Status” on page 118

➤ “CIs” on page 118

➤ “Drill Down” on page 119

KPI Status
The KPI columns for the view (for example, System, Performance, and 
Availability) contain colored indicators representing performance status for 
each CI under that KPI (if the KPI is applicable for the CI). 

If a KPI is relevant for at least one CI in the tree branches currently 
displayed, then that KPI is displayed for all CIs. The KPIs that are not 
relevant for a particular CI display a hyphen (-) meaning that the KPI is not 
applicable for this CI.

For an explanation of the status icons, see “Understanding KPI Status” on 
page 352.

CIs
The Console tab top level displays the view and the status of the top level 
CIs’ KPIs. The tree pane provides a snapshot of tree branches at two 
consecutive levels (configurable default). For example, when you first access 
the view, if there is only one parent, you see the two highest levels: Tours 
Business (parent) and Springfield and Unionville (children).

If there is more than one child, all CIs are shown collapsed when you first 
access the view.
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You can expand each CI individually to show its child CIs, or you can use 
the Expand All/Collapse All buttons to expand all CIs in the view (so that 
you see child CIs for all CIs). These buttons are shown only when one or 
more of the currently displayed CIs can be expanded or collapsed.

After a CI is expanded using either of these methods, it remains expanded 
for as long as the browser window is open, even if you move to another 
HP Business Availability Center application.

If you move from another tab to a CI in the Console tree pane (for example, 
by clicking a CI name in the Filters tab, or by selecting an option from a CI 
options menu), then the relevant CI name is shown highlighted in the tree 
(and in the View Explorer), and the CI is shown expanded. However, CIs 
expanded in this way do not retain the setting and are collapsed again when 
you move away from that level of the view.

Drill Down
To view the CIs two levels down from the current CIs, click a drill-down link 
(linked CI name). CIs are displayed as drill-down links if there is at least one 
level below the CI, or if there is at least a CI with child CIs within the same 
branch. In the previous example, the CIs Springfield and Unionville are shown 
as drill-down links because Tours Business is a CI with child CIs. Click 
Springfield to display the CI’s child CIs. The view of the tree changes; 
Springfield is shown as the parent CI and the level under the selected CI is 
displayed.

The CIs at the new level are by default shown collapsed; however, if the 
displayed level contains only one parent CI, or if you have previously 
expanded CIs, then the child CIs are shown for the relevant CIs.
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Service Level Management Results in the Console Page

You can use the Dashboard Console to proactively monitor your service 
level agreements (SLAs). The console displays a PNR KPI bar that enables you 
to see which SLAs are problematic. You can drill down to see which specific 
CI may cause you to breach a service contract. 

Dashboard calculates whether the measurements of an SLA are within the 
limits set out in a service level agreement (as defined in Service Level 
Management). Furthermore, Dashboard calculates whether an SLA is in 
breach of contract, or might be in breach in the near future.

Dashboard displays the results color-coded according to the status of the CI 
(that is, whether the CI is functioning within the SLA’s time constraints). 

For details on attaching a PNR (point of no return) KPI to a CI to view data 
in Dashboard, see “Example – Attaching a PNR KPI to a CI” on page 367.

For details about the tooltip that is displayed when you move the mouse 
over the PNR KPI, see “SLM PNR Rule” in CI Attribute Customization.

Tasks

Display and Customize View Information in the Console 
Tab

This task describes how to view information in the Console tab.

This task includes the following steps:

➤ “Select a View and Display a View Information in the Console Page” on 
page 121

➤ “Customize the View Information in the Console Page” on page 121

➤ “Access Additional Information” on page 121
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 1 Select a View and Display a View Information in the Console 
Page
The data displayed in the Console tab depends on the view you have 
selected. Select a view and click the Console tab to display the components 
of the active Dashboard view organized into the same hierarchy tree format 
defined for the CIs in Dashboard Administration. The KPIs columns for the 
view (for example, System, Performance, or Availability) contain colored 
indicators representing performance status for each KPI under the CI. For 
details, see “Console Page” on page 125.

 2 Customize the View Information in the Console Page
Customization options are available to filter parts of the hierarchy and to 
handle acknowledgments. For details about the options, see “Customize the 
Console Page” on page 123.

 3 Access Additional Information
Access more information by using the context menu options. 

For details, see “Menu Options” on page 62.

Example – Find Visible and Hidden Child CIs 

You can display a CI’s visible and hidden child CIs in a specific view. For 
details, see “Find Visible and Hidden Child CIs” on page 50.
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Example – Searching for Views That Include a Specific Child

In View Explorer, click Search to perform a search for the CIs whose names 
include the selected child CI’s name string in all views, and display the 
results in the View Explorer search page.

Click the appropriate CI in the list to display more information about the 
selected CI in the selected view.

If the CI is not visible in any view, in Dashboard, the following message is 
displayed: Search is complete. There are no results to display for the current 
search parameters.

The CI is not visible in any view in the following situations:

➤ It is included in the CMDB but does not belong to any view.

➤ It belongs to a view but the Exclude all child CIs option has been selected 
for its parent CI in that view. For details see the Remove manually added 
children button in “Instance View Editor”in Model Management.
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Customize the Console Page

You can customize the Console page display using the following options:

This task includes the following steps:

➤ “Modify the Number of Levels Displayed in the Console Page” on page 123

➤ “Display Children Section Expanded” on page 123

➤ “Display the Information in Columns” on page 124

➤ “Modify the Background Color of the Console Page” on page 124

➤ “Add a Details Link to CIs in the Console Page” on page 124

 1 Modify the Number of Levels Displayed in the Console Page
To modify the number of levels in the Console tab, select Admin > Platform 
> Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Dashboard Application, and locate the Business Console - Number of 
display levels entry in the Dashboard Layout Properties table. Modify the 
value. Default is 2. If you specify 1 only the parent CIs are displayed.

 2 Display Children Section Expanded
To display the children section expanded when accessing the Console page, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
click Applications context, select Dashboard Application, and change the 
Business Console -Default state in the Dashboard Application - Dashboard 
Layout Properties table to expanded. The default is collapsed. The change is 
performed immediately.
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 3 Display the Information in Columns
You can modify the Console tab definition to display columns instead of 
one table.

To display the Console tab in columns, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications context, select 
Dashboard Application, open the Business Console - Number children 
sections in the Dashboard Application - Dashboard Layout Properties table, 
and specify the number of columns you want to display in the Console tab. 
The default is 1. You can select a number between 1 and 3. The change is 
performed immediately.

 4 Modify the Background Color of the Console Page
To modify the background color of the Console tab, edit the /* added for 
bam */ section of the stylesheet used by the Dashboard Console tab located 
at
<HP Business Availability Center root directory>/AppServer/
webapps/siet.war/static/act/stylesheets/Properties.css. 

It is recommended to backup the original stylesheet before making any 
changes. 

 5 Add a Details Link to CIs in the Console Page
To add a Details link for every CI in the tab, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and in the Dashboard Application - Dashboard 
Layout Properties table, modify the Show element CMDB details link in UI 
entry. Default is false. For details, see “Node Details Dialog Box” on page 80.

Reference

Console User Interface

This section describes:

 ➤  Console Page on page 125
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Console Page

Description Shows the components of the active Dashboard view 
organized into the same hierarchy tree format that you 
defined for the CIs. For details, see “Working with CIs” 
in Model Management. 

To Access: Select Applications > Dashboard, and click 
the Console tab.

Important 
Information

Customizable: You can customize this tab. For details, 
see the customization section in “Dashboard Console” 
on page 117.

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Included in Tasks “Display and Customize View Information in the 
Console Tab” on page 120

Useful Links “Console Page” on page 117

“Real-Time Changes to CI Properties” on page 23

For details about the functionality of View Explorer, see 
“View Explorer” in Model Management.

GUI Element (A-Z) Description

Click to access the context menu options. For details, 
see “Menu Options” on page 62.

The acknowledge utility enables you to track 
performance problems identified in the system and in 
the network infrastructure by keeping a record of when 
the problem was acknowledged and by which user. For 
details, see “Acknowledge Performance Problems” on 
page 36.

Indicates that at least one change-monitored property 
of the CI’s child CIs has changed. 

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 40.
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Indicates that at least one change-monitored property 
of the CI’s child CIs has changed.

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 40.

Indicates that at least one change-monitored property 
of the CI and at least one change-monitored property 
of the CI’s child CIs have changed.

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 40.

Click to toggle the sound on or off. The icon tooltip 
indicates the action you perform if you click the 
button. For details, see “Set Up Sound Notification 
When KPI Status Changes to Critical” on page 52 or 
“Switch Off the Alert Sound When CI is 
Acknowledged” on page 40.

<CIs> The tree is built from group parent, children and 
monitor configuration items (CIs). For details, see 
“Working with CIs” in Model Management. 

<Expand/collapse> Click [+] or [-] in the tree of CIs to expand or collapse 
the tree.

GUI Element (A-Z) Description
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<KPIs and their 
statuses/values>

For each CI in the view, Dashboard displays real-time 
status in one or more KPI columns (for example, 
System, Performance, and Availability). A color-coded 
icon (LED) represents the status assigned to the KPI for 
its current performance level. Additional icons show 
trend and history for the CI under that KPI. For details, 
see “Understanding KPI Status” on page 352.

If a KPI is relevant for at least one CI in the tree 
branches currently displayed, then that KPI is 
displayed for all CIs. The KPIs that are not relevant for 
a particular CI display a hyphen (-), meaning that 
those KPIs are not applicable for this CI.

Tooltip: Move the cursor above a KPI status icon to 
display a tooltip providing additional information 
about the KPI: 

➤ CI Name. The name of the CI.

➤ Status. The status of the CI (calculated according to 
one of the status calculation methods). It may also 
display:

➤ Not up to date. For decayed CIs, indicating that 
the CI has passed its timeout period. (For a 
SiteScope CI, this status is displayed after a 
SiteScope monitor is disabled.)

➤ Stopped. When a Business Process profile is 
stopped.

➤ Calculation Rule. The name of the rule that 
calculates the KPI status or value.

➤ Held Status Since. The date and time since which 
this CI has held its current operational status.

➤ Invisible Children. Might not appear. The number of 
child CIs belonging to other views, which are 
connected to this CI but do not belong to this view. 
For details, see “Find Visible and Hidden Child CIs” 
on page 50.

The KPIs are ordered, from left to right, according to 
their Display Order defined in the Repositories. For 
details, see “KPIs Repository Page” in CI Attribute 
Customization. 

GUI Element (A-Z) Description
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Last Update Shows connectivity with the Dashboard servlet, 
running on the Tomcat servlet engine by displaying 
the time the information in the tab was last updated.

GUI Element (A-Z) Description
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Dashboard Filters

This chapter describes the Dashboard Filters.

This chapter includes:

Concepts

 ➤  Filters on page 132

Tasks

 ➤  Display and Customize a View Information in Filters on page 132

 ➤  Search for Specific CIs and Filter the Results on page 133

 ➤  Create or Customize an Active Filter on page 137

 ➤  Create a Temporary Filter Using Quick Filter on page 139

Reference

 ➤  Dashboard Filters User Interface on page 140
Concepts
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Filters

The Filters tab enables you to view operational status for specific segments 
or components of your business. The Filters tab displays (in a flat 
non-hierarchical way) the configuration items (CIs) that match the 
following criteria: they belong to the selected view, and at least one of their 
Key Performance Indicators (KPIs) has the status specified in the active filter.

For details about the Filters tab user interface, see “Filters Page” on page 148.

Tasks

Display and Customize a View Information in Filters

This section describes the processes for displaying and customizing a view 
information in the Filters tab, and gives examples.

This task includes the following steps:

➤ “Select a View in View Explorer” on page 132

➤ “Set the Active Filters” on page 133

➤ “Add a Details Link to CIs in the Filters Page – Optional” on page 133

 1 Select a View in View Explorer
The data displayed in the Filters tab depends on the view you have selected. 
For details, see “Filters Page” on page 148.
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 2 Set the Active Filters
You use the Active Filters capability to create filters that enable you to filter 
the CIs displayed in the Filters tab, enabling you to focus on the specific 
view, on specific CI types or statuses, or on problematic areas. For details, see 
“Filters Page” on page 148.

You can also create a new active filter. For details, see “Create or Customize 
an Active Filter” on page 137.

You can also create a temporary filter. For details, see “Create a Temporary 
Filter Using Quick Filter” on page 139.

 3 Add a Details Link to CIs in the Filters Page – Optional
To add a Details link for every CI in the Filters page, select Admin > Platform 
> Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Dashboard Application, and in the Dashboard Application - 
Dashboard Layout Properties table, modify the Show element CMDB details 
link in UI entry. Default is false. 

The Details link enables you to view CMDB information about the CI. For 
details, see “Node Details Dialog Box” on page 80.

Search for Specific CIs and Filter the Results

You can search for a specific CI using the View Explorer search function to 
filter the list of CIs that HP Business Availability Center displays. For more 
details about the Search feature, see “View Explorer” in Model Management.

You can locate CIs by their name, by related CIs, by their CITs, in the 
current view, or in all views. If, in addition to using the Search feature in 
View Explorer, you display the Filters tab in the right pane of the 
Dashboard, the resulting filtered report displays only the CIs that have been 
located by the search filtered by the selected filter in the Filters tab. 

For details about the Filters tab, see “Filters Page” on page 148.
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Example – Searching for CIs in the Current View

You can search for CIs in the current view by name, related CIs, or CITs.

➤ The result is a list of all of the CIs corresponding to the search criteria listed 
in View Explorer. The Filters tab displays a filtered list of the CIs and the CI’s 
children CIs corresponding to the search criteria filtered by the active filter 
and the current operational status in each KPI for each of the CIs.  
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➤ If the search result is a single CI, or if you click one of the CIs in the search 
list results, the Filters tab displays the selected CI and its child CIs filtered by 
the active filter, and the current operational status in each KPI for each of 
the CIs. 
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Example – Searching for CIs in More Than One View

You can search for CIs in all views by name, related CIs, or their CITs.

➤ The result is a list of all of the CIs and the views that include them, 
corresponding to the search criteria listed in View Explorer. The Filters tab 
displays a filtered list of the CIs corresponding to the search criteria, filtered 
by the active filter and the current operational status in each KPI for each of 
the CIs. 
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➤ You can click a specific CI in the results of the search list to display in the 
Filters tab a filtered list of the CIs corresponding to the search criteria and to 
the selected view, filtered by the active filter and the current operational 
status in each KPI for each one of those CIs.  

Create or Customize an Active Filter

Active Filters enable you to focus on a specific view, CI type or status, or 
problematic areas.

The currently active filter is displayed in the Active Filters box in the Filters 
tab. You can select a different filter from the Active Filters list.

The Active Filters list contains the Dashboard predefined filters (shown as 
gray text strings) and any additional filters you defined (shown as black text 
strings). 
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To define or customize filters, access the Filters tab, and select one of the 
following options:

➤ To define a new filter, click New. The Defining/Editing Filters Page opens. 

➤ To use an existing filter as the basis for the new filter, select the filter name 
in the Select a filter list and then click Save As. The Filter Name dialog box 
opens, where you can specify a name for the filter you are creating. You are 
then returned to the Defining/Editing Filters Page.

For details, see “Filters Page” on page 148.

Example

The private:filter ver filter for Application KPIs and Customer KPIs with the 
OK status. 
138



Chapter 4 • Dashboard Filters
Create a Temporary Filter Using Quick Filter

Quick Filter enables you to display CIs whose KPIs have one of the selected 
statuses. The filter is a temporary filter that persists until you log off, change 
its selection of statuses, or select another filter.

After you select a combination of filters to display a view’s data, you can 
further refine the report by selecting specific KPI’s statuses. The displayed 
CIs have at least one KPI with one of the selected statuses.

For details, see “Filters Page” on page 148.

Note: You cannot save the settings you selected in Quick Filter, but you can 
create a similar filter using Active Filter. For details, see “Defining/Editing 
Filters Dialog Box” on page 141.

Example

The global:Show All report includes all statuses.  
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To display only the CIs whose KPIs have OK and/or Critical statuses, select 
those statuses in the Quick Filter bar and click Apply.

The filtered report includes only the OK and/or Critical statuses. 

Reference

Dashboard Filters User Interface

This section describes:

 ➤  Defining/Editing Filters Dialog Box on page 141

 ➤  Filter Name Dialog Box on page 147

 ➤  Filters Page on page 148
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Defining/Editing Filters Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Used to define new filters or customize existing filters

To Access: Click Application > Dashboard, and click the 
Filters tab. Select the view in the View Explorer. Click 
Active Filters.

Important The Filters tab has predefined filters you can use to 
display commonly required information. For details, 
see “Predefined Filters” on page 144.

Note:

➤ If more than one user is logged in at the same time 
using the same user name (for example, admin), then 
every time one of the users saves a change to the 
filters, the associated filters file is updated with a 
copy of that user’s filters. 

➤ The information displayed in the Filters tab is not 
refreshed while the Defining/Editing Filters dialog 
box is open. (This also applies when the 
Defining/Editing Filters dialog box is not in focus.)

Included in Tasks “Create or Customize an Active Filter” on page 137

GUI Element (A-Z) Description

To invert the selection use the Invert Selection button. 

Acknowledged Select one of the following options:

➤ All. To display all of the CIs whether they are 
acknowledged or not.

➤ Yes. To display the CIs that are acknowledged.

➤ No. To display the CIs that are not acknowledged.
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Cancel Click to exit the Defining/Editing Filters dialog box 
without saving your changes to the filter criteria for the 
currently displayed filter. 

Warning: The filter you create is saved and appears in 
the Active Filters list.

Clear All Clears all the selected filter fields.

Define filter Select the check box for each KPI status type that you 
want to include in the filter. 

Specify any combination of the listed filter criteria. The 
filter displays the CIs that meet all of the selected 
criteria, as follows:

If no status is selected for a KPI then all statuses are 
included in the filter.

Filter by Change Select one of the following options to filter by the CIs 
that are set to be monitored in real-time for changes 
(only 20 CIs and their children can be monitored at a 
time). For details, see “Real-Time Changes to CI 
Properties” on page 23:

➤ Ignore Configuration Change. To display all CIs, 
whether their configuration changed or not.

➤ Only Changed Configuration Items. To display only 
the CIs whose configuration changed.

➤ Exclude Changed Configuration Items. To display 
only the CIs whose configuration did not change.

Filter by CI type Select one of the following options:

➤ All. All the CI types are included (monitor and non-
monitor CIs).

➤ All excluding monitors. All the CI types are included 
except for monitor CIs that are excluded.

➤ Monitors only. All the CI types are excluded except 
for monitor CIs that are included.

GUI Element (A-Z) Description
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New Click to define a completely new filter in the Filter 
Name dialog box that opens. All the KPI’s statuses are 
cleared. 

Note: By default, a filter is called Custom Filter when 
you create a filter without assigning it a name.

OK Click to save your changes to the currently displayed 
filter and to close the Defining/Editing Filters dialog 
box.

Rename Click to rename the filter; for example, when you are 
want to change the name of a filter you created.

Save As Select the filter name in the Select a filter list, and click 
to use the selected filter as the basis for the new filter. 
The KPIs’ statuses that were selected for the filter you 
are using as a model are still selected.

The Filters Name dialog box opens, where you can 
specify a name for the filter you are creating.

Select a filter Click to modify an existing filter, select the filter in the 
box and click Select a filter. 

To use the selected existing filter as the basis for the 
new filter, select the filter name in the box, and click 
Select a filter. Then click Save As. The KPI statuses that 
were selected for the filter you are using as a model are 
still selected.

Predefined filters are used to include or exclude CIs 
according to their type, and KPIs according to their 
status. These filters cannot be modified or deleted. 

For details, see “Predefined Filters” on page 144.

Visibility Select the required visibility option:

➤ Private. If you want to create a private filter.

➤ Public. If you want to create a public filter.

Note: Visibility is displayed only to the administrator 
or to a user with the appropriate permissions.

Different levels of visibility are available. For details, 
see “Visibility Levels” on page 145.

GUI Element (A-Z) Description
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Predefined Filters

The predefined filters are:

Predefined Filter Name Description

global: Show All Displays all of the CIs, all their KPIs, and the status 
of the KPIs.

global: Show Errors Displays, for all CI types, only the CIs whose 
Availability, Customer, HP System, OT Impact, PNR, 
Performance, RT Impact, System, User, Volume, and 
custom KPIs have a critical status.

global: Show Errors – 
Monitors Only

Displays only the monitor CIs whose Availability, 
Customer, HP System, OT Impact, PNR, 
Performance, RT Impact, System, User, Volume, and 
custom KPIs have a critical status.

global: Show Errors and 
Warnings

Displays, for all CI types, only the CIs whose 
Availability, Customer, HP System, OT Impact, PNR, 
Performance, RT Impact, System, User, Volume, and 
custom KPIs have a minor, major, or critical status.

global: Show Monitors 
Only

Displays only the monitor CIs, their KPIs, and the 
status of the KPIs.

global: Show PNR Displays, for all CI types, only the CIs whose PNR 
KPI has an OK, Warning, Minor, Major, Critical, or 
No Data status.
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Visibility Levels

The visibility levels you can select when defining a filter include:

Visibility Level Filter Description

Global Global filters are predefined and built-in. They 
are available for all customer users. They 
cannot be modified. You can use them as 
templates to build public or private active 
filters. Their names have the following syntax: 
global:<name>. They appear in the list of 
active filters as gray text strings. For a list of 
global active filters, see “Predefined Filters” on 
page 144.

Public Administrators or users with the appropriate 
permissions can build public active filters. 
Those filters are available for all users at the 
specific customer. You can use the global active 
filters as templates to build public active filters. 
Their names have the following syntax: 
public:<name>. They appear in the list of 
active filters as black text strings.
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Private Users can build their own private active filters. 
Those filters are available only to the user who 
created them. You can use the global and 
public active filters as templates to build 
private active filters. Their names have the 
following syntax: private:<name>. They 
appear in the list of active filters as black text 
strings.

For each user name used when logging on to 
HP Business Availability Center, Dashboard 
creates an associated filters file. When you log 
on to HP Business Availability Center using a 
specific user name, you can only view and 
modify the filters contained in the associated 
filters file. The file is updated with the filter 
modifications made by each user who logs in 
under this user name, so any changes you 
make to the filters may overwrite 
modifications made by previous users.

Temporary Another type of private active filter. These 
filters are created when you select statuses in 
the Quick Filter and click Apply or when you 
use the Filter subtree - Monitors only option in 
a CI context menu. The name of the 
temporary filter is temp: Quick Filter. For 
details, see “Create a Temporary Filter Using 
Quick Filter” on page 139. You cannot save 
temporary filters.

Visibility Level Filter Description
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Filter Name Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Used to define a new filter name.

To Access: In Defining/Editing Filters, select Save As.

GUI Element (A-Z) Description

Name Enter the name of the filter.
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Filters Page

Description Enables you to view operational status for specific 
segments or components of your business. The Filters 
tab displays (in a flat non-hierarchical way) the 
configuration items (CIs) that match the following 
criteria: they belong to the selected view, and at least 
one of their Key Performance Indicators (KPIs) has the 
status specified in the active filter.

To Access: Select Applications > Dashboard and click 
the Filters tab.

Important 
Information

➤ Sort the information displayed in the Filters tab 
according to the entries in any column by clicking 
the column header. Toggle between ascending and 
descending order by clicking the header again.

➤ If you select (in View Explorer) a specific CI, the 
filter works only on the CI’s subtree. 

➤ If you select the view's root, the filter is applied to 
the whole view.

➤ Hold the cursor over a CI to display its full name in a 
tooltip.

Customization: For details, see “Add a Details Link to 
CIs in the Filters Page – Optional” on page 133.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Filter Definition Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Included in Tasks “Display and Customize a View Information in Filters” 
on page 132

Useful Links “Filters” on page 132

“Real-Time Changes to CI Properties” on page 23

For details about the functionality of View Explorer, see 
“View Explorer” in Model Management.

GUI Element (A-Z) Description

Last Update Shows connectivity with the Dashboard servlet, 
running on the Tomcat servlet engine by displaying 
the time the information in the tab was last updated.

GUI Element (A-Z) Description

Click to toggle the sound on or off. The icon tooltip 
indicates the action you perform if you click the 
button. For details, see “Set Up Sound Notification 
When KPI Status Changes to Critical” on page 52 or 
“Switch Off the Alert Sound When CI is 
Acknowledged” on page 40.

Active Filters link Define or modify active filters in the Defining/Editing 
Filters dialog box. For more information, see 
“Defining/Editing Filters Dialog Box” on page 141.

Apply To apply the Quick Filter selection to the display.

List of existing filters Select a filter from the Active Filters list. The filter can 
be one of the predefined filters or a custom filter.
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Quick Filter by 
Statuses

Quick Filter enables you to display CIs whose KPIs have 
one of the selected statuses. The filter is a temporary 
filter that persists until you log off, until you change its 
selection of statuses, or until you select another filter.

After you have selected a combination of filters to 
display a view’s data, you can further refine the report 
by selecting specific KPI’s statuses. The CIs that are 
displayed have at least one of their KPIs with one of the 
selected statuses.

Select a combination of KPI statuses in the Quick Filter 
bar. You can also use one of the options in the list to 
further filter the results:

➤ All. To display all types of CIs whose KPIs match the 
selected combination of KPI statuses selected in 
Quick Filter.

➤ Monitors only. To display only the monitor CIs 
whose KPIs match the selected combination of KPI 
statuses selected in Quick Filter.

➤ All excluding monitors. To display all types of CIs, 
except the monitor CIs, whose KPIs match the 
selected combination of KPI statuses selected in 
Quick Filter.

Note: You cannot save the settings you selected in 
Quick Filter, but you can create a similar filter using 
Active Filter. For details, see “Defining/Editing Filters 
Dialog Box” on page 141.

GUI Element (A-Z) Description
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Filtered CIs Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Indicates that at least one change-monitored property 
of the CI’s child CIs has changed. 

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 40.

Indicates that at least one change-monitored property 
of CI itself has changed. 

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 40.

Indicates that at least one change-monitored property 
of the CI and at least one change-monitored property 
of the CI’s child CIs have changed. 

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 40.

<menu options> Access more information by using the context menu 
options. For details, see “Menu Options” on page 62.
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<Tooltip> Move the cursor above a KPI status icon to the Details 
tooltip that includes the following information: the 
name of the KPI and the name of the CI, the name of 
the rule used to calculate the KPI status, and the time 
and date when the KPI status changed to the current 
status.

Ack Displays an icon that represents the CI 
Acknowledgment status.

Note: A tooltip for the Ack icon displays the current 
status of the CI’s acknowledgment.

The acknowledge utility enables you to track 
performance problems identified in the system and 
network infrastructure by keeping a record of when the 
problem was acknowledged and by which user. You can 
access the utility using context menu options or by 
clicking the Ack icon  that is displayed in an Ack 
column in some of the Dashboard tabs.

Note: A user with the appropriate permissions can 
show or hide the Ack column in the Dashboard 
application. To display/hide the Ack column, select 
Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, click Applications context, 
select Dashboard Application, and locate the Show CI 
Acknowledgment column in the Business Console area. 
Select false (to hide the Ack column) or true (to display 
the Ack column). The change takes effect immediately. 

Held Status Since The time and date when the KPI status changed to the 
current status.

GUI Element (A-Z) Description
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KPIs Displays text or an icon indicating the current 
operational status of each CI. For an explanation of the 
color coding for status icons, see “Understanding KPI 
Status” on page 352. 

Name Displays the filtered list of CIs. You can click a specific 
CI name to move to that CI in the Console tab. The 
relevant CI is shown highlighted in the View Explorer. 
The arrow to the right of a CI name opens the options 
menu for the CI. For details, see “Customize Dashboard 
Display and Refresh Rate” on page 53. 

GUI Element (A-Z) Description
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5
Geographical Map

This chapter describes the Dashboard Geographical Map.

This chapter includes:

Concepts

 ➤  Geographical Maps on page 156

Tasks

 ➤  Display and Customize a View in Geographical Map on page 162

 ➤  Display a Geographical Map With Google Earth on page 168

 ➤  Create a Geographical Map for an Unavailable Zoom Level of a Specific Area 
on page 171

 ➤  Customize Virtual Earth on page 172

 ➤  Customize Maps Applet on page 174

Reference

 ➤  Geographical Map User Interface on page 175
Concepts
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Geographical Maps

In Dashboard, you can associate a geographical map with a view. If you have 
specified geographical locations for the view’s CIs, real-time status indicators 
representing the CIs statuses are displayed on the map at those locations. 
For details about the geographical map user interface, see “Geographical 
Map Page” on page 176.

In Dashboard Administration, in the geographical map, you can shift the 
map’s focus and enlarge or shrink the map to fit the view it represents. 
When you save the changes, the modified map is automatically displayed 
when you select the view in the Geographical Map tab in Dashboard 
Application. For details, see “Geographical Map Page” on page 176. 

If you have an Internet connection, geographical maps can be displayed 
using Virtual Earth. For details, see “Understanding Virtual Earth” on 
page 160. 

If you do not have an Internet connection, geographical maps can be 
displayed using a maps applet. For details, see “Understanding the Maps 
Applet” on page 161.

Note: The Virtual Earth map is only available in English and cannot be 
translated. For localization, use the maps applet. The Maps Applet does not 
display the names of cities or countries.

This section includes the following topics:

➤ “Location Status Information” on page 157

➤ “Geographical Map Tooltips” on page 158

➤ “Understanding Google Earth” on page 159

➤ “Understanding Virtual Earth” on page 160

➤ “Understanding the Maps Applet” on page 161
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Location Status Information
The map displays color-coded status indicators that represent the worst KPI 
status for all CIs attached to the location at each geographical location. The 
color coding is the same as for other icons in Dashboard. For more 
information about color coding, see “Understanding KPI Status” on 
page 352.

The location is defined individually for group or leaf (monitor) CIs in a view. 
You can specify the CI location when you define a new CI or when you edit 
a CI’s properties. For details, see “Properties Dialog Box” in Model 
Management. You can also specify geographical locations for end-user groups 
in “New/Edit End-User Group Page” in Using End User Management. If you do 
not specify a geographical location for at least one CI in the view, the 
Geographical Map tab displays only the map.

Each status indicator in the map can represent one or more CIs from the 
view with the same location. If you select a CI in View Explorer, the 
geographical map is redisplayed automatically and shows only the selected 
CI and the CI’s children status indicators if a location is specified for them. 
If you select another view, the geographical map reloads automatically to 
show the view’s CI status indicators in the appropriate locations.

If you search for a specific CI in View Explorer and you click the result of the 
search, the geographical map is not automatically redisplayed. The map is 
redisplayed only when you go back to browser mode. It shows only the 
selected CI and the CI’s children status indicators if a location is specified for 
them.

To determine a location status, Dashboard takes the worst KPI status for all 
KPIs attached to all the CIs assigned to that location and determines an 
overall worst status. 
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Geographical Map Tooltips
Tooltips provide the worst status for each KPI associated with the location, 
and how long the KPI has been at that status. A KPI is associated with a 
location if that KPI is assigned to at least one of the CIs attached to the 
location.

The tooltip includes the following information:

Item Description

KPI Name The name of the KPI. The color of the header 
indicates the worst status of the KPI.

Location The name of the location (country, city, and state, if 
applicable).

Status The status of the KPI.

Held status since The time and date when the KPI status changed to 
the current status.

Caused by The names of the CIs/monitors where the problem 
occurred.
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Understanding Google Earth

Note to HP Software-as-a-Service users: This feature is not available when 
working with HP Software-as-a-Service.

You can view the geographical map information in a three-dimensional map 
using the Google Earth feature. This feature is available only to the 
administrator. 

Note: The integration of CI locations with your Google Earth installation is 
at the beta stage.
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Understanding Virtual Earth
If you have an Internet connection you can display the geographical map 
using Microsoft MSN Virtual Earth. HP Business Availability Center 
integrates Virtual Earth online mapping functionality, available over MSN, 
to enable you to use the geographical map of a view. If the view’s CIs are 
assigned geographical locations, real-time status indicators are displayed on 
the map at those geographical locations. 

Virtual Earth geographical maps are based on Microsoft Network (MSN) 
technology and use dynamic HTML. 

The Virtual Earth geographical map presents a flat geopolitical view of the 
planet where you can display the country borders, the geographical features, 
or both.

When you magnify the view, the main cities appear for the part of the map 
that is displayed on the screen.
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Understanding the Maps Applet
The maps applet presents a flat geopolitical view of the planet. 

You can use the maps applet to display the geographical map of a view. The 
map displays the worst status at each geographical location and detailed 
information about the CI’s KPIs.  

Tasks
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Display and Customize a View in Geographical Map

This section describes the processes to view real-time status indicators in a 
geographical map, and gives examples.

This task includes the following steps:

➤ “Setup Requirements for the Map Applet” on page 162

➤ “Specify the Hierarchy Structure of the Business Process Monitoring Source 
Adapter” on page 162

➤ “Assign a Geographical Location to the Appropriate CIs” on page 163

➤ “Select the Display Technology” on page 164

➤ “Assign a Geographical Map to a View” on page 165

➤ “Refine the Geographical Map” on page 167

➤ “View the Geographical Map” on page 167

➤ “Adjust the Displayed Geographical Map” on page 167

 1 Setup Requirements for the Map Applet
The maps applet requires that Sun JRE plug-in 1.6.0_x (latest version 
recommended) be installed on the client machine.

The city names use UTF8 format. If HP Business Availability Center is 
working with a Microsoft SQL Server, or an Oracle Server that is not 
configured for UTF8 support, non-English characters (for example, é) are 
displayed as empty square brackets [ ].

 2 Specify the Hierarchy Structure of the Business Process 
Monitoring Source Adapter
The geographical map displays real-time status indicators showing the worst 
status at different geographical locations. To view this information you must 
change the hierarchy structure of the Business Process Monitoring source 
adapter to Transactions/Locations.

Select Admin > Universal CMDB > Modeling > Source Manager, and click 
the Edit button for the Business Process Monitoring source adapter and 
select the Transactions/Locations hierarchy structure.
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Example

The Business Process Monitoring source adapter hierarchy is 
Transaction/Location.

 3 Assign a Geographical Location to the Appropriate CIs
To view the real-time status indicators corresponding to a view’s CI on the 
map, you must assign a geographical location to the relevant CIs in the 
view.

Select Admin > Universal CMDB > Modeling > It Universe Manager. Select a 
CI in the topology map or View Explorer. In the Information Pane, select the 
Properties tab, click Edit, enter the country, state, and city information in 
the Properties dialog box, and click Apply.
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Example

The jpetstore CI is located in Paris, France.

 4 Select the Display Technology
You can display a geographical map using Virtual Earth, a maps applet, or 
Google Earth. You must select the display technology as follows:

➤ Virtual Earth. If you have an Internet connection, use Virtual Earth to 
display the geographical map. To enable Virtual Earth, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, click 
Applications, select Dashboard Applications, and locate the Use Virtual 
Earth entry in the Dashboard Application - Maps Management Properties 
table. Set the property value to true. This is the default. 

➤ Maps Applet. If you do not have access to Internet, use the maps applet to 
display the geographical map. To enable maps applet, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, click 
Applications, select Dashboard Applications, and locate the Use Virtual 
Earth entry in the Dashboard Application - Maps Management Properties 
table. Set the property value to false. 
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➤ Google Earth. The Google Earth display technology is available only in 
Dashboard Administration. If you have access to Internet, you can use 
Google Earth to display the geographical map. You must specify that you 
want to display the Export to Google Earth button in the Geographical Map 
tab in Dashboard Administration. To display the Export to Google Earth 
button in the Geographical Map tab in Dashboard Administration, select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings, click 
Applications, select Dashboard Applications, and locate the Enable Export to 
Google Earth button entry in the Dashboard Application - Maps 
Management Properties table. Set the property value to true (false hides the 
Export to Google Earth button).

Note to HP Software-as-a-Service users: The Export to Google Earth button 
is not available when working with HP Software-as-a-Service.

Note: Google Earth is available only in Dashboard Administration and only 
to users with administrative permissions.

 5 Assign a Geographical Map to a View
Assign a map to a view by selecting a view in the Geographical Map and 
saving the map.

To assign a geographical map to a view, select Admin > Dashboard, click the 
Geographical Map tab to open the Geographical Map Administration page, 
select the appropriate view in the View list in View Explorer, and click Save.

If you assigned geographical location to a view’s CIs, the corresponding 
status indicators are displayed on the map as soon as you assign a map to 
the view. 
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Note: To remove CI icons from the map, you must delete their geographical 
location.

Example

The map shows the status of the jpetstore CI in Paris, France.  
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 6 Refine the Geographical Map
As an administrator, you can refine the geographical display depending on 
the type of display you have selected using the following possibilities:

➤ Adjust the geographical map using the elements described for each type of 
map. For details, see “Geographical Map Page” on page 176.

➤ Customize the map. For details about Virtual Earth, see “Customize Virtual 
Earth” on page 172. For details about the Map Applet, see “Customize Maps 
Applet” on page 174.

You can save the changes.

 7 View the Geographical Map
To view the resulting geographical Virtual Earth or maps applet map, click 
Application > Dashboard, select the view in View Explorer, and click the 
Geographical Map tab.

 8 Adjust the Displayed Geographical Map
As a user, you can adjust the geographical display in different ways 
depending on the type of display you have selected. The changes cannot be 
saved. For details, see “Geographical Map Page” on page 176.
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Display a Geographical Map With Google Earth 

Note to HP Software-as-a-Service users: This feature is not available when 
working with HP Software-as-a-Service.

Note: 

➤ This feature is only available in Dashboard Administration.

➤ The integration of CI locations with your Google Earth installation is at 
the beta stage.

You can view the geographical map information in a three-dimensional map 
using the Google Earth feature. This feature is available only to the 
administrator. This section describes the processes to view status indicators 
in Google Earth.

This task includes the following steps:

➤ “Import Location Status into Google Earth” on page 168

➤ “Set the Refresh Rate for the View” on page 170

➤ “View Indicators by Status” on page 170

➤ “View Connecting Lines” on page 170

 1 Import Location Status into Google Earth
You can import the location status information shown in the geographical 
map for the current view into a local Google Earth application. After 
importing the information, Google Earth displays all the CI status indicators 
in the appropriate geographical locations.

To list all the views you create in the same folder, create a new folder (for 
example, an HP Business Availability Center folder) in the Places folder in 
Google Earth, and then add to that folder all the views you create. 
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You can create a view in Google Earth by creating a network link using the 
view’s URL. This creates a container folder and a sub-folder.

To import location status into Google Earth: 

 a If you have not already installed Google Earth on your local computer, 
open the Google Earth site (http://earth.google.com/) and download the 
application.

 b Open the Google Earth application.

 c Click the My Places directory in the Places area.

 d Select Add > Network Link. 

 e The Google Earth - New Network Link dialog box opens.

 f Enter the view name in the Name box.

 g Copy the URL displayed in the Integration with Google Earth page to the 
Location box.

Note: This URL creates a container folder called by the name you 
specified in the Name box, and a sub-folder called by the name of the 
view.

 h If this is the first time you are creating a view in Google Earth, in the 
Create In area, click New Folder and enter HP Business Availability 
Center to create a new folder called HP Business Availability Center.

If the HP Business Availability Center folder already exists in the Create 
In area tree, select the folder (you can also set the cursor on the folder 
before you select Add > Network Link in step d).

 i Click OK to close the New Network Link dialog box. 

The Google Earth page displays the HP Business Availability Center folder 
in the Places area. 

Open the HP Business Availability Center directory to list the views you 
have added.
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 2 Set the Refresh Rate for the View
You can set the refresh rate of the view sub-folder.

To set the refresh rate for the view: 

 a Right-click the view sub-folder.

 b Select Edit.

 c Select Refresh Parameters to open the Time-Based Refresh area.

 d In the Time-Based Refresh area, select Periodically from the When list 
and select 1 minute. 

 e Click OK.

 3 View Indicators by Status
You can filter the status indicators that are displayed in Google Earth to 
include specific statuses.

To view the indicators by status:

 a In the Places area, expand the HP Business Availability Center folder.

 b Select the view you want to display. The folder displays the list of statuses 
of the CIs in the view.

 c Select one or more of statuses. Only the CIs with the selected statuses are 
displayed in Google Earth.

 4 View Connecting Lines
Different locations are connected with a line when you specify different 
geographical locations for monitor CIs and non-monitor CIs they monitor 
in the view. For example: 
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To view the connecting lines:

 a In Google Earth, select the view you want to display.

 b Select Connecting Lines in your view folder to display the connecting 
lines in Google Earth:

If you select Connecting Lines in more than one view, you can see all the 
lines of all the selected views at the same time.

Create a Geographical Map for an Unavailable Zoom 
Level of a Specific Area

If you need a zoom level of a specific area that is not available in the 
Geographical Map, create a picture of the map and use the Custom Map 
feature instead.
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Customize Virtual Earth

You can customize a Virtual Earth map.

Note: All the steps in this task are optional and can be performed in any 
order.

This task includes the following steps:

➤ “Adjust the Virtual Earth Map” on page 172

➤ “Specify the Size of the Indicators” on page 172

➤ “Specify the Statuses to Be Displayed” on page 173

➤ “Specify the Time Delay” on page 173

 1 Adjust the Virtual Earth Map
You can zoom or shift the Virtual Earth map so that it shows the 
information you require. For details, see “Geographical Map Page” on 
page 176.

 2 Specify the Size of the Indicators
You can modify the default size (19 pixels) of the indicators that are 
displayed on the Virtual Earth map.

To modify the size of the indicators, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Applications, and enter the indicator size (in pixels) in the Indicator size in 
Virtual Earth entry in the Dashboard Application - Maps Management 
Properties table. 
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 3 Specify the Statuses to Be Displayed
You can select the statuses you want to display in the Virtual Earth map.

To specify the statuses to be displayed, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Applications, and locate the Ignore gray statuses entry in the Dashboard 
Application - Maps Management Properties table. Select one of the 
following options:

➤ ALL. Locations with gray statuses (downtime, stopped, no data and 
uninitialized) are not displayed on the map. 

➤ NO. Locations with gray status are displayed on the map.

 4 Specify the Time Delay
You can modify the default time delay between the completion of new 
location download from the server and the display of the information by 
Virtual Earth (in seconds). Use larger values if user has slower connection.

To modify the time delay, select Admin > Platform > Setup and Maintenance 
> Infrastructure Settings, click Applications, select Dashboard Applications, 
and locate the Wait after getting data entry in the Dashboard Application - 
Maps Management Properties table. Enter the delay (in seconds). The 
default is 4. 
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Customize Maps Applet

You can customize a maps applet.

Note: All the steps in the task are optional and can be performed in any 
order.

This task includes the following steps:

➤ “Adjust the Maps Applet” on page 174

➤ “Specify the Map Refresh Rate” on page 174

➤ “Specify the Maximum Number of CIs Displayed in a Location’s Tooltip” on 
page 175

 1 Adjust the Maps Applet
You can adjust the maps applet so that it shows the required information. 
For details, see “Geographical Map Page” on page 176.

 2 Specify the Map Refresh Rate
You can modify the default of the map refresh rate. The default is 30 
seconds.

To specify the map refresh rate, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Applications, and locate the Maps Applet Refresh Rate entry in the 
Dashboard Application - Maps Management Properties table. Enter the 
refresh rate.
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 3 Specify the Maximum Number of CIs Displayed in a Location’s 
Tooltip
You can specify the maximum number of CIs that can be displayed in the 
tooltip for a location in the Geographical Map. The default is 10. 

Keep in mind that the CIs are displayed in the Caused by section in the 
tooltip, so do not specify more than can be accommodated.

To specify the maximum number of CIs displayed in a location’s tooltip, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
click Applications, select Dashboard Applications, and locate the Maximum 
CIs in tooltip for location entry in the Dashboard Application - Maps 
Management Properties table. Enter the new maximum.

Reference

Geographical Map User Interface

This section describes:

 ➤  Geographical Map Page on page 176
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Geographical Map Page

Description Enables you to display real-time status indicators on a 
geographical map, with the view's CIs at the 
geographical locations they were assigned. The status 
indicator shows the worst status of the CIs at the 
geographical location. You can also access detailed 
information about the CI’s KPIs. 

To Access: 

➤ Select Admin > Dashboard, and click the 
Geographical Map tab.

➤ Select Applications > Dashboard, and click the 
Geographical Map tab.

Important 
Information

When you magnify the map, the main cities appear for 
the part of the map that is displayed on the screen.

The geographical map display can be rendered using:

➤ Virtual Earth. For details, see “Using Virtual Earth” 
on page 177.

➤ A maps applet. For details, see “Using the Map 
Applet” on page 180.

➤ Google Earth. For details, see “Using Google Earth 
(Admin)” on page 182.

The Geographical Map tab shows a different display, 
depending on the type of setup you have selected. The 
types of setups are: Microsoft MSN Virtual Earth, a flat, 
geopolitical map supplied with Business Availability 
Center, or Google Earth (available only in Dashboard 
Administration). For details, see “Select the Display 
Technology” on page 164.

Included in Tasks “Display and Customize a View in Geographical Map” 
on page 162

Useful Links “Geographical Maps” on page 156

For details about the functionality of View Explorer, see 
“View Explorer” in Model Management.
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Using Virtual Earth

Description If you have an Internet connection, you can display 
the geographical map using Microsoft MSN Virtual 
Earth (Version 4.0) in Dashboard Geographical Map 
tab. HP Business Availability Center integrates Virtual 
Earth online mapping functionality, available over 
MSN, to enable you to use the geographical map of a 
view. 

Virtual Earth geographical maps are based on Microsoft 
Network (MSN) technology and use dynamic HTML.

The Virtual Earth geographical map presents a flat 
geopolitical view of the planet where you can display 
only the country borders, only the geographical 
features, or both. 

When you magnify the view, the main cities appear for 
the part of the map that is displayed on the screen.

Useful Links “Understanding Virtual Earth” on page 160

For details about the functionality of View Explorer, see 
“View Explorer” in Model Management.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Enable you to zoom in and out in order to enlarge or 
shrink the map. 

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

Click to shift the center of the map to the nearest CI.

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

Click to zoom out completely.

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

 This icon is only available in Dashboard Application.

Click to open the map on a standalone page. 

Close the page to return to Dashboard.

2D

Click to display the map in two-dimensional format.
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3D

Click to display the map in three-dimensional format.

Note: This is available only if you have Windows XP 
installed on your local computer.

<Adjustments> ➤ Click the map and drag to move the map in the 
window.

➤ Double-click the map to zoom in.

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The color coding is the same as for other icons in 
Dashboard. For more information about color coding, 
see “Understanding KPI Status” on page 352. 

The round icon represents the status of a location 
when at least one of the CIs is not a monitor CI.

The square icon represents the status of a location 
where all the CIs are monitor CIs.

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. For details about the 
contents of the tooltips, see “Geographical Map 
Tooltips” on page 158.

<View> When you select a view in View Explorer, the 
Geographical Map tab displays the selected view bar 
centered in the tree with all its root CIs expanded. 

Last Update Shows connectivity with the Dashboard servlet, 
running on the Tomcat servlet engine by displaying 
the time the information in the tab was last updated.

GUI Element (A-Z) Description
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Using the Map Applet 

open In a Virtual Earth map, open the map in a standalone 
page by clicking open to explore the map in one 
window and perform other tasks in the main BAC 
window.

Road/Aerial/Hybrid Click:

➤ Road to display the map with the country borders

➤ Aerial to display the map with the topographical 
features

➤ Hybrid to display the map with both the country 
borders and the topographical features

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

Search Use this feature to perform a search in Microsoft MSN 
Virtual Earth (outside of HP Business Availability 
Center). 

Description If you do not have an Internet connection, the 
Geographical Map page displays a maps applet graphic 
instead of a Virtual Earth map. 

The Geographical tab displays the worst status at each 
geographical location and detailed information about 
the CI’s KPIs. 

The map applet present a flat geopolitical view of the 
planet. 

Useful Links “Understanding the Maps Applet” on page 161

For details about the functionality of View Explorer, see 
“View Explorer” in Model Management.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

 Enable you to zoom in and out to enlarge or shrink the 
map.

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

<Adjustments> Click the area that interests you. The map shifts to 
make the location you clicked the new center of the 
map.

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

<Status of a location 
with group CIs or 
with monitor CIs>

The geographical map of the view displays the worst 
status at each geographical location. 

<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The color coding is the same as for other icons in 
Dashboard. For more information about color coding, 
see “Understanding KPI Status”. 

The round icon represents the status of a location 
when at least one of the CIs is not a monitor CI.

The square icon represents the status of a location 
where all the CIs are monitor CIs.
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Using Google Earth (Admin)

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. For details about the 
contents of the tooltips, see “Geographical Map 
Tooltips” on page 158.

<View> When you select a view in View Explorer, the 
Geographical Map tab displays the selected view bar 
centered in the tree with all its root CIs expanded. 

Description Displays the worst status at each geographical location 
and detailed information about the CI’s KPIs. 

Google Earth presents a three-dimensional view of the 
planet. When you magnify the view, the main cities 
appear for the part of the map that is displayed on the 
screen.

Important 
Information

Note to HP Software-as-a-Service: This feature is not 
available when working with HP Software-as-a-Service.

Notes: 

➤ The integration of CI locations with your Google 
Earth installation is at the beta stage.

➤ This feature is only available from Dashboard 
Administration.

Useful Links “Understanding Google Earth” on page 159

For details about the functionality of View Explorer, see 
“View Explorer” in Model Management.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Places area> Select the view and filter the CIs you want to display.

<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The map presents color-coded status indicators that 
represent the worst status at each geographical 
location. The color coding is the same as for other 
icons in Dashboard. For more information about color 
coding, see “Understanding KPI Status” on page 352. 

The round icon represents the status of a location with 
group CIs.

The square icon represents the status of a location with 
monitor CIs.

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. For details about the 
contents of the tooltips, see “Geographical Map 
Tooltips” on page 158.

<Zoom and direction 
tools>

Enables you to zoom in or out of the current display.
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Custom Map

This chapter describes the Dashboard Custom Map.

This chapter includes:

Concepts

 ➤  Custom Maps on page 186

Tasks

 ➤  Display a View in a Custom Map on page 188

Reference

 ➤  Custom Map User Interface on page 192
Concepts
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Custom Maps

The Custom Map feature enables you to associate a view’s CIs represented by 
real-time status indicators with a custom image that describes the real world 
that your view represents. The graphical representation of a view used by 
your organization can be a logical network diagram, business logic, or any 
other graphics. For details about the custom maps user interface, see 
“Custom Map Page” on page 192.

For example, you can associate a graph representing your company’s 
network with real-time data coming from the different parts of the network.

One custom map can be defined for each view. The image shown in the 
Custom Map tab is the one defined for the active view. When you select a 
different view, the corresponding image is automatically displayed in the 
tab. If you do not define a custom map for a view, users accessing the 
Custom Maps tab, when that view is active, see a message stating that there 
is no defined image for the view.

You can create a custom map by adding CI icons from the view and 
associating them with elements of the custom image. The status indicator 
shows the worst status (worst of all KPIs) for that CI.
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When you place the cursor over the status indicator, a tooltip shows the 
name of the associated CI, and KPI details. For details, see “Custom Map 
Page” on page 192.

When you click a status indicator, the corresponding CI in the View 
Explorer is highlighted. If necessary, the View Explorer automatically 
expands to show the selected CI.

When your site does not have an Internet connection, you can upload an 
image or the URL of an image to be used as the background image.

Note: 

➤ The tab displays the image centered in the image pane. If the image is 
larger than the image pane, use the scroll bars. 

➤ When a CI is removed from the IT universe model, the corresponding CI 
icon (in Dashboard Administration) and the corresponding status 
indicators (in Dashboard) are automatically removed from the relevant 
custom maps.

Tasks
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Display a View in a Custom Map

This section describes the processes to view real-time status indicators in a 
custom map, and gives examples.

This task includes the following steps:

➤ “Create a Custom Map for a View” on page 188

➤ “Add CIs to the Custom Map” on page 189

➤ “Display a View’s Custom Map” on page 190

➤ “Access Additional Information” on page 192

 1 Create a Custom Map for a View
You can create a custom map by selecting a view and attaching the URL of 
the custom image or the image itself to that view. For details, see “Custom 
Map Page” on page 192.

Any type of image supported by the browser can be loaded from any URL 
(including HTTP protocol and HTTP authentication); in such a case, ensure 
that the URL is available at all times. 

You can also upload a file system image; in such a case the image is available 
at all times. The type of the image must be supported by the browser. 

The best image to select depends on the customer’s environment. The 
custom map feature does not resize the image, so in higher resolution 
screens it looks different from the same image in lower resolution screens. 
Additionally, you can view the Custom Map tab with or without View 
Explorer which influences the size of the image you want to display.
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Example

You want to use a picture of your network to display the status of each 
element in the network:

 2 Add CIs to the Custom Map
You can add CI icon(s) to the image, to create an association between the 
image and the view. Select the CI in View Explorer, and click Add CI Icon. 
The CI icon is displayed in the left top corner of the diagram with a blue 
outline. Drag the CI to the required location in the diagram. The CI icon is 
set at that position.

For details, see “Custom Map Page” on page 192.
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Example

You add the appropriate CI to the custom map:

 3 Display a View’s Custom Map
After you complete the custom map, display it in Dashboard to view the CI’s 
status in the appropriate location in the diagram.

Example

You add the appropriate CI to the custom map:
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Example

Other examples of custom maps can be:
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 4 Access Additional Information
Use the context menu options to access more information. For details, see 
“Menu Options” on page 62.

Reference

Custom Map User Interface

This section describes:

 ➤  Custom Map Page on page 192

Custom Map Page 

Description Enables you to create or display a map for the selected 
view including the view's CIs represented by real-time 
status indicators and a background custom image.

To Access: 

➤ Select Admin > Dashboard, and click the Custom 
Map tab.

➤ Select Applications > Dashboard, and click the 
Custom Map tab.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

➤ Use, as an image, any diagram or picture, created 
using any tool, provided that the format is 
supported by the browser. It is recommended to use 
one of the following formats: GIF, JPG, or PNG.

➤ Do not overlap CI icons. When icons overlap, you 
see only the top status indicator in the custom map.

➤ After setting a CI icon on the diagram, you can 
move the cursor over it to display the CI name in a 
tooltip.

➤ You can save the image you want to use as the 
background to the custom map to HP Business 
Availability Center or you can use a URL to access an 
external image.

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Display a View in a Custom Map” on page 188

Useful Links “Custom Maps” on page 186

For details about the functionality of View Explorer, see 
“View Explorer” in Model Management.

GUI Element (A-Z) Description

This icon appears only in Dashboard Administration.

Marks the location of the status indicator for the CI. 

This icon appears only in Dashboard Application.

Indicates the worst status (worst of all KPIs) of the CI. 

Use the Refresh button at any time to reload the 
diagram (for example, if changes have been made to 
the source file). Reloading the diagram does not affect 
the position of the indicators.
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<Current image 
information>

A string with the image information is displayed above 
the image. The string starts with Linked URL <URL> or 
Saved Image.

<Tooltip> Move the cursor above the status icon of the CI to 
display additional information about each KPI 
attached to the CI in a separate section. The tooltip 
associated with a CI status indicator displays 
information about each KPI attached to the CI in a 
separate section. The color of each section represents 
the color of the corresponding KPI’s status. For details 
about the colors, see “Understanding KPI Status” on 
page 352.

The tooltip can display any of the following 
information, depending on the KPI:

➤ the header of each section displays Details followed 
by the name of the KPI

➤ CI name. The name of the CI.

➤ Status. The status of the KPI.

➤ Held status since. The date and time when the status 
changed to the current status.

➤ Historical worst. The tooltip of the historical status 
of the CI. For details, see “Trend and History” on 
page 360.

GUI Element (A-Z) Description
194



Chapter 6 • Custom Map
Add CI Icon This button appears only in Dashboard 
Administration.

Click to add the selected icon. The CI icon is displayed 
in the left top corner of the diagram with a blue outline 

. Drag the CI to the required location in the 
diagram. The CI icon is set at that position.

Browse This button appears only in Dashboard 
Administration.

Click to browse the local file system and select the 
image you want to use as a background for the custom 
map.

Clear CI Icons This button appears only in Dashboard 
Administration.

Click to clear all the CI icons. A confirmation message 
is issued: You are about to clear all nodes from the 
view. Are you sure?

Delete Image This button appears only in Dashboard 
Administration.

Click to delete the image and all the CI icons from the 
custom map associated with the current view.

Image URL This field appears only in Dashboard Administration.

The URL of the image must use the format: 
<protocol>://<hostname>/<path_to_image>

The protocol can be HTTP or HTTPS.

To use a local machine as the location of the image, 
enter the URL with the following format: 
file:///<path_to_image> 

This results in an image that cannot be displayed for a 
user working outside the local network.

You can also use a file-sharing path as follows: 
\\server\<path_to_image>

When you enter a URL, the Save and Link to URL 
buttons are enabled.

GUI Element (A-Z) Description
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Link to URL This button appears only in Dashboard 
Administration.

The button is enabled only when the file in the Image 
URL box is not a file system image (shared or URL).

Click to save the URL of the image.

Note: 

➤ Only one URL or one image is saved per view.

➤ If you enter a URL in the Image URL box and click 
the Link to URL button, the URL is saved.

Remove CI Icon This button appears only in Dashboard 
Administration.

Click to remove the CI icons in the custom map. 

Revert This button appears only in Dashboard 
Administration.

Click to revert to the last saved configuration before 
you save the changes.

Save This button appears only in Dashboard 
Administration.

Click to save the image. 

Note: 

➤ Only one URL or one image is saved per view.

➤ If you enter a URL in the Image URL box and click 
the Save button, the image itself is saved like a 
regular image.

GUI Element (A-Z) Description
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Topology Map

This chapter describes Dashboard Topology Map.

This chapter includes:

Concepts

 ➤  Dashboard Topology Map on page 197

Tasks

 ➤  Display and Customize a View Information in the Topology Map on page 198

Reference

 ➤  Topology Map User Interface on page 198
Concepts

Dashboard Topology Map

The topology map in Dashboard displays the results of a pattern or an 
instance view. You set up the topology map by creating an instance view or 
pattern view in View Manager. For information on those views, see 
“Instance Views and Pattern Views” in Model Management.

For details about the Topology Map user interface, see “Topology Map Page” 
on page 199.

The topology map shows the results of the currently selected view in the 
View Explorer, and includes CIs and relationships that are defined in the 
view you created in View Manager. You can change the way the maps are 
displayed by selecting one of the view layouts (Hierarchical, Symmetric, 
Circular, or Orthogonal). For details, see “Layout Properties Dialog Box” in 
Reference Information.
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Tasks

Display and Customize a View Information in the 
Topology Map

You can display and customize a view’s topology map.

This task includes the following steps:

➤ “Select a View in View Explorer” on page 198

➤ “Customize the View Information” on page 198

 1 Select a View in View Explorer
To view the results of an instance view or a pattern view defined in View 
Manager in the Topology Map, access the Topology Map. For details, see 
“Topology Map Page” on page 199.

 2 Customize the View Information
You can display the contents of the topology map using different layout 
options. For details, see “Layout Properties Dialog Box” in Model 
Management.

Reference

Topology Map User Interface

This section describes:

 ➤  Topology Map Page on page 199
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Topology Map Page

Description Provides a topological representation of the view's CIs 
and CI relationships. CIs are represented by pictorial 
icons, with an attached indicator that shows worst 
status for each CI. When the CIs are organized by 
layers, you click a CI icon to drill down to the next 
layer. Use the topology map tools to change the 
topological layout and to focus on areas of interest.

To Access: Select Applications > Dashboard and select 
the Topology Map tab. In View Explorer, select the 
required view from the View list.

Important 
Information

For information on pattern and instance views, see 
“Working with Pattern and Instance Views in 
IT Universe Manager” in Model Management. 

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Context menu options are available from View 
Explorer. For details, see “Customize Dashboard 
Display and Refresh Rate” on page 53.

From the Topology Map tab, the Open in Console 
context menu option is available to open the Console 
tab opens and displays the selected CI and its direct 
child CIs. For details, see “Console Page” on page 125.

In the topology map, you can select multiple CIs by 
holding down the CTRL button and clicking the CIs or 
dragging the mouse diagonally along the CIs. 

If you select multiple CIs, only one CI has a black 
selection rectangle around it, while all of the other 
selected CIs have red selection rectangles around them. 
In this situation, when you right-click anywhere on the 
map to open the context menu, the option is 
performed only on the CI surrounded by the black 
rectangle.
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Included in Tasks “Display and Customize a View Information in the 
Topology Map” on page 198

Useful Links “Dashboard Topology Map” on page 197

For details about the functionality of View Explorer, see 
“View Explorer” in Model Management.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

An icon with a downward arrow indicates that there is an 
additional CI layer beneath it, created by a parent or child 
organization rule defined in View Manager (in a pattern 
view). For information on how to set up organization 
rules, see “Adding Folding Rules to Relationships” in 
Model Management.

For example, if the IP CI is defined as a child of the host 
CI in View Manager, you can double-click any host icon 
in the topology map to display a map of IPs connected 
with that host.

To drill down to the lower level(s), double-click an icon 
with a downward arrow.

This icon attached to a CI icon indicates that the best 
status of the CI’s KPIs is Critical. For details about the 
KPI’s statuses, see “Colors of KPI Statuses Used in 
Dashboard” on page 354.

This icon attached to a CI icon indicates that the worst 
status of the CI’s KPIs is Info. For details about the KPI’s 
statuses, see “Colors of KPI Statuses Used in Dashboard” 
on page 354.

This icon attached to a CI icon indicates that the best 
status of the CI’s KPIs is Minor. For details about the KPI’s 
statuses, see “Colors of KPI Statuses Used in Dashboard” 
on page 354.

This icon attached to a CI icon indicates that the best 
status of the CI’s KPIs is Not up to 
date/Stopped/Downtime. For details about the KPI’s 
statuses, see “Colors of KPI Statuses Used in Dashboard” 
on page 354.

This icon attached to a CI icon indicates that the best 
status of the CI’s KPIs is OK. For details about the KPI’s 
statuses, see “Colors of KPI Statuses Used in Dashboard” 
on page 354.
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This icon attached to a CI icon indicates that the best 
status of the CI’s KPIs is Major. For details about the KPI’s 
statuses, see “Colors of KPI Statuses Used in Dashboard” 
on page 354.

<CI Icons> The icon that represents each CI in the topology map is 
defined by the administrator in CI Type Manager. For 
information on how to assign an icon to a CIT, see “Icon 
Page” in CI Attribute Customization.

<CI_tooltip> Click the appropriate CI on the map to display a tooltip 
that provides status information about the KPIs assigned 
to the CI.

<main menu> The options in the main menu are a subset of the options 
described in “Main Menu” in Model Management.

<Node> The nodes in the topology map represent CIs.

Hold the pointer over a node to display its tooltip which 
describes the type of the CI.

<relationship_
tooltip>

When you point to a relationship in the topology map, a 
tooltip is displayed that contains the relationship CI type 
of the selected relationship as defined in CI Type 
Manager. For details, see “CI Type Manager” in 
CI Attribute Customization.

When you point to a CI in the topology map, a tooltip is 
displayed containing information about the CI, as seen 
below. 

GUI Element Description
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<Relationship> The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip, 
which describes the type of the relationship.

<right-click option> Right-click the appropriate CI on the map to display the 
Open in Console option. Select the option to open the 
Console tab focussed on the CI.

<Toolbar> For details about the icons displayed in the toolbar, see 
“Toolbar Options” in Model Management.

Last Update Shows connectivity with the Dashboard servlet, running 
on the Tomcat servlet engine by displaying the time that 
the information in the tab was last updated.

Note: This field appears in the Topology Map in 
Dashboard only.

GUI Element Description
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8 
HP Business Process Insight Data in 
HP Business Availability Center

This chapter describes how to incorporate HP Business Process Insight data 
in HP Business Availability Center.

This chapter includes:

Concepts

 ➤  HP Business Process Insight Data in HP Business Availability Center Overview 
on page 206

 ➤  Decay of HP Business Process Insight Samples on page 215

Tasks

 ➤  View HP Business Process Insight Data in HP Business Availability Center 
on page 215

 ➤  Customize HP Business Process Insight KPI Assignments on page 219

 ➤  Enrich the Business Processes View and Other Improvements on page 221

Reference

 ➤  HP Business Process Insight Reports User Interface on page 222
Concepts
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HP Business Process Insight Data in HP Business 
Availability Center Overview

HP Business Process Insight sends topology and data to HP Business 
Availability Center, about the business process flows and business process 
steps that you monitor to obtain meaningful impact data about the health 
of your business.

In HP Business Availability Center, the HP Business Process Insight KPI 
assignments group creates the Business Process topology for the monitored 
HP Business Process Insight system, and the Business Processes view. 
HP Business Availability Center calculates the performance of the CIs that 
represent HP Business Process Insight business processes and business 
process steps and displays that information in the Business Processes view. 
HP Business Process Insight monitors the Business Processes view.

In addition, you can also access the HP Business Process Insight application 
using a context menu option in the HP Business Availability Center 
application.
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This section includes the following topics:

➤ “Business Processes View” on page 207

➤ “Topology for HP Business Process Insight” on page 208

➤ “KPI Assignments for HP Business Process Insight” on page 210

Business Processes View
HP Business Process Insight creates the processes topology in the CMDB 
using the UCMDB API. The topology includes the Business Process CIs and 
the BPI Business Process Step CIs, as well as the BPI Value Monitor, BPI 
Process Monitor, BPI Duration Monitor, BPI Custom Value Monitor, and BPI 
Step Monitor CIs for the monitored HP Business Process Insight system. 

In HP Business Availability Center, the HP Business Process Insight KPI 
assignments group adds KPIs, rules, context menus, context menu items, 
and tooltips to those CIs.  Status for these CIs can be viewed in Dashboard in 
the Business Processes view. 

Service Level Management has its own sets of KPIs and rules that are 
attached to CIs within agreements.

In HP Business Availability Center, the Business Processes view has the 
following structure:
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The Business Process CI, in Dashboard, corresponds to the Business Process 
flow in HP Business Process Insight. 

The BPI Business Process Monitor CI is a child of the Business Process CI. It 
monitors the HP Business Process Insight business process. 

The Business Process Insight Step CI, in Dashboard, corresponds to an 
activity in the Business Process flow in HP Business Process Insight. The 
Business Process Insight Step CI is a child of the Business Process CI. 

The BPI Business Process Step Monitor CI monitors the corresponding 
activity in the Business Process flow in HP Business Process Insight.

The IT Universe CI represents the HP Business Availability Center CI the BPI 
Step CI depends on, such as: database, host, CPU, and other information 
provided by the SiteScope, Business Process Monitor, Real User Monitor, or 
Diagnostics monitors or probes. 

Topology for HP Business Process Insight
All the sample information sent by HP Business Process Insight is displayed 
by the Backlog, Volume, Business Health, Value, and Duration KPIs attached 
to the BPI Business Process Step Monitor, BPI Business Process Monitor, BPI 
Value Monitor, BPI Duration Monitor, and BPI Custom Value Monitor CIs 
and propagated to the Business Process CI. The rules listed in the table 
below calculate the statuses of those KPIs based on data obtained from 
HP Business Process Insight samples.

The Business Process Insight Menu, and the Business Process Monitor 
Group Menu context menus, Goto BPI context menu item, and the tooltips 
corresponding to the rules listed in the table below, are preconfigured to 
provide the appropriate infrastructure to work with the HP Business Process 
Insight-related CIs in Dashboard. For details about the KPIs, rules, context 
menus, context menu items, and tooltips, see Repositories in CI Attribute 
Customization.
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In Dashboard, the CIs, KPIs, and default rules that are preconfigured to work 
with HP Business Process Insight are:

CI KPI Rule

BPI Value Monitor or 
BPI Custom Value 
Monitor

“Backlog” in 
CI Attribute 
Customization

“BPI Monitor Backlog Value Rule” in 
CI Attribute Customization

“Volume” in 
CI Attribute 
Customization

“BPI Monitor Volume Value Rule” in 
CI Attribute Customization

“Value” in 
CI Attribute 
Customization 

“BPI Value Monitor Rule” in 
CI Attribute Customization

BPI Duration Monitor “Backlog” in 
CI Attribute 
Customization 

“BPI Monitor Backlog Value Rule” in 
CI Attribute Customization

“Volume” in 
CI Attribute 
Customization

“BPI Monitor Volume Value Rule” in 
CI Attribute Customization

“Duration” in 
CI Attribute 
Customization 

“BPI Duration Monitor Rule” in 
CI Attribute Customization

BPI Business Process 
Step Monitor

“Backlog” in 
CI Attribute 
Customization 

“BPI Monitor Backlog Value Rule” in 
CI Attribute Customization

“Volume” in 
CI Attribute 
Customization 

“BPI Monitor Volume Value Rule” in 
CI Attribute Customization
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Note: The KPIs listed in the table use special icons in Top View in 
Dashboard. For details, see “KPI Icons in Top View” in Using Dashboard.

In Service Level Management, specific KPIs, and rules are preconfigured to 
work with HP Business Process Insight. For details, see “KPIs and Rules for 
Business Process Insight” in Using Service Level Management.

KPI Assignments for HP Business Process Insight

Note: This KPI assignment attaches the KPIs listed in the KPI config column 
and their rules listed in the rule column in the task table, and the context 
menu listed in the context menu id column in the Task table to the BPI 
Custom Monitor CIs. For details about KPI assignments, see “Assignment 
Groups Page” on page 438.

BPI Business Process 
Monitor

“Backlog” in 
CI Attribute 
Customization 

“BPI Monitor Backlog Value Rule” in 
CI Attribute Customization

“Volume” in 
CI Attribute 
Customization 

“BPI Monitor Volume Value Rule” in 
CI Attribute Customization

“Business Health” 
in CI Attribute 
Customization

“BPI Health Average Weighted 
Status Value Rule” in CI Attribute 
Customization

CI KPI Rule
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The HP Business Process Insight assignment group includes the following 
KPI assignments:

➤ BPI Custom Monitor CIs:

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

cmdb_class
property 
condition_
name

Operator Value

bpi_custom
_monitor

N/A N/A N/A

context menu id KPI config rule

BPIMenu 
– Business Process 
Insight Menu

600 – Backlog 605 – BPI Monitor Backlog 
Value Rule

1050 – Volume 607 – BPI Monitor Volume 
Value Rule

1311 – Value 609 – BPI Value Monitor 
Rule 
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➤ BPI Duration Monitor CIs:

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

➤ BPI Step Monitor CIs:

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

cmdb_class
property 
condition_
name

Operator Value

bpi_duration
_monitor

N/A N/A N/A

context menu id KPI config rule

BPIMenu 
– Business Process 
Insight Menu

600 – Backlog 605 – BPI Monitor Backlog 
Value Rule

601 – Duration 608 – BPI Duration 
Monitor Rule

1050 – Volume 607 – BPI Monitor Volume 
Value Rule

cmdb_class
property 
condition_
name

Operator Value

bpi_step
_monitor

N/A N/A N/A
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➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

➤ BPI Process Monitor CIs:

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

context menu id KPI config rule

BPIMenu 
– Business Process 
Insight Menu

600 – Backlog 605 – BPI Monitor Backlog 
Value Rule

1050 – Volume 607 – BPI Monitor Volume 
Value Rule

cmdb_class
property 
condition_
name

Operator Value

bpi_process
_monitor

N/A N/A N/A

context menu id KPI config rule

BPIMenu 
– Business Process 
Insight Menu

600 – Backlog 605 – BPI Monitor Backlog 
Value Rule

602 - Business Health 617 - BPI Health Average 
Weighted Status Value 
Rule

1050 – Volume 607 – BPI Monitor Volume 
Value Rule
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➤ BPI Value Monitor CIs:

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

cmdb_class
property 
condition_
name

Operator Value

bpi_step
_monitor

N/A N/A N/A

context menu id KPI config rule

BPIMenu 
– Business Process 
Insight Menu

600 – Backlog 605 – BPI Monitor Backlog 
Value Rule

1050 – Volume 607 – BPI Monitor Volume 
Value Rule

1311 – Value 609 – BPI Value Monitor 
Rule
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Decay of HP Business Process Insight Samples

In HP Business Process Insight, the collection_interval attribute specified for 
each monitor CI indicates the time period after which the sample is send to 
HP Business Availability Center. The default is 15 minutes. This value is 
customizable. For details on customizing the default, see HP Business 
Process Insight documentation.

HP Business Availability Center displays the last sample information for the 
time period specified in the collection_interval attribute, until the next 
sample is sent from HP Business Process Insight. The sample is kept for an 
additional 90 seconds (default decay setting) to make sure that the views 
continue to display the same statuses. This is needed to have views display 
statuses instead of No data, when a new sample has not yet been received by 
HP Business Availability Center due to overload problems or late arrival of 
the new sample. The default decay setting is customizable.  For details, see 
“Customize the Decay Settings of the HP Business Process Insight Samples – 
Optional” on page 217.

Tasks

View HP Business Process Insight Data in HP Business 
Availability Center

HP Business Process Insight data can be incorporated in HP Business 
Availability Center. The topology of the Business Process flow and its steps is 
inserted in the CMDB by HP Business Process Insight. Real-time data 
(samples) is sent to HP Business Availability Center using the Web Data 
Entry (WDE) mechanism, which receives data from HP Business Process 
Insight for processing before it enters the data loader. Data about each BPI 
Monitor CI and its KPIs is periodically sent to HP Business Availability 
Center.

This task includes the following steps:

➤ “Prerequisite Steps” on page 216

➤ “Log Out of HP Business Availability Center and Log Back In” on page 216

➤ “Customize the Decay Settings of the HP Business Process Insight Samples – 
Optional” on page 217
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➤ “Specify the Data Unit for the CI” on page 217

➤ “Customize the KPI Assignments – Optional” on page 217

➤ “View HP Business Process Insight Data in the Business Processes View” on 
page 218

➤ “Create Other Views or Enrich the Business Processes View – Optional” on 
page 218

➤ “Use HP Business Process Insight CIs in Service Level Management” on 
page 218

➤ “Use Reports to Analyze the Data” on page 218

➤ “Access the HP Business Process Insight Application from HP Business 
Availability Center” on page 219

➤ “View HP Business Process Insight Portlets in My BAC” on page 219

 1 Prerequisite Steps

➤ HP Business Process Insight and HP Business Availability Center must be in 
the same Domain Name Server (DNS).

➤ Consult HP Business Process Insight documentation for the steps to be 
performed on the HP Business Process Insight server before data can be sent 
to HP Business Availability Center. This includes specifying the host name, 
user name, and password of the server where HP Business Availability 
Center is located and to make sure that the appropriate samples are sent 
periodically.

 2 Log Out of HP Business Availability Center and Log Back In 
After you have set up HP Business Availability Center information in 
HP Business Process Insight, you must log out of HP Business Availability 
Center and then log back in. This step adds the the HP Business Process 
Insight reports in Application > Dashboard >  Reports.
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 3 Customize the Decay Settings of the HP Business Process 
Insight Samples – Optional
To modify the default decay settings of the HP Business Process Insight 
samples, launch your Web browser, enter the following address, using JMX 
login credentials: 
http://<server_name>:8080/jmx-console (where <server_name> is the name 
of the machine on which HP Business Availability Center is installed), and 
in the Infrastructure Settings Manager service under Foundations, execute 
the setSettingValuePerCustomerId method with the following parameters:

➤ contextName = decay-settings

➤ settingName = com.mercury.am.rules.dashboard.decay-time

➤ customerId = <customer_id> (1 if not in HP Software-as-a-Service mode)

➤ newValue = <value>

For details on the sample decay settings, see “Decay of HP Business Process 
Insight Samples” on page 215.

 4 Specify the Data Unit for the CI
You can assign a data unit to a BPI Business Process Monitor CI. The data 
unit is displayed in Dashboard with the value of the CI’s KPI.

Select Admin > UCMDB > Modeling > IT Universe Manager, select the 
appropriate BPI Business Process Monitor CI, click the Properties tab, and 
scroll down to the Data Units box in the Other Properties area where you 
can enter the data unit required for the CI.

 5 Customize the KPI Assignments – Optional
If required, you can change the way the KPI assignments retrieves the 
samples provided by the HP Business Process Insight system and assigns the 
appropriate logic: KPIs, rules, context menus, context menu items, and 
tooltips. For details, see “Customize HP Business Process Insight KPI 
Assignments” on page 219.
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 6 View HP Business Process Insight Data in the Business Processes 
View
You can view the status of business process flows and business process steps 
in the Business Processes view in HP Business Availability Center. 

 7 Create Other Views or Enrich the Business Processes View – 
Optional
You can create additional views that include HP Business Process Insight CIs 
or enrich the Business Processes view with other CIs. For details, see “Enrich 
the Business Processes View and Other Improvements” on page 221.

 8 Use HP Business Process Insight CIs in Service Level 
Management
You can create service  agreements based on HP Business Process Insight  CI. 
For details, see “Services Manager and Business Services” in Using Service 
Level Management.

 9 Use Reports to Analyze the Data
Access the following reports to help you analyze HP Business Process Insight 
data:

➤ BPI Monitors Over Time report. Displays two graphs for each selected BPI 
Duration Monitor CI or BPI Custom/Value Monitor CI. One graph display 
the average/minimum/maximum/weighted value or duration of the selected 
CI over time. The other graph display the violated instances of the CI over 
time. For details, see “BPI Monitors Over Time Report” on page 224.

➤ Business Process Over Time report. Displays over time information about 
the volume, backlog, and health of the selected Business Process CI, over the 
selected time period. You can select only Business Process CIs with BPI 
Business Process Monitor child CI. For details, see  “Business Process Over 
Time Report” on page 228.

➤ Business Process Summary report. Displays the summary data of the 
selected business processes. For details, see  “Business Process Summary 
Report” on page 233.
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 10 Access the HP Business Process Insight Application from 
HP Business Availability Center
From the Business Processes view, you can connect to the HP Business 
Process Insight application using the Go to BPI context menu option from 
view CIs or from other views where you have added the HP Business Process 
Insight-related CIs.

 11 View HP Business Process Insight Portlets in My BAC
You can add the HP Business Process Insight portlets to My BAC to display 
the HP Business Process Insight data. For details on how to add these 
portlets to a My BAC page, see “Manage the Portlets in Your Portal” in Using 
My BAC. For details on how to add these portlets to a My BAC module, see 
“Add Portlets to a Page” in Using My BAC.

Customize HP Business Process Insight KPI Assignments

The KPI assignment mechanism retrieves the samples provided by the 
HP Business Process Insight system, assigns the appropriate logic: KPIs, rules, 
context menus, context menu items, and tooltips, depending on the type of 
sample and displays the information using the Business Processes view. 

You can modify the pre-defined HP Business Process Insight KPI 
assignments. For details about the pre-defined KPI assignments, see “KPI 
Assignments for HP Business Process Insight” on page 210. 

Select Admin > Dashboard > KPI Assignments, and select HP Business 
Process Insight to access the HP Business Process Insight KPI assignment 
definitions.  In the Define Assignment Configuration dialog box, you can 
modify the data assignment rules.  For details about the data assignment 
rules, see “Define Assignment Configuration Dialog Box” on page 440.

For details about the rules that are attached to the KPIs, see “Topology for 
HP Business Process Insight” on page 208.
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Example

In an online book store, you can use the BPI Value Monitor CIs assignment 
rule to calculate how much money you made from selling a specific book, 
(multiply the number of books you sold by the price per unit). You can use 
the BPI Custom Monitor CIs assignment rule to calculate the loss incurred 
by a book "on sale" (multiply the number of units of the book you sold "on 
sale" by the difference between the sale price and the regular price per unit).
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Enrich the Business Processes View and Other 
Improvements

You can create other views to display the impact of other CIs in HP Business 
Process Insight or you can enrich the Business Processes view with other CIs.

This task includes the following steps:

➤ “View the Impact of Other CI’s Statuses in HP Business Process Insight” on 
page 221

➤ “Enrich the Business Processes View” on page 222

 1 View the Impact of Other CI’s Statuses in HP Business Process 
Insight
You can create other views that include the HP Business Process Insight CIs 
and make those CIs dependent on other HP Business Availability Center CIs. 
The statuses of those HP Business Process Insight CIs are impacted by the 
statuses of the relevant HP Business Availability Center CIs. The impact is 
automatically propagated to all the views where those HP Business Process 
Insight CIs appear including the Business Processes view that is monitored 
by HP Business Process Insight. This way, you can see the impact of other CI 
statuses in HP Business Process Insight. 

Example

HP Business Process Insight monitors the Business Processes view and 
retrieves the status of all the BPI CIs in that view. 

To view the impact of non-BPI CIs in the Business Processes view, you can 
create multiple views within HP Business Availability Center where each 
view represents different BPI processes and/or Process Steps (Nodes). In 
those views, you make the status/value of BPI processes or process steps  
dependent on the relevant non-BPI CIs from HP Business Availability Center 
other views.
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With this structure, when the status of a BPI process becomes critical due to 
non-BPI CIs status change, the status of the BPI process is reflected in all the 
HP Business Availability Center views that contain the BPI process. One of 
these views is the Business Processes view that is monitored by the 
HP Business Process Insight monitors, which then see the current status of 
the process/steps and bring it across correctly to HP Business Process Insight. 

 2 Enrich the Business Processes View
To enrich the Business Processes view, you can attach IT Universe CIs to the 
appropriate Business Process Insight Step CI. For example, if the Business 
Process Insight Step CI depends on a specific host, then you attach a Host 
CI to the Business Process Insight Step CI. The KPIs of the IT Universe CI are 
then propagated to the Business Process Insight Step CI and displayed by 
the KPIs you assigned to the IT Universe CIs. 

For details about attaching KPIs to a CI, see “Attach KPIs to CIs and 
Configure the KPIs” on page 373.

For details about theBusiness Process Monitor, or Real User Monitor, see 
“Source Manager Overview” in Model Management.

For details about the KPIs, see “KPI Repository” in CI Attribute Customization.

For details about the rules, see “Business Rules Repository Overview” in 
CI Attribute Customization.

Reference

HP Business Process Insight Reports User Interface

This section describes:

 ➤  BPI Monitors Dialog Box on page 223

 ➤  BPI Monitors Over Time Report on page 224

 ➤  Business Processes Dialog Box on page 227

 ➤  Business Process Over Time Report on page 228

 ➤  Business Process Summary Report on page 233
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BPI Monitors Dialog Box

Description Enables you to select the view and the view’s CIs you 
want to display in the report.

To access: Click BPI Monitors in the BPI Monitors Over 
Time report.

Important 
Information

You can select only BPI Duration Monitor CIs, BPI Value 
Monitor, or BPI Custom Monitor CIs that have a Business 
Process CI as their direct parent.
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BPI Monitors Over Time Report

Description Displays two graphs for each selected BPI Duration 
Monitor CI or BPI Custom/Value Monitor CI. One graph 
displays the average/minimum/maximum/weighted 
value or duration of the selected CI over time. The other 
graph displays the violated instances of the CI over time.

To access: Select Applications > Dashboard > Reports > 
BPI Monitors Over Time
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

This report is displayed only when HP Business Process 
Insight includes information about HP Business 
Availability Center and starts sending samples.

Included in Tasks “View HP Business Process Insight Data in HP Business 
Availability Center” on page 215

GUI Element (A–Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

BPI Monitors Click to open the BPI Monitors dialog box.

If one CI is selected, its name is displayed to the right of 
the link. If more than one CI is selected, Filtered (n) is 
displayed to the right of the link, where n represents the 
number of selected CIs.
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Monitor Data Area

Description Displays a separate graph line for each one of the selected 
CI for the selected time period. 

If you have selected BPI Value/Custom Monitor CIs, the 
graph displays the following information:

➤ Average Value per Instance. The average value of the 
completed instances of the selected CIs out of the total 
number of completed instances of the selected CIs.

➤ Minimum Value. The minimum value of all the 
completed instances of the selected CIs.

➤ Maximum Value. The maximum value of all the 
completed instances of the selected CIs.

➤ Weighted Average Value. The weighted average value 
of all the completed instances of the BPI Custom 
Monitor CIs out of the total number of completed 
instances of the CI. This is displayed only when you 
select BPI Custom Monitor CIs.

If you have selected BPI Duration Monitor CIs, the graph 
displays the following information:

➤ Average Duration per Instance. The average duration 
of the completed instances of the selected CIs out of 
the total number of completed instances of the 
selected CIs.

➤ Weighted Average Duration. The weighted average 
duration of all the completed instances of the BPI 
Custom Monitor CIs out of the total number of 
completed instances of the CI. This is displayed only 
when you select BPI Custom Monitor CIs.

➤ Minimum Duration. The minimum duration of all the 
completed instances of the selected CIs.

➤ Maximum Duration. The maximum duration of all the 
completed instances of the selected CIs.

A tooltip for each point in the graph displays the value of 
the point.
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Status Distribution Area

Business Processes Dialog Box

Description Displays the following data for the selected CI over the 
selected time period:

➤ % of Critical Value/Duration Violated Instances. The 
percentage of the total number of instances of the CI 
that completed with a Critical Violated status out of 
the total number of completed instances of the CI.

➤ % of Major Value/Duration Violated Instances. The 
percentage of the total number of instances of the CI 
that completed with a Major Violated status out of the 
total number of completed instances of the CI.

➤ % of Minor Value/Duration Violated Instances. The 
percentage of the total number of instances of the CI 
that completed with a Minor Violated status out of the 
total number of completed instances of the CI.

➤ % of Warning Value/Duration Violated Instances. The 
percentage of the total number of instances of the CI 
that completed with a Warning Violated status out of 
the total number of completed instances of the CI.

➤ % of Value/Duration Non-Violated Instances. The 
percentage of the total number of instances of the CI 
that completed with a Non-Violated status out of the 
total number of completed instances of the CI.

Tooltip for violated stacked bars displays the number of 
instances, the total number of instances and the 
percentage.

Description Enables you to select the view and the view’s CIs you 
want to display in the report.

To access: Click Business Process in the Business Process 
Summary report.

Important 
Information

You can select only Business Process CIs that have a BPI 
Business Process Monitor child CI.
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Business Process Over Time Report

Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays information about the volume, backlog, and 
health of the selected Business Process CI, over the 
selected time period. You can select only Business Process 
CIs with BPI Business Process Monitor child CI.

To access: Drill down from the Business Processes 
Summary report or from the corresponding portlet in 
My BAC.

Important 
Information

This report is displayed only when HP Business Process 
Insight includes information about HP Business 
Availability Center and starts sending samples.

Included in Tasks “View HP Business Process Insight Data in HP Business 
Availability Center” on page 215

GUI Element (A–Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Business Process Click to open the Business Processes dialog box where 
you can select the view and the view’s CI you want to 
display.

The selected CI is displayed to the right of the link.

Show Select one of the following options:

➤ Value. Select to display value-related metrics for the 
business processes in the Value area.

➤ Count. Select to display count-related metrics for the 
business processes in the Count area.
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Data Area
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Description When you click the Drill Down to Business Process Over 
Time report button in the Value area of the Business 
Process Summary report, the report displays the 
following information:

➤ Total Value of Completed Instances. Displays the total 
value of completed business process instances, over 
the specified period of time. This element uses the left 
y-axis.

➤ Avg. Backlog Value. Displays the average value of 
backlogged business process instances out of the 
number of samples reported over the specified period 
of time. This element uses the right y-axis.

When you click the Drill Down to Business Process Over 
Time report button in the Count area of the Business 
Process Summary report, the report displays the 
following information:

➤ # of Completed Instances. Displays the total number 
of completed business process instances, over the 
specified period of time. This element uses the left 
y-axis.

➤ Avg. # of Backlog Instances. Displays the average 
number of backlogged business process instances in 
process out of the number of samples reported over 
the specified period of time. This element uses the 
right y-axis.

Important 
Information

Click a point in the graph to drill down to the lowest 
granularity level which is an hour. For example, drill 
down from the day in the week to the hour in the day.

A tooltip provides the value of each point in the graph 
when you move the mouse over the point.
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Health Area
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Description When you click the Drill Down to Business Process Over 
Time report button in the Value area of the Business 
Process Summary report, the report displays the average 
distribution of the value of the backlogged business 
process instances, over the specified time period, per 
status. The components of the backlogged business 
process instances are Avg. Value of Healthy/At Risk/
Blocked Instances, which displays, as a green/yellow/red 
bar, the average percentage/distribution of Healthy/At 
Risk/Blocked backlogged business process instances out 
of the number of samples reported over the specified 
period of time. 

When you click the Drill Down to Business Process Over 
Time report button in the Count area of the Business 
Process Summary report, the report displays the average 
distribution of the backlogged business process instances, 
over the specified time period, per status. The 
components of the backlogged business process instances 
are Avg. % of Healthy/At Risk/Blocked Instances, which 
displays, as a green/yellow/red bar, the average 
percentage of Healthy/At Risk/Blocked backlogged 
business process instances out of the number of samples 
reported over the specified period of time.

Important 
Information

Click a bar in the graph to drill down to the lowest level 
of granularity, which is 1 hour. For example, drill down 
from the day in the week to the hour in the day.

A tooltip provides the exact number of business processes 
instances/values.
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Business Process Summary Report

Description Displays the summary data of the selected Business 
Process CIs.

To access: Select Applications > Dashboard > Reports > 
Business Process Summary.

Important 
Information

This report is displayed only when HP Business Process 
Insight includes information about HP Business 
Availability Center and starts sending samples.

Included in Tasks “View HP Business Process Insight Data in HP Business 
Availability Center” on page 215
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Business Processes Click to open the Business Processes dialog box where 
you can select the view and the view’s CIs you want to 
display.

You can select only Business Process CIs that have a BPI 
Business Process Monitor child CI.

If one CI is selected, its name is displayed to the right of 
the link. If more than one CI is selected, Filtered (n) is 
displayed to the right of the link, where n represents the 
number of selected CIs.

Show Select one of the following options:

➤ Value. Select to display value-related metrics for the 
business processes in the Value area.

➤ Count. Select to display count-related metrics for the 
business processes in the Count area.

➤ Both. Select to display both the count-related and 
value-related metrics for the business processes. Both 
the Value and the Count area are displayed. This is the 
default.
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Value Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

The area is displayed if you select Value.

GUI Element (A–Z) Description

Select a business process and click the Drill Down to 
Business Process Over Time button to drill down to the 
Business Process Over Time report for the selected 
business process. The report is displayed with the Value 
option selected.

Select a business process and click the Drill Down to 
Duration Monitors Over Time button to drill down to the 
BPIs Monitors Over Time report for the selected business 
process. Only the selected BPI Duration Monitors CIs are 
displayed in the report.

The button is enabled only if the selected business 
process has BPI Duration Monitors child CIs.

Select a business process and click the Drill Down to 
Value Monitors Over Time button to drill down to the 
BPIs Monitors Over Time report for the selected business 
process. Only the selected BPI Value Monitor and BPI 
Custom Monitor CIs are displayed in the report.

The button is enabled only if the selected business 
process has BPI Value Monitor or BPI Custom Monitors 
child CIs.
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Avg. Value of At Risk 
Instances

Displays the average value of the backlogged business 
processes that have an At Risk status in HP Business 
Process Insight, out of the number of samples reported 
over the specified period of time. The cell background is 
green.

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Value of Backlog Instances cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Value of Backlog 
Instances cell.

Avg. Value of Backlog 
Instances

Displays the average value of backlogged business process 
instances out of the number of samples reported over the 
specified period of time. 

Tooltip: Displays the value of the table cell.

Avg. Value of Blocked 
Instances

Displays the average value of the backlogged business 
processes that have a Blocked status in HP Business 
Process Insight, out of the number of samples reported 
over the specified period of time. The cell background is 
green.

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Value of Backlog Instances cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Value of Backlog 
Instances cell.

GUI Element (A–Z) Description
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Avg. Value of Healthy 
Instances

Displays the average value of the backlogged business 
processes that have a Healthy status in HP Business 
Process Insight, out of the number of samples reported 
over the specified period of time. The cell background is 
green.

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Value of Backlog Instances cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Value of Backlog 
Instances cell.

Business Process The name of the selected Business Process CI.

Tooltip: Displays the name of the business process CI.

Total Value of 
Completed Instances

Displays the total value of the instances that were 
completed in the selected time period.

Tooltip: Displays the value of the table cell.

GUI Element (A–Z) Description
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Count Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

The area is displayed if you select Count.

GUI Element (A–Z) Description

Select a business process and click the Drill Down to 
Business Process Over Time button to drill down to the 
Business Process Over Time report for the selected 
business process. The report is displayed with the Count 
option selected.

Select a business process and click the Drill Down to 
Duration Monitors Over Time button to drill down to the 
BPIs Monitors Over Time report for the selected business 
process. The report is displayed with the Count option 
selected. Only the BPI Duration Monitors CIs are 
displayed in the report.

The button is enabled only if the selected business 
process has BPI Duration Monitors child CIs.

Select a business process and click the Drill Down to 
Value Monitors Over Time button to drill down to the 
BPIs Monitors Over Time report for the selected business 
process and with the Count option selected. Only the BPI 
Value or BPI Custom Monitor CIs are displayed in the 
report.

The button is enabled only if the selected business 
process has BPI Value or BPI Custom Monitors child CIs.
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Avg. Number of At 
Risk Instances

Displays the average number of backlogged At Risk 
business process instances out of the number of samples 
reported over the specified period of time. 

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Number of Backlog Instances 
cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Number of Backlog 
Instances cell.

Avg. Number of 
Backlog Instances

Displays the average number of backlogged business 
process instances out of the number of samples reported 
over the specified period of time. 

Tooltip: Displays the value of the table cell.

Avg. Number of 
Blocked Instances

Displays the average number of backlogged Blocked 
business process instances out of the number of samples 
reported over the specified period of time. 

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Number of Backlog Instances 
cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Number of Backlog 
Instances cell.

Avg. Number of 
Healthy Instances

Displays the average number of backlogged Healthy 
business process instances out of the number of samples 
reported over the specified period of time. 

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Number of Backlog Instances 
cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Number of Backlog 
Instances cell.

GUI Element (A–Z) Description
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Business Process The name of the selected Business Process CI.

Tooltip: Displays the name of the business process CI.

Number of 
Completed Instances

Displays the total number of the instances that were 
completed in the selected time period.

Tooltip: Displays the value of the table cell.

GUI Element (A–Z) Description
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9
Business Transaction Management

This chapter describes Business Transaction Management for Business 
Availability Center.

This chapter includes:

Concepts

 ➤  Business Transaction Management - Overview on page 242

 ➤  Business Transaction Data in Business Availability Center on page 244

 ➤  Business Transaction Management in Dashboard on page 250

 ➤  Mapping End User Management Data to Business Transactions on page 254

 ➤  Drill Down from End User Management to TransactionVision on page 255

 ➤  Business Transaction Flow Map on page 256

Tasks

 ➤  Set Up Integration with HP TransactionVision on page 263

 ➤  Map End-User Transactions to Business Transactions on page 267

Reference

 ➤  Business Transaction Management User Interface on page 274
Concepts
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Business Transaction Management - Overview

Business Transaction Management integrates HP TransactionVision data 
into Business Availability Center applications, providing visibility into the 
business transactions driving your enterprise.

TransactionVision tracks user-defined business transactions throughout 
their entire lifecycle, using non-intrusive methods. TransactionVision traces 
WebSphere MQ API, CICS API, J2EE servlet, EJB, and JMS calls across 
transaction-based systems, and tracks and analyzes the interaction with 
each component.

The data on each transaction’s path through the monitored components is 
sent to HP Business Availability Center in aggregated samples (see “Business 
Transaction Samples” on page 246). This data is mapped to the business 
transaction CIs (see “Transaction Class – Business Transaction CI Mapping” 
on page 244).

Business Transaction Management provides the following capabilities:

➤ Dashboard/reports. In Business Availability Center Dashboard and reports, 
the business transaction CIs enable you to measure business impact and to 
monitor health for your critical business transactions, based on KPIs. You 
can also drill down from a business transaction to HP TransactionVision. See 
“Business Transaction Management in Dashboard” on page 250.

➤ Business Transaction Flow Map. Business Availability Center supports ad 
hoc calls to TransactionVision to request real-time data on a business 
transaction. This data is used to generate a transaction flow map across the 
infrastructure components. See “Business Transaction Flow Map” on 
page 256.

➤ My BAC. You can view real-time and historical data for business transactions 
in the predefined Business Transactions page in My BAC. See “Default 
Module” in Using My BAC.

➤ Service Report. You can create a service report that includes business 
transaction metrics. See “Service Report Builder Wizard” in Using My BAC.
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➤ Service Level Management. You can include the business transactions in 
Service Level Management agreements, and use business transaction 
measurements such as backlog or exception rate to verify that your 
revenue-generating transactions are functioning as expected, and to check 
compliance with your business goals. See “Business Process and Business 
Transaction Data in Service Level Management” in Using Service Level 
Management.

➤ End User Management. Business Transaction Management integrates 
TransactionVision with Real User Monitor and Business Process Monitor, 
providing contextual drill-down capability from the End User Management 
reports to TransactionVision’s Transaction Tracking report, enabling further 
analysis of business transaction metrics. See “Drill Down from End User 
Management to TransactionVision” on page 255.

Note: For details on setting up the integration, see “Set Up Integration with 
HP TransactionVision” on page 263.
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Business Transaction Data in Business Availability Center

Business Transaction Management is built on the integration of 
HP TransactionVision data into Business Availability Center. The following 
sections describe the structure and mapping of the data.

➤ “Transaction Class – Business Transaction CI Mapping” on page 244

➤ “Business Transaction Samples” on page 246

➤ “Business Transaction Properties” on page 247

➤ “Business Transaction State Categories” on page 249

Transaction Class – Business Transaction CI Mapping
Once the integration is set up between HP TransactionVision and 
HP Business Availability Center, each transaction class in TransactionVision 
is mapped to a CI of type Business Transaction in the CMDB. Each Business 
Transaction CI has an attached child CI (using monitored_by link) of type 
TV Monitor. Both these CIs take their name from the name of the 
transaction class in TransactionVision.

The CIs are automatically included in the Business Transactions view 
(viewable in Admin > Universal CMDB > Modeling > IT Universe Manager), 
and are available to be added to other instance views, enabling you to create 
views for your applications and critical business processes that include data 
from TransactionVision.

Whenever a transaction class is updated in TransactionVision, the update is 
propagated to the corresponding CIs in the CMDB; creating a new 
transaction class triggers the automatic creation of the CIs for the new 
business transaction in the CMDB, and deleting a transaction class causes 
the deletion of the corresponding business transaction CIs.
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Business Transaction Samples
Business transaction samples are sent to Business Availability Center 
through a TransactionVision scheduled job running in the 
TransactionVision Web application server. The TransactionVision sample job 
delivers aggregated samples, containing pre-defined metrics over a 
configurable time frame (default is 5 minutes), for instances of a monitored 
business transaction. 

Samples are sent for two types of instances of the business transaction: 
completed and in-process:

➤ The completed metrics are based on the aggregation of all completed 
instances (reached their end criteria) during the time frame.

➤ The in-process metrics are based on a snapshot of all in-process instances 
(not yet reached their end criteria) at the time TransactionVision created the 
sample.

The metrics for both these transaction instance types are mapped to a single 
TV Monitor CI (based on the TransactionVision ID attached to the CI), but 
different KPI rules deal with each metric type.

The samples contain numerical count and monetary value metrics for the 
completed and in-process transaction instances, broken down by various 
state categories (see “Business Transaction State Categories” on page 249). 
For details on the fields in the samples, see “Data Sample for 
TransactionVision” in Reference Information.
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Business Transaction Properties
The properties for the TV Monitor CI include attributes that are populated 
from the transaction class in TransactionVision. You can view the properties 
by selecting Properties in the context menu for a TV Monitor CI in 
Applications > Dashboard, or in the information pane for the CI in Admin > 
Universal CMDB > Modeling > IT Universe Manager.

The properties received from TransactionVision are used by the KPIs and 
reports for the TV Monitor CI. These properties are described below:

Property Description

Aggregation delta The time period allocated for the delay while the sample 
is created. The default is 60 seconds (defined in 
TransactionVision).

Collection interval The time period, in seconds, covered by each sample 
received for this business transaction. The default is 300 
seconds (defined in TransactionVision).
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TransactionVision 
currency unit

The applicable currency for the monetary values 
received for this business transaction. This currency unit 
is displayed in the Dashboard tabs and reports for all 
monetary values associated with this business 
transaction.

TransactionVision 
Exception attribute 
rule

The check box for this property is selected if the 
Exception attribute rule is defined for the transaction 
class in TransactionVision. If the check box is selected, 
Business Availability Center assigns the Exceptions KPI 
to the business transaction.

TransactionVision 
Failures attribute rule

The check box for this property is selected if the Failures 
attribute rule is defined for the transaction class in 
TransactionVision. If the check box is selected, Business 
Availability Center assigns the Failures KPI to the 
business transaction.

TransactionVision ID The internal ID for the business transaction in 
TransactionVision.

TransactionVision 
threshold

The response time threshold defined for the business 
transaction in TransactionVision. Instances of the 
transaction that take longer than this time are 
considered "late."

TransactionVision 
Value attribute rule

The check box for this property is selected if the Value 
attribute rule is defined for the transaction class in 
TransactionVision. If the check box is selected, Business 
Availability Center assigns the Value KPI to the business 
transaction.

Property Description
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Business Transaction State Categories
The samples from TransactionVision contain metrics for completed and 
in-process (backlogged) business transaction instances. These metrics are 
further broken down by various state categories for the data, according to 
definitions in the TransactionVision application. 

The state categories referred to in Business Availability Center are:

➤ Failed. Business transaction instances that did not meet a success threshold 
defined by the TransactionVision Failures attribute rule. For example, the 
rule may classify all transaction instances that did not meet a threshold of 
$100, as failed.

➤ Successful. The total count of transaction instances, minus the failed count.

➤ Late. (Also referred to as delayed.) Business transaction instances with a 
response time that exceeded the threshold set in TransactionVision. The 
threshold used can be seen in the properties for the TV Monitor CI.

➤ Exceptions. Business transaction instances that did not follow the expected 
flow path, as defined by the TransactionVision Exception attribute rule. 

Note: Transactions can be classified in more than one state category, for 
example, as both late and as successful.
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Business Transaction Management in Dashboard

The following sections describe the options available for analyzing your 
business transaction data in Dashboard, and the KPIs and rules used with 
the data.

➤ “Business Transactions View” on page 250

➤ “KPIs and Rules for TransactionVision Data” on page 252

Business Transactions View
In the Business Availability Center Dashboard tabs, you can use the Business 
Transactions view to monitor the real-time performance and health of your 
business transactions.

The business transaction KPIs in the view reflect the data received in the 
latest sample (there is no aggregation of the sample data in Dashboard). For 
example, if a KPI has a value of $2000, this value is only for the data 
received in the last sample, the value from the previous sample was not 
added to it. For information on the KPIs used for the TransactionVision data, 
and how to see status for the KPIs, see “KPIs and Rules for TransactionVision 
Data” on page 252.

By default, the Business Transactions view includes only TransactionVision 
CIs, providing back-end monitoring. You can add the end-user perspective 
by mapping end-user transactions from Business Process Monitor and Real 
User Monitor to the business transactions. For details, see “Map End-User 
Transactions to Business Transactions” on page 267.
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TV Monitor CI Context Menu

In Dashboard, the context menu for the TV Monitor CI contains the 
following Business Transaction Management options:

➤ Business Transaction Over Time report. Opens the report in a new browser 
window, enabling you to view a graphical representation of KPI values for 
the selected business transaction, over time. You can also access the report 
by drilling down from the Business Transaction Summary report. For details, 
see “Business Transaction Over Time Report” on page 287.

➤ Business Transaction Summary report. Opens the report in a new browser 
window, enabling you to view a summary of KPI values for the selected 
business transaction over a selected time period. You can also access the 
report from the Dashboard Reports tab. For details, see “Business 
Transaction Summary Report” on page 282.

➤ Go to TransactionVision. Enables you to drill down to the Transaction 
Tracking report in HP TransactionVision. In the Transaction Tracking report, 
you can see all instances for the business transaction during the last 5 
minutes (approximately in synchronization with the data displayed in 
Dashboard).

➤ Business Transaction Flow Map - Completed/In-Process. Opens the flow 
map for the selected business transaction in either Completed or In-process 
mode. For details, see “Business Transaction Flow Map” on page 256.

TV Monitor CI Tooltip

The tooltip for the TV Monitor CI KPIs displays standard Dashboard tooltip 
information, including the name of the rule used for the KPI. The tooltip 
may contain additional business transaction information, depending on the 
rule in use for the KPI. For example, information may be displayed on the 
number of valid transaction instances used for the calculation, or the 
average duration time.
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KPIs and Rules for TransactionVision Data
There are seven KPIs that are used for TransactionVision data in Dashboard:

➤ Backlog

➤ Delays

➤ Duration

➤ Exceptions

➤ Failures

➤ Value

➤ Volume

Descriptions of the KPIs, and lists of which rules are relevant for each KPI, 
can be found in “List of Dashboard KPIs and Their Details” in CI Attribute 
Customization.

The KPIs and rules used by the TransactionVision data CIs in Dashboard are 
automatically assigned by the KPI Assignments mechanism, as described in 
“Edit Group Page” on page 450. Backlog, Delays, and Volume KPIs are 
always assigned by default to the Business Transaction and TV Monitor CIs; 
the Exceptions, Failures, and Value KPIs are each assigned by default, only if 
the corresponding attribute rule is defined for the business transaction in 
TransactionVision. (You can see which attribute rules are defined in the 
Properties page for the TV Monitor CI—see “Business Transaction 
Properties” on page 247.)

The Duration KPI must always be manually assigned to the CIs.

The rules for the TV Monitor CI are all sample-based, and by default 
recalculate data for each new sample.

The Business Transaction CIs by default use the Business Transaction Group 
Rule for each business transaction KPI. This rule assigns value and status to 
the KPI by taking the value and status directly from the KPI for the child TV 
Monitor CI.
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The business transaction KPIs do not include predefined objective 
thresholds. (The objective thresholds are used to assign a status to the KPI, 
based on the KPI value.) As each business transaction represents an 
individual business event, with individual business objectives, you need to 
set appropriate objective thresholds for each business transaction KPI, so 
that it displays a meaningful status. Until objective thresholds are defined, 
the KPI displays data with Info (blue) status in Dashboard.

You can edit the default KPIs and rules assigned to the CIs, and define 
objective thresholds for each KPI, in the Admin > Dashboard > KPIs tab.
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Mapping End User Management Data to Business 
Transactions

By default, the Business Transactions view includes only CIs for business 
transactions from HP TransactionVision, providing back-end monitoring. 
You can add the end-user perspective by mapping end-user transactions 
from Business Process Monitor and Real User Monitor to the business 
transactions. As a result of this mapping, the following information is 
available in Dashboard:

➤ the branch for a Business Transaction CI includes KPI status information 
from the end-user perspective.

➤ the Business Transaction Flow Map for a transaction includes worst status 
Application and Performance measurements for the Web Clients 
component. For details, see “Data Retrieval for the Flow Map” on page 258.

You set up the mapping in End User Management Administration, when 
defining Business Process profile and Real User Monitor transactions, or 
while editing existing transactions. Each transaction can be mapped to only 
one Business Transaction CI (but multiple Business Process Monitor and 
Real User Monitor transactions can be mapped to a single Business 
Transaction CI). 

See the following pages for information on where you perform the mapping:

➤ For mapping Business Process Monitor transactions while creating new 
Business Process profiles or adding new transaction monitors to profiles, see 
“Set Transaction Properties Page” in Using End User Management.

➤ For mapping existing transactions in a Business Process profile, see “Edit 
Transaction Page” in the Business Process Monitor section of Using End User 
Management.

➤ For mapping new and existing Real User Monitor transactions, see 
“New/Edit Transaction Page” in the Real User Monitor section of Using End 
User Management.

A task flow for performing the mapping is provided in “Map End-User 
Transactions to Business Transactions” on page 267.
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Drill Down from End User Management to 
TransactionVision

Business Availability Center supports HP TransactionVision integration with 
Real User Monitor and Business Process Monitor. From certain Real User 
Monitor and Business Process Monitor reports, you can perform a 
contextual drill-down to the relevant TransactionVision report, to view 
connected back-end activity as monitored by TransactionVision business 
transactions.

➤ Drill down from Real User Monitor. Both TransactionVision and Real User 
Monitor monitor actual customer transactions, but from different 
complementary, perspectives. The drill downs to the TransactionVision 
Transaction Tracking report help you to correlate the TransactionVision 
business transactions with Real User Monitor sessions, session pages, and 
business-critical (configured) pages. This enables you to investigate, for 
example, why a transaction took a long time or did not complete properly.

For more information, see “Viewing HP TransactionVision Data From Real 
User Monitor Reports” in Using End User Management.

➤ Drill down from Business Process Monitor. From the Triage report and the 
Triage Raw Data report, you can drill down to the TransactionVision 
Transaction Tracking report, helping you to correlate TransactionVision 
business transactions with transaction breakdown data collected by Business 
Process Monitor.

For more information, see “Triage Report” and “Triage Raw Data Report” in 
Using End User Management.
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Business Transaction Flow Map

The business transaction flow map provides a detailed, graphical 
representation of the flow path for instances of a business transaction, 
through the network and target machines. The flow data is received from 
HP TransactionVision, and shows the flow of completed instances or 
backlogged instances.

For details on the contents of the flow map, see “Business Transaction Flow 
Page” on page 276.

The following sections describe the flow map components and 
functionality:

➤ “Completed and In-Process Flow Maps” on page 256

➤ “Data Retrieval for the Flow Map” on page 258

➤ “Time Frame for the Flow Map” on page 257

➤ “Flow Map Components” on page 260

➤ “Flow Map Structure” on page 261

➤ “Flow Map Metrics” on page 262

Completed and In-Process Flow Maps
When Business Availability Center is integrated with TransactionVision (see 
“Set Up Integration with HP TransactionVision” on page 263), you can open 
a flow map for a business transaction in one of two modes. Select the 
required Business Transaction Flow Map mode from the context menu for a 
TV Monitor CI in Dashboard:

➤ In the Completed mode of the flow map, the data is based on the 
aggregation of all transaction instances that reached their end criteria 
during a specific time frame. This time frame reflects the collection interval 
for the business transaction data currently displayed in Dashboard.

➤ In the In-Process mode of the flow map, the data is based on a snapshot of 
the transaction instances that have not reached their end criteria at that 
specific point in time. The snapshot time corresponds to the end of the time 
frame for the business transaction data currently displayed in Dashboard.
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For information on how the time frame is calculated, see “Time Frame for 
the Flow Map” on page 257.

Time Frame for the Flow Map
The Business Transactions view in Dashboard shows data for the last data 
collection interval. The flow map aims to show data relating to the same 
time frame.

To achieve this, Business Availability Center and TransactionVision use the 
following information:

➤ The timestamp of the last sample from TransactionVision (the same sample 
that was used for calculating the current Dashboard data). The timestamp is 
the time that TransactionVision sent the sample to Business Availability 
Center.

➤ The collection interval that the sample covered, included as an attribute on 
the TV Monitor CI. The default value for the collection interval is 300 
seconds (configurable in TransactionVision).

➤ The aggregation delta for the sample, included as an attribute on the TV 
Monitor CI. The aggregation delta is defined in TransactionVision, and 
allows for the delay during sample creation. Default value is 60 seconds 
(configurable in TransactionVision).

Tip: You can check the aggregation delta and collection interval in the 
Properties dialog box for the TV Monitor CI (opened from the CI context 
menu). See “Business Transaction Properties” on page 247.
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When you select to open a Completed flow map, the query to 
TransactionVision requests all completed transactions within the following 
time frame:

➤ End time: The timestamp minus the aggregation delta.

➤ Start time: The end time minus the collection interval.

When you select to open an In-Process flow map, the query to 
TransactionVision requests all transactions that were currently in process at 
the end of the time frame (the same end time as above).

Note: If there is no data for the query period, an error message is displayed 
when the flow map tries to open.

Once you have opened the flow map, the data in it is not automatically 
updated when the data collection interval changes in the Dashboard. You 
must use the Refresh button in the flow map to update the data to reflect 
the new collection interval.

Data Retrieval for the Flow Map
Each time you open a flow map for a business transaction, you set up an ad 
hoc call to the TransactionVision machine. All TransactionVision 
information shown in the flow map is retrieved using this connection—no 
information is taken from the TransactionVision samples that arrive to the 
Bus.

The call to the TransactionVision machine requests information on the 
high-level components activated by the business transaction instances, for 
the relevant time frame. (For information on the time frame used for the 
request, see “Time Frame for the Flow Map” on page 257.)

The retrieved TransactionVision information generally includes data for the 
hosts on which the components are deployed, including the host IP address. 
Business Availability Center uses the IP address to query the CMDB for a 
matching Host CI, and retrieves status information for KPIs attached to the 
Host CI. The KPI status is usually based on SiteScope data. 
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The host information from TransactionVision and Business Availability 
Center are combined, so that each relevant component in the flow map 
displays a status icon showing the worst status of the host KPIs (when this 
information exists). The tooltip for the component shows host information 
retrieved from TransactionVision and from the CMDB (for example, the 
host type), as well as information on the associated KPIs.

In addition, if you have mapped one or more End User Management 
transaction CIs to the Business Transaction CI (as described in “Mapping 
End User Management Data to Business Transactions” on page 254), then 
Business Availability Center displays information on the worst status 
Performance and Availability KPIs (of the KPIs attached to the End User 
Management transaction CIs), in the tooltip for the Web Clients 
component.
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Flow Map Components
The flow map shows the flow of the instances for a business transaction 
through the components of the network and target machines. The 
components are represented in the map by flow component icons. The map 
may also display a component icon labeled Web Clients, representing the 
Web client (or multiple Web clients) that originated one or more instances 
of the transaction, in response to an end user action.

Each flow component represents an actual software or hardware element 
that one of the transaction instances passed through, and may include 
additional data from the software or hardware upper layers. For example, if a 
transaction instance passed through a J2EE application, the map shows a 
flow component for the J2EE application, and may include additional data 
for the application server and the host in the tooltip.

Each component is shown only once, regardless of how many instances of 
the transaction passed through that component.

The flow map includes only specific component types (so you will not see 
all component types identified by TransactionVision). The icon for each 
component type is determined by the CMDB class type for that component. 
For a list of the component icons used in the flow map, see “Flow Map 
Components” on page 291.
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Flow Map Structure
Communication between components in the map is represented by links 
(directed arrows). There is no particular order to the flow as represented in 
the graph, and the flow is a summarized one for all instances of the business 
transaction. Therefore, the following flow structures between the 
infrastructure elements are all possible:

➤ Two links between two components, each link going in the opposite 
direction. 

➤ A component with a self-directed link.

➤ A flow with several end points.

➤ A circular flow.

➤ Unconnected flow paths (this can occur when there are elements that 
cannot be interpreted by TransactionVision, for example, if the technology 
is not supported).
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Flow Map Metrics
If the flow map is set to show volume, value, or latency data (according to 
the selections made for the Display Data option in the flow map toolbar), 
then the flow map displays these metrics, broken down by transaction state 
categories, along the edge of each link arrow (the information can also be 
viewed in the tooltip for the link). The displayed metrics are supplied by 
TransactionVision, and relate to the flow of transaction instances (either 
completed or in process, as relevant) between the two components 
connected by the arrow. 

The metrics provide the following information:

➤ Volume. Displays a count of the transaction instances that passed/are in 
process between the two components.

➤ Value. Displays the total monetary value associated with the transaction 
instances that passed/are in process between the two components.

➤ Latency. Displays the average latency (response time) for the transaction 
instances that passed/are in process between the two components (in 
milliseconds).

For each metric, data is displayed across three transaction state categories, 
Successful, Late, and Failed. 

For example, the following information may be displayed in the tooltip for a 
link:

If a metric is not applicable for a link, or if there is no criteria set in 
TransactionVision for late status or failed status, then the relevant metric 
shows N/A.

Tasks
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Set Up Integration with HP TransactionVision

This task describes set up and configuration for the integration with 
HP TransactionVision, so that Business Transaction Management is available 
in Business Availability Center, and to enable drill down to the 
TransactionVision application.

For more information on the integration, see “Business Transaction 
Management - Overview” on page 242.

Note: 

➤ There is no data upgrade if you were working with TransactionVision in 
previous Business Availability Center versions. You must set up the 
integration for Business Availability Center 7.50 as described in this task.

➤ Business Availability Center does not support basic authentication 
protocol for communication with TransactionVision.

This task includes the following steps:

➤ “Prerequisites” on page 263

➤ “Configure Integration Settings in TransactionVision” on page 264

➤ “Configure Integration Settings in Business Availability Center” on page 264

➤ “Authenticate User Credentials” on page 264

➤ “Modify KPI Assignments” on page 265

➤ “Integration Results” on page 265

 1 Prerequisites
HP TransactionVision should be installed on your network.
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 2 Configure Integration Settings in TransactionVision
On the TransactionVision machine, define the required integration settings.

For details on the integration:

➤ see the TransactionVision User Guide for TransactionVision usability 
information relating to the integration with Business Availability Center.

➤ see the TransactionVision Administration Guide for TransactionVision 
configuration information relating to the integration with Business 
Availability Center.

 3 Configure Integration Settings in Business Availability Center
In Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Foundations, select Integrations with other applications, and locate 
the HP TransactionVision table.

Click the Edit button for the HP TransactionVision Host and Port entry, and 
enter the host name and port for the TransactionVision machine in the 
format: <protocol>://<host name>:<port number>

For example: http://tv.mycompany.global:9080

 4 Authenticate User Credentials
By default, both Business Availability Center and TransactionVision are set 
to use Lightweight Single Sign-On (LW-SSO) for communication between 
the applications, so you should not need to enter user authentication 
credentials.

In order for the drilldown from Business Availability Center to 
TransactionVision to function, you must configure the lwssofmconf.xml file 
in both applications. For details on configuring this file, see “LW-SSO 
Infrastructure Configuration” in Platform Administration.

For more information on LW-SSO, or on moving to a different user 
authentication strategy, see “Setting Up a Single Sign-On Authentication 
Strategy” in Platform Administration. 
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Note: Your Web browser should be set to accept cookies, for LW-SSO to 
function.

 5 Modify KPI Assignments
Business Availability Center provides predefined KPI assignments for the 
monitoring CIs created in the CMDB for the TransactionVision business 
transactions. The KPI assignments define the default Dashboard KPIs and 
rules attached to the created CIs, and the selectors for assigning samples to 
the CIs. For details, see “KPI Assignment Management Overview” on 
page 418.

If required, you can modify the KPI assignments. For details, see “Edit Group 
Page” on page 450.

 6 Integration Results
After setting up the integration, TransactionVision data and connections are 
available in Business Availability Center:

➤ Business Transaction CIs and TV Monitor CIs are created in the CMDB based 
on synchronization with the TransactionVision application, and assigned 
KPIs based on the KPI assignment information. The CIs are updated with 
transaction run data received in the incoming samples from 
TransactionVision. For details, see “Business Transaction Data in Business 
Availability Center” on page 244.

➤ The Business Transactions view is automatically populated with the Business 
Transaction and TV Monitor CIs, enabling you to monitor the business 
transactions in Dashboard, and to select business transaction CIs to include 
in service agreements in Service Level Management. For details, see 
“Business Transactions View” on page 250, and “Business Process and 
Business Transaction Data in Service Level Management” in Using Service 
Level Management.
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➤ The Business Transaction Summary report is added to the list of available 
reports in the Dashboard Reports tab. You can also access the Business 
Transaction Summary and Business Transaction Over Time reports from the 
context menu for a TV Monitor CI in Dashboard. For details, see “Business 
Transaction Summary Report” on page 282 and “Business Transaction Over 
Time Report” on page 287.

➤ From Dashboard, you can open the Business Transaction Flow Map for a TV 
Monitor CI. Data for the flow map is provided directly from an ad hoc call 
to the TransactionVision machine. For details, see “Business Transaction 
Flow Map” on page 256.

➤ From Dashboard, you can drill down from a TV Monitor CI to the 
Transaction Tracking Report page in TransactionVision. For details, see 
“Business Transaction Management in Dashboard” on page 250

➤ In End User Management, you can drill down from certain Real User 
Monitor and Business Process Monitor reports to the appropriate report page 
in TransactionVision. For details, see “Mapping End User Management Data 
to Business Transactions” on page 254.
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Map End-User Transactions to Business Transactions

This task describes how to map Business Process Monitor and Real User 
Monitor transactions in End User Management Administration, to business 
transactions from HP TransactionVision.

For more information, see “Mapping End User Management Data to 
Business Transactions” on page 254.

This task includes the following steps:

➤ “Prerequisites” on page 267

➤ “Map Business Process Monitor Transactions in the Business Process Profile 
Wizard” on page 267

➤ “Map New and Existing Transactions” on page 269

➤ “Results in Dashboard” on page 271

 1 Prerequisites
In order to do the mapping, Business Availability Center must be integrated 
with TransactionVision, and there must be Business Transaction CIs in the 
Business Transactions view.

 2 Map Business Process Monitor Transactions in the Business 
Process Profile Wizard
While working in the Business Process Profile Wizard to create a new 
Business Process profile, or to add a new transaction monitor to an existing 
profile, you have the option to map the Business Process Monitor 
transactions to business transactions.

 a Open the Business Process Profile Wizard and define profile and 
transaction monitor properties. See “Business Process Profile Wizard” in 
Using End User Management.
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 b In the Set Transaction Properties Page, select the check box for the 
transaction you want to map. Selecting a check box enables the Map 
Business Transaction button.

Note: If more than one transaction is selected, or if the transaction is already 
mapped to a business transaction, then the button remains disabled.

 c Click Map Business Transaction to open the Select Related Business 
Transaction dialog box, where you select the required Business 
Transaction CI.

 d Save your selection. After mapping, the Business Transaction column in 
the Set Transaction Properties page displays the name of the Business 
Transaction CI mapped to the Business Process Monitor transaction.

 e Repeat for each Business Process Monitor transaction you want to map to 
a business transaction.

 f If you want to change the mapping for a transaction, you must first 
remove the mapping by selecting the transaction check box and clicking 
Detach Business Transaction. You can then remap the transaction to a 
different business transaction, as described in step c.
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Example

In the following picture, the transaction ok in a transaction profile has been 
mapped to the Business Transaction CI Bond, and transaction tx_15 has been 
mapped to the Business Transaction CI Equity:

 3 Map New and Existing Transactions
In the End User Management Administration Monitors tab, you can select a 
Business Process Monitor transaction already in a profile and map it directly 
to a business transaction. You can also map a new or existing Real User 
Monitor transaction to a business transaction.

 a Access the Edit Transaction page for a Business Process Monitor 
transaction (see “Edit Transaction Page” in Using End User Management), 
or the New Transaction or Edit Transaction page for a Real User Monitor 
transaction (see “New/Edit Transaction Page” in Using End User 
Management).

 b In the Related Business Transaction area, click Map Business Transaction 
to open the Select Related Business Transaction dialog box, where you 
select the required Business Transaction CI.
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 c If you want to change the mapping for a transaction, you must first 
remove the mapping by clicking Detach Business Transaction. You can 
then remap the transaction to a different business transaction.

Note: The Map Business Transaction and Detach Business Transaction 
buttons are displayed only in Edit mode.

 d After mapping, the Related Business Transaction area displays the name 
of the Business Transaction CI.

Example

In the following pictures, the Business Process Monitor transaction tx_10 has 
been mapped to Business Transaction CI Equity:
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And the Real User Monitor transaction tx1 has been mapped to Business 
Transaction CI Equity:

 4 Results in Dashboard
After performing the mapping, you can immediately see the end-user 
transaction CIs added in the Business Transactions view.

The end-user KPI information appears in the Business Transaction Flow Map 
only after the next sample update. 
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Example

In the Business Transactions view in Dashboard, you can see the end-user 
transaction CIs mapped to the Business Transaction CI Equity:
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In the Business Transaction Flow Map for Equity, you can see worst status for 
the end-user Availability and Performance KPIs attached to the Web Clients 
component:

Reference
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Business Transaction Management User Interface

This section describes:

 ➤  Business Transaction/s Dialog Box on page 274

 ➤  Business Transaction Flow Page on page 276

 ➤  Business Transaction Summary Report on page 282

 ➤  Business Transaction Over Time Report on page 287

 Business Transaction/s Dialog Box

Description Enables you to select the Business Transaction CI(s) to be 
included in the report.

To access:

➤ In the Business Transaction Summary Report, click the 
Business Transactions link.

➤ In the Business Transaction Over Time Report, click 
the Business Transaction link.

Important 
Information

The information here applies to both the Business 
Transaction dialog box and the Business Transactions 
dialog box.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Not currently in use.

<CI list> Displays the CIs in the selected view. Only Business 
Transaction CIs can be selected. 

➤ In the Business Transactions dialog box, select the 
check box for every Business Transaction CI that you 
want to include in the report.

➤ In the Business Transaction dialog box, click the 
Business Transaction CI on which you want the report 
to be based.

View Enables you to select an alternative view to locate the 
required Business Transaction CIs.

Default: Displays the Business Transactions view.
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Business Transaction Flow Page
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Description Displays a flow map in a new browser page, showing a 
graphic representation of the flow for the selected 
business transaction through the target machine. The 
flow information is taken directly from 
HP TransactionVision.

The map includes metrics for the traffic between each 
flow component, and associated KPI data.

To access: 

1  In Applications > Dashboard, display the Business 
Transactions view.

2  Right-click a TV Monitor CI to open the context 
menu.

3  Select either:
Business Transaction Flow Map > Completed (for flow 
of completed business transaction instances)
or 
Business Transaction Flow Map > In Process (for flow 
of in-process business transaction instances)

Important 
Information

➤ On opening, the flow map displays information 
corresponding to the active time frame. This is the 
time frame that matches the data collection period 
currently active in Dashboard. The map information is 
not automatically updated to reflect new data 
collection periods—use the Refresh button to update 
the data in the map.

For more information on how the active time frame is 
calculated, see “Time Frame for the Flow Map” on 
page 257.

➤ The title bar includes the name of the business 
transaction, and the end time for the active time 
frame.

➤ The flow for the transaction is indicated by icons 
representing flow components, and arrows 
representing the flow links.

Useful Links “Business Transaction Flow Map” on page 256
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Toolbar Options

The following toolbar options are included:

GUI Element (A–Z) Description

Click the Refresh button to update the flow map to show 
data for the most recent time frame (corresponding to 
the data collection period that is currently active in 
Dashboard).

After refreshing:

➤ all default settings for the flow map are restored.

➤ the title bar updates to display the end time for the 
active time frame.

Click the Pan button, then click and drag in the flow 
map to view different areas of the map.

Click the Select button, then:

➤ click an entity in the map to select it.

➤ click and drag an entity in the map to reposition it 
within the flow map. For example, you can click on 
the elbow of a link arrow and drag it to a different 
location.

➤ click and drag over an area to select the entities within 
that area.

Click again outside the selected area to deselect.

Click the Zoom button, then click and drag in the map to 
zoom in and out.

Click the Fit to window button to resize the map to fit 
the available viewing space.

Click the Move selected to center button to move the 
currently selected items to the center of the viewing area.

Click the Rearrange button to restore the map to its 
default appearance.
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Click the Save as image button to open a dialog box 
where you define the target location and required 
settings for saving the flow map as an image.

Click the Display Data button to open a list of data 
display options. Select the check box for each option that 
you want displayed in the flow map.

➤ CI Additional Data. Displays the name or IP of the host 
running the component (when this information is 
available) under each relevant component icon.

➤ Value. Displays value metrics for each link, alongside 
each link arrow.

➤ Volume. Displays volume metrics for each link, 
alongside each link arrow.

➤ Latency. Displays latency metrics for each link, 
alongside each link arrow.

For more information on these options, see “Flow Map 
Metrics” on page 262.

Note: If an option is not selected, you can still see the 
metrics information in the tooltip for the link, or the 
host information in the tooltip for a component.

GUI Element (A–Z) Description
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Flow Map

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Flow component 
icon>

Example:

Each flow component (for example, Application, Servlet, 
MQ Queue, and so forth) is represented by an icon.

For a reference list of the icons used in the flow map, see 
“Flow Map Components” on page 291.

If you selected to show CI Additional Data in the Display 
Data list, then the flow map displays the name or IP of 
the host running the component (when this information 
is available) under each relevant component icon.

Tooltip: Hold the pointer over a component icon to 
display a tooltip containing information for the host that 
the component is deployed on, including KPI 
information.
For the Web Clients component, the tooltip displays KPI 
information relating to end user transactions that are 
mapped to the business transaction.

For more information on the data in the tooltips, see 
“Data Retrieval for the Flow Map” on page 258.
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<Status indicator>

Example:

Status indicators are displayed in the bottom-right corner 
of a component icon, when there is a Host CI in the 
CMDB that corresponds to the host that the component 
is deployed on. The status indicator shows the worst 
status held by the KPIs attached to the Host CI. 

For more information, see “Data Retrieval for the Flow 
Map” on page 258.

<Link arrow>

Example:

The link arrows, each connecting two component icons, 
indicate the direction of the transaction flow. 

If the flow map is set to show volume, value, or latency 
data (according to the selections made in the Display 
Data list), then the flow map displays these metrics, 
broken down by three transaction state categories, along 
the edge of each link arrow. The format 
<successful>/<late>/<failed> is used to display the 
metrics across each transaction state category, for 
example: Volume: 100/2/1

For an explanation of the metrics and transaction state 
categories, see “Flow Map Metrics” on page 262.

Tooltip: Hold the pointer over a link arrow to display a 
tooltip that shows the metrics broken down by 
transaction state.

GUI Element (A–Z) Description
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Business Transaction Summary Report
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Description Displays metrics for selected business transactions from 
HP TransactionVision. The metrics (calculated by either 
volume or by monetary value, depending on the selected 
mode) are shown broken down by different transaction 
state categories, such as failures or delays.

You can use this report to see summarized results for 
transactions during a set time period.

To access: Applications > Dashboard > Reports > Business 
Transaction Summary
Or:
In a Dashboard tab, open the context menu for a TV 
Monitor CI and select Go to Report > Business 
Transaction Summary

Important 
Information

The report appears in the Reports list only when the 
integration is set up with TransactionVision. For details, 
see “Set Up Integration with HP TransactionVision” on 
page 263.

Useful Links For information on the transaction state categories, see 
“Business Transaction Data in Business Availability 
Center” on page 244.
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click the Drilldown button to drill down to the Business 
Transaction Over Time report for the business transaction 
currently selected in the table. The Business Transaction 
Over Time report opens using the same report settings as 
selected in the Business Transaction Summary report.

(The Business Transaction Over Time report shows 
monetary values if you drill down from the Value table, 
and volume if you drill down from the Count table.)

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Business Transactions Displays the number of transactions selected for 
inclusion in the report. 

To change the selection, click the Business Transactions 
link, and select the required transactions in the Business 
Transactions dialog box.

Default: All business transactions selected.

Show Select the required radio button:

➤ Value. Displays the Value table, showing metrics based 
on the monetary value for each business transaction 
instance. The unit and the monetary value are defined 
in TransactionVision. 

➤ Count. Displays the Count table, showing metrics 
based on the volume of business transaction instances 
in each category.

➤ Both. Displays both the Value and the Count tables.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Avg. Backlog (Count table) Displays the average number of backlogged 
(in-process) instances of the business transaction during 
the time range.

Avg. Backlog Value (Value table) Displays the average monetary value of the 
backlogged (in-process) instances of the business 
transaction during the time range.

Avg. Duration Displays the average duration (in seconds) for a 
successfully completed instance of the business 
transaction, triggered during the time range.

Business Transaction Lists the Business Transactions CIs selected for inclusion 
in the report.

Delays Displays the percentage of business transaction instances 
classified as late, or the percentage cost for the business 
transaction instances classified as late, during the time 
range (for both in-process and completed instances).

Tooltip: The tooltip for each cell shows the values used to 
calculate the percentage.

Exceptions Displays the percentage of business transaction instances 
classified as exceptions, or the percentage cost for the 
business transaction instances classified as exceptions, 
during the time range (for both in-process and completed 
instances).

Tooltip: The tooltip for each cell shows the values used to 
calculate the percentage.
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Failures Displays the percentage of business transaction instances 
classified as failures, or the percentage cost for the 
business transaction instances classified as failures, 
during the time range (for both in-process and completed 
instances).

Tooltip: The tooltip for each cell shows the values used to 
calculate the percentage.

Total Count (Count table) Displays the total number of completed 
instances of the business transaction during the time 
range.

Total Value (Value table) Displays the total monetary value for all 
completed instances of the business transaction during 
the time range.

GUI Element (A-Z) Description
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Business Transaction Over Time Report
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Description Displays metrics over time for a selected business 
transaction from HP TransactionVision.

The metrics (calculated by either volume or by monetary 
value, depending on the selected mode) are shown on 
two graphs:

➤ Transaction Measurements Correlation. A line graph 
showing the correlation between two measurements 
(select from total transactions, backlog, and duration).

➤ Transaction State. A bar graph showing the percentage 
results for transaction states (exceptions, delays, 
failures) out of total transactions.

You can use this report to see the performance of a 
transaction over time.

To access:

Drill down from the Business Transaction Summary 
Report
Or:
In a Dashboard tab, open the context menu for a TV 
Monitor CI and select Go to Report > Business 
Transaction Over Time

Useful Links For information on the transaction state categories, see 
“Business Transaction Data in Business Availability 
Center” on page 244.
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Available 
measurements

Select the check boxes for either one or two 
measurements, to display the measurements in the 
Transaction Measurements Correlation graph:

➤ Total transactions. Displays total volume or total value 
for completed transaction instances.

➤ Average backlog. Displays average backlog 
(transaction instances in-process) count or value for 
the time period.

➤ Average duration. Displays the average duration of 
completed transaction instances for the time period.

Business Transaction Displays the name of the business transaction for which 
results are shown in the report. 

To change the selection, click the Business Transaction 
link, and select the required transaction in the Business 
Transaction dialog box.

Show Select the required radio button:

➤ Value. The graphs display results based on the 
monetary value of each instance for the business 
transaction. The unit and the monetary value are 
defined in TransactionVision. 

➤ Count. The graphs display results based on the volume 
of instances for the business transaction.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Drill down> Click a point or a bar in the graphs to drill down in the 
Business Transaction Over Time report to a finer 
granularity for the business transaction. For example, in a 
report showing results per week, you can drill down from 
a particular week to show results per day in the week. You 
can then drill down again from a particular day to show 
results per hour in that day.

Transaction 
Measurements 
Correlation graph

Displays the time period on the x-axis, and the units for 
the selected measurements on the y-axes. Each point on 
the graph shows the total or average for the preceding 
time period. 

Tooltip: Hold the cursor over a point in the graph to see 
the value for the measurement.

Transaction State Displays the time period on the x-axis, and percentage on 
the y-axis. A separate bar is shown for each transaction 
state during each time period included in the graph.

Tooltip: Hold the cursor over a bar in the graph to see the 
values for the measurement and the percentage 
calculation.
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Flow Map Components
The following table lists the component icons that are used for the Business 
Transaction Flow map, described in “Business Transaction Flow Page” on 
page 276.

Note: The database component is not included in the table—the icon used 
for database varies, depending on the database type.

 

Icon Component Name

Program (software elements)

J2EE Application

Web Clients

IBM WebSphere MQ Queue

IBM WebSphere MQ Cluster Queue

JMS Topic

JMS Queue

CICS Transaction
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IMS Program

Batch Job

Icon Component Name
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10
Dashboard Reports 

This chapter describes the Dashboard reports.

This chapter includes:

Concepts

 ➤  Dashboard Reports Overview on page 295

Tasks

 ➤  View KPIs Over Time Information on page 298

Reference

 ➤  Reports User Interface on page 300

 ➤  Troubleshooting and Limitations on page 327
Concepts

Dashboard Reports Overview

Dashboard reports enable you to view and analyze performance data 
collected by HP Business Availability Center data collectors and stored in the 
HP Business Availability Center database. 

The Dashboard reports are:

➤ KPIs Summary. Displays a summary of KPI status distribution over time for 
each selected KPI. For details, see “KPIs Summary Report” on page 321.

➤ KPIs Trend. Displays the trend for changes in KPI status over time, for 
selected statuses. For details, see “KPIs Trend Report” on page 324.
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➤ KPIs Distribution Over Time. Displays KPI status distribution over time for 
selected statuses. For details, see “KPIs Distribution Over Time Report” on 
page 303.

➤ KPIs Over Time. Displays the status or value, over time, of selected CIs and 
KPIs that are accessible from the Dashboard application. For details, see 
“KPIs Over Time Report” on page 306.

➤ Business Process Summary, Business Process Over Time, or BPI Monitors 
Over Time. Display the information needed to monitor HP Business Process 
Insight. For details, see “BPI Monitors Over Time Report” on page 224, 
“Business Process Over Time Report” on page 228, or “Business Process 
Summary Report” on page 233.

➤ Business Transaction Summary, or Business Transaction Over Time. Displays 
summarized information for selected business transactions monitored by 
HP TransactionVision, and information over time for specific transactions. 
For details, see “Business Transaction Over Time Report” on page 287, and 
“Business Transaction Summary Report” on page 282.

You can print the generated report, send the report by email, open the 
report in different formats, publish the report in different formats, or save 
the report to the report repository. For details, see “Working in Reports - 
Overview” in Reports.
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Note: 

➤ Data is displayed in a report starting from the point that data was 
collected for the selected CIs. For example, if you set the report to show 
data every week for the past month, but data was collected only for the 
past two weeks, the report shows data starting from two weeks ago to the 
present date.

➤ The KPI Summary, KPI Trend, and KPI Distribution Over Time reports are 
generated only for CIs of type Application, Business Process, Business 
Service, and Line of Business; in addition, the CIs must be flagged to save 
KPI data over time (historical data). For details, see “Persistent Data and 
Historical Data” on page 365. (Contact HP Software Support if you need 
to change the supported CITs.)

➤ HP Business Availability Center records in a reports log errors that occur 
when generating reports. The reports log can also include the following 
activities: creating a new report, generating a report, modifying the 
report filters, drilling down in reports, and so on. For details about the 
reports log, see “Reports Log” in Reports.

➤ HP Business Availability Center enables you to generate Dashboard 
reports automatically, and to specify a header and a footer for those 
reports. For details, see “Customizing Reports” in Reports.

Tasks
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View KPIs Over Time Information

The steps below describe the process used to set up to view KPIs over time 
information in Dashboard.

This task includes the following steps:

➤ “Save KPI Status Information for the KPIs Over Time Reports” on page 298

➤ “Access KPIs Over Time Reports” on page 298

➤ “Drill Down to HP Diagnostics” on page 299

➤ “Access KPIs Distribution Over Time Report” on page 299

➤ “Access the KPIs Summary Report” on page 299

➤ “Access the KPIs Trend Report” on page 299

 1 Save KPI Status Information for the KPIs Over Time Reports
Persistent data is used to produce KPIs Over Time reports with status 
information, as described in “KPIs Over Time Report” on page 306. Set the 
Save KPI data over time for this CI option to save the calculated 
measurement for each of the CI KPIs, at 15 minute intervals (default value). 
This is done by activating the saveValuesToPersistency global attribute in 
the Rules Repository. For details, see “Persistent Data and Historical Data” 
on page 365.

This option is selected, by default, for Business Services, Applications, 
Business Processes and others. This option is not available for Monitor type 
CIs.

 2 Access KPIs Over Time Reports
You can access the KPIs Over Time reports from different locations in 
HP Business Availability Center.

To access KPIs Over Time report, see “KPIs Over Time Report” on page 306.
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Note: The context menu includes the KPIs Over Time Report option for all 
CIs except for monitors. The report displays data only for CIs whose KPIs are 
persistent. For details, see “Persistent Data and Historical Data” on page 365.

 3 Drill Down to HP Diagnostics 
If HP Diagnostics integrates with HP Business Availability Center, you can 
drill down to HP Diagnostics views from the KPIs Over Time report for 
Business Process Step CIs in the End User Monitors views, and for the 
Diagnostics Probe Group, and Diagnostics Probe CIs in the Diagnostics 
View. For details, see “KPIs Over Time Report” on page 306.

 4 Access KPIs Distribution Over Time Report
KPIs Distribution Over Time report enables you to analyze KPI trend by 
viewing KPI status distribution over time for selected statuses. For details, 
see “KPIs Distribution Over Time Report” on page 303.

 5 Access the KPIs Summary Report
KPIs Summary report enables you to view a summary of KPI status 
distribution over time for each selected KPI. For details, see “KPIs Summary 
Report” on page 321.

 6 Access the KPIs Trend Report
KPIs Trend report enables you to analyze the trend for changes in KPI status 
over time, for selected statuses. For details, see “KPIs Trend Report” on 
page 324.

Reference
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Reports User Interface

This section describes:

 ➤  Configuration Items Dialog Box on page 301

 ➤  KPIs Dialog Box on page 302

 ➤  KPIs Distribution Over Time Report on page 303

 ➤  KPIs Over Time Report on page 306

 ➤  KPIs Summary Report on page 321

 ➤  KPIs Trend Report on page 324

 ➤  Statuses Dialog Box on page 327
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Configuration Items Dialog Box

Description Enables you to select the CIs to be included in a 
Dashboard report, for the duration of a Web session. 
The report provides information based on the selected 
CIs.

To access: In a Dashboard report, click Configuration 
Items in the reports settings area.

Important 
Information

➤ When selecting CIs for the KPI Summary, KPI Trend, 
and KPI Distribution Over Time reports, only CIs 
that meet the following criteria are available for 
selection in the Configuration Items dialog box:

➤ The CIs with attached KPIs.

➤ The CIs that are flagged to save KPI data over time 
(historical data). For details, see “Persistent Data 
and Historical Data” on page 365.

➤ The CI types that are defined for inclusion in 
these reports; by default, Application, Business 
Process, Business Service, and Line of Business 
CITs are defined for inclusion. (Contact HP 
Software Support if you need to change the 
supported CITs.)

➤ When selecting CIs for the KPIs Over Time report, 
only non-monitor (leaf) CIs are available for 
selection. 

➤ Only CIs are flagged to save KPI data over time 
(historical data) appear in the KPIs Over Time report. 
For details, see “Persistent Data and Historical Data” 
on page 365.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

KPIs Dialog Box

GUI Element (A-Z) Description

<View tree> Displays the CIs in the selected view. Select the check 
boxes for the required CIs.

Browse The default mode for the Configuration Items dialog 
box, enabling you to select a view and CIs.

Search Click Search to move to Search mode, where you can 
search for CIs. For details, see “View Explorer” in Model 
Management.

View Select the relevant view from the dropdown list (start 
typing in the view name to filter the list), or click the 
ellipse button to open the Select View dialog box, 
where you can select a view from the view folders tree.

Note: Only the CIs selected in the currently displayed 
view are saved for the report filter when you click OK. 
If you select another view before clicking OK, all 
previous CI selections are discarded.

Description Enables you to select the KPIs to be included in a 
Dashboard report, for the duration of a Web session. 
The report provides information based on the selected 
KPIs.

To access: In a Dashboard report, click KPIs in the 
reports settings area.

Important 
Information

You must define at least one CI for the report before 
you can select KPIs. After selecting CIs, the Application 
KPI is in some cases selected automatically (if it is 
attached to the selected CIs).
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

KPIs Distribution Over Time Report

GUI Element (A-Z) Description

KPIs Lists the KPIs that are attached to the selected CIs. 
Availability and Performance are listed first, then all 
other KPIs in alphabetical order.

Select the check boxes for the required KPIs.

Description Displays KPI status distribution over time for selected 
statuses.

To access:

➤ Select Applications > Dashboard > Reports tab > KPIs 
Distribution Over Time

➤ Access the KPIs Distribution Over Time portlet in 
My BAC

Important 
Information

➤ This report is produced only for certain CIs with 
historical KPI data. For details, see “Configuration 
Items Dialog Box” on page 301.

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Useful Links “Configuration Items Dialog Box” on page 301
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Report Settings

GUI Element (A-Z) Description

<Common report 
settings>

See “Common Report Elements” in Reports.

Configuration Items Displays the name of the selected CI for the report, and 
if more than one CI is selected, indicates the number of 
CIs that the report is based on. For example, 
Filtered (4) means that four CIs are selected for 
inclusion in the report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.

KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are attached 
to the selected CIs separated by a slash; for example, 
Filtered (1/3). 

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: If the Application KPI is attached to any 
of the selected CIs, then this KPI is selected 
automatically.

Statuses Indicates the number of statuses that are included in 
the report and the 7 possible statuses separated by a 
slash; for example, Filtered (5/7).

Click the Statuses link to open the Statuses dialog box 
where you can select statuses.

Default value: All statuses that are defined as 
non-critical are selected, and All Non-Critical Statuses 
is displayed. For details, see “Statuses Dialog Box” on 
page 327.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Bar chart> Each KPI instance for each CI is displayed in a separate 
bar chart (as long as there is relevant data for the KPI 
on that CI). Each chart shows status distribution (in 
percentage) for the KPI over the selected time frame. 

<Bar> Each bar in a chart represents a time interval, 
according to the granularity selected for the report. For 
example, if the selected granularity is every 1 week, 
then each bar represents a week during the overall time 
frame. The legend for the x-axis shows the time 
interval for each bar.

Each bar is divided into colored status sections, 
according to the statuses selected for inclusion in the 
report, so that each section represents the percentage 
of time that the status was held by the KPI during that 
time interval.

Tooltip: Hold the pointer over a bar section to display a 
tooltip containing the following information:

➤ Status. The name of the status represented by the 
section.

➤ Status Duration. Amount of time that the KPI held 
this status during the time interval. This can be 
given in hours, minutes, and seconds (for example, 
01:10:48) or in days and hours (for example, 30 
days, 9 hours).

➤ Status Percentage. Percentage of the time interval 
that the KPI held this status. 
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KPIs Over Time Report

Description Enables you to view the status or the value, over time, 
of selected KPIs and CIs, in table or graph format.

For example, when you encounter a problem with a 
specific CI while viewing the Dashboard, and the 
Performance and Availability KPIs are attached to that 
CI, you can view the KPIs Over Time report of that CI’s 
Performance and Availability. You can also receive a 
daily report showing all CIs statuses in the past day.

To access: 

➤ Select Applications > Dashboard > Reports > KPIs 
Over Time. The report is also available from the 
context menu of CIs in Dashboard.

➤ Access the KPIs Over Time portlet in My BAC
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Important 
Information

The report displays the status or value of each CI and 
each instance of the attached KPIs. For example, when 
you select one CI with the Availability and 
Performance KPIs, and another CI with the Availability 
KPI the report has only three rows.

➤ You can:

➤ Add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in My BAC. 

➤ Add this report to a custom report. For details, see 
“Customizing Reports” in Reports. 

➤ Schedule when to run the report. For details, see 
“Report Schedule Manager Main Page” in Platform 
Administration.

➤ If you select a future date in the To setting in the 
report settings, the report is not generated and an 
error message is issued.

➤ The report is designed to provide information about 
the KPIs of higher level CIs; for example, Business 
Services, Application, Business Processes CIs, and so 
on, but not about the KPIs of monitor CIs. To obtain 
similar information about the KPIs of monitor CIs, 
see “Reports User Interface” in Using End User 
Management, “Alerts and Reports” in Using System 
Availability Management, or “Trend Reports” in 
Reports.

➤ The context menu of all CIs except monitors CIs 
includes the KPIs Over Time Report option. 

➤ The report displays data only for CIs with persistent 
KPIs. For details, see “Persistent Data and Historical 
Data” on page 365.

➤ There is no limit to the number of lines that can be 
displayed in the table. If displaying the table slows 
performance, it is recommended to limit the time 
period or the number of CIs and KPIs you want to 
display.

Included in Tasks “View KPIs Over Time Information” on page 298
307



Chapter 10 • Dashboard Reports
Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Common report 
settings>

See “Common Report Elements” in Reports.

Configuration Items Indicates the number of CIs that are included in the 
report. For example, Filtered (4) means that four CIs 
are selected for inclusion in the report.

To select CIs, click the Configuration Items link. For 
details, see “Configuration Items Dialog Box” on 
page 301.

KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are defined 
for the selected CIs separated by a slash, for example, 
Filtered (1/3). 
All is displayed when all available KPIs are selected.

To select KPIs, click the KPIs link. For details, see “KPIs 
Dialog Box” on page 302.

Default value: When you select one or more CIs and 
the Performance and Availability KPIs are assigned to 
those CIs, the KPIs are automatically selected.
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Report type Select:

➤ Statuses. To display the status information in the 
report. For details, see “KPIs Over Time Report with 
Status Data” on page 310. The KPIs Over Time report 
with status data displays only the status of the 
selected KPIs for the selected CIs. Those KPIs may 
also have values in the HP Universal CMDB but the 
report does not show the values. 

➤ Values. To display the value information in the 
report. For details, see “KPIs Over Time Report with 
Value Data” on page 317. The KPIs Over Time report 
with values data displays only the value of the 
selected KPIs for the selected CIs. Those KPIs may 
also have statuses in the HP Universal CMDB but the 
report does not show the statuses. 

GUI Element (A-Z) Description
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KPIs Over Time Report with Status Data

Important 
Information

The report displays data only for CIs whose KPIs are 
persistent. For details, see “Persistent Data and 
Historical Data” on page 365.

Ensure that the Save historical data for this CI option 
has been selected for the CI. For details, see “KPIs Page” 
on page 398.

Note: The statuses are shown over time, starting with 
the event and ending with the next event. 

The report displays only the status of the relevant KPIs. 
Those KPIs may also have values in the HP Universal 
CMDB but the status report does not show those 
values.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to display status information about the children 
that contribute to the status of the selected CI’s KPI.

Note: Drilling down to the level of the monitor CI is 
unavailable as there is no calculated status for those CIs 
and only raw data is available. To obtain similar 
information about the KPIs of monitor CIs, see “Real 
User Monitor Reports User Interface” in Using End User 
Management, “Alerts and Reports” in Using System 
Availability Management, or “Trend Reports” in Reports.

Example: A view has the following hierarchy: the 
app_world_2 CI, with its trx1_EUM, trx_General, and 
trx_SAM child CIs. 

The KPIs Over Time report displays information about 
the status of the Performance KPI for the app_world_2, 
trx1_EUM, and trx_General CIs. 

Click the Drill to influencing children button for the 
app_world_2 CI and the Performance KPI. The drilled 
down report displays the status of the Performance 
KPIs for all of the children of the app_world_2 CI that 
have a Performance KPI, as shown in the graph that 
follows. 

If the selected CI and KPI do not have influencing 
children, then the report displays the message: No 
influencing children found.
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Click to display status information about the parents of 
the CI whose status is influenced by the status of the 
selected CI’s KPI. A CI may have more than one parent 
but the parent CIs that are displayed in the report are 
the parent CIs that are part of the view.

Note: You can drill up to influenced parents only when 
the CIs have persistent data.

Example: A view has the following hierarchy: the 
trx_weekly_plan CI and its parent the app_world_2 CI.

The KPIs Over Time report displays information about 
the Availability and Performance KPIs of the 
trx_weekly_plan CI. 

Drill up to influenced parents for the Availability KPI, 
the report displays the status of the Availability KPI for 
the app_world_2 CI (parent of trx_weekly_plan CI), as 
shown in the graph that follows.  

If the selected CI and KPI do not have influenced 
parents, then the report displays the message: No 
influenced parents found.

GUI Element (A-Z) Description
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<Drill down> This capability is available only in graph format.

Click any time segment in the graph time footer to drill 
down (zoom) on all of the CI and KPI information for 
that period of time. The time segment you zoom on is 
split into four equal parts that can also be zoomed until 
each time segment is one minute long.

The From date and time of the segment you select 
becomes the From date and time of the whole time 
footer and the To date and time of the segment you 
select become the To date and time of the whole time 
footer.

Example: If the time period you selected is from 7/13/05 
8:51 AM till 7/13/05 4:44 PM, the time footer is split 
into four equal segments. If you drill down on the first 
segment of the time footer, the From date and time of 
that segment is 7/13/05 8:51 AM, and its To date and 
time is what is indicated under the second tick of the 
time footer: 7/13/05 11:29 AM. The drilled down report 
time From and To fields display those dates and times, 
and the time footer of the report displays this period of 
time split into four equal parts: (11:29-8:51)/4=39 mn. 
The first part starts at 8:51 AM, and ends at 
8:51+:39=9:30, the second part starts at 9:30 and ends 
at 9:30+:39=10:09, and so on.

GUI Element (A-Z) Description
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<Drill down to 
Diagnostics>

If HP Diagnostics is enabled, you can drill down to 
HP Diagnostics views from the KPIs Over Time report. 

To access the drill down options, click the down arrow 
to the right of a Business Process Step CIs in the 

End User Monitors View, and of the Diagnostics Probe 
Group, and Diagnostics Probe CIs in the Diagnostics 
View and select one of the options. For information 
about the available options, see “Drill Down to 
HP Diagnostics” on page 319.

By default, if HP Diagnostics is enabled, the 
Application KPI is automatically added to all relevant 
CIs in the CMDB. The relevant CIs are the logical CIs. 
For details, see the HP Diagnostics User’s Guide.

The context menu options that are available from the 
KPIs Over Time report are a subset of the Drill to 
Diagnostics options available in Dashboard. For details, 
see “Drill Down to HP Diagnostics” on page 319.

GUI Element (A-Z) Description
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<Tooltip> Move the cursor above the graph to display more 
information about the KPI. The background of the 
tooltip reflects the color of the status calculated by the 
rule attached to the KPI and according to the KPI’s 
objectives. 

 

The tooltip displays the name of the KPI in the tooltip 
title and the following information:

➤ Configuration Item. The name of the CI to which 
the current KPI is assigned.

➤ Status. The status of the KPI.

➤ Start Time. The time when an event occurred, 
starting the sampling period for that event.

➤ End Time. The time when a new event occurred, 
ending the sampling period of the previous event.

➤ Duration. The duration of the sampling period.

Configuration Item The name of the selected configuration item.

Duration Note: This field appears only when the report is in 
table format.

The duration of the sampling period.

End Time Note: This field appears only when the report is in 
table format.

The time when a new event occurred, ending the 
sampling period of the previous event

KPI The name of the KPI. 

Start Time Note: This field appears only when the report is in 
table format.

The time when an event occurred, starting the 
sampling period for that event.

GUI Element (A-Z) Description
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Status When the report is in table format, Status displays the 
status of each KPI of each CI, according to the selected 
granularity, during the selected time period.

When the report is in graph format, Status displays the 
status of the KPI as a background color during the 
selected time period. A tooltip is available for each cell 
in the graph (see <Tooltip> for details).

GUI Element (A-Z) Description
316



Chapter 10 • Dashboard Reports
KPIs Over Time Report with Value Data

Important 
Information

➤ To display the KPIs Over Time report ensure that:

➤ The Save historical data for this CI option has 
been selected for the CI. For details, see “KPIs 
Page” on page 398.

➤ The saveValuesToPersistency global attribute is set 
to true in all of the rules. For details, see “Global 
Attributes Dialog Box” in CI Attribute Customization.
Note: If this option is selected, data on status and 
measurements over time for a CI is saved in the 
database. The persistent data is used to produce KPIs 
Over Time reports and Business Dashboard 
reports.The report displays only the values of the 
relevant KPIs. Those KPIs may also have statuses in 
CMDB but the value report does not show those 
statuses.

➤ Reports of this type are relevant for KPIs with 
business rules that calculate meaningful values, such 
as rules for calculating percentage, volume, financial 
impact, or Real User Monitor values. 

➤ You can select the number of sampling points in the 
Every boxes.

➤ You can drill down each point in the graph to 
display the data in the period of time that 
corresponds to your selection. For example, if you 
have selected to display information every day for 
the past week, then drilling down on one point 
displays the detailed information for every hour of 
the selected day, and then drilling down on one 
hour displays the detailed information for 5 minutes 
intervals in the hour, and so on down to a minute 
interval.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Graph> Displays the value of the KPI assigned to a specific CI at 
the specified time (indicated by a colored line).

When you select two KPIs and more than one CI, each 
pair of KPIs is displayed in a separate graph. The left y-
axis displays the scale of the first KPI and the right 
y-axis displays the scale of the second KPI.

When you select one KPI, the Y-axis displays the scale 
for the KPI, a line displays the value of the KPI over 
time, and faint colored horizontal lines show the KPI 
objectives (the colors correspond to the objective 
colors of the KPI).

A legend lists the name of the CI, the name of the KPI 
and the color used to represent the KPI value.
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Drill Down to HP Diagnostics 

The following table displays the Diagnostics drill down options for CIs in 
KPIs Over Time reports:

<Time period> This field appears only in table format.

Each column represents a time segment corresponding 
to the selected granularity of the selected time 
period. The table displays the value of the KPI in 
the time segment.

<Tooltip> This field appears only in graph format.

Move the mouse over any dot in the graph to display 
the value of the KPI at this point.

Configuration Item This field appears only in table format.

The name of the selected configuration item.

KPI This field appears only in table format.

The name of the KPI. Each selected KPI is displayed in a 
separate line.

CI Type Diagnostics Drilldown Options

Diagnostics Probe Group ➤ Summary View (Probe Group Summary)

➤ Layers View (Load)

Diagnostics Probe ➤ Summary View (Probe Summary)

➤ Layers View (Load)

Business Process Step ➤ Transactions View

➤ Layers View

GUI Element (A-Z) Description
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The HP Diagnostics views accessed with the context menu options that are 
available from the KPIs Over Time report are as follows:

HP Diagnostics Views Description

Summary View Note: This option is available for all Diagnostics 
Probe CIs. This option is displayed only if you have 
installed Diagnostics. 

Opens the Probe Summary View in the 
HP Diagnostics application, for the probe group and 
for the time frame specified in the View box in the 
KPIs Over Time report. 

For more information about Diagnostics, see the 
HP Diagnostics User’s Guide.

Layers View Note: This option is available for all Business 
Process Monitor, and Diagnostics Probe CIs. This 
option is displayed only if you have installed 
Diagnostics. 

The Layers (Load) view displays the performance 
metrics for the Diagnostics layers where processing 
has taken place in your application, for the 
transaction that corresponds to the Business Process 
Monitor CI or for the selected Probe CI and for the 
time frame specified in the View box in the KPIs 
Over Time report. 

For more information about Diagnostics, see the 
HP Diagnostics User’s Guide.

Transactions View Note: This option is available for all Business 
Process Step CI. This option is displayed only if you 
have installed Diagnostics. 

The Transactions view displays performance metrics 
for the transactions that are being executed by your 
applications, with the transaction corresponding to 
the Business Process Step CI highlighted, and for 
the time frame specified in the View box in the KPIs 
Over Time report. For more information about 
Diagnostics, see the HP Diagnostics User’s Guide.
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KPIs Summary Report

Report Settings

Description Displays a summary of KPI status distribution over 
time for each selected KPI.

To access:

➤ Select Applications > Dashboard > Reports > KPIs 
Summary

➤ Access the KPIs Summary portlet in My BAC

Important 
Information

➤ This report is produced only for certain CIs with 
historical KPI data. For details, see “Configuration 
Items Dialog Box” on page 301.

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Useful Links “Configuration Items Dialog Box” on page 301

GUI Element (A-Z) Description

<Common report 
settings>

See “Common Report Elements” in Reports.
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Configuration Items Displays the name of the selected CI for the report, and 
if more than one CI is selected, the number of CIs that 
the report is based on. For example, Filtered (4) means 
that four CIs are selected for inclusion in the report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.

KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are attached 
to the selected CIs separated by a slash; for example, 
Filtered (1/3). 

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: If the Application KPI is attached to any 
of the selected CIs, this KPI is selected automatically.

GUI Element (A-Z) Description
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Pie chart> Each pie chart represents a KPI instance (name 
displayed at the top) for a CI (name displayed on the 
left), and summarizes the statuses for the KPI over the 
selected time frame (as long as there is relevant data for 
the KPI on that CI). 

Each pie chart is divided into colored status slices, so 
that each slice represents the percentage of time that a 
particular status was held by the KPI. 

Tooltip: Hold the pointer over a pie slice to display a 
tooltip containing the following information:

➤ Status. The name of the status represented by the 
slice.

➤ Status Duration. The amount of time that the KPI 
held this status during the time frame. This can be 
given in hours, minutes, and seconds (for example, 
01:10:48) or in days and hours (for example, 30 
days, 9 hours).

➤ Status Percentage. The percentage of the time that 
the KPI held this status

Functionality: Right-click a pie for animation 
functionality. For more information, see “Viewing 
Reports with Adobe Flash Player” in Reports.
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KPIs Trend Report

Report Settings

Description Displays the trend for changes in KPI status over time, 
for selected statuses.

To access:

➤ Select Applications > Dashboard > Reports tab > KPIs 
Trend

➤ Access the KPIs Trend portlet in My BAC

Important 
Information

➤ This report is produced only for certain CIs with 
historical KPI data. For details, see “Configuration 
Items Dialog Box” on page 301.

➤ Data is displayed in the report starting from the 
point that data was collected for the selected CIs. For 
example, if you set the report to show data every 
week for the past month, but data was collected 
only for the past two weeks, the report shows data 
from two weeks ago to the present date.

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Useful Links “Configuration Items Dialog Box” on page 301

GUI Element (A-Z) Description

<Common report 
settings>

See “Common Report Elements” in Reports.

Configuration Items Displays the name of the selected CI for the report, and 
if more than one is selected, indicates the number of 
CIs that the report is based on. For example, 
Filtered (4) means that four CIs are selected for 
inclusion in the report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.
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Group by Select a radio button to determine how the data is 
organized:

➤ CIs. A separate chart is displayed for each CI, 
containing trend data for all relevant KPIs.

➤ KPIs. A separate chart is displayed for each KPI, 
containing trend data for all relevant CIs.

KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are attached 
to the selected CIs separated by a slash; for example, 
Filtered (1/3).

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: If the Application KPI is attached to any 
of the selected CIs, this KPI is selected automatically.

Statuses Indicates the number of statuses that are included in 
the report, and the seven possible statuses separated by 
a slash; for example, Filtered (5/7).

Click the Statuses link to open the Statuses dialog box 
where you can select statuses.

Default value: All statuses that are defined as 
non-critical are selected, and All Non-Critical Statuses 
is displayed. For details, see “Statuses Dialog Box” on 
page 327.

GUI Element (A-Z) Description
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Chart in report> A separate chart is displayed for each included CI, or 
for each included KPI, depending on the Group by 
filter selection. Each chart shows status trend (in 
percentage) over time, within the selected time frame 
(as long as there is relevant data for the KPI on that CI).

<Line on chart> Each line on the chart represents the status trend for a 
specific KPI on a specific CI, based on a compilation of 
all statuses selected in the Statuses filter. A legend is 
given to distinguish each KPI or CI.

The points for the line are plotted at the intervals 
defined by the report granularity (the legend for the 
x-axis shows the time interval for each point), so that 
each point represents a period of time during the 
overall time frame.

Each point shows the percentage of time that the KPI 
held all included statuses during that time interval. For 
example, if the KPI had OK status for 10% of the time 
interval, and Warning status for 20%, and both of these 
statuses are included in the Statuses filter, then both 
periods are included in the total percentage (adding 
30% to the total).

Tooltip: Hold the pointer over a point on the line to 
display a tooltip containing the following information:

➤ Status Duration. The total time that the KPI held the 
included statuses during the time interval. This can 
be given in hours, minutes, and seconds (for 
example, 01:10:48) or in days and hours (for 
example, 30 days, 9 hours).

➤ Status Percentage. Percentage of the time interval 
that the KPI held the included statuses. 

Note: When one line is on top of another, the 
information is the same for both lines.
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Statuses Dialog Box

Troubleshooting and Limitations

HP Business Availability Center records, in a reports log, errors that occur 
when generating reports. The reports log can also include information about 
the following activities: creating a new report, generating a report, 
modifying the report filter(s), drilling down in reports, and so on. For details 
about the reports log, see “Reports Log” in Reports.

Description Enables you to select the KPI statuses to be included in 
a Dashboard report, for the duration of a Web session. 
The report provides information based on the selected 
statuses.

To access: In a Dashboard report, click Statuses in the 
reports settings area.

Important 
Information

➤ You must define at least one CI for the report before 
you can select statuses. 

➤ When you first select the CIs for the report or open 
the report, the default status selection is 
automatically applied. The default selection is for all 
statuses that are defined as non-critical, meaning all 
statuses other than Critical.

You can modify the definition of non-critical 
statuses in the Infrastructure Settings page:
Select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Default 
Non-Critical Statuses entry in the Business Report 
Properties table. Modify the value to include or 
exclude the required statuses.
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KPIs 

This chapter describes how to configure KPIs.

This chapter includes:

Concepts

 ➤  KPI Configuration Overview on page 332

 ➤  How Dashboard KPIs Work on page 333

 ➤  About Business Rules on page 336

 ➤  No Data Timeout for Transaction CIs on page 339

 ➤  KPI Objectives on page 340

 ➤  Selectors for KPIs on page 350

 ➤  KPIs for User Modes on page 352

 ➤  Understanding KPI Status on page 352

 ➤  Trend and History on page 360

 ➤  Persistent Data and Historical Data on page 365

Tasks

 ➤  Configure a KPI – Workflow on page 366

 ➤  Attach KPIs to CIs and Configure the KPIs on page 373

 ➤  Edit KPI Properties on page 374

 ➤  Set Up the Real-Time Monitoring of CI Property Changes on page 380

 ➤  Define Selectors on page 382

 ➤  Set Up User Mode Functionality on page 388
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Reference

 ➤  KPIs User Interface on page 396
Concepts

KPI Configuration Overview

The Dashboard KPIs (Key Performance Indicators) provide quantifiable 
measurements that help you monitor in real-time how well your business is 
achieving its objectives. The KPIs provide real-time status for the CIs 
representing your business and processes, enabling you to assess the 
business impact of problems in the system.

Each KPI works with a predefined set of values, against which the incoming 
metrics are measured. The resulting measurement for the KPI is translated 
into a color-coded status indicator, displayed in the Dashboard Console, 
where the color represents a more desirable or less desirable condition for 
the KPI. You can learn more about KPI functionality in “How Dashboard 
KPIs Work” on page 333.

CIs can have multiple KPIs attached. KPIs can be attached to a CI as follows: 

➤ KPIs may be attached to the CI as part of the CI creation.

➤ For CIs created by the source adapters in Source Manager, all CIs are 
automatically assigned default KPIs, according to the nature of the CI. 
For example, a CI for a Business Process Monitor profile has default KPIs 
for availability and performance. You can edit a source adapter to define 
additional KPIs that you want added to the created CIs.

For more information on the source adapters and how they define the 
default KPIs, see “Source Manager Overview” in Model Management.

➤ CIs that are added manually or by Discovery and Dependency Mapping 
do not have automatically assigned KPIs. For information on how 
Discovery and Dependency Mapping creates CIs, see “Discovery and 
Dependency Mapping – Overview” in Discovery and Dependency Mapping 
Guide.

➤ KPIs may be attached to a CI as a result of propagation from child CIs. Most 
KPIs propagate up through the hierarchy, so that parent CIs have the same 
KPIs as all their child CIs.
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➤ KPIs may be manually attached to a CI in the Dashboard Administration 
KPIs tab. You may want to attach new KPIs to a CI, in addition to the 
default/propagated KPIs, to broaden the information derived from the 
monitoring measurements. For example, you can add an OT Impact KPI to 
assess the ongoing cost of an application that is not available.

In the KPIs tab, as well as attaching new KPIs to a CI, you can edit existing 
KPIs and delete attached KPIs. For details, see “KPIs Page” on page 398.

How Dashboard KPIs Work

HP Business Availability Center provides a selection of predefined KPIs to 
work with Dashboard. The definitions for the KPIs are contained in an XML 
file, which contains the default parameters for creating each KPI instance.

Note: You can edit the KPI definitions, or create customized KPIs, in the KPIs 
Repository, as described in “List of Dashboard KPIs and Their Details” in 
CI Attribute Customization.

Each CI has its own attached KPIs (that define what is being monitored for 
that specific CI). Each attached KPI generally defines:

➤ The business rule (for example, Performance rule) to be used with the 
collected metrics, to calculate a measurement for the KPI.

➤ The source for the metrics to be used for the KPI: either from data samples 
(for monitoring CIs), or from other KPIs. In the latter case, the KPI metrics 
may be taken from the child CIs (when using, for example, the Summary of 
Values rule), or from another KPI attached to the same CI (when using, for 
example, the Impact Over Time rule).

➤ The thresholds (objective values) that the KPI measurement is compared 
against; and the status (color) allocated to the KPI, based on the defined 
thresholds.

➤ Where and how to display the status indicator for the KPI in Dashboard, and 
where to store the KPI measurement.
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For most KPI types, the KPIs propagate up to all parent CIs (there are 
exceptions to this, for example, the PNR (Service Level Management) KPI). 
This means that if you attach a KPI, for example, Volume, to a child CI, then 
a Volume KPI is also added to each parent CI for that child, up to the top of 
the subtree.

Each KPI added by propagation has its own KPI instance definition, with its 
own business rule and properties. For example, the Volume KPI for a child 
CI may use the RUM Page Monitor Volume Rule, while the Volume KPI for 
the parent CI (added by propagation from the child CI) may use the Worst 
Child Rule.

The calculations required by the KPI business rule are made by the Business 
Logic Engine. When a data sample arrives on the bus and is identified (by 
means of the KPI selector) as relevant for a specific monitoring CI, the 
required metrics are passed to the relevant KPI instance for that CI, for 
example, an Availability KPI. At regular intervals (default 15 seconds) the 
Business Logic Engine recalculates the measurement for the KPI using the 
metrics received for the KPI since the last calculation.

If the new measurement causes a change in the status of the KPI, the new 
status is passed to the parent CIs. The Business Logic Engine then 
recalculates the measurement for the corresponding KPI of each parent CI, 
using the new received status information. If the new measurement causes a 
change in the status for that KPI, the new status is again passed up the 
hierarchy to the corresponding KPI instances for the parent CIs, and so on. 

You can change the default Business Logic Engine calculation time interval 
in the Infrastructure Settings page. For details, see “Change the Default 
Business Logic Engine Calculation Time Interval – Optional” on page 369.

Notes and Limitations for KPIs and CIs

➤ Any change you make to the KPIs for a CI—adding new KPIs, deleting KPIs, 
or editing KPI properties—changes the CI in the HP Universal CMDB, 
meaning that the changes are seen in any view that includes the CI.

➤ You must create at least one HP Business Availability Center profile database 
for Dashboard to receive data samples. For details, see “Profile Database 
Properties - MS SQL Server Page” in Platform Administration.
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➤ There are no restrictions on the type of KPI that can be attached to a CI, or 
on the type of business rule that you can select from the allowed rules list 
for a KPI. You must ensure that you select KPIs and business rules that are 
appropriate for the CI type.

➤ The Application KPI is only applicable for CIs corresponding to 
HP Diagnostics (and is attached automatically to HP Diagnostics CIs when 
HP Diagnostics is supported in HP Business Availability Center). For more 
information, see the HP Diagnostics User’s Guide.

➤ KPIs added to a CI as part of a SLA definition in Service Level Management 
Administration have no relevance to the Dashboard KPIs and do not appear 
in the KPIs tab. Conversely, KPIs added to a CI in the KPIs tab have no 
relevance for the CI when it is included in an SLA, and do not appear for the 
CI in Service Level Management.

➤ Deleting a KPI may impact on other KPIs that are dependent on the first KPI. 
For example, OT Impact is calculated based on the status of another KPI, 
such as Availability; in this case, deleting the Availability KPI would prevent 
calculation of OT Impact. 

➤ KPIs created for CIs by the source adapter templates frequently have 
objective values that differ from the default ones used by the business rule. 
However, when editing one of these KPIs, if you select a different rule and 
then revert to the original rule, then the original objective values are 
replaced with the rule default values.

➤ The Edit KPI for child transactions button is enabled for all KPIs, but:

➤ It is relevant Transaction and Availability KPIs (an error message is 
displayed for other KPIs).

➤ It is valid only when there are Business Process Monitor transaction CIs 
contained in the subtree. 

Changes made in the Edit KPIs for Child Transaction window have no effect 
on KPIs other than Transaction and Availability, or on CIs for which the 
option does not apply.

➤ After applying the Edit KPI for child transactions option, a KPI was saved 
successfully message is displayed in the top-right corner of the page, even if 
no changes were made to any CIs.
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➤ If a transaction CI in the subtree is using a business rule other than the 
default monitor rule for the KPI (Transaction Availability rule or Transaction 
Performance rule), then when you apply the Edit KPI for child transactions 
option, the existing rule is replaced with the default rule.

➤ The Objectives area in the Edit KPIs for Child Transaction window displays 
the default Operator for the rule. When you apply your changes, the 
displayed default operator is updated to all transaction CIs (regardless of 
which operator they were using previously).

About Business Rules

A KPI must always have an associated business rule that defines the logic to 
be performed (by the Business Logic Engine) to calculate the measurement 
for the KPI. The properties and objectives that are assigned to the KPI 
depend on the selected rule. 

HP Business Availability Center provides predefined rules for use with the 
KPIs. The rules are defined in the Business Rules Repository, where you can 
edit the rules, or create customized rules. For information on the business 
rules available in Dashboard, the roles they play, and how to edit them, see 
“List of Dashboard Business Rules” in CI Attribute Customization.

Some business rules are specific to a particular KPI, while others can be used 
for a variety of KPIs. In the KPIs Repository, each KPI has a defined default 
rule, and a list of rules that can be used with that KPI. (If required, the 
default rule and the allowed rule list can be modified.)

When a CI is created by the source adapters in Source Manager, it is assigned 
KPIs and business rules according to the adapter definitions. When a KPI is 
added manually to a CI in the KPIs tab, it is assigned the default business 
rule defined for the KPI (the default rule is usually a rule for groups). For 
example, for the RT Impact KPI, there are two applicable rules: Real Time 
Impact Rule and Sum of Values Rule. When you add a new RT Impact KPI to 
a CI, the default rule for the KPI, Sum of Values Rule, is automatically 
assigned. You can change the assigned rule when adding or editing the KPI 
in the KPIs tab, by selecting a new rule from the list of allowed rules for the 
KPI. 
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There are two categories of business rule, monitor rules and group rules, as 
described in the following sections. Most KPIs work with at least one rule 
from each category. 

This section includes the following topics:

➤ “Monitor Rules” on page 337

➤ “Group Rules” on page 338

Monitor Rules
Monitor rules (also called leaf rules) are business rules that are applied to leaf 
CIs of monitor type. Monitor rules are used to calculate a measurement for 
the KPI based on original sample data that is caught by the KPI selector. For 
example, the Availability Rule calculates the Availability KPI for BPM 
Transaction from Location CIs, based on the sample data received from 
Business Process Monitor.

A monitoring CI is intended to receive incoming metrics, generally received 
using one of the data collector, such as SiteScope, Business Process Monitor, 
or Real User Monitor. Monitoring CIs are automatically added to the 
HP Universal CMDB by the source adapters in Source Manager, according to 
the monitoring definitions. These monitoring CIs have default KPIs that use 
a monitor rule, and predefined selector.

In general, the leaf CIs in a subtree (the CIs that form the lowest level of the 
hierarchy) should always be one of the monitoring CIs. When creating new 
subtrees in your views in IT Universe Manager, you attach monitoring CIs 
created by the source adapters as leaf nodes, and these CIs then pass KPI 
status up the hierarchy.
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Group Rules
Group rules are business rules that determine KPI status based on data 
received from other KPIs, rather than from original sample data. The 
received data can come from the KPIs of child CIs, or from another KPI 
associated with the same CI.

Note: Even though this category are called group rules, some of them are also 
applicable for monitoring/leaf level CIs. For example, the Impact Over Time 
Rule (used with the OT Impact KPI) can be used with a group CI or a 
monitoring CI. What all rules in this category have in common is that their 
status calculations are contingent on data received from other KPI instances, 
rather than from the samples.

The group rules vary in the type of logic they use to arrive at a status result. 
For example:

➤ The rule may select a KPI status held by one of the child CIs, and apply that 
status to the parent, as done by the Worst Child Rule.

➤ The rule may aggregate the received data to calculate a measurement, and 
compare the measurement with defined objectives, as done by the Sum of 
Values Rule.

➤ The rule may calculate a measurement based on the status of another KPI for 
the CI, and compare the measurement with defined objectives, as done by 
the Real Time Impact Rule when receiving status from the Availability KPI.
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No Data Timeout for Transaction CIs

When a KPI is using a monitor rule (for example, the Transaction 
Availability Rule), the Business Rule Parameters area includes the No data 
timeout property. This property defines the number of seconds from the 
time the last sample was received for the KPI, until the KPI is timed out—at 
which point the KPI changes to decay status (gray). 

The default value for the No data timeout property is generally taken from 
the monitor rule definitions (as defined in the Business Rules Repository). 
However, for Business Process Monitor transaction CIs, Dashboard calculates 
a new No data timeout value, based on the schedule for running the 
transaction. The calculation takes the schedule interval (defined in End User 
Management Administration) for the business process profile that contains 
the transaction (default value = 15 minutes) and adds an additional 90 
seconds. For example, for a transaction with a schedule interval of 15 
minutes, the No data timeout value is 990 seconds. (For details on defining 
the profile schedule, see “Data Collectors Page” in Using End User 
Management.) 

This calculation method means that the timeout value is automatically 
adjusted to align with changes made to the profile schedule interval in End 
User Management Administration, so that the KPI is not incorrectly timed 
out. If there is more than one scheduling scheme in effect, the following 
rules are used for the calculation:

➤ If multiple schedules are defined for a profile running on a Business Process 
Monitor instance, the largest schedule interval is used (all schedules are 
treated equally, whether they apply to the whole week or part of the week).

➤ If the profile is assigned to several locations, each with a different schedule, 
then smallest interval from amongst the locations is used (after first 
applying the rule above).
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KPI Objectives

The KPI objectives define the standards for allocating business status to the 
KPI.

The following sections describe objectives and how to define them for a KPI.

➤ “About Status and Objectives” on page 340

➤ “Defining Logical Objectives” on page 343

➤ “Excluding Statuses” on page 344

➤ “Units of Measurement for Objectives” on page 347

➤ “Example of Defining Objectives” on page 349

About Status and Objectives
The status displayed for a KPI in Dashboard provides an indication of how 
well a business process or system is meeting your business objectives. Based 
on traffic light colors (with additions), the Dashboard shows you if the KPI 
measurement is meeting the objective requirements (green), or is critically 
failing (red), or is at some business risk level between the two. 

Five statuses are available in Dashboard (for active status), each representing 
a different level of business performance:

➤ OK (green)

➤ Warning (olive)

➤ Minor (yellow)

➤ Major (orange)

➤ Critical (red)

Depending on the CI and KPI types, active status may be represented in 
Dashboard using from two to all five of these status levels. In most cases 
(not for SiteScope measurements), the KPI is assigned a status as follows:

➤ The business rule calculates a measurement for the KPI.

➤ The calculated measurement is compared with defined objective values. 
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➤ The KPI is assigned a status according to where the measurement falls 
within the objectives. For example, a KPI measurement of 50% may fall 
within the definition for the Minor objective, so the KPI is assigned Minor 
status (yellow).

The objective values used for each KPI can originate from various sources:

➤ The business rule definitions in the Business Rules Repository provide 
default objective values for every rule that uses objectives. The business rules 
generally define different objective values for each of the five statuses used 
in Dashboard. You can define new default objective values for a business 
rule, as described in “Rule Details Dialog Box” in CI Attribute Customization.

➤ The source adapter may specify specific objective values to be used with the 
business rule for a KPI. These values override the values from the Business 
Rule Repository. You can modify the template for a source adapter to define 
custom objective values, as described in “Modify an Adapter Template” in 
Model Management.

➤ The source adapter may specify reference values for the objective 
parameters, so that the objective values are taken from the threshold values 
defined in End User Management Administration. These values override the 
values from the Business Rule Repository.

➤ You can modify the objective values for an individual KPI in the Dashboard 
Administration KPIs tab, while adding or editing a KPI. The new values 
override values from the source adapter or from the business rule. For 
details, see “No Data Timeout for Transaction CIs” on page 339. 

SiteScope Monitoring CIs

For SiteScope monitoring CIs, KPI status is based on the status received from 
SiteScope (calculated according to the thresholds defined in SiteScope). 
Three status levels are used in Dashboard: 

➤ OK (green) in Dashboard corresponds to Good or OK status in SiteScope

➤ Minor (yellow) in Dashboard corresponds to Warning status in SiteScope

➤ Critical (red) in Dashboard corresponds to Error status in SiteScope

The SiteScope status definitions cannot be changed in Dashboard, so the 
business rules for SiteScope KPIs do not include objective values.
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End User Monitoring CIs 

For end user monitoring CIs (from Business Process Monitor, Real User 
Monitor), KPI status is calculated by comparing the KPI measurement with 
objective values.

➤ For Business Process Monitor transaction CIs, the KPI objective values are 
either taken from End User Management Administration or the rule 
definition: 

➤ For CIs using the Transaction Performance Rule (ID# 13), the Business 
Process Monitoring source adapter references the transaction thresholds 
defined for the corresponding monitoring object in End User 
Management Administration. The threshold values map to KPI objective 
values for three status levels in Dashboard: OK, Minor, and Critical.

➤ For CIs using the Transaction Availability Rule (ID# 5), KPI objectives are 
taken from the default values for the rule in the Business Rules 
Repository. The rule defines objective values for all five status levels in 
Dashboard.

➤ For Real User Monitor monitoring CIs, depending on the rule used, the KPI 
objective values are taken from the Real User Monitor source adapter, End 
User Management Administration, or the rule definition. For example:

➤ For RUM Application Error Monitor CIs using the RUM Event Monitor 
Volume Rule (ID# 73), the objective values are defined directly in the 
source adapter. The objective values defined for this rule use four of the 
Dashboard status levels: OK, Warning, Minor, and Critical.

➤ For RUM Page Monitor CIs using the RUM Page Monitor Availability Rule 
(ID# 49), the source adapter references the Availability threshold defined 
in End User Management Administration for the page. This is a single 
value, so two status levels are used in Dashboard: OK and Critical.

➤ For RUM Sessions Monitor CIs using the RUM Session Monitor 
Availability Rule (ID# 52), the source adapter does not define objective 
values, so KPI objectives are taken from the default values for the rule in 
the Business Rules Repository. The rule defines objective values for three 
Dashboard status levels: OK, Minor, and Critical.
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For all end user monitoring CIs, you can edit the objective values in the KPIs 
tab to use as many of the status levels as you require, as described in 
“Defining Logical Objectives” on page 343.

Warning: KPIs created for CIs by the source adapter templates, frequently 
have objective values that differ from the default ones used by the business 
rule. However, when editing one of these KPIs in the KPIs tab, if you select a 
different rule and then revert to the original rule, the original objective 
values are replaced with the rule default values.

Defining Logical Objectives
The objectives values for a KPI should cover the whole spectrum of possible 
measurements for that KPI. (This means active measurements, the objectives 
do not take into consideration the values given to a KPI for no data, 
downtime, and so on.) 

The KPI measurement is evaluated against each objective level, starting from 
OK (green), and continuing (in order) to Critical (red). This process stops at 
the first objective level into which the KPI measurement fits. 

To define where the boundaries of each objective level falls, each objective 
from OK to Major is associated with an Operator. (The Critical objective 
definition is always Otherwise, meaning that this status is applied to all 
measurements that fall beyond the Major objective limit.) You can select the 
operator that matches your requirements; the same operator is applied to all 
objective levels.

The available operators are:

> 
>=
<
<=
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You must ensure that the objectives contain logical values (according to the 
data type) and are correctly ordered, and that the operator is logical for the 
order. For example:

➤ If you enter descending objective values, such as 70, 55, 40, 20, you must use 
operator > or >=, so that the OK objective covers all measurements greater 
than 70. 
For a KPI measurement of 88: 88 >= 70 is true, so assigned status is OK.
For a KPI measurement of 18: evaluation of the KPI measurement against 
every objective is false, so status falls into the Otherwise category and be 
assigned status Critical.

➤ If you enter ascending objective values, such as 10, 25, 35, 40, you must use 
operator < or <=, so that the OK objective covers all measurements less 
than 10.
For a KPI measurement of 7: 7 <= 10 is true, so assigned status is OK.
For a KPI measurement of 50: evaluation of the KPI measurement against 
every objective is false, so status falls into the Otherwise category and be 
assigned status Critical.

Excluding Statuses
Not all the statuses need be used for a KPI; for example, the OT Impact KPI 
by default uses only OK (green) and Critical (red) status. There are two 
methods used in Dashboard to exclude statuses, as described in the 
following sections.
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Blank Objective Value

When the objective value for a status is left blank, Dashboard ignores that 
status during KPI status calculation. For example, the Performance KPI for a 
transaction may have the following objectives defined (taken from the 
threshold settings for the transaction in End User Management 
Administration):

In this case, if the measurement for the KPI does not fall into the OK 
objective level, then Warning is skipped and the measurement is evaluated 
against the Minor objective level. If it does not fall into that level, Major is 
also skipped, and the KPI is assigned Critical status.

If you want to exclude statuses when editing the objective values for a KPI, it 
is recommended that you use this method.

Repeated Objective Value

Dashboard allocates status by starting at OK status, and evaluating the KPI 
measurement against each objective level until the right level is found. 
When an objective value is repeated for two or more statuses, the repeat 
occurrences are passed over and those statuses are not used. 
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For example, the Availability KPI for a RUM page monitor may have the 
following objectives defined (by using the Availability threshold setting in 
End User Management Administration for all four defined objective values):

In this case, if the measurement for the KPI is greater or equal to 98%, then 
it is given OK status. If it is less than 98%, then evaluation against the 
Warning, Minor, and Major statuses also does not give any result and these 
statuses are not used; the KPI is then assigned Critical status.

Example of Defining Objectives

A specific transaction monitor CI is using the Transaction Performance Rule. 
For this transaction, the required objectives are as follows:

➤ The objective for acceptable performance time is under 6000 milliseconds. 
An average performance time that reaches 6000 milliseconds is already of 
concern.

➤ Performance time of 8000 milliseconds is considered seriously problematic.

➤ Performance time of 10000 milliseconds is considered critical.

In addition, Warning status is not required for this KPI.
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In the Edit KPI window for the transaction’s Performance KPI, the objective 
levels and operator are modified as follows:

When a measurement is calculated for the KPI from the incoming 
performance data, the measurement is compared with the objectives 
assigned to the KPI as follows:

➤ For a measurement under 6000 milliseconds, status = OK

➤ For a measurement of 6000 milliseconds or more, but under 8000 
milliseconds, status = Minor

➤ For a measurement of 8000 milliseconds or more, but under 10000 
milliseconds, status = Major

➤ For a measurement of 10000 milliseconds or more, status = Critical

Units of Measurement for Objectives
The objectives use a unit of measurement, shown after the objective value 
box in the KPI Objectives area:
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The unit is part of the business rule definition, and indicates the format of 
the calculated measurement. This format may reflect the units used by the 
incoming data (for example, milliseconds for performance time data), or it 
may be a new format applied as a result of the business rule calculations (for 
example, dollars for a financial loss calculation). If required, the default unit 
for a rule can be changed in the rule definition (as described in “Rule Details 
Dialog Box” in CI Attribute Customization).

The following default units are used:

Default Unit (A-Z) Description

<No unit> is displayed after the objective value box for 
business rules that handle volume, where the KPI 
measurement represents a simple numerical count. 
For example, this is the case for the RUM 
Transaction Monitor Volume Rule.

Financial ($) This unit is used for business rules that determine 
financial loss for a CI, for example, the Impact Over 
Time Rule.

Milliseconds or Seconds This unit is used for business rules that handle 
performance time data for a transaction or monitor, 
for example, the Transaction Performance Rule or 
RUM Page Monitor Performance Rule.

Percentage (%) This unit is used for business rules that handle 
availability over time data for a transaction, for 
example, the Transaction Availability Rule, and for 
the PNR Rule, where the KPI measurement 
represents percentage of time remaining for CI 
unavailability before the SLA is in breach of 
contract.
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Example of Defining Objectives
A specific transaction monitor CI is using the Transaction Performance Rule. 
For this transaction, the required objectives are as follows:

➤ The objective for acceptable performance time is under 6000 milliseconds. 
An average performance time that reaches 6000 milliseconds is already of 
concern.

➤ Performance time of 8000 milliseconds is considered seriously problematic.

➤ Performance time of 10000 milliseconds is considered critical.

In addition, Warning status is not required for this KPI.

In the Edit KPI window for the transaction’s Performance KPI, the objective 
levels and operator are modified as follows:

When a measurement is calculated for the KPI from the incoming 
performance data, the measurement is compared with the objectives 
assigned to the KPI as follows:

➤ For a measurement under 6000 milliseconds, status = OK

➤ For a measurement of 6000 milliseconds or more, but under 8000 
milliseconds, status = Minor

➤ For a measurement of 8000 milliseconds or more, but under 10000 
milliseconds, status = Major

➤ For a measurement of 10000 milliseconds or more, status = Critical
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Selectors for KPIs

Monitoring CIs are CIs that are intended to receive real-time data from the 
data samples sent by the external system (purely logical CIs do not receive 
data samples). The data samples, containing information collected by a 
monitoring system (either HP or third-party), are supplied to HP Business 
Availability Center over the bus.

When a monitoring (leaf) CI has a KPI and associated business rule that are 
intended to be applied to actual data samples, the KPI properties include a 
selector. A selector is a filter definition that defines which samples are 
relevant for the KPI.

The Business Logic Engine filters the data samples arriving on the bus using 
selectors, which are set using Dashboard Administration. A selector is 
defined as part of the monitor rule for a KPI attached to a monitoring CI. 
The selector identifies and catches the data that is relevant for the CI and 
the KPI.

A different selector can be used by each KPI with an associated monitor rule, 
enabling (when required) the use of different samples for each KPI. 

You can define selectors as explained in the following sections:

Monitoring CI in HP Universal CMDB
When a monitoring CI is added to the HP Universal CMDB by a monitoring 
adapter, a selector is automatically defined for each of the default KPIs for 
the CI. For details, see “Predefined Monitoring Service Views” in Model 
Management.

Dynamic Node Factory CIs
The selector is defined directly as part of the CI definition, not in a KPI. The 
selector used by a Dynamic Node Factory can be defined and/or edited in 
the IT Universe Manager tab of CMDB Administration, as described in 
“Working with Dynamic Node Factory Overview” in Model Management. The 
functionality and definitions for a Dynamic Node Factory selector are the 
same as for a KPI selector, as described in this section.
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KPI Assignments
You can create or customize a KPI assignment rule for each CI type. An 
assignment rule includes a condition and a task. The condition describes 
specific characteristics of a CI. The task describes the context menus, KPIs, 
rules, rule parameters, and selectors that are to be assigned automatically to 
the CI when the condition occurs, if the assignment is running. For details, 
see “Define Assignment Configuration Dialog Box” on page 440.

EMS
The mechanism used to integrate EMS (Enterprise Management Systems) 
software into HP Business Availability Center, includes an assignment rule 
mechanism. The assignment rule mechanism is triggered when a specific 
monitor CI attribute is updated. An assignment rule includes a condition 
and a task. The condition describes specific characteristics of a CI. The task 
describes the context menus, KPIs, rules, rule parameters, and selectors that 
are to be assigned automatically to the CI when the condition occurs, if the 
assignment is running. The task description includes a selector. For details, 
see “Define Assignment Configuration Dialog Box” in Solutions and 
Integrations.

Source Adapters
For information on editing selector definitions in the source adapters, see 
“Define Selectors” in Model Management.

KPI Definition in Dashboard
If required, you can edit the default KPI selectors in the KPIs tab. You can 
also attach new KPIs to a monitoring CI, assign a monitor rule and manually 
define the selector. For more information about defining selectors, see 
“Define Selectors” on page 382, “Set Up User Mode Functionality” on 
page 388, or “Set Up User Mode Functionality” on page 388.
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KPIs for User Modes

HP Business Availability Center provides the option to define Dashboard 
KPIs for two different user types (modes): operations and business. This 
option enables the creation of two versions of a single KPI, where each KPI 
version is geared towards the particular viewing requirements of one of the 
user types.

For example: You might want to create two versions of the Availability KPI, 
so that the Availability KPI for an operations user shows Critical status (red) 
when transaction availability is below 30%, and the Availability KPI for a 
business user shows Critical status when transaction availability is below 
20%.

Each user type sees the appropriate version of the KPI in the Dashboard 
views.

Understanding KPI Status

For each CI, Dashboard displays real-time status in one or more KPI columns 
in the view. 

Each KPI can include three icons: Status, Trend, and History.

A color-coded icon (LED) is displayed for each KPI in a view, representing 
the status assigned to that component for its current performance level. In 
addition to the main status icon for a KPI, the KPI column can contain 
additional icons showing trend and history for the CI under that KPI. 
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The status of a KPI in Dashboard provides an indication of how well a 
business process or system is meeting your business objectives. Based on 
traffic light colors (with additions), the Dashboard shows you whether the 
KPI measurement is meeting the objective requirements (green), is critically 
failing (red), or is at some business risk level between the two (olive, yellow, 
orange). For more details about objectives, see “KPI Objectives” on page 340. 

The status of each KPI is calculated using a business rule. A different 
business rule may be used for a parent CI and a child CI with the same KPI 
attached. The business rules are defined for the KPI in Dashboard 
Administration. For details on the rules, see “List of Dashboard Business 
Rules” in CI Attribute Customization.

This section includes the following topics:

➤ “Types of CIs” on page 353

➤ “Colors of KPI Statuses Used in Dashboard” on page 354

➤ “Status Scores” on page 356

➤ “Stopped/Downtime Status” on page 357

➤ “Statuses and Group Rules” on page 358

➤ “Influence of Must and Weight on Status” on page 359

Types of CIs
There are two types of CIs whose status is calculated differently:

➤ Monitor CI. Monitor CIs receive real data from data samples. These data 
samples are used to calculate the status of the KPIs attached to the monitor 
CIs.

The foundation of status definition for all monitor CIs is a comparison of 
performance metrics with objective values. 

➤ Group CI Status. For group CIs (all CIs except monitor CIs), Dashboard 
displays a status icon that represents a "summary" of the status for the child 
components (that is, the CIs that belong to the lower level in the 
hierarchical structure). 
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The Details tooltip for each status icon provides some information regarding 
the calculation method in use for the KPI. For details, see 
“Stopped/Downtime Status” on page 357.

Note: The color displayed for a CI icon in Dashboard represents a summary 
of interim status values for a predefined duration (the default duration value 
is generally 300 seconds). The calculation of status values is an ongoing 
process, using samples collected every 60 seconds (default granularity 
value), thus the interim status may actually change several times over the 
duration without causing any change in the color of the icon. For example, 
if the icon for a transaction is red at the beginning of a duration, and during 
the duration the interim status changes from red to green and back to red, at 
the end of the duration the icon is still red.

Colors of KPI Statuses Used in Dashboard
The following shows the main status levels that are used to show status for 
KPIs in Dashboard (note that some of the Dashboard KPIs use text in place 
of icons, but use the same color coding to indicate status as shown here):

Icon Description Status Name
Numerical 
Code

Definition

Red with 
attached "X"

Critical 0 The measurement calculated for 
the KPI fell within the value 
range for the Critical objective.

Orange with 
attached 
exclamation 
marks

Major 5 The measurement calculated for 
the KPI fell within the value 
range for the Major objective.

Yellow with 
attached 
exclamation 
mark

Minor 10 The measurement calculated for 
the KPI fell within the value 
range for the Minor objective.
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Olive with 
attached tilda

Warning 15 The measurement calculated for 
the KPI fell within the value 
range for the Warning objective.

Green OK 20 The measurement calculated for 
the KPI fell within the value 
range for the OK objective.

Blue with 
attached i

Info -1 The KPI has a value and no 
status. The reason is that the 
KPI’s objectives have not yet 
been specified. For details about 
setting the objectives, see 
“Objectives Area” on page 410.

Gray with 
attached dash

Not up to 
date (Decay)

-2 The following cases might be the 
cause of the KPI’s status:

➤ The KPI has passed a timeout 
period during which no new 
information has been 
received.

The default timeout period is 
15 minutes, and the default 
decay status color is gray.

➤ No performance measurement 
data has yet been received for 
this KPI. This may be the case 
if no measurements have been 
taken for the CI in the period 
since starting Dashboard or 
Business Process Monitor.

Icon Description Status Name
Numerical 
Code

Definition
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Note: 

➤ The numerical code is used in HP Business Availability Center files to 
perform calculation instead of the corresponding status.

➤ To change the color of the icons used at each status level, you can 
customize some of the icons, or complete sets of icons. For details, see 
“Change the KPI Status Icons” in CI Attribute Customization.

➤ Change icons indicate when a change was made to a specific static 
attribute of a specific CI in the HP Universal CMDB. For details, see “Real-
Time Changes to CI Properties” on page 23.

For Trend and History status, see “Trend and History” on page 360.

Status Scores
Real-time statuses can be:

Gray with 
attached dash 
and green 
outline

Stopped or 
Downtime

-3 
(Stopped) 
-4 
(Downtim
e)

The corresponding 
profile/group/monitor for the CI 
is currently disabled. For details, 
see “Stopped/Downtime Status” 
on page 357.

Gray with white 
center

Not 
applicable 
for this CI

N/A This KPI is not applicable for the 
CI.

0 worst

5 bad

10 middle

15 good

20 best

Icon Description Status Name
Numerical 
Code

Definition
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In most rules, only the main three statuses (0, 10 and 20) are used.

When a score has been calculated from more than one value, the scores are 
assigned status using the following definitions:

➤ 0 = worst

➤ 0 < score < 7.5 = bad

➤ 7.5 to 12.5 (inclusive) = middle

➤ 12.5 < score < 20 = good

➤ 20 = best

They are then assigned the colors:

Note: Only relevant statuses (0-20) are taking into consideration ("gray " 
statuses are ignored).

Stopped/Downtime Status
If a monitor in SiteScope or Business Process Monitor is stopped (disabled 
indefinitely) or in downtime (disabled for a scheduled time period), 
Dashboard displays a Stopped/Downtime status icon for the corresponding 
CIs (gray with a green outline). 

worst red

bad orange

middle yellow

good olive

best green
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When the downtime or stopped period finishes, the status icon changes to 
No Data until data is received for the CI.

You can determine whether the CI is stopped or in downtime by holding the 
cursor over the Stopped/Downtime icon for the CI. The displayed Details 
tooltip gives the CI status, the rule used to calculate the result, and, if the CI 
is in downtime, to give the date and time when downtime finishes.

In the Top View tab, the icon for a Stopped or Downtime status CI is shown 
in gray with a green border.

Statuses and Group Rules
Some group rules select the worst or best status for child CIs according to 
the following groups:

There is a priority between the groups. The first group of statuses has the 
highest priority, the second group the second priority and the third one the 
last priority. 

The child CIs of a specific CI may have statuses in different status groups. 
The status of the parent CI is taken from the group with the highest priority. 
The statuses of the child CIs in the other groups are not taken into 
consideration. 

Groups Statuses

first group OK, Warning, Minor, Major, Critical

second group Info

third group No Data, Downtime, Stopped
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For example:

➤ The child CIs of a specific CI have the Critical, Info statuses; the status for 
the parent CI, when calculated using the Worst Child rule is: Critical. 

➤ The child CIs of a specific CI have the Critical, Warning, and No Data 
statuses; the status for the parent CI, calculated using the Worst Child rule 
is: Critical. 

Influence of Must and Weight on Status
When Must and Weight properties have been defined for the relationship 
between a parent CI and a child CI, these properties have an impact on the 
status calculations for the KPIs of the parent CI.

Must and Weight can be used to qualify a relationship. Weight is used for 
weighted percentage status calculations. Must is used for dominant child 
status calculations.

The dominant and/or weight information affects only the status of the 
group to which this CI belongs, and does not affect the status of the CI 
itself. The status of a group CI is based on its child CIs, and the status of a 
monitor CI is based on the information received from the monitoring 
source. 

For more details about Weight and Must, see “Understanding the Percentage 
Rule” in CI Attribute Customization.
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Trend and History

The following status levels are used to show historical and trend status for 
monitor CIs in Dashboard:

The trend status has three positions: up, down, and no change. It shows the 
trend of the real-time status.

The history status can display the worst status or the average status over a 
time period. 

Icon Description Status Status Definition

Small gray 
downward 
arrow

Downward 
trend

Real-time status shows a downward 
trend.

Small gray 
double-sided 
arrow

Stable trend Real-time status shows a stable trend. 

Small gray 
upward 
arrow

Upward trend Real-time status shows an upward 
trend. 

Small green 
with 
attached 
checkmark

Historical OK All performance measurements fell 
within the OK objective level over a 
time period up to the present.

Small yellow 
with 
attached 
exclamation 
mark

Historical 
Warning

At least one performance 
measurement fell within the 
Warning objective level, but no 
measurements fell within the Critical 
objective level, over a time period up 
to the present.

Small red 
with 
attached "X"

Historical 
Critical

At least one performance 
measurement fell within the Critical 
objective level, over a time period up 
to the present.
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Note: No history or trend status is displayed for a CI if there is no relevant 
data, for example, if it is uninitialized or stopped, or if it is not relevant for 
the KPI.

Move the mouse over the Trend icon to display the name of the trend, the 
name of the CI, and the trend of the KPI in the selected time period. For 
details about the tooltip, see “Trend” in CI Attribute Customization.

Move the mouse over the History icon to display the name of the KPI, the 
name of the CI, and the type of history used when calculating the history 
status, and the worst or average status of the KPI in the selected time period. 
For details about the tooltip, see “History” in CI Attribute Customization.

For more information on how to customize your trend and history statuses 
and explanations about how those statuses are calculated, see 
“Understanding KPI Status” in CI Attribute Customization.

You can customize the set of Trend and History icons. For details, see 
“Change the KPI Status Icons” in CI Attribute Customization.

Note: If a transaction in an HP Virtual User Generator script is renamed, 
Business Availability Center considers it as a new transaction. A new BPM 
Transaction from Location CI is created in the CMDB using the new name, 
and the CI with the old transaction name is removed after it stops receiving 
samples. In Dashboard, the new CI does not display trend and history status 
data from before the transaction name change.
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The way the trend and history status is determined is described in the 
following sections:

➤ “History Calculation” on page 362

➤ “Trend Calculation” on page 363

➤ “Modifying the Trend and History Status Calculations” on page 363

➤ “Hidden Parameters” on page 364

History Calculation
The history status icon displays either the worst status or the average status 
for the CI’s KPI during a specified time period. 

The calculation method for history status is determined by the value set for 
the HistoryType parameter (one of the global parameters in the Business 
Rules Repository, described in “List of Dashboard Business Rules” on 
page 164). The possible calculation methods are Worst (default value) or 
Average. Whichever calculation method is used, only status scores that have 
meaning (scores 0 to 20—the non-gray icons) are taken into consideration.

➤ Worst. Takes the worst status over the period of time specified in the 
HistorySize parameter (also one of the global parameters).

For example: if HistorySize is 60 minutes (default value) and the KPI’s values 
for the last 60 minutes are: 10, 10, 5, 0, -2, 20, the worst status is 0, so the 
history icon is red.

➤ Average. Takes the average status over the period of time specified in the 
HistorySize parameter (Simple Moving Average). The calculation result is 
rounded to the nearest of the following values: 0, 5, 10, 15, or 20. 

For example: if HistorySize is 60 minutes and the KPI’s values for the last 60 
minutes are: 10, 10, 5, 0, -2, 20, the Average status is 10 (rounded from 
(10+10+5+0+20)/5=9), so the history icon is yellow.
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Trend Calculation
The trend status icon shows the trend in real-time status for the CI KPI, 
using three directions: up, down, and no change.

Trend analysis is performed by comparing the Simple Moving Average 
(SMA) value for a long window with the SMA for a short window. If the 
short window SMA is higher than the long window SMA, the trend is 
considered to be up. If the long window SMA is higher, the trend is 
considered to be down. The SMA is calculated only on status scores that 
have meaning (scores 0 to 20—the non-gray icons).

➤ Long window SMA. Based on the mean status of a KPI over the period of 
time specified in the HistorySize parameter (default = 60 minutes), one of 
the global parameters in the Business Rules Repository, described in “List of 
Dashboard Business Rules” on page 164.

➤ Short window SMA. Based on the mean status of a KPI over the period of 
time defined by (TrendRate * HistorySize). The TrendRate parameter 
(default = 0.3) represents the time rate between the long and short window, 
and is defined in the hidden parameters described in “Modifying the Trend 
and History Status Calculations” on page 363.

Modifying the Trend and History Status Calculations
You can modify the way the trend and history statuses are calculated and 
displayed, by editing certain rule parameters. A rule parameter can be set in 
three places: 

➤ As part of the global rule parameters that apply to all rules and affect all CIs. 
For details on editing global parameters, see “Global Attributes Dialog Box” 
in CI Attribute Customization.

➤ Directly for a rule, so that it affects all CIs that use this rule. For details on 
editing rule parameters, see “Rule Details Dialog Box” in CI Attribute 
Customization.

Some parameters for trend and history statuses are predefined and can be 
viewed and edited in the Business Rules Repository page; others are hidden, 
but can be manually added on the Repositories tab if you want to override 
the parameter default value. 
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Hidden Parameters
The history and trend statuses use the following hidden parameters. These 
are parameters with default values that are not visible to the user. However, 
if necessary, they can be overridden by defining the parameter in the global 
parameters for the Business Rules Repository (described in “Global 
Attributes Dialog Box” in CI Attribute Customization).

The CalculationGranularity parameter determines how many calculations 
are performed for a CI in a certain period of time. During normal 
functioning, Dashboard or Service Level Management perform the 
calculation approximately every 20 seconds (~180 calculations/hour). If 
Dashboard or Service Level Management is running without a problem, 
there is no reason to change the default value.

If Dashboard or Service Level Management has a heavy calculation load, 
causing the calculations to take more time, Dashboard or Service Level 
Management might automatically adjust the granularity to calculate less 
often. For example, calculation may take place every minute or more, 
meaning 60 or less calculations an hour. If this is a problem, you can define 
the CalculationGranularity parameter above, to override the automatic 
granularity rate; however, this modification should be made with great 
caution, and only by advanced users. Contact HP Software Support for 
assistance.

Name Default 
Value

Description

TrendRate 0.3 Sets the time rate between the long window 
(period of time defined by the HistorySize 
parameter) and a short window.

CalculationGranularity 20 Sets the time difference, in seconds, between 
recalculating statuses for a view. This 
knowledge is shown in <HP Business 
Availability Center root directory>
\log\EJBcontainer\TrinityStatistic.log.
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Note: If the CalculationGranularity parameter is not changed when there is a 
heavy calculation load, this does not cause wrong results, but note that 
calculations are done on a longer time scale (for example, calculation may 
be done on a history size of three hours instead of one hour).

Persistent Data and Historical Data

A KPI whose data is persistent is attached to a CI whose Save KPI data over 
time for this CI option has been selected. For details, see “KPIs Page” on 
page 398. This option is selected by default for Business Process, Line of 
Business, and Monitor Application CIs. This option is not available for 
Monitor type CIs.

For each CI with the Save historical data for this CI option, the following 
information is stored in the database:

➤ Every status change for each KPI

➤ The current calculated value for each KPI, read at regular time intervals (the 
default time interval is 15 minutes)

When the option is first selected, the current status for all of the CI KPIs is 
written to the database. As long as the settings remain the same, each time 
there is a change in status for one of the CI’s KPIs (for example, from Critical 
to OK), the status change is written to the database.

Note: Saving historical data for long periods of time or for many CIs and 
KPIs can require a lot of database memory, so this option should be used 
with care. When you no longer require data to be saved for a CI, clear the 
Save historical data for this CI check box for that CI.

This capability is used in the Dashboard reports. For details, see “Dashboard 
Reports” on page 295.

Tasks
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Configure a KPI – Workflow

This section describes the processes for the main task flow used to configure 
KPIs, and gives examples.

Configure a KPI using the steps described in this section.

This task includes the following steps:

➤ “Define or Edit KPIs” on page 366

➤ “Set Up the User Mode for the KPI – Optional” on page 366

➤ “Attach KPIs to CIs” on page 367

➤ “Change the Default Business Logic Engine Calculation Time Interval – 
Optional” on page 369

➤ “Change the No Data Timeout Value for Transaction CIs – Optional” on 
page 369

➤ “Modify the Number of CIs Monitored for Change in Real-Time” on 
page 370

➤ “Monitor CI Property Changes in Real-Time” on page 371

➤ “View the Result in Dashboard” on page 371

 1 Define or Edit KPIs
You can globally define or edit a KPI. For details, see “KPIs Repository Page” 
in CI Attribute Customization.

You can edit a specific KPI. For details, see “KPI Details Dialog Box” in 
CI Attribute Customization.

 2 Set Up the User Mode for the KPI – Optional
HP Business Availability Center provides the option to define Dashboard 
KPIs for two different user types (modes): operations and business. This 
option enables the creation of two versions of a single KPI, where each KPI 
version is geared towards the particular viewing requirements of one of the 
user types. For details, see “KPIs for User Modes” on page 352.

For details about the User Mode functionality, see “Set Up User Mode 
Functionality” on page 388.
366



Chapter 11 • KPIs
Example

For a detailed example, see “Example – Scenario of KPI Versions for User 
Modes” on page 391.

 3 Attach KPIs to CIs
You can attach additional KPIs to any CI. You can attach one of the default 
KPIs provided with HP Business Availability Center, or attach a KPI that you 
defined in the KPIs repository. 

For details about attaching a KPI to a CI, see “Attach KPIs to CIs and 
Configure the KPIs” on page 373.

If you have set a version for a KPI, manually attach the KPI versions to the 
CIs to which you want them to apply. For details, see “Attach KPI Versions 
to CIs” on page 390.

Example – Attaching a PNR KPI to a CI

The PNR (Point of No Return) KPI enables you to view how well agreement 
objectives are being met. When the PNR KPI is defined for a CI, a bar is 
displayed in Dashboard indicating how much more time (in percentages) 
the CI can be unavailable before the agreement is in breach of contract. For 
an explanation of unavailability, see “Dashboard PNR Rule” on page 180.

Perform the following procedure to view Service Level Management data in 
an information bar in Dashboard.

Proceed as follows to set up Dashboard to display Service Level Management 
data in Dashboard:

 a Create an agreement. For details, see “Agreement Wizard” in Using Service 
Level Management.

The agreement must include a CI with an attached Availability KPI 
and/or a System Availability KPI, for the Dashboard PNR KPI to show 
data in reports. If both KPIs are attached to the CI, the PNR KPI is 
calculated by using only the Availability KPI. If only the System 
Availability KPI is attached to the CI, the PNK KPI is calculated using the 
System Availability KPI.
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 b In Dashboard Administration, attach a PNR KPI to the same CI. For 
details on attaching a KPI, see “No Data Timeout for Transaction CIs” on 
page 339. During KPI creation: 

➤ Choose the PNR KPI.

➤ Select the agreement whose data is to be displayed in Dashboard.

➤ Select the calendar and tracking period. These parameters are defined 
when creating the agreement. For details, see “Define Agreement 
Properties Page” in Using Service Level Management.

➤ Add the objective’s ranges that Dashboard uses to calculate when 
unavailability time approaches breach of contract levels.
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 c View the results in Dashboard: Applications > Dashboard > Console. 
Choose the view and select the CI.

For details on the information that Dashboard displays in the Console 
page, see “Service Level Management Results in the Console Page” on 
page 120.

 4 Change the Default Business Logic Engine Calculation Time 
Interval – Optional
You can change the default Business Logic Engine calculation time interval 
in the Infrastructure Settings page. 

Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
click Foundations, select Online Business Logic Engine, and locate the 
Model calculation interval entry in the Calculation Related Settings table. 
Edit the value as required.

 5 Change the No Data Timeout Value for Transaction CIs – 
Optional
When a KPI is using a monitor rule (for example, the Transaction 
Availability Rule), the Business Rule Parameters area includes the No data 
timeout property. This property defines the number of seconds from the 
time the last sample was received for the KPI, until the KPI is timed out—at 
which point the KPI changes to decay status (gray). For details, see “No Data 
Timeout for Transaction CIs” on page 339.
369



Chapter 11 • KPIs
 6 Modify the Number of CIs Monitored for Change in Real-Time
For a limited number of CIs, Dashboard can monitor for changes to the CI 
properties (or changes to the properties of the CI’s child CIs) in real-time. 

This information is in addition to the Dashboard Change Report, which 
shows a historical report on changes to properties for CIs over a period of 
time. (For details on the Change Report, see “Change Report Page” in Model 
Management.)

For details on where to set the Monitor changes check box see “KPIs Page” 
on page 398. 

You can set the monitor changes option for up to 20 CIs. Once 20 CIs have 
been configured, a message is displayed when you try to set the option for 
another CI, stating that the limit has been reached.

If you then clear the option for one or more of the configured CIs, the 
option becomes available again for all CIs, until the 20 CIs limit is again 
reached.

Note: To change the 20 limit, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Application, and locate the Maximum monitored CIs entry in the Change 
Impact Properties table. Modify the value as required. However, change this 
value with caution to avoid too much load on the system.

When the monitor changes option has been set for a CI, Dashboard 
continuously monitors that CI and all its child CIs, to see if a change occurs 
in one of the significant properties defined for the CIs.

The significant properties vary for each CIT, according to the CIT definition 
in Admin > CMDB > CI Type Manager. In CI Type Manager, in the Attributes 
tab for the CIT, the Change Monitored column must be selected for a 
property, in order for that property to be significant and therefore 
monitored. For more information on CIT definitions, see “CI Type 
Manager” in CI Attribute Customization.
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If a change occurs in one of the significant properties for the CI or the CI 
children, an icon is displayed in Dashboard beside the CI name. For more 
information, see “Real-Time Changes to CI Properties” on page 23.

After a change occurs, the change icon is displayed for 24 hours (default 
value). You can change the default value, as described in “Customize the 
Change Period” on page 41.

 7 Monitor CI Property Changes in Real-Time
For a limited number of CIs, Dashboard can monitor for changes to the CI 
properties (or changes to the properties of the CI’s child CIs) in real-time. 
For details, see “Attach KPI Versions to CIs” on page 390.

This information is in addition to the Dashboard Change Report, which 
shows a historical report on changes to properties for CIs over a period of 
time. For details, see “Change Report Page” in Model Management.

 8 View the Result in Dashboard
If you have defined user modes for a KPI, each user type sees in Dashboard 
the appropriate KPI version for their assigned user mode (operations or 
business user), for all KPIs that are defined as specific to a user mode. Users 
who are not assigned a user mode (undefined) see KPIs for both modes, as 
do system administrators:
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In the Geographical Map and Custom Map tabs, status at a location is based 
on whichever KPI versions the user sees in Dashboard:
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Attach KPIs to CIs and Configure the KPIs

You can attach additional KPIs to any CI. You can attach one of the default 
KPIs provided with HP Business Availability Center, or attach a KPI that you 
defined in the KPIs repository. For details about the KPI repository, see “KPIs 
Repository” in CI Attribute Customization.

This task includes the following steps:

➤ “Attach a KPI to One or More CIs” on page 373

➤ “Define the KPI Objectives” on page 374

➤ “Define the KPI Selector” on page 374

 1 Attach a KPI to One or More CIs
There can be only one instance of each KPI for a CI. Dashboard 
Administration also gives you the option of attaching a KPI to multiple CIs. 
The KPI is added to all CIs that do not already have that KPI attached. All 
instances of the KPI have the same defined business rule and properties. 

For information on KPI functionality, see “How Dashboard KPIs Work” on 
page 333.

For details about attaching a new KPI to a single CI or to multiple CIs, see 
“How Dashboard KPIs Work” on page 333.

For each new KPI, define the KPI type and business rule. Where relevant, 
also define additional information required by the rule. Attaching a new KPI 
to a CI, and defining the KPI properties, must be undertaken with care; these 
actions can result in KPIs that give an inaccurate performance assessment in 
Dashboard. Please read the notes and limitations before proceeding. For 
details, see “Notes and Limitations for KPIs and CIs” on page 334.
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 2 Define the KPI Objectives
Dashboard uses objectives to calculate the status of a KPI. You can modify 
the objectives of a specific KPI. For details, see the Objectives area in “New 
KPI/Add KPI to Multiple CIs/Edit KPI/Edit KPI for Child Transaction Dialog 
Box” on page 406.

 3 Define the KPI Selector
Use selectors to filter the samples relevant for the KPI. For details, see 
“Define Selectors” on page 382.

Edit KPI Properties

You can edit KPI properties for individual KPIs in the Edit KPI window. You 
can also perform a multiple edit on certain KPI properties for transaction 
CIs.

Editing KPI properties must be undertaken with care; the changes can result 
in KPIs that give an inaccurate performance assessment in Dashboard. Read 
notes and limitations before proceeding. For details, see “Notes and 
Limitations for KPIs and CIs” on page 334.

This task includes the following steps:

➤ “Edit a KPI Properties” on page 374

➤ “Edit the KPI Properties for Multiple Transaction CIs” on page 375

 1 Edit a KPI Properties
You can modify all properties for a defined KPI (apart from the KPI type), 
whether it is a default KPI for the CI, or a KPI attached by a user.

For details, see “How Dashboard KPIs Work” on page 333.
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 2 Edit the KPI Properties for Multiple Transaction CIs
The KPIs tab has a multiple edit function, enabling you to modify the 
Availability or Performance KPIs for all BPM Transaction from Location CIs 
in a group. This function enables you to define new business rule parameter 
values and/or objective values for all child transactions CIs that appear in a 
subtree of a view, in one operation.

You can define the new values in the Edit KPI for Child Transactions 
window. Every new value you define replaces the previous value for that 
property, for each transaction CI in the subtree. Property boxes left blank in 
the Edit KPI for Child Transactions window do not affect the CIs. For details, 
see “How Dashboard KPIs Work” on page 333.

Before using the Edit KPIs for Child Transactions function, you should 
ensure that the planned new values are logical for all transaction CIs in the 
subtree. You should also review the Notes and Limitations section; for 
details, see “Notes and Limitations for KPIs and CIs” on page 334.
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Example

The following example describes editing the objective values for transaction 
CIs in a subtree.

 a In the KPIs tab, the Performance KPI objective values for every 
transaction CI in the myapp subtree appear as in the following figure. 
They are displayed by clicking the Edit KPI button for any of the 
transaction CIs.

For this example, two additional objective values are added, to include 
Warning and Major status levels for each transaction CI, and the Minor 
objective value is modified.
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 b In View Explorer, select the parent CI for the subtree—in this case, the 
Application CI myapp:

 c In the right pane, click the Edit KPIs for child transactions button for the 
required KPI—in this case, the Performance KPI.
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 d In the Edit KPI for Child Transactions window, enter the required 
values—in this case, 10000 for Warning objective, 11000 for Minor 
objective, and 12000 for Major objective.
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 e After applying the changes, all transaction CIs in the myapp subtree have 
the following objective values defined:
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Set Up the Real-Time Monitoring of CI Property Changes

For a limited number of CIs, Dashboard can monitor for changes to the CI 
properties (or changes to the properties of the CI’s child CIs) in real-time. 

This information is added to the information available in the Dashboard 
Change Report, which shows a historical report on changes to properties for 
CIs over a period of time. For details on the Change Report, see “Change 
Report Page” in Model Management.

To display real-time changes for a CI and its children, the Monitor changes 
check box must be selected for that CI in the KPIs tab. 

Note: The Monitor changes option is only enabled if:

➤ You are working in a shared CMDB environment.

➤ You enable change impact monitoring by selecting Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, click Applications, 
select Dashboard Application, and locate the Host name for MAM GUI 
Web server entry in the Change Impact Properties table. Define the Web 
server name and restart HP Business Availability Center.
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You can set the monitor changes option for up to 20 CIs. After you configure 
20 CIs, a message is displayed when you try to set the option for another CI, 
stating that the limit has been reached.

If you then clear the option for one or more of the configured CIs, the 
option becomes available again for all CIs, until the 20 CIs limit is again 
reached.

Note: To change the 20 limit, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Application, and locate the Maximum monitored CIs entry in the Change 
Impact Properties table. Modify the value as required. However, change this 
value with caution to avoid overload on the system.

When the monitor changes option has been set for a CI, Dashboard 
continuously monitors that CI and all its child CIs, to see if a change occurs 
in one of the significant properties defined for the CIs.

The significant properties vary for each CIT, according to the CIT definition 
in Admin > CMDB > CI Type Manager. In CI Type Manager, in the Attributes 
tab for the CIT, the Change Monitored column must be selected for a 
property, in order for that property to be significant and therefore 
monitored. For more information on CIT definitions, see “CI Type 
Manager” in CI Attribute Customization.

If a change occurs in one of the significant properties for the CI or the CI 
children, then an icon is displayed in Dashboard beside the CI name. For 
more information, see “Analyze Real-Time Change Information” on 
page 40.

After a change occurs, the change icon is displayed for 24 hours (default 
value). You can change the default value. For details, see “Customize the 
Change Period” on page 41.
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Define Selectors

In the selector Filter area, you define selector expressions to filter the data 
samples, to target only those samples that are relevant for the KPI. A selector 
expression requires a Field, an Operator, and a Value, defined in that order. 
For more information, see “Selector Area” on page 411.

You can define selectors using predefined sample parameters, or create 
custom selectors. You can then combine those selectors to create complex 
filters with several selector expressions.

This task includes the following steps:

➤ “Define a Selector Expression Using Predefined Sample Parameters” on 
page 382

➤ “Define a Custom Selector” on page 385

➤ “Build Complex Filters” on page 386

 1 Define a Selector Expression Using Predefined Sample 
Parameters
Define the selector expressions by selecting from metadata—predefined 
sample types and sample parameters in the database. 

Note: You can also build a custom selector as explained below.

When defining or editing a selector using predefined sample data, you can 
select Field and Operator values from predefined lists. This definition 
method validates the field names and operators, and prevents errors that 
might occur when manually entering field names. It also simplifies the 
process of defining a selector. 

The predefined fields use metadata, information on sample types collected 
from data samples arriving from various data sources (including HP data 
collectors and third-party data sources) and stored in the database. For 
explanations of the data samples and their fields, see “Data Samples” in 
Reference Information.
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Example

 a Define the sample type that applies for this KPI. Select the sample type 
from the list at the top of the Selector area in the New KPI or Edit KPI 
window. The list is based on the sample types currently in the database.

For example, for a KPI that relates to transaction measurements, select 
sample type Transactions from the list.

When you select a sample type from the list, all previously defined 
expressions for the selector are overridden, so the contents of the Filter 
box are automatically deleted. 
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The Field box in the first selector expression converts to a dropdown list, 
containing all valid options for the selected sample type. The Field box 
defines the required reference property in the data samples.

 

 b Select an option from the Field list. 

The Operator list is automatically updated so that it contains only those 
operators that are valid for the selected field. For example, if the selected 
field always contains a text string, then only the operators that are used 
with text are included in the list, such as like, notIn, ==, in.

 c Enter a value for the selected field in the Value box.

Note: The Value property is case sensitive and must be entered precisely 
as used in the data samples from the data source, or the selector fails. The 
recommended method is to take the values from the samples published 
on the bus. 
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 2 Define a Custom Selector
Define the selector expressions by manually defining the sample type and 
sample parameters. You can build a custom selector using any field name, 
and, if required, can combine fields from two or more data types. 

Note: You can have HP Business Availability Center automatically assign the 
default selector for the monitoring CI, by leaving the selector expressions 
blank in the New KPI/Edit KPI window. After clicking OK to close the 
window, HP Business Availability Center assigns the KPI the default selector 
for the CI, as used by the default KPIs attached to the CI.

When defining or editing a selector, you can build a custom selector by 
manually defining all information for the selector. Ensure that no sample 
type is defined in the list at the top of the Selector area in the New KPI or 
Edit KPI window (the box should display Custom).

If a sample type was previously selected in the list, and you then select 
Custom, all previously defined expressions for the selector are overridden 
and the contents of the Filter box are automatically deleted.

Every selector must include the definition of the sample type required for 
the KPI, so when manually defining a selector, at least one selector 
expression must contain this information. For example, for a KPI that relates 
to transaction measurements, the selector must "catch" transaction samples, 
which are defined by the sample type "trans_t" in the selector.
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Note: The Field and Value properties are case sensitive and must be entered 
precisely as used in the data samples from the data source, or the selector 
fails. The recommended method is to take the values from the samples 
published on the bus. For details, see “Data Samples” in Reference 
Information.

To define a custom selector expression, enter the required reference property 
in the Field box, select an operator from the Operator list. You can select 
from any of the operators used in Dashboard, and enter the required value 
for the property directly in the Value box.

For details about samples, see “Sample: Transactions (trans_t)” in Reference 
Information.

 3 Build Complex Filters
You can use metadata to build a complex filter, by defining blocks of selector 
expressions that together form a complex logical expression: 

➤ Narrow the filter by using a logical And operator to attach additional 
selector expressions to an expression block. 

➤ Widen the filter by using a logical Or operator to add alternative expression 
blocks (each containing one or more selector expressions).

You can define as many selector expressions and blocks of selector 
expressions as required:

➤ To define an additional selector expression within a block, click the And 
button for that block. An additional empty selector expression row is 
displayed in the block.
386



Chapter 11 • KPIs
For example, you can define a filter that looks for transaction samples that 
contain both profile name X and transaction name Y. 

➤ To define an alternative expression block, click the Add ’OR’ Expression 
button. A new block is created, with an empty selector expression row.

Example

You can define a filter that looks for transaction samples that contain either 
transaction name X or transaction name Y. 

You can add additional selector expressions to the new block using the And 
button for the block. 

A data sample qualifies for the selector if all the selector expressions in a 
single expression block are TRUE for the data sample. For example, either 
selector expressions a and b and c in block 1 are all TRUE, or selector 
expressions d and e and f in block 2 are all TRUE. 

Example of selector with two expression blocks.
387



Chapter 11 • KPIs
Set Up User Mode Functionality

You can set up user mode functionality in HP Business Availability Center 
by defining the mode for users, defining the KPI versions for each mode, 
and attaching the KPI versions to the CIs.

This task includes the following steps:

➤ “Assign a User Mode” on page 388

➤ “Define KPI Versions for the User Modes” on page 388

➤ “Attach KPI Versions to CIs” on page 390

 1 Assign a User Mode
There are two ways to assign a user mode to a user:

➤ The system administrator, when defining new users in the Admin > Platform 
> Users and Permissions > User Management page, can set User Mode to 
Undefined, Operations User, or Business User. By default, all new/existing 
users are set as Unspecified (meaning that they see KPIs for both modes in 
Dashboard).

➤ Users can change their own user mode in the Admin > Personal Settings > 
General Settings page. In the User Mode area, select the required mode 
from the Select user mode list.

After changing the mode in the General Settings page, you must log out of 
HP Business Availability Center and log in again to see the mode filtering 
work.

 2 Define KPI Versions for the User Modes
The following steps describe how to define different versions of a KPI to use 
with each user mode. You can assign user modes to a new KPI that you 
define, or to an existing KPI by cloning or overriding the KPI. For more 
information, see “KPIs Repository Page” in CI Attribute Customization.

If you want one of the KPI versions for a user mode to automatically replace 
an existing KPI, then you must override the existing KPI and edit the new 
version.
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It is recommended that you give a name to each KPI that is assigned a user 
mode that easily identifies the KPI with the appropriate user version. For 
example, you can add an appropriate suffix.

Example – Define KPI Versions For User Modes

 a Access the Admin > Dashboard > Repositories > KPIs page.

 b Define the business user version of the KPI:

➤ Add the required KPI to the Custom KPIs area by cloning or overriding 
a KPI, or creating a new KPI. Open the KPI for editing.

➤ In the displayed KPI Details window, give the new KPI/copied KPI an 
appropriate name. For example, add the suffix "_biz" (as in 
Availability_biz).

➤ Select Business in the Applicable for User Mode list.

 c Define the operations user version of the KPI:

➤ Add the required KPI to the Custom KPIs area by cloning or overriding 
a KPI, or creating a new KPI. Open the KPI for editing.

➤ In the displayed KPI Details window, give the new KPI/copied KPI an 
appropriate name. For example, add the suffix "_ops" (as in 
Availability_ops).

➤ Select Operations in the Applicable for User Mode list.

Note: If you override a KPI, the overridden version of the KPI replaces the 
original KPI throughout Dashboard, so all CIs that are assigned the 
original CI (for example, Availability) are automatically updated to the 
new version (for example, Availability_ops).

 d Edit the details for each KPI version, according to your requirements. For 
example, you might want different business rules to apply to each 
version. For more information, see “KPI Details Dialog Box” in 
CI Attribute Customization.
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 e If you want to use a different version of a business rule with each KPI 
version, you must define the rule versions in the Business Rules 
Repository. For example, for two versions of the Availability KPI, you may 
require two versions of the Transaction Availability Rule, each with 
different default objective values.

For details on defining business rules, see “Set Up/Edit a Business Rule” in 
CI Attribute Customization.

 3 Attach KPI Versions to CIs
You can manually attach the KPI versions to the CIs to which you want 
them to apply. 

➤ If the original KPI is already attached to CIs (for example, the Availability 
KPI is automatically attached to transaction CIs), then the KPI version that 
overrode the original (for example, Availability_ops) is automatically 
attached to the CIs instead. You can manually attach the second KPI version 
(for example, Availability_biz).

➤ If there are two new KPI versions, one for business and one for operations 
then for every applicable CI you manually attach the two versions (and 
delete the original KPI if it is not required).

To attach the KPI versions to CIs, select Admin > Dashboard > KPIs page, add 
the KPI versions to each CI where they are required, so that the CIs have 
both versions of the KPI. You can add the KPI to multiple CIs in one 
operation. For example, you might want to define different objective values 
for the KPI. For KPIs that require selectors: Do not define anything in the 
Selector area, leave the selector expressions empty. Click OK to save the KPI 
details. The KPI version is added to each selected CI, and propagates up the 
hierarchy to the parent CIs. After you click OK to add the KPI to the CI(s), 
HP Business Availability Center automatically replaces each blank selector 
with the default selector defined for the other KPIs attached to each CI. For 
details, see “How Dashboard KPIs Work” on page 333.
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Example – Scenario of KPI Versions for User Modes

In the following example scenario, two versions of the Availability KPI are 
set up, one for each user mode. The Availability_ops version uses the default 
objective values; however, when the Availability_biz version is attached to 
CIs, different objective values are defined.

Proceed as follows to set up and use Availability KPI versions for user modes:

 a Access the Admin > Dashboard > Repositories > KPIs page.

 b In the Factory KPIs area, select the check box for the Availability KPI and 
click Clone. The cloned KPI is displayed in the Custom KPIs area.

 

 c Click the Edit buttonfor the cloned KPI. In the displayed KPI Details 
window, edit the KPI properties as follows:

➤ In the Display Label box, add the suffix _biz to the Availability label.

➤ Select Business in the Applicable for User Mode list.
 

➤ Click OK.

 d In the Factory KPIs area, select the check box for the Availability KPI and 
click Override. The old Availability KPI is shown as overridden, and the 
new version of the KPI is displayed in the Custom KPIs area. 
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 e Click the Edit button for the new KPI. In the displayed KPI Details 
window, edit the KPI properties as follows:

➤ In the Display Label box, add the suffix _ops to the Availability label.

➤ Select Operations in the Applicable for User Mode list.
 

➤ Click OK.

The KPI names are displayed in the Custom KPIs area.
 

 f Access the Admin > Dashboard > KPIs page and open the End User 
Monitors View. For all BPM Transaction from Location CIs, the 
Availability KPI has been replaced with the Availability_ops KPI.
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 g Add the Availability_biz KPI to all BPM Transaction from Location CIs. 
Use the keyboard CTRL key to select all the CIs, then right-click one of the 
selected CIs and select Add KPI.

The Add KPI to Multiple CIs window opens.

 h Edit the properties in the Add KPI to Multiple CIs Window as follows:

➤ Select Availability_biz in the KPI list.

➤ Select Transaction Availability Rule in the Business rule list.

➤ In the Objectives area, enter the objective values required for 
Availability KPI in business user mode: 80, 60, 40, 20.
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➤ Leave the selector expressions empty.
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➤ Click OK. The Availability_biz KPI is added to the KPIs list for each 
selected CI.

The appropriate selector is automatically defined for each new KPI, by 
copying the selector definitions for the other KPIs attached to the BPM 
Transaction from Location CI. (You can click the Edit buttonfor the 
Availability_biz KPI to view the selector.)

The Availability_biz KPI also propagates up to the CI parents, using the 
default group rule for the KPI.

 i In the Applications > Dashboard > Console page, you can see the 
Availability KPI versions as follows:

➤ For users assigned Operations mode:
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➤ For users assigned Business mode:

A CI can display different status for each Availability KPI version 
(although each KPI has the same Availability score), because of the 
different objective levels defined for each version.

Reference

KPIs User Interface

This section describes:

 ➤  Context Menus List Editor Dialog Box on page 396

 ➤  Event Details Dialog Box on page 397

 ➤  KPIs Page on page 398

 ➤  New KPI/Add KPI to Multiple CIs/Edit KPI/Edit KPI for Child Transaction 
Dialog Box on page 406

Context Menus List Editor Dialog Box

Description Enables you to select the context menus you want to 
assign to the CI.

To Access: Click Edit in the KPIs page.

Important 
Information

Move the context menus from the Available Context 
Menus box to the Active Context Menus box, and the 
other way around, using the arrows.
396



Chapter 11 • KPIs
Event Details Dialog Box

Description Enables you to display data from the last sample that 
arrived for a monitor CI; this includes all of the 
parameters for the CI, and the parameter values at the 
last update.

To Access: From the Console or Filters tabs in 
Dashboard, click the status icon for a monitor CI. (If 
there is an associated Event Details dialog box for a CI, 
then the cursor changes to a hand when you hold the 
cursor over the status icon for the CI.)

Important 
Information

To view the Event Details dialog box for CIs, you must 
configure Dashboard to save the last sample for the CI. 
You can configure this per KPI rule (so that you only 
see sample details for a monitor CI under that KPI), or 
for all rules. For details on how to do this, see “View 
Sample Details” in Using Dashboard.

Note: Storing last sample details may require use of a 
large amount of memory, slowing down Dashboard 
performance.

Note: You can open as many Event Details dialog boxes 
as required; if you move to another application or 
administration page in HP Business Availability Center, 
any open Event Details dialog boxes are closed.

Included in Tasks “View Sample Details” on page 35
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

KPIs Page

GUI Element (A-Z) Description

Event Message area Displays the details for the CI (according to the KPI) at 
the last update. 

Note: The Event Details dialog box is not automatically 
refreshed when there is a new update for the CI. You 
can refresh by right-clicking in the dialog box (outside 
of the Event Message panel) and selecting Refresh, or 
by closing and reopening the dialog box.

Event Source area Contains parameters providing information on the KPI 
(in the Dimension name field) for which the event 
details are relevant, the date and time of the last update 
to the CI, and the CI status at that update.

Description Displays, depending on the selected CI, information 
about the CI’s assigned KPIs, the view’s KPIs, the 
associated business rules, context menu, the KPI’s user 
mode, and/or additional information.

To Access: Select Admin > Dashboard, click the KPIs 
tab, select the required view and the required CI in the 
View Explorer in the left pane. (For information on 
using View Explorer, see “View Explorer” in Model 
Management.)

Included in Tasks “Configure a KPI – Workflow” on page 366
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KPI Selection Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the view’s KPIs, the KPI’s user mode (Business 
or Operation), and whether the KPI is included in the 
CI status, in the view, or both.

Important 
Information

The KPI Selection area is displayed when you select the 
root CI in the view.

You can sort the information displayed in the KPIs 
table by clicking on the column header. You can switch 
the column between ascending and descending order 
by clicking the header again.

GUI Element (A-Z) Description

Business Appears only when you select the root CI in View 
Explorer.

A star indicates if the KPI is defined for the Business 
user mode. For details about user mode, see “KPIs for 
User Modes” on page 352.

Include in CI Status Clear the option to ensure that the KPI is displayed in 
the Dashboard views and in the tooltips but that it is 
not included in the CIs generic status when the CI 
status is calculated by including all the CI’s KPIs (like in 
Top View, Custom Map, Geographical Map, and 
Topology Map).

Default value: The option is selected.

Note: 

➤ The selection has a similar impact on the relevant 
My BAC portlets. For details, see “Edit Preferences 
<portlet_name> Dialog Box” in Using My BAC.

➤ The Include in CI Status option is automatically 
cleared when the Include in View option is cleared.
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Include in View Clear the option to ensure that the KPI is not displayed 
in the Dashboard views and in the tooltips, and that it 
is not included in the CIs generic status when the CI 
status is calculated by including all the CI’s KPIs (like in 
Top View, Custom Map, Geographical Map, and 
Topology Map). 

Default value: The option is selected.

Note: The selection has a similar impact on the 
relevant My BAC portlets. For details, see “Edit 
Preferences <portlet_name> Dialog Box” in Using My 
BAC.

Note: The Include in CI Status option is automatically 
cleared when the Include in View option is cleared.

KPI The name of the KPI.

Operations Appears only when you select the root CI in View 
Explorer.

A star indicates if the KPI is defined for the Business 
user mode. For details about user mode, see “KPIs for 
User Modes” on page 352.

GUI Element (A-Z) Description
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KPIs area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays, depending on the selected CI, the CI’s 
assigned KPIs, associated business rules, and context 
menu, or the view’s KPIs, whether the KPI is defined in 
Business or Operation user mode, and whether to 
include the KPI in the CI status or the view’s 
calculations

If you select a CI in View Explorer (not the root CI), the 
KPIs page displays the KPIs and associated business 
rules defined for the selected CI.

If you select the root CI in View Explorer, the KPIs page 
display all the view's KPIs when you expand the KPI 
Selection area. 

To Access: Select Admin > Dashboard, click the KPIs 
tab, and select the required view and then the required 
CI in the View Explorer in the left pane. (For 
information on using View Explorer, see “View 
Explorer” in Model Management.)

Important 
Information

You can sort the information displayed in the KPIs 
table by clicking on the column header. You can switch 
the column between ascending and descending order 
by clicking the header again.

GUI Element (A-Z) Description

Click to edit an existing KPI for a CI (or for multiple 
transaction CIs), as described in “How Dashboard KPIs 
Work” on page 333.
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Click to edit the KPIs for the child transactions. For 
details, see “How Dashboard KPIs Work” on page 333.

The Edit KPI for child transactions button is enabled for 
all KPIs, however:

➤ The option is only relevant for Performance and 
Availability KPIs (an error message is displayed for 
other KPIs).

➤ The option has validity only when there are 
Business Process Monitor transaction CIs contained 
in the subtree. 

Note: 

➤ Changes made in the Edit KPIs for Child Transaction 
window have no effect on KPIs other than 
Performance and Availability, or on CIs for which 
the option does not apply.

➤ After applying the Edit KPI for child transactions 
option, a KPI was saved successfully message is 
displayed in the top-right corner of the page, even if 
no changes were made to any CIs.

➤ If a transaction CI in the subtree is using a business 
rule other than the default monitor rule for the KPI 
(Transaction Availability Rule or Transaction 
Performance Rule), then when you apply the Edit 
KPI for child transactions option, the existing rule is 
replaced with the default rule.

Click to delete a KPI attached to a CI.

Business Rule The name of the business rule attached to the KPI.

KPI The name of the KPI.

GUI Element (A-Z) Description
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Monitor changes Set Dashboard to monitor (in real-time) changes made 
to the properties for a selected CI, or to the child CIs 
for the selected CI, as described in “Change the No 
Data Timeout Value for Transaction CIs – Optional” on 
page 369.

The icons that mark the changed CIs appear in the 
Console and Filter pages.

For a limited number of CIs (20 by default), Dashboard 
can monitor for changes to the CI properties (or 
changes to the properties of the CI’s child CIs) in 
real-time. To change the default, see “Set Up the Real-
Time Monitoring of CI Property Changes” on page 380

This information is in addition to the Dashboard 
Change Report, which shows a historical report on 
changes to properties for CIs over a period of time. (For 
details on the Change Report, see “Change Report 
Page” in Model Management.)

Note: The Monitor changes option is only enabled if:

➤ You are working in a shared CMDB environment.

➤ You enable change impact monitoring by selecting 
Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, click Applications, select 
Dashboard Application, and locate the Host name 
for MAM GUI Web server entry in the Change 
Impact Properties table. Define the Web server name 
and restart HP Business Availability Center.

New KPI Click to attach a new KPI to the CI. For details, see 
“How Dashboard KPIs Work” on page 333.

GUI Element (A-Z) Description
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Save KPI data over 
time for a CI

Click to set HP Business Availability Center to save KPI 
data for CIs, as described in “KPIs Over Time Report” 
on page 306.

You can enable/disable this option for multiple CIs by 
selecting the required CIs in View Explorer (using the 
keyboard CTRL key) and right-clicking one of the 
selected CIs. 

The option is selected by default for CIs of the 
following types: Business Process, Business Process 
Group, Line of Business, Application (logical 
application), and End User Management Application 
Related Group. The option is not available (disabled) 
for monitoring CIs. 

(If you also want to save data on the actual 
measurements for the KPIs, you must change the 
default settings for Dashboard in the Repositories, as 
described in “Change the No Data Timeout Value for 
Transaction CIs – Optional” on page 369.)

Saving status (and measurements) data for long periods 
or for many CIs can occupy a lot of database memory, 
so this option should be used with care. When you no 
longer require data to be saved for a CI, clear the check 
box.

GUI Element (A-Z) Description
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Context Menu area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays, depending on the selected CI, the CI’s 
assigned KPIs, associated business rules, and context 
menu, or the view’s KPIs, whether the KPI is defined in 
Business or Operation user mode, and whether to 
include the KPI in the CI status or the view’s 
calculations

If you select a CI in View Explorer (not the root CI), the 
KPIs page displays the KPIs and associated business 
rules defined for the selected CI.

If you select the root CI in View Explorer, the KPIs page 
display all the view's KPIs when you expand the KPI 
Selection area. 

To Access: Select Admin > Dashboard, click the KPIs 
tab, and select the required view and then the required 
CI in the View Explorer in the left pane. (For 
information on using View Explorer, see “View 
Explorer” in Model Management.)

Important 
Information

You can sort the information displayed in the KPIs 
table by clicking on the column header. You can switch 
the column between ascending and descending order 
by clicking the header again.

GUI Element (A-Z) Description

<Context menu> The name of the context menus that you assigned to 
the CI.

Default Menu The default menu is, by default, assigned to the CI.

Edit Click to open the Context Menus List Editor dialog box 
where you select the context menus you want to assign 
to the CI.
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New KPI/Add KPI to Multiple CIs/Edit KPI/Edit KPI for 
Child Transaction Dialog Box

Description Enables you to attach additional KPIs to any CI or to 
edit the properties of a CI’s KPIs. 

To Access: Click the KPIs tab and select:

➤ (Single CI) the required CI in View Explorer, and 
either click the New KPI/Edit KPI  button in the 
right pane, or right-click the CI in View Explorer and 
select Add KPI/Edit KPI. 

➤ (Multiple CIs) the required CIs in View Explorer 
using the keyboard Ctrl key, right-click one of the 
selected CIs in View Explorer, and select Add 
KPI/Edit KPI.

➤ (multiple transactions) the required group-level CI 
in View Explorer, and either click the Edit KPI for 
child transactions  button corresponding to the 
KPI (Performance or Availability) that you want to 
edit. 
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Important 
Information

There can be only one instance of each KPI for a CI. For 
each new KPI, you define the KPI type and business 
rule. Where relevant, you also define additional 
information required by the rule.

You can attach one of the default KPIs provided with 
HP Business Availability Center, or attach a KPI that 
you defined in the KPIs repository (as described in “Set 
Up a KPI” in CI Attribute Customization). When you 
attach a KPI to multiple CIs, the KPI is added to all CIs 
that do not already have that KPI attached. All 
instances of the KPI have the same defined business 
rule and properties. Attaching a new KPI to a CI, and 
defining the KPI properties, must be undertaken with 
care; these actions can result in KPIs that give an 
inaccurate performance assessment in Dashboard. Read 
the “Notes and Limitations for KPIs and CIs” on 
page 334 before proceeding.

For information on KPI functionality, see “How 
Dashboard KPIs Work” on page 333.

Note: Changes made in the Edit KPIs for Child 
Transaction window have no effect on KPIs other than 
Transaction and Availability, or on CIs for which the 
option does not apply.

Included in Tasks “Configure a KPI – Workflow” on page 366
407



Chapter 11 • KPIs
KPI Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Hold the pointer over the question mark icon to 
display additional information for the rule.

Business Rule After selecting a KPI, the Business rule list is 
automatically updated to display all business rules that 
are relevant for the selected KPI. Select the required 
rule from the list. The rule is used to calculate the 
measurement and status for the KPI. For an 
explanation of the role of the rules, see “About 
Business Rules” on page 336. For information on each 
individual rule, see “List of Dashboard Business Rules” 
in CI Attribute Customization.

Important: After selecting a rule, the New KPI window 
is automatically updated to display the areas (Business 
Rule Parameters, Objectives, Selector, and so on) that 
are relevant for the selected rule.

Note: You should only select a monitor rule if the KPI 
is attached to a monitoring CI. For more information, 
see “Monitor Rules” on page 337.

KPI Select a KPI from the KPI list. The list contains the 
names of all available KPIs (KPIs that are already 
attached to the CI are not included in the list). For an 
explanation of each individual KPI, see “List of 
Dashboard KPIs and Their Details” in CI Attribute 
Customization.

Note: When defining a KPI for multiple CIs, the KPI list 
contains all KPI types.

OK If you do not define a selector for the KPI, then after 
clicking OK to close the New KPI window, HP Business 
Availability Center automatically assigns to the KPI the 
default selector (generally defined for the other KPIs 
attached to the monitoring CI).
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Business Rule Parameters Area

SLA If you are defining a PNR KPI, select the required values 
from the SLA list.

For information on defining the PNR KPI, see “Event 
Details Dialog Box” on page 397.

Time Interval If you are defining a PNR KPI, select the required values 
from the Time interval lists.

For information on defining the PNR KPI, see “Event 
Details Dialog Box” on page 397.

Tracking Period If you are defining a PNR KPI, select the required values 
from the Tracking period lists.

For information on defining the PNR KPI, see “Event 
Details Dialog Box” on page 397.

Description Enables you to view and modify the parameters 
relevant for the selected rule. All parameters have 
default values.

Important 
Information

If required, modify the parameter values by entering a 
new value in the appropriate boxes. The information 
after each box directs you as to the type of value that 
can be entered, for example, Any Number, Text, or 
Boolean.

Multiple KPI selection. In the Business Rule Parameters 
area, the value box is empty. Enter the required value 
in the boxes. Make sure you enter values that apply 
logically to all transactions in the group. 

For information on rule parameters and possible 
values, see the section for the relevant rule, as 
described in “List of Dashboard Business Rules” in 
CI Attribute Customization.

GUI Element (A-Z) Description
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Objectives Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define value ranges that are used to 
determine status for the KPI. The measurement for the 
KPI (calculated by the business rule) is compared with 
the objectives, and a color status assigned accordingly. 

The objectives are defined in a unit of measurement 
appropriate to the type of data dealt with by the rule. 
The unit is indicated after the objective value box.

Important 
Information

This area is displayed when necessary.

If required, you can modify the default values for the 
objectives.

Multiple KPI selection. In the Objectives area, the value 
box is empty. Enter the required value, or select a 
different operator for the objectives. Make sure you 
enter values that apply logically to all transactions in 
the group. 

For information on defining objectives, see “KPI 
Objectives” on page 340.

GUI Element (A-Z) Description

OK, Warning, Minor, 
Major, Critical

Enter the required objective value for each status in the 
appropriate box. Ensure that the numbers you enter are 
logically ordered.

For more information on objectives functionality and 
defining objectives, see “KPI Objectives” on page 340.

Operator Select the required operator. This operator is applied for 
all objectives.

Note: The Objectives area in the Edit KPIs for Child 
Transaction window displays the default Operator for 
the rule. When you apply your changes, the displayed 
default operator is updated to all transaction CIs 
(regardless of which operator they were using 
previously).
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Selector Area

Description Enables you to define the filter criteria for the KPI. The 
selector catches data samples from the incoming data 
that meet the filter criteria. A selector is required for all 
KPIs (attached to monitoring/leaf CIs) that are 
intended to calculate a measurement based on original 
sample data; otherwise no data is mapped to the KPI 
and it remains gray in Dashboard.

Important 
Information

The Selector area is displayed when necessary.

If relevant for the rule, the Selector area is displayed in 
the window. This area is displayed only for certain 
monitor rules and for Dynamic Node Factory CIs.

For a detailed explanation of selector functionality and 
defining selectors, see “Selectors for KPIs” on page 350.

In the Filter area, define selector expressions to create a 
filter for the selector. Each selector expression defines a 
required criteria for the new KPI. 

Note: If you do not define a selector for the KPI, then 
after clicking OK to close the dialog box, HP Business 
Availability Center automatically assigns to the KPI the 
default selector (generally defined for the other KPIs 
attached to the monitoring CI). For details, see “Define 
Selectors” on page 382.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<box> Selector filters can be manually defined to create a 
custom filter, or defined using metadata (predefined 
sample types). If you want to use metadata for the 
filter, select a sample type from the list at the top of the 
Selector area.

When the list displays Custom, the filter is defined 
manually. 

For more information, see “Set Up User Mode 
Functionality” on page 388.

Add 'OR' Expression You can create additional expression blocks (each 
containing one or more selector expressions) using the 
Add 'OR' Expression button, to widen the filter.

For more details, see “Build Complex Filters” on 
page 386.

And Click to define additional selector expressions to build 
a more complex filter. You can attach additional 
selector expressions to the first selector expression 
using the And button, to create an expression block 
that narrows the filter. 

For more details, see “Build Complex Filters” on 
page 386.

Field Enter the name of a reference property that the selector 
expression searches for in the incoming data samples 
sent from the data source. For details about the 
samples, see “Data Samples” in Reference Information.
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Operator The relational operator that the selector expression 
uses when comparing the actual value for the property 
against the value defined in the selector. The 
expression gives a result of TRUE or FALSE for each 
data sample.

Select an option from the list. It can be:

➤ = = or != =. Filters the samples where the value of the 
sample field specified in the Field box equals or is 
not equal to the value specified in the Value box.

➤ > or <. Filters the samples where the value of the 
sample field specified in the Field box is less or more 
than the value specified in the Value box.

➤ in or notIn. Use the |!| separator Value box. The value 
specified in the Value box can only be 100 characters 
long.

➤ >= or <=. Filters the samples where the value of the 
sample field specified in the Field box is more or 
equal to or less or equal to the value specified in the 
Value box.

➤ prefix or notPrefix. Filters in the samples where the 
sample field value starts with the string entered in 
the Value box.

➤ suffix or notSuffix. Filters in the samples where the 
sample field value ends with the string entered in 
the Value box.

➤ like or notLike. The expression you enter in the 
Value box should follow the Java standard for 
regular expression. 

Note: It is recommended to use the suffix or notSuffix 
operators instead of the like and notLike operators that 
are performance intensive.

GUI Element (A-Z) Description
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Value Enter the required value for the property. 

This is the property value that the expression compares 
with the value in the data sample. The value must be in 
numeric format if a numeric operator is selected, or it 
must be entered between quotation marks if a text 
string operator is selected.

For more information, see “Define Selectors” on 
page 382.

GUI Element (A-Z) Description
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KPI Assignments

This chapter describes how to manage KPI Assignments.

This chapter includes:

Concepts

 ➤  KPI Assignment Management Overview on page 418

 ➤  SiteScope KPI Assignment Group Overview on page 420

Tasks

 ➤  Manage KPI Assignment Groups on page 432

 ➤  Configure a KPI Assignment Rule on page 433

 ➤  Work with the SiteScope Assignment Group – Workflow on page 436

Reference

 ➤  KPI Assignments User Interface on page 437
Concepts
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KPI Assignment Management Overview 

KPI assignment are mechanisms that are activated under certain conditions  
to incorporate specific data into HP Business Availability Center, at the 
monitoring level. 

A KPI assignment includes a condition and a task. The condition describes a 
CI or sets conditions on the attributes of a CI. The task describes the context 
menus, KPIs, and rules that are automatically assigned to the CI when the 
condition occurs, and the assignment is running. Those elements are added 
to the configuration management database (CMDB).

Factory KPI assignment groups are pre-defined sets of KPI assignments. They  
work together to cover all the sets of conditions for monitoring level CIs 
needed to incorporate data from the corresponding monitored system into 
HP Business Availability Center. For details about groups, see “Groups” on 
page 420.

The following factory KPI assignment groups are available:

➤ HP Business Process Insight. For details about the KPI assignments included 
in this group, see “KPI Assignments for HP Business Process Insight” on 
page 210.

➤ SOA. For details about the KPI assignments included in this group, see “SOA 
KPI Assignment Group Details” on page 452.

➤ HP TransactionVision. For details about the KPI assignments included in this 
group, see “HP TransactionVision KPI Assignment Group Details” on 
page 454.

➤ SiteScope. For details about the KPI assignments included in this group, see 
“SiteScope KPI Assignment Group Overview” on page 420.

For details about the KPI assignments user interface, see “Assignment 
Groups Page” on page 438.

For details about how the assignment rules work, see “Assignment Rules 
Mechanism and KPI Propagation” on page 419.
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Assignment Rules Mechanism and KPI Propagation
The Dashboard and Service Level Management KPIs assignment rules 
mechanism receives notification from the CMDB about the creation of 
monitor CIs. The KPI assignment rules mechanism is activated when a 
specific attribute of the monitor CI is updated and the assignment rule 
conditions for that CI are based on the updated attribute. The assignment 
rules mechanism performs the following actions:

➤ Creates the KPIs attached to the monitor CI.

➤ Assigns the business rule to the KPI with parameters that can be based on 
attributes of the monitor CI.

➤ Assigns objectives that can be based on attributes of the monitor CI.

➤ Assigns selectors that can be based on attributes of the monitor CI.

➤ Adds the context menus.

A regular propagation mechanism propagates the assignment rule KPIs to 
higher levels in the model. For details, see “How Dashboard KPIs Work” in 
Using Dashboard.

The assignment rules mechanism is an HP Business Availability Center 
service that can be managed by Service Manager. For details, see “System 
Health Setup Wizard” in Platform Administration.

A service completes the missed assignments as soon as HP Business 
Availability Center is restarted, after it has been stopped.

The assignment rules mechanism is deployed on the Data Processing server.

Note: It is recommended to create assignment rules only for monitor CIs.

In EMS integration, the topology is added either when performing discovery 
or by the EMS Integration monitors.

For details about creating assignments, see “Define Assignment 
Configuration Dialog Box” on page 516.
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Groups
A group is a logical feature that enables you to group KPI assignments. A 
group must contain at least one assignment.

Some assignment rules are created and grouped together to cover all the 
conditions that can be applied to a specific CI. Those assignment rules can 
include the rules to be applied if the sample’s field has a specific value and 
the rules to be applied if the sample’s field does not have that specific value.

Some groups include assignment rules that are applied to different CIs.

Note: It is recommended to create assignment rules only for monitor CIs.

SiteScope KPI Assignment Group Overview

Note: The feature described here is available to users working with SiteScope 
9.50 or later. If you are working with SiteScope 9.00 or earlier, see “SiteScope 
Source Adapter Details” in Model Management. 

The SiteScope Assignment group is a logical group of KPI assignments. The 
KPI assignments assign specific KPIs, rules, and context menus to the 
appropriate CIs in the configuration management database (CMDB) under 
specified conditions usually related to the samples sent by SiteScope to 
HP Business Availability Center. 

SiteScope sends the topology information and builds the hierarchy, 
including the hosts, SiteScope groups, monitors, and additional topologies 
corresponding to specific SiteScope monitors, needed to incorporate data 
(collected by SiteScope data collectors, or supplied by other external 
resources) directly to HP Business Availability Center. The KPI assignments 
mechanism, analyzes the samples, and adds the KPIs, rules, and context 
menus at the monitoring level of the topology. 
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Siebel, SAP, and SOA topology and their measurements also use the KPI 
assignments mechanism to add the KPIs, rules, and context menus needed 
to incorporate data (collected by the appropriate SiteScope data collectors) 
into HP Business Availability Center, at the monitoring level.

The information is then used to build views for the HP Business Availability 
Center applications. Those views present the real-time monitoring data 
received from the data sources in Dashboard and Service Level Management. 

The SiteScope Assignment group is preconfigured to work immediately with 
the data collected by the SiteScope data collectors.

Note: All topologies created by SiteScope and stored in CMDB are subjected 
to the aging process. To prevent aging, see “Aging of CIs in CMDB” in Using 
System Availability Management. 

This section includes the following topics:

➤ “Predefined Monitoring Views” on page 421

➤ “Hierarchies” on page 422

➤ “KPI Assignments” on page 424

Predefined Monitoring Views
Predefined views display the created CI hierarchies for the SiteScope 
monitors. When data is received over the bus for a defined source, you can 
open the relevant view in Dashboard and view status information for the 
CIs. You can use the CI hierarchies created in the predefined monitoring 
views as the building blocks for defining your own customized views.
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Hierarchies
The default topology corresponding to the SiteScope monitors is included in 
the following views:

➤ System Monitors view:

The curved arrow indicates that the hierarchy element is recursive; the CI 
type is the child of the level above in the hierarchy, but it can also be a child 
of the CI type itself. For example, a SiteScope Group CI type is the child of a 
SiteScope Profile CI type, but can also be the child of a SiteScope group CI 
type. The view also supports the legacy hierarchies (Depends on and 
Monitored by relationships and Include Measurements and Include 
Machines options). The legacy hierarchy is not shown in the picture of the 
view displayed above.

➤ Monitored Hosts view:

Additional topologies are related to the HP Business Availability Center for 
SAP Applications, HP Business Availability Center for Siebel Applications, 
and HP Business Availability Center for SOA solutions within HP Business 
Availability Center:

➤ Siebel Application Server topology:

SiteScope creates the topology for the SiteScope Siebel Application Server 
monitor. For details, see “Siebel Views” in Solutions and Integrations.
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Note: The topology is created only if you have installed the Business 
Availability Center for Siebel license.

➤ Siebel Web Server topology:

SiteScope creates the topology for the SiteScope Siebel Web Server monitor. 
For details, see “Siebel Views” in Solutions and Integrations.

Note: The topology is created only if you have installed the Business 
Availability Center for Siebel license.

➤ SAP CCMS topology:

SiteScope creates the topology for the SiteScope SAP CCMS monitor. For 
details, see “SAP Systems View” in Solutions and Integrations.

Note: The topology is created only if you have installed the Business 
Availability Center for SAP license.

➤ SAP Work Processes topology:

SiteScope creates the topology for the SiteScope SAP Work Processes 
monitor.  For details, see “SAP Systems View” in Solutions and Integrations.

Note: The topology is created only if you have installed the Business 
Availability Center for SAP license.

➤ SOA topology:

SiteScope creates the topology for the SiteScope Web Service monitor. For 
details, see “SOA Views and Reports” in Solutions and Integrations.
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Note: The topology is created only if you have installed the Business 
Availability Center for SOA license.

KPI Assignments
The SiteScope assignment group includes the following assignments:

➤ SiteScope Monitors: 

The KPI assignment is used to assign the System KPI, its attached SiteScope 
Monitor Rule, and the SiteScope Monitor Menu, to the SiteScope Monitor 
CI.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

cmdb_class
property 
condition_
name

Operator Value

sitescope_
monitor

logging_option NOT_EQ logOnlyStatusChanged

managed_by EQ Discovery:SiteScope

context menu id KPI config rule

ssMonitorMenu – 
SiteScope Monitor Menu

1 – System 4 – SiteScope Monitor 
Rule
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➤ SiteScope Monitors Reporting Status Changes

The KPI assignment is used to assign the System KPI, its attached EMS 
Simple Rule, and the SiteScope Monitor Menu, to the SiteScope monitors 
that report status changes.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

cmdb_class
property 
condition_
name

Operator Value

sitescope_
monitor

logging_option EQ logOnlyStatusChanged

managed_by EQ Discovery:SiteScope

context menu id KPI config rule

ssMonitorMenu – 
SiteScope Monitor Menu

1 – System 0 – EMS Simple Rule
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➤ SiteScope Profile:

The KPI assignment is used to assign the SiteScope Availability KPI, and its 
attached SiteScope Profile Rule, to the SiteScope Profile Monitor CIs.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

cmdb_class
property 
condition_
name

Operator Value

sitescope_
profile_
monitor

managed_by EQ Discovery:
SiteScope

context menu id KPI config rule

N/A 1001 – SiteScope 
Availability

35 – SiteScope Profile 
Rule
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➤ SiteScope Siebel Measurements. 

The KPI assignment is used to assign the Siebel KPI, its attached SiteScope 
Vertical Rule, and the SiteScope Measurement Menu, to the SiteScope Siebel 
Measurements CIs. Those CIs correspond to measurements from the Siebel 
Application Server, Siebel Web Server, and Siebel Log monitors. The KPI 
assignment is activated when the measurement’s names do not include the 
No. of tasks in error or No. of Running Sessions strings.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

cmdb_class
property 
condition_
name

Operator Value

sitescope_
measurement

monitor_type LIKE Siebel%

data_name NOT_LIKE %No. of tasks in error

data_name NOT_LIKE %No. of Running 
Sessions

managed_by EQ Discovery:SiteScope

context menu id KPI config rule

ssMeasurementMenu – 
SiteScope Measurement 
Menu

300 – Siebel 1108 – SiteScope Vertical 
Rule
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➤ SiteScope Siebel Sessions Measurements. 

The KPI assignment is used to assign the Sessions KPI, its attached SiteScope 
Vertical Rule, and the SiteScope Measurement Menu, to the SiteScope Siebel 
Sessions Measurements CIs. Those CIs correspond to measurements from 
the Siebel Application Server monitor. The KPI assignment is activated when 
a measurement’s name includes the No. of Running Sessions string.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

cmdb_class
property 
condition_
name

Operator Value

sitescope_
measurement

monitor_type EQ Siebel Application 
Server

data_name LIKE %No. of Running 
Sessions

managed_by EQ Discovery:SiteScope

context menu id KPI config rule

ssMeasurementMenu – 
SiteScope Measurement 
Menu

304 – Sessions 1108 – SiteScope Vertical 
Rule
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➤ SiteScope Siebel Tasks in Error Measurements: 

The KPI assignment is used to assign the Tasks in Error KPI, its attached 
SiteScope Vertical Rule, and the SiteScope Measurement Menu, to the 
SiteScope Siebel Task in Error Measurements CIs. Those CIs correspond to 
measurements from the Siebel Application Server monitor. The KPI 
assignment is activated when a measurement’s name includes the No. of 
tasks in error string.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

cmdb_class
property 
condition_
name

Operator Value

sitescope_
measurement

monitor_type EQ Siebel Application 
Server

data_name LIKE %No. of tasks in error

managed_by EQ Discovery:SiteScope

context menu id KPI config rule

ssMeasurementMenu – 
SiteScope Measurement 
Menu

301 – Tasks in Error 1108 – SiteScope Vertical 
Rule
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➤ SiteScope SAP Measurements: 

The KPI assignment is used to assign the SAP KPI, its attached SiteScope 
Vertical Rule, and the SiteScope Measurement Menu, to the SiteScope SAP 
Measurements CIs. Those CIs correspond to measurements from the SAP 
CCMS, SAP Work Processes, SAP Java Web Application Server, and SAP 
CCMS Alerts monitors.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

cmdb_class
property 
condition_
name

Operator Value

sitescope_
measurement

monitor_type LIKE %SAP%

managed_by EQ Discovery:SiteScope

context menu id KPI config rule

ssMeasurementMenu – 
SiteScope Measurement 
Menu

305 – SAP 1108 – SiteScope Vertical 
Rule
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➤ SiteScope SOA Monitors: 

The KPI assignment is used to assign the Performance KPI, its attached 
SiteScope WS Operation Performance Rule, the Availability KPI, its attached 
WS Operation Availability Rule, and the SiteScope Monitors Menu, to the 
SiteScope Web Service Monitor CIs. This monitor corresponds to the 
SiteScope Web Service monitor.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

Tasks

cmdb_class
property 
condition_
name

Operator Value

sitescope_
webservice_
monitor

managed_by EQ Discovery:SiteScope

context menu id KPI config rule

ssMonitorMenu – 
SiteScope Monitor Menu

6 – Performance 1304 – SiteScope WS 
Operation Performance 
Rule

7 – Availability 1300 – WS Operation 
Availability Rule
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Manage KPI Assignment Groups

Note: You can partially edit factory groups:

➤ You can modify a factory group’s KPI assignments.

➤ You cannot add new KPI assignments to a factory group.

➤ You cannot delete existing KPI assignments within a factory group.

You can add, edit, or delete custom groups.

To manage KPI assignment groups, use the steps listed in this task.

This task includes the following steps:

➤ “Manage the Groups” on page 432

➤ “Manage the KPI Assignments” on page 432

➤ “Manage a KPI Assignment Conditions and Tasks” on page 433

 1 Manage the Groups
You can create custom KPI Assignment groups, or edit factory or custom KPI 
Assignment groups. For details, see “Assignment Groups Page” on page 438.

 2 Manage the KPI Assignments
You can stop or start any of the KPI assignments in the group. When a KPI 
assignment is stopped, the task it represents is not performed. 

You can create KPI assignments for custom KPI Assignment groups, or you 
can edit existing KPI assignments for custom or factory KPI Assignment 
groups. 

For details, see “Edit Group Page” on page 450.
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 3 Manage a KPI Assignment Conditions and Tasks
You can modify a KPI assignment condition and task. For details, see 
“Configure a KPI Assignment Rule” on page 433.

Configure a KPI Assignment Rule

You can create or edit a KPI assignment rule for each CI type. 

An assignment definition includes a condition and a task. The condition 
describes specific characteristics of a CI. The task describes the KPIs, rules, 
and context menus that are to be assigned automatically to the CI when the 
condition occurs and the assignment is running. For details, see “KPI 
Assignment Management Overview” on page 418.

Note: Only users with administrator privileges can create assignments.

This task includes the following steps:

➤ “Access the Define Assignment Configuration Dialog Box” on page 433

➤ “Define the Condition” on page 434

➤ “Define the Task” on page 434

➤ “Define the Objectives and the Operator” on page 435

 1 Access the Define Assignment Configuration Dialog Box
To create or edit a KPI assignment, you specify the condition, the task, the 
objectives, and the operator. For details, see “Define Assignment 
Configuration Dialog Box” on page 440.
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 2 Define the Condition
The condition specifies the criteria used to trigger the assignment performed 
by the task. 

Example

If you want the assignment to be triggered when the value of the data-name 
attribute of the host cmdb-class that appears in the sample equals test, the 
condition that corresponds to this request is:

Example

If you want the assignment to be triggered when the cmdb-class is 
logical_application, the condition that corresponds to this request is:

 3 Define the Task
The task specifies the KPIs, rules, context menus, context menu items, and 
tooltips to assign to the relevant CI.

Example

The groupMenu and itCIs context menus, the Availability KPI, the WS 
Operation Availability Rule are assigned to the CI, the default value of the 
No data timeout parameter of the rule is changed to 1200 (the type of the 
value is Long), and the rule calculates the KPI status when the value of the 
sampleType sample field is ws_perf_aggr_t and the value of the dc_source 
sample field is RefProp:data_name:

The objective is defined with the LESS_THAN_EQUAL operator and four 
values corresponding to the OK, WARNING, MINOR, and MAJOR types.

<condition cmdb-class="host">
 <property-condition name="data_name" operator="EQ" value="test"/>

</condition>

<condition cmdb-class="logical_application"/>
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 4 Define the Objectives and the Operator
When the KPI assignment mechanism receives a creation notification from 
the CMDB, it adds the KPI objective configuration to the new CI according 
to the assignment configuration. Use the following format:

<task-config>
<contextmenu id="groupMenu, itCIs" /> 
<kpis-config>

<kpi-config type="7">
<rule>1300</rule> 

<rule-parameter key="No data timeout" value="1200" type="Long"/>
<rule/>
<trinity-selector>

<CompositeSelector logicalOp="AND">
<Selector key="sampleType" op="EQ" type="String" value="ws_perf_aggr_t" /> 
<Selector key="dc_source" op="EQ" type="String" value="RefProp:data_name" /> 

</CompositeSelector>
</trinity-selector>
<objective>

<operator type="LESS_THAN_EQUAL"/>
<threshold type="OK" value="RefProp:rank_1_from"/>
<threshold type="WARNING" value="default"/>
<threshold type="MINOR" value="RefProp:rank_1_to"/>
<threshold type="MAJOR" value="default"/>

</objective>
</kpi-config>

</kpis-config>
</task-config>

<objective>
<operator type="operator"/>
<threshold type="OK" value="value"/>
<threshold type="WARNING" value="value"/>
<threshold type="MINOR" value="value"/>
<threshold type="MAJOR" value="value"/>

</objective>
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Work with the SiteScope Assignment Group – Workflow

Note: If you are working with SiteScope 9.0 and lower, see “Work with the 
SiteScope Source Adapter – Workflow” in Model Management. If you are 
working with SiteScope 9.50, use the following task.

This task describes how to work with the SiteScope assignment group.

This task includes the following steps:

➤ “Set Up the Permissions” on page 436

➤ “Set the SiteScope Monitors to Report to HP Business Availability Center” on 
page 437

➤ “Results” on page 437

 1 Set Up the Permissions
You must have at least the Superuser or Administrator role to have access to 
Dashboard Administration. If you have the Superuser role, you have full 
viewing and editing rights for all of the Dashboard Administration, 
including the KPI Assignments. If you have the Administrator role, you can 
only view/edit views for which you have permission and you cannot edit, 
add, or view KPI Assignments. To access the Permissions page, select Admin 
> Platform > Users and Permissions. For details, see “User Management 
Entry Page” in Platform Administration.

Note to HP Software-as-a-Service customers: You must have at least the 
Superuser, Operator, Customer Super User, or Customer Administrator role 
to have access to the Dashboard Administration. If you have the Customer 
Administrator role, you can only view/edit views for which you have 
permission, and you cannot edit the KPI Assignments. 
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 2 Set the SiteScope Monitors to Report to HP Business 
Availability Center
When you have defined monitors for SiteScope and then you set SiteScope 
to report to HP Business Availability Center for the first time, the logging 
option of each SiteScope monitor is automatically changed to Do not report 
to HP Business Availability Center.

Use this option when you do not want the SiteScope monitors and 
measurements for the subject monitor to be transferred to HP Business 
Availability Center. Select another logging option for the monitors whose 
information you need. For details on this option, see “Common Monitor 
Settings” in Using System Availability Management.

Monitors that you define after you set SiteScope to report to HP Business 
Availability Center, by default, have the Report everything option set.

 3 Results
You can view the topology created by SiteScope KPI Assignments in the 
“Hierarchies” on page 422.

Reference

KPI Assignments User Interface

This section describes:

 ➤  Add Group Dialog Box on page 438

 ➤  Assignment Groups Page on page 438

 ➤  Define Assignment Configuration Dialog Box on page 440

 ➤  Edit Group Page on page 450
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Add Group Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Assignment Groups Page

Description Enables you to add a group.

To access: Click  in the KPI Assignments tab.

Included in Tasks “Configure a KPI Assignment Rule” on page 433

GUI Element (A-Z) Description

Name The name of the group.

Mandatory.

Description The description of the group. The description is 
displayed in the Assignment Groups dialog box. 

Description Displays the Factory and Custom assignment groups.

To access: Select Admin > Dashboard > KPI Assignments

Important 
Information

You can create, edit, and delete custom groups.

You can partially edit factory groups, that is:

➤ You can modify a factory group’s assignments.

➤ You cannot add new assignments to a factory group.

➤ You cannot delete existing assignments within a 
factory group.

Included in Tasks “Configure a KPI Assignment Rule” on page 433
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Click to open the Add Group dialog box.

Select a group and click the button to open the Edit 
Group page where you can edit the group.

Select a group and click the button to delete the group.

Note: If you select a Factory group and click the button, 
the following message is displayed: Deleting a factory 
group is prohibited.

Click the Reset Column Width button to enable you to 
modify the width of the table columns or ro restore the 
table columns to their original width.

Description The description of the assignment group.

Name The name of the assignment group.

The following factory assignment groups are listed:

➤ HP Business Process Insight. For details about the KPI 
assignments included in this group, see “KPI 
Assignments for HP Business Process Insight” on 
page 210.

➤ SOA. For details about the KPI assignments included in 
this group, see “SOA KPI Assignment Group Details” 
on page 452.

➤ HP TransactionVision. For details about the KPI 
assignments included in this group, see “HP 
TransactionVision KPI Assignment Group Details” on 
page 454.

➤ SiteScope. For details about the KPI assignments 
included in this group, see “SiteScope KPI Assignment 
Group Overview” on page 420.

Type The type of the assignment group. It can be Custom or 
Factory.
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Define Assignment Configuration Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to configure an assignment.

To Access: Click the  button in the Assignment 
Group page.

Important 
Information

After you have created an assignment you cannot 
modify the condition. A workaround is to delete the 
assignment and to recreate it with a new condition.

Included in Tasks “Configure a KPI Assignment Rule” on page 433

GUI Element (A-Z) Description

Condition The condition is written in XML. It uses parameters to 
specify the criteria used to trigger the Task. For details 
about the parameters, see “KPI Assignment Rule – 
Condition” on page 441.

For details about creating a condition, see “Define the 
Condition” on page 434.

Description The description of the assignment. 

Name The name of the assignment.

Mandatory.

Run on existing CIs Set to retroactively run the assignment on existing CIs. 

When you select this option, and click OK, the 
assignment is run retroactively on the appropriate CIs 
with the appropriate conditions. 

Note: Selecting this option does not change the status 
of the KPI assignment itself.
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KPI Assignment Rule – Condition
Use the following format:

Status It can be:

➤ Assignment Configuration will be stopped after 
creation when you are creating a new assignment. 
After you configure the assignment the status of the 
assignment is automatically set in Stopped status in 
the Edit Group page if you are using KPI 
Assignments in Dashboard or in the Add Integration 
page if you are using EMS Integration.

➤ Stopped or Running depending on the status of the 
assignment you are editing.

Task The task is written in XML. It uses parameters to define 
the tasks used to assign the KPIs, rules, and context 
menus to the selected CI are listed in the following 
table. The task that is performed after the assignment is 
triggered. For details, see “KPI Assignment Rule – Task” 
on page 444.

For details about creating a task, see “Define the Task” 
on page 434.

Validate Click to validate the XML code in both the Condition 
and Task areas and to perform the indentation of the 
code.

<condition cmdb_class="class_name">
<property-condition name="name" operator="operator" value="value"/>

</condition> 

GUI Element (A-Z) Description
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The parameters used to define the KPI Assignment rule conditions are as 
follows:

Property_Condition Operator

Use one of the following values:

Element Description

condition A collection used to define the condition. 

The element’s attribute is cmdb-class, which represents the 
name of the CMDB class (not the display name) that 
corresponds to the CI for which you are creating the 
assignment. For details about the CMDB classes, select Admin > 
Modeling, select the CI type, and click the Details tab.

Note: This element is mandatory. It can contain one or more 
property-condition elements.

property-
condition

An element that creates a restriction on the condition. You can 
use more than one property-condition. The element’s 
attributes are:

➤ name. Mandatory. The name of one of the attributes of the 
CMDB class. For details about the CMDB classes, select  
 Admin > Modeling, select the CI Type, and click the
Details tab.

➤ operator. Mandatory. The operator. For details about the 
possible operators, see “Property_Condition Operator” on 
page 442. 

➤ value. Mandatory. A string that is compared to the value of 
the attribute of the CMDB class specified in 
class_attribute_name. Not mandatory when using IS_NULL 
and NOT_NULL.

Value Description

EQ Returns true when the value of the CMDB class attribute 
equals the value specified in the value attribute of the 
property-condition. See the example below.
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Example: To assign different KPIs to a CI when the value of a CI attribute 
equals or is different from a certain value, you can create:

➤ An assignment with a condition using the EQ operator, the 
property-condition name and value.

➤ Another assignment with a condition using the NOT_EQ operator for the 
same property-condition name and value.

IN Returns true when the value of the CMDB class attribute 
equals one of the elements that is listed in the value attribute 
of the property-condition. The elements in the list should be 
separated with a comma. 

IN_LIST Returns true when the value attribute of the 
property-condition equals one of the elements listed in the 
value of the CMDB class attribute, when the CMDB attribute 
type is string_list.

IS_NULL Checks where the CI attribute was not assigned a value. 
Returns true when the CMDB class attribute is empty.

LIKE Returns true when the value of the CMDB class attribute 
matches the string in the value attribute of the 
property-condition. The string of the value attribute can 
contain % as a wildcard. % may represent 0 or more 
characters.

NOT_EQ Returns true when the value of the CMDB class attribute does 
not equal the value specified in the value attribute of the 
property-condition. See the example below.

NOT_LIKE Returns true when the value of the CMDB class attribute does 
not match the string in the value attribute of the 
property-condition. The string of the value attribute can 
contain % as a wildcard. % may represent 0 or more 
characters.

NOT_NULL Checks where the CI attribute was assigned a value. Returns 
true when the CMDB class attribute is not empty.

Value Description
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For example:
 

KPI Assignment Rule – Task
Use the following format:

<condition cmdb-class="sitescope_monitor">
    <property-condition name="data_updated_by" operator="LIKE" 
value="%SiteScope_%"/>
    <property-condition name="logging_option" operator="NOT_EQ" 
value="logOnlyStatusChanged"/>
</condition>

<condition cmdb-class="sitescope_monitor">
    <property-condition name="data_updated_by" operator="LIKE" 
value="%SiteScope_%"/>
    <property-condition name="logging_option" operator="EQ" 
value="logOnlyStatusChanged"/>
</condition>

<task-config>
<contextmenu id="id, id" /> 
<kpis-config>

<kpi-config type="type">
<rule>rule_number</rule> 

<rule-parameter key="key" value="value" type="Type"/>
<rule/>
<trinity-selector>

<CompositeSelector logicalOp="logicalOp">
<Selector key="key" op="op" type="type" value="value" /> 

</CompositeSelector>
</trinity-selector>
<objective>

<operator type="type"/>
<threshold type="OK" value="value"/>
<threshold type="WARNING" value="value"/>
<threshold type="MINOR" value="value"/>
<threshold type="MAJOR" value="value"/>

</objective>
</kpi-config>

</kpis-config>
</task-config>
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The parameters used to define the KPI Assignment rule tasks are as follows:

Element Description

task-config An element used to define the task.

contextmenu Optional. An element used to specify the context menu 
you want to add to the CI to which the assignment is 
attached. 

The element’s attribute is id, which represents the 
internal name of the context menu. To add more than 
one context menu to a CI, separate their internal 
names with commas (,).

For details about the context menu internal names, see 
“Context Menu Repository Page” in CI Attribute 
Customization.

kpis-config A collection of kpi-config elements.

kpi-config An element used to define the KPI. 

The element’s attribute is type, which represents the ID 
number of the KPI. 

For details about the KPI number, see “KPIs Repository 
Page” in CI Attribute Customization.

rule An element that specifies the number of the rule you 
want to attach to the KPI. For details about the rule 
numbers, see “Parameter Details Dialog Box (KPIs)” in 
CI Attribute Customization.

Note: It can also be a collection of parameters when 
you want to override existing rule parameters or when 
you want to add new parameters to the rule.
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rule-parameter Optional. An element that defines the rule parameter. 
The element’s attributes are:

➤ key. The display name of the rule parameter.

➤ value. The value of the parameter. Corresponds to 
the Default Value in the Business Rule Repository.

➤ When you specify a value (not empty), the rule 
parameter value in the KPIs page in Dashboard 
Admin, is the given value. 

➤ When you specify RefProp:<property_name> the 
rule parameter value in the KPIs page in 
Dashboard Admin, is the CI property value.

➤ type. The type of parameter. Corresponds to the 
Type of the parameter. 

For details, see “Parameter Details Dialog Box 
(Rules)” in CI Attribute Customization.

trinity-selector A collection of selector definitions.

Composite
Selector

An element that indicates how to group logically the 
selectors. 

The element’s attribute is logicalOp, which is the 
logical operator. It can be: AND, OR, NAND, or NOR.

For example, if you want to create the following 
sample filter: a & b || c & d, use the following set of 
CompositeSelectors:

CompositeSelector logicalOp="OR"
CompositeSelector logicalOp="AND"

Selector "a"
Selector "b"

CompositeSelector logicalOp="AND"
Selector "c"
Selector "d"

Element Description
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Selector An element that filter the samples relevant for the KPI. 
It indicates how to filter the sample fields that are used 
by the rules to calculate the KPI status. When a 
monitoring (leaf) CI has a KPI and associated business 
rule that are intended to be applied to actual data 
samples, the KPI properties include a selector. 

The element’s attributes are:

➤ key. The name of the sample field.

➤ op. The operator can be:

➤ EQ or NOT_EQ

➤ GT or LT

➤ GTEQ or LTEQ

➤ IN or NOT_IN. Use the |!| separator in the value 
attribute.

➤ MATCH or NOT_MATCH. The expression you 
enter in the value attribute should follow the Java 
standard for regular expression.

➤ PREFIX or NOT_PREFIX. Filters in the samples 
where the sample field value starts with the string 
entered in the value attribute.

➤ SUFFIX or NOT_SUFFIX. Filters in the samples 
where the sample field value ends with the string 
entered in the value attribute.

➤ type. The type of field can be: String, Double, 
Integer, Long, Boolean, Float, or Binary.

➤ value. The value of the field in the sample can be:

➤ RefProp:<name of CI property>. The value can 
contain the reference to a CI property.

➤ RefPropObject:CMDB_ID. The only supported 
value is CMDB_ID. It corresponds to the ID 
number of the CI in the CMDB database. This 
value can only be used for composite selectors. Its 
type is Binary.

Element Description
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objective Optional. A collection of objective definitions. 

Note:

➤ When the KPI assignment mechanism receives a 
creation notification from uCMDB, it adds the KPI 
objective configuration to the new CI, according to 
the assignment configuration.

➤ If the KPI Objective is not defined in the 
assignment, the default objectives are taken from 
the rule repository, according to the specified rule 
type.

➤ The KPI Objective configuration must include the 
following thresholds: OK, MINOR,WARNING,MAJOR 

operator Optional. An element used to define the objective 
operator.  The element’s attributes is type. It can be:

➤ default. To indicate to take the default operator 
value from the rules repository, according to the 
specified rule type (can be empty). The result is the 
same if the operator is empty.

➤ RefProp:<reference_property_name>. The operator 
type is taken from the created CI. The value of the 
CI property must be one of the following: 
GREATER_THAN, LESS_THAN, 
GREATER_THAN_EQUAL, LESS_THAN_EQUAL, 
default, or the property is empty. If the value of the 
CI is default or if the property is empty, the default 
operator is used. 

➤ GREATER_THAN. The resulting operator is >

➤ LESS_THAN. The resulting operator is <

➤ GREATER_THAN_EQUAL. The resulting operator is 
>=

➤ LESS_THAN_EQUAL. The resulting operator is <=

Element Description
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threshold Mandatory. An element used to define the thresholds. 
The element’s  attribute is type. It can be:

➤ default. To indicate to take the default threshold 
value from the rules repository, according to the 
specified rule type. The resulting threshold value is 
the default value according to the rule (can be 
empty).

➤ ignore. To skip the threshold checking. This is 
similar to leaving an empty threshold in the KPI 
definition in the Edit KPI dialog box. For details, see 
“How Dashboard KPIs Work” in Using Dashboard. 
The resulting threshold value is empty.

➤ RefProp:<reference_property_name>. The threshold 
value is taken from the created CI. If the CI property 
is empty, the result is the same as using default. 

➤ <number>. A number that has a float, integer, or 
long format.

Element Description
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Edit Group Page

General Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to edit an existing group.

To access: In the Assignment Groups page, select a 
group and click .

Important 
Information

Depending on the KPI Assignment group you have 
selected, the Assignments area lists different 
assignments. 

Each factory KPI Assignment group has its own group 
of KPI assignments. For details, see:

➤ “HP Business Process Insight KPI Assignment Group 
Details” on page 452

➤ “SOA KPI Assignment Group Details” on page 452

➤ “SiteScope KPI Assignment Group Details” on 
page 454

➤ “HP TransactionVision KPI Assignment Group 
Details” on page 454

Included in Tasks “Configure a KPI Assignment Rule” on page 433

GUI Element (A-Z) Description

Description The description of the group. The description is 
displayed in the Assignment Groups dialog box. 

Name The name of the group.

Mandatory.

Type It can be:

➤ Factory for factory KPI Assignment Groups.

➤ Custom for custom KPI Assignment Groups.
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Assignments Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Select an assignment rule and click to start the 
assignment of the rule to existing CIs when they were 
stopped and to new CIs. The status of the assignment 
rule is Running.

Select an assignment rule and click to stop the 
assignment of the rule to the appropriate CI. The status 
of the assignment rule is then Stopped.

Click to create an assignment rule in the Define 
Assignment Configuration dialog box.

Note: This button is disabled for Factory assignment 
rules.

Select an assignment rule and click to edit the rule in 
the Define Assignment Configuration dialog box.

Select a data assignment rule and click to delete.

Note: This button is disabled for Factory assignment 
rules.

Select an assignment rule and click to synchronize the 
selected rule.

Click to refresh the list of KPI assignments after you 
have added or deleted KPI assignments, or after you 
have modifies KPI assignment names.

Click to enable you to adjust the width of the table's 
columns by dragging the borders of the column to the 
right or the left, or to reset the table columns' width to 
its default setting.

Description The description of the KPI assignment

Name The name of the KPI assignment.
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HP Business Process Insight KPI Assignment Group Details

For details about this assignment group, see “KPI Assignments for 
HP Business Process Insight” on page 210.

SOA KPI Assignment Group Details

The SOA KPI assignments include the following information:

➤ Diagnostics

The KPI assignment is used to assign the KPIs, rules, and context menu 
listed in the Task table to the Diagnostics Web Service Monitor CI.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

Status The status: 

➤ Running. The assignment has been started and is 
running on the appropriate CIs. 

➤ Stopped. The assignment has been stopped and is 
not running.

cmdb_class
property 
condition_
name

Operator Value

diagnostics_
webservice_
monitor

- - -

GUI Element (A-Z) Description
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➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

The Throughput KPI is not added to Diagnostics Web Service Monitor CI 
when the information is virtual; meaning that the data is collected by the 
SiteScope monitors.

➤ BPM

The KPI assignment is used to assign the KPIs, rules, and context menu 
listed in the Task table to the BPM Web Service Monitor CI.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

context menu id KPI config rule

diagnosticsMonitorMenu 
– Diagnostics Monitor 
Menu

6 – Performance 1301 – Diagnostics WS 
Operation Performance 
Rule

7 – Availability 1300 – WS Operation 
Availability Rule

400 – Throughput 1303 – Diagnostics WS 
Operation Throughput 
Rule

cmdb_class
property 
condition_
name

Operator Value

bpm_
webservice_
monitor

- - -
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➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

 

SiteScope KPI Assignment Group Details

For details about this assignment group, see “SiteScope KPI Assignment 
Group Overview” on page 420.

HP TransactionVision KPI Assignment Group Details

The HP TransactionVision assignment group includes the following KPI 
assignments:

➤ HP TransactionVision Common KPIs:

This KPI assignment attaches the KPIs listed in the KPI config column, their 
rules listed in the rule column, and the context menu listed in the context 
menu id column in the Task table to the TV Monitor CIs.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

context menu id KPI config rule

diagnosticsMonitorMenu 
– Diagnostics Monitor 
Menu

6 – Performance 1306 – BPM WS 
Operation Performance 
Rule

7 – Availability 1300 – WS Operation 
Availability Rule

cmdb_class
property 
condition_
name

Operator Value

tv_tx
_monitor

N/A N/A N/A
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➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

➤ HP TransactionVision Exceptions:

This KPI assignment attaches the KPIs listed in the KPI config column, their 
rules listed in the rule column, and the context menu listed in the context 
menu id column in the Task table to the TV Monitor CIs.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

context menu id KPI config rule

tvTransaction – 
TransactionVision Menu

600 – Backlog 1426 – TransactionVision 
Backlog Rule (In-Process)

1050 – Volume 1416 – TransactionVision 
Transaction Volume Rule

1313 – Delays 1422 – TransactionVision 
Delayed Value Rule 
(In-Process Transactions)

cmdb_class
property 
condition_
name

Operator Value

tv_tx
_monitor

exceptionRule
Defined

IS_TRUE N/A
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➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

➤ HP TransactionVision Failures:

This KPI assignment attaches the KPIs listed in the KPI config column, their 
rules listed in the rule column, and the context menu listed in the context 
menu id column in the Task table to the TV Monitor CIs.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

context menu id KPI config rule

tvTransaction – 
TransactionVision Menu

1310 – Exceptions 1423 – TransactionVision 
Exceptions Rate Rule 
(In-Process Transactions)

cmdb_class
property 
condition_
name

Operator Value

tv_tx
_monitor

failureRuleDefined IS_TRUE N/A

context menu id KPI config rule

tvTransaction – 
TransactionVision Menu

1312 – Failures 1429 – TransactionVision 
Failures Value Rule 
(In-Process Transactions)
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➤ HP TransactionVision Value:

This KPI assignment attaches the KPIs listed in the KPI config column, their 
rules listed in the rule column, and the context menu listed in the context 
menu id column in the Task table to the TV Monitor CIs.

➤ Condition: 

The table headers represent the tags used for specifying the cmdb_class 
(CI), property condition-name, operator, and value. 

➤ Task:

The table headers represent the tags used for specifying the context menu 
ids, KPIs, and rules that compose the assignment.

cmdb_class
property 
condition_
name

Operator Value

tv_tx
_monitor

valueRuleDefined IS_TRUE N/A

context menu id KPI config rule

tvTransaction – 
TransactionVision Menu

1311 – Value 1425 – TransactionVision 
Value Rule (In-Process 
Transaction)
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13
Dashboard Ticker 

This chapter describes the Dashboard Ticker.

This chapter includes:

Concepts

 ➤  Dashboard Ticker Overview on page 461

Tasks

 ➤  View Data in Dashboard Ticker on page 465

 ➤  Control Dashboard Ticker on page 467

 ➤  Set Ticker Preferences on page 468

Reference

 ➤  Ticker User Interface on page 469
Concepts

Dashboard Ticker Overview

HP Dashboard Ticker enables you to monitor a selected view in a non-
intrusive manner on your desktop in a Ticker Window or in a Message 
Window without opening HP Business Availability Center. 

Using HP Dashboard Ticker, you can, without opening HP Business 
Availability Center, select a view, select the server where HP Business 
Availability Center is installed, adjust the rate and the scrolling speed of the 
Ticker Window, and open the Message Window.
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This section includes the following topics:

➤ “Understanding Dashboard Ticker” on page 462

➤ “Ticker Window” on page 463

➤ “Message Window” on page 464

Understanding Dashboard Ticker
After you install HP Dashboard Ticker, one of HP Dashboard Ticker’s icons 
appears in the desktop tray bar. The type of icon displayed indicates 
different situations. A tooltip is available for each icon to describe HP 
Dashboard Ticker’s status.

For details about installing the Ticker, see “Install Dashboard Ticker” on 
page 465.

Status Icon Description Tooltip

Online. The ticker has connected with 
the server and is monitoring status.

Connected with 
<server-url>

where server-url is 
the URL of the 
server.

Message. An incoming message was 
received. A KPI has turned to Critical 
state. 

Incoming message

Offline. The server could not be found 
or the response returned from the 
server is not recognizable.

Offline - <reason>

where reason 
explains why the 
ticker is offline.

Connecting. Dashboard Ticker is 
attempting to connect to the server. 

The indication is an animated icon.

Connecting...
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HP Dashboard Ticker attempts to connect with the server using the supplied 
server address after the period of time specified in the Update interval 
parameter in the Preferences. If the server cannot be found or a connection 
cannot be established, the tray icon changes to Offline. For details about the 
Update interval parameter, see “Ticker Preferences Dialog Box” on page 471.

The tray icon changes to Connecting if Dashboard Ticker is trying to 
connect to the server. 

The tray icon changes to Online when the server has connected successfully. 

Every KPI in the selected view is checked. Any KPI with an error status is 
checked against the information already in HP Dashboard Ticker. If it is the 
first time this KPI appears in the view, or if the KPI’s status has changed to 
an error status, it is displayed in the Message Window and/or the Ticker 
Window. As soon as a message is put in the queue, the tray icon changes to 
Message, indicating that there is a message to be viewed. HP Dashboard 
Ticker’s internal message queue can contain an unlimited number of 
messages. 

Ticker Window
The Ticker Window displays a scrolling list (from right to left) of the top 
level CIs monitored by Dashboard along with icons that display the status of 
each one of the CI’s KPIs.

Move the mouse above any icon in the Ticker Window to display a tooltip 
that includes the name of the KPI.
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For details, see “Ticker Window” on page 469 in the user interface section.

Message Window
The Message Window is used to inform the user that a KPI’s status has 
changed to error/poor/worst. 

The Message Window displays the following information: 

For details, see “Message Window” on page 470 in the user interface section.

Tasks
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View Data in Dashboard Ticker

HP Dashboard Ticker enables you to monitor a selected view in a non-
intrusive manner on your desktop in a Ticker Window or in a Message 
Window without opening HP Business Availability Center. For details, see 
“Dashboard Ticker Overview” on page 461. 

This task includes the following steps:

➤ “Install Dashboard Ticker” on page 465

➤ “Launch Dashboard Ticker” on page 465

➤ “Meet the Requirements” on page 466

➤ “Control Ticker Behavior” on page 466

➤ “Set the Ticker Preferences” on page 466

➤ “View Dashboard Information in Dashboard Ticker” on page 467

 1 Install Dashboard Ticker
Install HP Dashboard Ticker as explained in this section.

To install HP Dashboard Ticker, select Admin > Platform > Setup and 
Maintenance to open the Downloads page, click HP Dashboard Ticker and 
follow the on-screen instructions.

 2 Launch Dashboard Ticker
After HP Dashboard Ticker is installed, you must launch it to configure its 
behavior.

To launch HP Dashboard Ticker, select Start > Programs > HP Dashboard 
Ticker > HP Dashboard Ticker to launch the application and open the 
Preferences page.

For details, see “Ticker Preferences Dialog Box” on page 471.
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 3 Meet the Requirements
To use the HP Dashboard Ticker you must have the following software 
installed on your computer: 

➤ Win2000 or Windows XP 

➤ Microsoft Internet Explorer 6.0 Service Pack 1 or later

Note: The requirements listed above are for the desktop version of HP 
Dashboard Ticker. To log on to HP Business Availability Center from the 
Message Window, you must fulfill the requirements detailed in the 
HP Business Availability Center Database Guide PDF.

 4 Control Ticker Behavior
You can control the behavior of HP Dashboard Ticker using the options that 
are displayed by right-clicking the icon in the tray bar. Depending on the 
icon, a subset of the capabilities described in this section is displayed. 

For details, see “Control Dashboard Ticker” on page 467.

 5 Set the Ticker Preferences
You can set the Ticker preferences so that you can view messages 
automatically or you can click the Message icon to display the Message 
Window. The Message Window fades out after 5 seconds. 

If you click the icon in the Message Window, the message that is currently 
displayed is removed from the queue as soon as you close the window. 

If you select to display the Message Window automatically and you do not 
click that window, the Message Window fades out after 5 seconds, and the 
message is considered unread. It is not removed from the queue.

For details, see “Set Ticker Preferences” on page 468.
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 6 View Dashboard Information in Dashboard Ticker
HP Dashboard Ticker enables you to monitor a selected view in a non-
intrusive manner on your desktop in a Ticker Window or in a Message 
Window without opening HP Business Availability Center.

For details about the Ticker Window, see “Ticker Window” on page 463.

For details about the Message Window, see “Message Window” on page 464.

Control Dashboard Ticker

You can view an event in the Message Window or in the Ticker Window. 
You can open the Web browser, connect to the HP Business Availability 
Center server, and display the view in Dashboard. You can select what 
information is displayed in HP Dashboard Ticker, and how it is displayed.

You can control the behavior of HP Dashboard Ticker using the options that 
are displayed by right-clicking the icon in the tray bar. For details, see 
“Understanding Dashboard Ticker” on page 462. 

Depending on the icon, a subset of the following options is displayed:

➤ Show Current Event. To display the event if an event is waiting in the 
queue. For details, see “Message Window” on page 464.

➤ Show Ticker. To display the Ticker Window. For details, see “Ticker Window” 
on page 469.

➤ Log On. Opens the default Web browser, connects to the HP Business 
Availability Center server, and displays the view in Dashboard. For details, 
see “Console Page” on page 125.

➤ Preferences. To modify the information that is displayed in HP Dashboard 
Ticker, and how it is displayed. For details, see “Ticker Preferences Dialog 
Box” on page 471.

➤ About. To display the About window.

➤ Exit. To exit HP Dashboard Ticker.
467



Chapter 13 • Dashboard Ticker
Set Ticker Preferences

You can view messages automatically (defined in Preferences) or you can 
click the Message icon to display the Message Window. The Message 
Window fades out after 5 seconds. 

If you click the icon in the Message Window, the message that is currently 
displayed is removed from the queue as soon as you close the window. 

If you select to display the Message Window automatically and you do not 
click that window, the Message Window fades out after 5 seconds and the 
message is considered unread. It is not removed from the queue.

You can:

➤ Reload a View to Display in the Ticker Window or in the Message Window

➤ Select the View to Display in the Ticker Window or in the Message Window

➤ Change the Server You are Accessing

➤ Modify the Refresh Rate of the Ticker Window

➤ Change the Scrolling Speed of the Ticker Window

➤ Select the Dock Orientation of the Ticker Window on Your Desktop

➤ Display a Popup Message Window When a New Message Arrives

➤ Sound an Alert When a New Message Arrives

➤ Automatically Load HP Dashboard Ticker When You Start Your Computer

For details about the steps to follow to view data in Dashboard Ticker, see 
“View Data in Dashboard Ticker” on page 465.

For details about setting the Ticker preferences, see “Ticker Preferences 
Dialog Box” on page 471.

Reference
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Ticker User Interface

This section describes:

 ➤  Ticker Window on page 469

 ➤  Message Window on page 470

 ➤  Ticker Preferences Dialog Box on page 471

Ticker Window

Description Enables you to view a scrolling list (from right to left) 
of the top level CIs monitored by Dashboard along 
with icons that display the status of each one of the 
CI’s KPIs. The icons correspond to the icons displayed 
in the Top View tab in Dashboard. 

To Access: Set up Dashboard Ticker. 

Important 
Information

➤ You set the scrolling speed of HP Dashboard Ticker 
in the Scrolling speed parameter in the Preferences 
page. For details, see “Ticker Preferences Dialog Box” 
on page 471.

➤ When you have moved the Ticker Window to a 
specific location on your desktop, the window is 
displayed in the same location the next time you 
select Show Ticker in the Preferences page or when 
you restart your computer.

➤ If you move the mouse to the Ticker Window, 
scrolling stops; it resumes when you move the 
mouse out of the Ticker Window.

➤ If you change any parameter in the Preferences page, 
scrolling restarts from the beginning.

➤ Modify the number of CI levels you want to display 
by changing the value of the Number of levels 
parameter in the Preferences. For details, see “Ticker 
Preferences Dialog Box” on page 471.

Included in Tasks “View Data in Dashboard Ticker” on page 465
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Message Window

GUI Element (A-Z) Description

<icons> The icons correspond to the icons displayed in the Top 
View tab in Dashboard. For details, see “KPI Icons in 
Top View” on page 112.

<tooltip> Move the mouse above any icon in the Ticker Window 
to display a tooltip that includes the name of the KPI. 
For details, see “Ticker Window” on page 463.

Description Conveys that a KPI’s status has changed to 
error/poor/worst. 

To Access: Setting up Dashboard Ticker. 

Important 
Information

➤ The window is displayed either automatically or 
manually. For details on how to set this option, see 
“Ticker Preferences Dialog Box” on page 471. 

➤ When you close the message window, the entry that 
was displayed is removed from the queue. You 
cannot redisplay that information. When you 
reopen the window, the next message in the queue 
is displayed.

➤ If you specified in the Preferences that an alarm 
should be sounded when a KPI’s status changes to 
error/poor/worst, an alarm sounds when the 
message is displayed. For details about the 
Preferences dialog box, see “Ticker Preferences 
Dialog Box” on page 471.

Included in Tasks “View Data in Dashboard Ticker” on page 465
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Ticker Preferences Dialog Box

GUI Element (A-Z) Description

The status icon of the KPI.

<first line> The name of the CI.

<second line> The name of the KPI.

<third line> The date and time when the status change was received 
by Dashboard Ticker.

Log-on Click to automatically open the view you specified in 
the Preferences, in the Console tab in Dashboard.

Description

Displays the current preferences for running the 
Dashboard Ticker. 

To Access: Right-clicking the Dashboard Ticker icon in 
the desktop tray bar and selecting Preferences.

Included in Tasks “View Data in Dashboard Ticker” on page 465
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Connection Settings Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

BAC server URL In the BAC server URL box, enter the URL or the IP 
address of the server you want to access. The URL 
format must be: http://<HP Business Availability 
Center server>/<virtual_Web_URL>
where virtual_Web_URL may be, for example: HPAM.

MMS customer Select if you are an HP Software-as-a-Service customer. 
In the ID box that is displayed, enter the customer ID 
number.

Update interval box The update interval timeout (in seconds). The 
minimum interval is 5 seconds.

Default value: 15 seconds.
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Login Information Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Selection Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Password Enter your password.

User name Enter your user name.

GUI Element (A-Z) Description

Number of levels Enter the number of levels you want to display in the 
Ticker. When displayed in the Ticker, all levels are 
flattened out.

Reload Click if you want to reload the views from the 
HP Business Availability Center server you are 
accessing.

View name Select the name of the view you want to display in the 
ticker. 
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Ticker Window Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Dock orientation Select the location of the Ticker on your desktop: 

➤ Top. The Ticker is docked at the top of the desktop.

➤ Bottom. The Ticker is docked at the bottom of the 
desktop.

➤ None. The Ticker is not docked. You can move it 
around on of the desktop. The default is None. 

Scroll speed Select a scrolling speed: Low, Mid, or High. The default 
is Mid.
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Options Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Load Dashboard 
Ticker when my 
computer starts

Select to automatically load Dashboard Ticker when 
you start your computer. For details about the Ticker 
Window, see “Ticker Window” on page 469.

Play incoming 
message sound alert

To automatically sound an alert when a new message 
arrives.

When the sound is switched on, a sound alert is played 
when the Ticker Window is currently displayed and a 
CI’s KPI changes status to Critical (red). The Critical 
status icon is also shown flashing until the next screen 
refresh. The alert sound is a WAV file downloaded by 
the browser. 

Note:

➤ The sound is played only if the status of a CI’s KPI in 
the currently displayed tree branches has changed to 
Critical. If a CI in a hidden part of the view has 
changed to Critical but does not change the status of 
any of the CIs in the currently displayed branches, 
no sound is heard.

➤ If the view is being loaded for the first time, no 
sound is played for the CI’s KPIs that are loaded at 
Critical status.

➤ If you are using Mozilla, you must download a plug-
in for playing WAV files, otherwise no sound is 
played.

To use another alert sound, access (if you are a user 
with administrative permissions) <HP Business 
Availability Center server root directory>\AppServer\ 
webapps\site.war\bam\pages\sounds and replace the 
ding.wav file with your own WAV file (you must 
rename your file ding.wav). The change takes effect 
immediately.
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Show incoming 
message desktop 
alert

To automatically display the Message Window when a 
new message arrives. If you do not select this option, 
you have to click the message icon to display the 
Message Window.

Show Ticker Window 
when my computer 
starts

To automatically load Dashboard Ticker Message 
Window when you start your computer. For details 
about the Message Window, see “Message Window” on 
page 464.

GUI Element (A-Z) Description
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Dashboard on a Mobile Device

This chapter describes how to view Dashboard data on a mobile device.

This chapter includes:

Concepts

 ➤  Dashboard on a Mobile Device Overview on page 477

Tasks

 ➤  View Data on a Mobile Device on page 478

Reference

 ➤  Mobile Device User Interface on page 479
Concepts

Dashboard on a Mobile Device Overview

You can display the operational status of components of your business using 
mobile devices with a browser that supports standard HTML. 

The configuration items (CIs) are shown in layers where each parent CI is a 
link to the layer of its children CIs. The status of the CI’s Key Performance 
Indicators (KPIs) is displayed on the right of the screen.

For details on what to do to display Dashboard data on a mobile device, see 
“View Data on a Mobile Device” on page 478.

For details about Dashboard data displayed on a mobile device, see “Mobile 
Device Page” on page 480.

Tasks
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View Data on a Mobile Device

You can display a view’s data on a mobile device using the steps described in 
this section. 

This task includes the following steps:

➤ “Pre-Requisites” on page 478

➤ “Access the Server URL” on page 478

➤ “Navigate to the View and Display the Data” on page 479

➤ “Change Display Characteristics – Optional” on page 479

 1 Pre-Requisites

➤ Ensure that the server you want to access is open to Internet.

➤ Ensure that the browser of the mobile device you want to use supports 
standard HTML.

 2 Access the Server URL
Enter the following URL in your mobile device: 
http://<HP Business Availability Center 
server>/<HP_BAC_web_application_context_name (usually 
topaz)>/mobileConsole.do

Tip: 

➤ In the mobile device, you can add the URL to your Favorites at any stage 
(login, view, or drill down). Depending on the stage, clicking the Back 
button might not access higher hierarchy levels or the view selection 
page.

➤ You must click Refresh to refresh the display as the refresh feature is not 
automatic and the data becomes obsolete.
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 3 Navigate to the View and Display the Data
Enter the appropriate information in the login screen, and select a view. For 
details, see “Mobile Device Page” on page 480.

 4 Change Display Characteristics – Optional
The display characteristics of the mobile console are controlled by an XSL 
file. If you want to modify any aspect of the display using non-Latin 
characters (for example, displaying the view and button names: Back and 
Refresh), contact HP Software Support for help in writing an XSL to support 
that feature.

Note: The characters used for KPI names depend on the user’s locale and not 
on the browser’s locale.

Reference

Mobile Device User Interface

This section describes:

 ➤  Mobile Device Page on page 480
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Mobile Device Page

Description Enables you to display a view on a mobile device. 

To Access: Enter the appropriate information in the 
login screen, and select a view. 

Important 
Information

➤ When more than a few KPIs are attached to the CI 
(depending on the device's screen resolution), the 
display becomes scrollable.

➤ Long CI names are wrapped. 

Note: Only the first four letters of the KPI names are 
displayed in the view. You might have to clone or 
rename some of the KPIs if their first four letters are the 
same; for example SAP and SAP Alert KPIs. All the 
feature’s visual aspects are controlled by the following 
XSL file:
\AppServer\webapps\site.war\mobile\dash\
console.xsl

You can modify the XSL file so the mobile device can 
display longer labels. Contact HP Software Support for 
help in writing an XSL to support that feature

This XSL file transforms the XML returned from 
HP Business Availability Center server to the mobile-
like HTML file that is displayed on the mobile device.

Included in Tasks “View Data on a Mobile Device” on page 478
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<KPI> The status of the KPIs attached to the CIs. For details 
on the displayed status, see “Understanding KPI Status” 
on page 352.

Back Click to go back to the login page.

Name The name of the CIs in the view.

Note: To drill down to a child CI, move the cursor to 
the CI, and click.

Refresh Click to refresh the view.

View The name of the view you selected in the login page.
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